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L Ä S G U I D E

Så här läser du denna handbok

Varje uppslag i handboken följer samma upplägg. På vänster sida står klickvägarna och 
de tekniska detaljerna; till höger i en varm sidokolumn hittar du alltid den enkla förkla
ringen. Små ikoner i början av varje rad talar om för dig på ett ögonblick vilken sorts 
information som följer nu.

D E  F Y R A  I KO N E R N A

Var hittar jag det? Den konkreta klickvägen genom appen — menyraden, 
Inspector-sektionen eller steg i nybörjarläget. De tillhörande tangentbordsgenvä
garna står också här. Ikonen är en kartnål och visar: Här sitter funktionen i 
användargränssnittet.

Detaljer. Standardvärden, värdeintervall och kodvägar. Du möter detta framför 
allt i träningsinställningarna, som inte är en menypost utan sifferparametrar. Iko
nen visar ett litet specifikationskort.

Tekniskt. Vad funktionen gör internt, vilka parametrar som påverkar, vad den 
reagerar på och vilka sidoeffekter den har. För läsare som vill förstå vad som 
händer bakom kulisserna. Ikonen är ett reglageblock och står symboliskt för rat
tarna under huven.

Kort sagt. Kärnan i klara ord — utan fackspråk, utan kod. Läs detta avsnitt först 
om du bara snabbt vill veta vad en funktion är till för och när du behöver den. 
Ikonen är en pratbubbla och står för „rakt på sak”. Denna kolumn är alltid satt på 
en varm sandton, så att ögat hittar den direkt.

K A P I T E L FÄ R G E R

Varje kapitel har sin egen accentfärg, som du känner igen på ID-märket (till exempel 
M1 ) till vänster om varje uppslagstitel och på de små ikonerna framför dem. När du 

bläddrar ser du direkt vilket kapitel du befinner dig i.

1 Menyer 2 Inspector 3 Inställningar 4 Hjälpfönster 6 Träning

7 Förinställningar 8 Exporter 9 SfM 10 Nybörjarläge



N AV I G E R I N G S T I P S

Snabbstart. Om det bara är handhavandet du är intresserad av, hoppa direkt 
till Kapitel 10 — Nybörjarläge. Det är den guidade varianten med fyra steg och 
kräver inga förkunskaper.

Djupare insteg. Kapitel 2 — Inspector och Kapitel 7 — Förinställningar förkla
rar reglagen och de förkonfigurerade kvalitetsprofiler som du har till hands i 
expertläget.

Slå upp. Innehållsförteckningen och PDF-fulltextsökningen hjälper dig att hitta en 
bestämd funktion. Du behöver inte läsa handboken från pärm till pärm.



R A D I A N C E K I T

K A P I T E L

Inledning — Vad du bör veta

Vad är RadianceKit?

RadianceKit är en native macOS-app som av en serie vanliga foton eller en video gör 
en begåbar 3D-rekonstruktion. Indata är till exempel 50 till 500 bilder som du har tagit 
runt ett objekt, genom ett rum eller över ett landskap. Utdata är en så kallad Gaussian-
Splatting-scen — en 3D-modell som du kan se i realtid på Mac-en från vilken vinkel som 
helst, som går att exportera och bädda in på webbsidor och som i sina huvuddrag ser 
fotorealistisk ut.

Appen körs helt lokalt på din Mac — inga bilder laddas upp till molnet, ingen inloggning 
krävs, ingen prenumeration. Den utnyttjar GPU:n i din Apple-silicon-Mac (M-serien) 
intensivt: en fullständig träning kan, beroende på scen och förinställning, ta mellan två 
minuter och flera timmar. Medan beräkningen pågår kan du arbeta helt normalt vidare 
på Mac-en, RadianceKit körs vidare i bakgrunden och hör av sig när resultatet är klart.

Det finns två handhavandelägen: Nybörjarläget (Simple Mode) leder dig i fyra steg 
genom arbetsflödet Import → Välj förinställning → Träning → Export. Expertläget (Expert 
Mode) öppnar en stor Inspector med alla rattar, ett live-förhandsvisningsfönster och di
agnosdiagram. Du kan när som helst växla mellan lägena; data i scenen bevaras därvid.

Vad är Gaussian Splatting?

Gaussian Splatting (ofta kort 3DGS eller bara Splatting) är en relativt ny metod för 
fotorealistisk 3D-framställning, presenterad 2023 i ett paper från Graz och INRIA. Idén: 
i stället för att modellera en scen som ett klassiskt polygonnät (trianglar) eller som ett 
voxelrutnät sätts den ihop av miljontals små, mjuka 3D-moln — varje enskilt moln är 
en 3D-gaussisk fördelning (därav namnet) med egen position, storlek, form, färg och 
genomskinlighet. Dessa moln tränas så att de från alla synvinklar i dina indata-foton 
tillsammans ger rätt bild.

Praktiskt betyder det: Gaussian Splatting kan visa reflektioner, högdagrar, mjukt löv
verk, hår eller draperier på ett sätt som klassisk 3D-modellering inte klarar, eller bara 
klarar med enorm möda. I gengäld är resultatet inte en redigerbar 3D-modell i klassisk 
mening — du kan inte bara flytta en enstaka vägg eller flytta en vas. Det är snarare en 
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fryst upptagning av rummet som du fritt kan röra dig igenom. För många tillämpningar 
— arkitekturvisualisering, produktpresentation, virtuella turer, kriminalteknik, kulturarv 
— är det just den rätta styrkan.

För att indata-bilderna ska bli en 3D-scen krävs två steg. Först beräknar appen via en 
metod som heter Structure-from-Motion (SfM) var din kamera stod vid varje foto. Vid 
det tillfället uppstår som biprodukt en grov punktsky över scenen. Sedan startar själva 
Gaussian-Splatting-träningen: med utgångspunkt i denna grova sky blir miljontals 3D-
moln stegvis fördelade, förstorade, förfinade och finjusterade i position och färg, tills de 
från alla indata-vinklar ger det passande bilden.

Du behöver inte veta något om något av detta för att använda RadianceKit. Nybörjar
läget döljer dessa steg helt. Men om du vill förstå vad diagnostalen i expertläget 
(iteration, loss, gaussians, SSIM …) betyder eller varför vissa scener blir vackrare än 
andra, hittar du svaren i de senare kapitlen i handboken.
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K A P I T E L

Kapitel 1 — Menulinje

RadianceKits menulinje strukturerer alle funktioner, der inte ligger direkte i hovedvindu
et eller Inspectoren. Det er først og fremmest handlinger, der virker på hele scenen 
(Åbn, Gem, Nyt projekt), styrer træningen (Start, Pause, Fortsæt), betjener viewporten 
(auto-rotation, screenshot, baggrundsfarve) og udløser eksporter til olika 3D- og 
medieformater. Dertil kommer springpunkter til alle hjælpevinduer (User Guide, Pareto 
Dashboard, Holdout Analysis, BayesOpt Console).

Tastaturgenveje står til højre for menuposten. Konventioner: ⌘  betyder Command-
tasten (Apple-tasten), ⇧  er Shift, ⌥  er Option (Alt) og ⌃  er Control. Eksempel: ⇧⌘T  
står for Shift+Command+T. Alle her dokumenterede genveje visas dessutom i et eget 
oversigtsvindue via Help → Keyboard Shortcuts (⌘/​).

De følgende 42 poster er dokumenteret i inventarets rækkefølge (M1–M42), grupperet 
efter det tilhørende top-niveau-menu. Alle poster er verificeret mod den aktuelle ko
destand i (linje 175–477). Ingen poster er fjernet eller forældede i forhold til inventaret; 
en ny Edit-menupost (Cmd-Z til „Remove Image”) optages av system- NSUndoMana
ger-frameworket og optræder därför inte i RadianceKitApp- koden (se note i slutningen 
av kapitlet).

File-menuen

Figur 1:  File-menuen foldet ud — poster M1 til M6
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File-menuen erstatter Apples standard-„New Window”-post med projektspecifikke 
handlinger. Den omfatter indlæsning/gem av scener, en dynamisk Recent-liste, 
workspace-importen og hård nulstilling til tom tilstand.

M1 File > Open Scene…

VA R

Menulinjen → File → Open Scene… (⌘O).

T E K N I S K T

Åbner en filvælger til formaterne RadianceScene -
bundle, .ply , .splat  og .spz . Enkelt-valg, kan 
visa både filer og mapper (til bundle-formatet). Ef
ter valg skrives stien i Recent- listen, og scenen 
indlæses asynkront — den forrige erstattes, og 
trænings-pipelinen initialiseres med den indlæste 
tilstand. PLY/SPZ/Splat-filer læses via de respekti
ve format-loadere; .radiancescene -bundlen är en 
mappe med manifest, cloud-snapshot og SfM-re
sultater.

KO R T  S AG T

Sådan indlæser du en allerede 
tränat scen tilbage i appen. Vir­
ker med RadianceKits eget for­
mat og med standardformaterne 
PLY, SPLAT og SPZ, som andre 
splatting-programmer genererer. 
Brug det, om du f.eks. har tränat 
en scen natten over og nästa dag 
vil arbejde videre eller eksporte­
re. Vid åbning erstattes den hid­
tidige tilstand i hovedvinduet — 
så gem først, om den nuværende 
scen stadig er viktig. Stien lander 
automatisk i „Open Recent” (M3), 
så du kommer snabbare til den 
nästa gang.

M2 File > Save Scene…

VA R

Menulinjen → File → Save Scene… (⌘S).

T E K N I S K T

Åbner en gem-fil-dialog med content-ty
pe RadianceScene -bundle og fortrykt filnavn 
scene.radiancescene. Skriver en mappe-pakke med 
manifest.json , den serialiserede gaussian-cloud 

(PLY-snapshot) og et dump av SfM-resultatet, 
så continue-träning också virker efter genåbning. 
Posten er deaktiveret, så længe der inte finns 
gaussians. Gemmer inte i training-logs-stien, men 
dér, hvor gem-dialogen peger — typiskt under ~/​
Documents/​.

KO R T  S AG T

Gemmer din aktuelle scen som 
fil (mere præcist: som en pakke-
mappe, der ser ud som en fil). 
Først därefter kan du senere åb­
ne denna scen igen med „Open 
Scene…” (M1). I pakken lander 
både gaussian-cloud’en og SfM-
resultatet, så du också kan ved­
hænge continue-träning (M12–
M14) senere. Så længe du endnu 
inte har afsluttet en träning, er 
posten grånet ud. Standardnav­
net er scene.radiancescene 
— du kan dock vælge dit eget 
navn i save-dialogen.
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M3 File > Open Recent > [scenenavn]

VA R

Menulinjen → File → Open Recent → (liste).

T E K N I S K T

Dynamisk undermenu, der genereres ud fra en 
liste over de senest åbnede stier (gemt i indstilling
erne). Hver liste-post navngives med filnavnet og 
indlæses vid klik. Om listen er tom, visas i stedet 
det deaktiverede label „No Recent Scenes”. Apple-
typiskt holder listen de N senest åbnede scener — 
begrænsningen sker vid skrivning til indstillingerne, 
inte i menu-builderen selv.

KO R T  S AG T

Her ser du de senest åbnede sce­
ner og kan springe tilbage til dem 
med et klik uden at gå via fildia­
logen. Om du lige er begyndt, er 
listen tom og står grå i menuen. 
Hver scen, du åbner via „Open 
Scene…” (M1), lander automatisk 
i denna liste. Om listen på et 
tidspunkt blir for fyldt, eller du vil 
tømme den av privatlivshensyn, 
så brug „Clear Recent” (M4).

M4 File > Open Recent > Clear Recent

VA R

Menulinjen → File → Open Recent → Clear Recent.

T E K N I S K T

Tømmer Recent-listen i indstillingerne. Virker med 
det samme uden bekræftelsesdialog. Posten optræ
der kun i undermenuen, om der overhovedet finns 
poster i Recent-listen (den står under en divider 
efter stierne).

KO R T  S AG T

Sletter listen over de senest åb­
nede scener. Praktisk, om du har 
leget med et test-datasæt og inte 
vil se stierne mere. Selve scen-
filerna slettes inte — kun forbin­
delsen i menuen. Handlingen vir­
ker med det samme uden spørgs­
mål; därefter optræder „No Re­
cent Scenes” i undermenuen. 
Posten dukker kun op, om der 
overhovedet er scener i listen — 
vid tom liste är den inte synlig.

7 / 221



R A D I A N C E K I T Kapitel 1 — Menulinje

M5 File > Import COLMAP / Metashape Workspace…

VA R

Menulinjen → File → Import COLMAP / Metashape 
Workspace… (⇧⌘I).

T E K N I S K T

Åbner en mappe-vælger. Forventer en mappe 
med COLMAP-workspace-layout (f.eks. sparse/​0/​
cameras.{bin,txt} plus images/​). Efter valg fore
tages en for-prøve av workspace — denna genken
der de tre layouts (sparse/​0/​, sparse/​, roden), og 
om rekonstruktionen er binær ( cameras.bin ) eller 
ETH3D-tekst ( cameras.txt ). Vid succes importe
res workspacet; annars visas kun en advarsel i app-
loggen. Se också kapitel 9 „SfM-backends”, Q6 for 
den fulde pipeline-logik.

KO R T  S AG T

Om du bruger Metashape, COL­
MAP, RealityCapture eller lignen­
de software til kamera-rekon­
struktionen og har en eksport, 
indlæser du mappen her. Radi­
anceKit springer så SfM-trinet 
over og starter direkte med træ­
ningen — det sparer timer på 
store scener. Træk-og-slip på ho­
vedvinduet virker på samme må­
de. Forventer en mappe med 
COLMAP-layout (altså sparse/​0/​ 
med cameras.*  plus images/​
-mappe). Mere om de un­
derstøttede layouts og workflows 
står i kapitel 9 „SfM-backends”.

M6 File > New Project

VA R

Menulinjen → File → New Project (⇧⌘N).

T E K N I S K T

Tjekker, om der finns ugemt arbejde. Om ja, duk
ker en bekræftelsesdialog op, före något går tabt. 
Om der inte er något att spara, kører nulstillingen 
direkte — den tømmer importerede bilder, SfM-re
sultatet, gaussian-cloud’en, trænings-state og alle 
afhængige UI-indikatorer. Advarsel: et preset-biblio
tek oprettet av brugeren bevares, fordi det ligger i 
app-indstillingerne og inte i projekt-tilstanden.

KO R T  S AG T

Nulstiller alt til en tom start 
— som om du lige havde åb­
net appen frisk. Om du stadig 
har ugemt arbejde, spørger ap­
pen først. Brug det, om du vil 
starte med en helt anden scen. 
Importerede bilder, SfM-resultat, 
gaussian-cloud og træningstil­
stand tømmes helt. Dine egne 
presets bevares dock, fordi de 
ligger i app-indstillingerne og in­
te hører til scenen.
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Mode-menuen

Figur 2:  Mode-menu med Simple- og Expert-Mode-skifter

To enkle kontakter mellan den guidede Simple Mode (wizard-agtig, 4 trin) og den fulde 
Expert Mode (klassisk Inspector-layout med alle håndtag).

M7 Mode > Simple Mode

VA R

Menulinjen → Mode → Simple Mode (⌘1).

T E K N I S K T

Skifter app-tilstanden til Simple Mode. Appens ho
vedområde visar så den guidede workflow i stedet 
for Expert-layoutet. Mode-tilstanden gemmes i ind
stillingerne (se S1 „Default Mode” i kapitel 3 Set
tings).

KO R T  S AG T

Skifter til skridt-for-skridt-vari­
anten, hvor appen fører dig 
genom import, behandling, for­
håndsvisning og eksport. Anbe­
fales, om du lige er begyndt, eller 
om du snabbt ska bruge et resul­
tat. De fleste detalje-håndtag er 
skjult — du arbejder med fornuf­
tige fortrukne inställningar. Om 
du senere vil dykke dybere, så 
skift bare til Expert Mode (M8). 
Hvilken tilstand der er aktiv vid 
app-start, kan du fastlægge i 
indstillingerne (kapitel 3, S1).
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M8 Mode > Expert Mode

VA R

Menulinjen → Mode → Expert Mode (⌘2).

T E K N I S K T

Skifter app-tilstanden til Expert Mode. Dermed op
træder det fulde Inspector-layout med alle sektioner 
(Presets, TrainingConfig, Enhancements, Metrics, 
LossChart, ProjectNavigator). I Expert Mode er alle 
training-parametre, COLMAP-vælger, mid-compact-
toggles og diagnostics tilgængelige. Også live-pre
view fungerer kun i denna tilstand.

KO R T  S AG T

Skifter til fuldvisning med alle 
håndtag. Her ser du loss-charts 
i realtid, kan finjustere alle para­
metre og forvalte flere sammen­
lignings-konfigurationer parallelt 
via presets. Anbefales, om du vil 
forstå, vad træningen internt gör, 
eller om du målrettet vil eksperi­
mentere. Også live-preview, COL­
MAP-vælger og diagnostics er 
kun tilgængelige her. Om du føler 
dig overvældet, så gå tilbage til 
Simple Mode via M7 — din scen 
bevares.

Training-menuen

Figur 3:  Training-menuen med Continue-undermenu — poster M9 til M14

Fire handlinger omkring trænings-kørslen: starte, pause, afbryde og forlænge med et 
angivet antal iterationer. Alle tre continue-poster er IAP-gated (kan inte klikkes i free-
trial-versionen).
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M9 Training > Start Training

VA R

Menulinjen → Training → Start Training (⇧⌘T).

T E K N I S K T

Starter trænings-pipelinen asynkront. Forudsæt
ning: et SfM-resultat foreligger, og der kører inte en 
anden pipeline. Begge betingelser blokerer posten, 
om de inte er opfyldt. Vid start læses de aktu
elle konfigurationsværdier, en ny JSONL-log opret
tes under ~/​Documents/​RadianceKit/​Logs/​training_​
YYYY-MM-DD_​HHmmss.jsonl, og afhængigt av stra
tegi-valget køres klassisk eller MCMC-stien. Træ
nings-tilstanden skifter fra „idle” til „training”.

KO R T  S AG T

Trykker på den store grønne knap 
— så snart du har importeret fo­
tos, og kamera-rekonstruktionen 
er ovre, begynder den egentlige 
Gaussian-Splatting-träning. Lad 
appen køre; afhængigt av pre­
set mellan 1 minut (Quick) og 
flere timer (MCMC Quality). Pos­
ten förblir grå, så længe der inte 
foreligger SfM-resultat, eller en 
anden pipeline kører. Hver kørsel 
skriver en log til ~/​Documents/​
RadianceKit/​Logs/​, som du 
senere kan analysere via Pareto 
Dashboard (M40).

M10 Training > Pause Training

VA R

Menulinjen → Training → Pause Training.

T E K N I S K T

Pauser den løbende träning. Aktiveres kun, när 
trænings-tilstanden er „training”. Pause stopper ite
rations-loopet vid nästa sikkerheds-sync-point, be
holder den fulde GPU-state (gaussian-buffers, opti
mizer-momenter, scheduler-position) og skifter til 
„paused”. Resume sker via fornyet tryk (post-titlen 
er statisk — appen skifter dock mellan pause/resu
me i selve logikken). Pausede træninger overlever 
inte app-quit; i så fald gem hellre scenen og udvid 
den senere via continue-training-post (M12–M14).

KO R T  S AG T

Holder kort træningen tilbage 
uden at miste fremskridtet. Prak­
tisk, om du kort ska bruge com­
puteren til något vigtigere. Klik 
igen for at fortsætte. Fungerer 
inte på tværs av app-genstart — 
om du virkelig vil fortsætte se­
nere, afslut træningen med Can­
cel (M11), gem scenen med Save 
Scene (M2) og brug därefter Con­
tinue Training (M12–M14). Under 
pause hviler GPU’en fuldstæn­
digt; hukommelsen förblir dock 
optaget.
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M11 Training > Cancel Training

VA R

Menulinjen → Training → Cancel Training.

T E K N I S K T

Afbryder den løbende träning. Aktiv, när trænings- 
tilstanden inte er „idle”. Sætter cancel-flaget i trä
nings-motor, vilket pænt afslutter iterations-loopet 
vid nästa sync-point, skriver det endelige summa
ry-element med i JSONL-loggen og nulstiller tilstan
den til „idle”. Den hidtil trænede cloud bevares 
(kan gemmes eller eksporteres), men markeres som 
„cancelled”.

KO R T  S AG T

Afbryder den løbende träning en­
deligt. Den hidtidige tilstand be­
vares — så om du allerede har 
et fremvisningsegnet resultat ef­
ter et par tusinde iterationer, kan 
du ändå eksportere det. Om du 
kun vil afbryde kort, så brug Pau­
se (M10) i stedet. I trænings-log­
gen markeres kørslen som „can­
celled”, den endelige loss-värde 
skrives ändå ned. En afbrudt 
scen kan du också fortsætte se­
nere via Continue Training (M12–
M14), så længe appen inte er bli­
vit afsluttet i mellemtiden.

M12 Training > Continue Training > +5 000 iterationer

VA R

Menulinjen → Training → Continue Training → 
+5,000 iterations.

T E K N I S K T

Fortsætter træningen med 5 000 iterationer. Ak
tiv, när en afsluttet träning kan fortsættes, og 
fuldversionen er oplåst. Fortsætteligheden gælder, 
när en afsluttet träning finns, og den fulde opti
mizer-state stadig er i hukommelsen. Vid continue 
føres Adam-momenterne og LR-scheduleren videre, 
så fortsættelsen opfører sig som en gennemgåen
de 25K-/45K-/60K-kørsel i stedet for en ny start. 
JSONL-loggen får en ny config-post med den in
krementelle opsætning. Kun tilgængelig i fuldversio
nen.

KO R T  S AG T

Hænger 5 000 yderligere træ­
nings-skridt på. Brug det, om re­
sultatet efter første kørsel er tæt 
på, men endnu inte helt skarpt. 
Fungerer kun i den betalte fuld­
version. I modsætning til en helt 
ny kørsel bevares optimizer-til­
standen, så fortsættelsen føles 
som en gennemgående kørsel. 
Om du behøver mere end 5 000 
skridt, så tag direkte M13 (+10 
000) eller M14 (+20 000).
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M13 Training > Continue Training > +10 000 iterationer

VA R

Menulinjen → Training → Continue Training → 
+10,000 iterations.

T E K N I S K T

Identisk med M12, men med 10 000 yderligere itera
tioner. Samme forudsætninger, samme LR-schedu
ler-sti. Anbefales, om den indledende träning blev 
kørt med en mid-tier-preset, og du vil se en signi
fikant kvalitetsstigning uden at starte kørslen helt 
forfra.

KO R T  S AG T

Forlænger træningen med 10 
000 skridt — den midterste av 
de tre tilgængelige continue-vär­
den. Godt valg, om første kørsel 
var okay, men du klart vil bli 
bedre. Som M12 og M14 fortsæt­
tes inlärningshastighet-forløbet 
sømløst i stedet for at starte for­
fra. Kun tilgængelig i fuldversio­
nen.

M14 Training > Continue Training > +20 000 iterationer

VA R

Menulinjen → Training → Continue Training → 
+20,000 iterations.

T E K N I S K T

Identisk med M12 / M13, men med 20 000 yderlige
re iterationer. Det største foruddefinerede continue-
spring. Vid MCMC-træninger är det ofte det, der gör 
forskellen mellan „passer” og „benchmark-egnet”; 
vid Classic fra 35–40K kommer der erfaringsmæs
sigt inte meget til.

KO R T  S AG T

Hænger 20 000 yderligere træ­
nings-skridt på, den maksimale 
continue-värde. Brug det, om du 
virkelig vil hente den sista kvan­
titet kvalitet ud. Vid klassisk trä­
ning efter 40 000 skridt giver 
det ofte inte meget mere — vid 
MCMC derimod betaler det sig 
ofte, fordi konvergensen sætter 
ind långsammare der. Regn med 
markant ekstra køretid afhæng­
igt av scenen. Som M12 og M13 er 
också denna post kun tilgænge­
lig i fuldversionen.
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Viewport-menuen

Figur 4:  Viewport-menuen med edit-mode, kamerastyring og baggrund-undermenu

Styrer 3D-viewporten: edit-mode til gaussian-valg og rensning, kamerastyring (auto-
rotation, playback, recording), screenshot, baggrundsfarve og reset.

M15 Viewport > Enter/Exit Edit Mode

VA R

Menulinjen → Viewport → Enter Edit Mode (eller 
„Exit Edit Mode” alt efter tilstand). ⇧⌘E.

T E K N I S K T

Posttitlen er dynamisk og visar alt efter tilstand „Ex
it Edit Mode” eller „Enter Edit Mode”. Vid tryk skiftes 
edit-mode på viewport-rendereren. Vid at forlade 
Edit Mode nulstilles dessutom det aktuelle valg. Edit 
Mode aktiverer klik-selektion på gaussians, box-
selection og sletning av markerede gaussians (se 
editor-området i UI’en). Deaktiveret, så længe der 
inte er forbundet en viewport-renderer.

KO R T  S AG T

Skifter mellan normal 3D-visning 
og en redigeringstilstand, hvor 
du kan markere og slette enkel­
te gaussians (f.eks. floaters eller 
outliers i baggrunden). Vid forla­
den nulstilles valget automatisk. 
Posten förblir grå, så længe der 
endnu inte är en scen synlig i 
viewporten. Etiketten skifter alt 
efter tilstand mellan „Enter Edit 
Mode” og „Exit Edit Mode” — du 
ser altså altid, vilken tilstand du 
er i.
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M16 Viewport > Toggle Auto-Rotation

VA R

Menulinjen → Viewport → Toggle Auto-Rotation 
(⌘⌥T).

T E K N I S K T

Slår den kontinuerlige rotation av viewport-kamera
et om en lodret akse genom scenens center til eller 
fra. Akse og hastighed kommer fra kamerastyrings-
konfigurationen. Auto-rotation är en ren viewport-
effekt og påvirker hverken träning eller recording — 
om du parallelt bruger turntable-video-recorderen 
(M18), leverer auto-rotationen dock præcis den sti, 
recorderen indfanger.

KO R T  S AG T

Drejer kameraet långsamt rundt 
om scenen, så du kan se den fra 
alle sider uden at trække med 
musen. Klik igen stopper rotatio­
nen. Praktisk vid vurdering av 
færdigtrænede scener eller som 
baggrundsanimation til en live-
demo. Om du parallelt optager 
en video (M18), leverer auto-rota­
tionen præcis den bevægelse, re­
corderen indfanger.

M17 Viewport > Toggle Camera Playback

VA R

Menulinjen → Viewport → Toggle Camera Playback.

T E K N I S K T

Slår kamerasti-playback til/fra. Om der finns en op
taget kamerasti (f.eks. fra en tidligere recording, 
eller fordi en transforms.json  er indlæst), kører 
stien — viewport- kameraet bevæger sig altså inte 
længere efter muse-/trackpad- input, men reprodu
cerer banen frame for frame. Fornyet tryk pauser 
playbacket.

KO R T  S AG T

Lader en tidligere optaget eller 
importeret kamerakørsel afspil­
le. Sådan kan du efterse den 
originale sti, scenen blev opta­
get med, eller tjekke en plan­
lagt orbit-bevægelse före video-
eksporten. Mens playbacket kø­
rer, er muse- og trackpad-input 
deaktiveret — kameraet følger 
strikt stien. Fornyet klik pauser 
afspilningen. Om du inte har ind­
læst eller optaget en kamerasti, 
sker der ingenting.
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M18 Viewport > Record Turntable Video

VA R

Menulinjen → Viewport → Record Turntable Video.

T E K N I S K T

Slår viewport-optagelsen til/fra. Vid første tryk star
ter en frame-optagelse i en midlertidig sti; vid 
andet tryk afsluttes optagelsen, enkodes og skrives 
til en MP4-sti (stien spørges via en gem-dialog). 
I modsætning til Export → Media → Orbit Video 
(M31), der genererer en fast 360°-sti med indstille
lig varighed, optager turntable-recorderen live det, 
du ser i viewporten — du kan altså också optage en 
manuel kamerakørsel.

KO R T  S AG T

Optager en video direkte i view­
porten. Lige meget om kamera­
et drejer automatisk, eller om 
du selv flytter det med musen 
— alt, vad du ser, gemmes i 
en MP4-fil. I modsætning til „Or­
bit Video”-eksporten (M31) angi­
ver du selv kamerakørslen. Førs­
te klik starter optagelsen, andet 
klik afslutter den og spørger om 
gemmesteder. Praktisk, om du 
f.eks. vil visa en bestemt detalje-
svingning, som den stive orbit-
bevægelse inte kunde klare.

M19 Viewport > Save Screenshot

VA R

Menulinjen → Viewport → Save Screenshot (⇧⌘S).

T E K N I S K T

Fanger et enkelt viewport-frame i fuld render-upp
lösning (altså inte vinduets pixel-layout, men det 
fulde render-target- indhold) som PNG-fil. Stien 
spørges via en gem-dialog. Baggrundsfarven (M21–
M23) brændes med ind. MetalFX-/MPS-upscaling- 
inställningar fra Enhancements (se I27/I28) virker, 
om de er aktive — screenshottet visar altså den 
opskalerede output.

KO R T  S AG T

Gemmer et øjebliksbillede av din 
aktuelle 3D-visning som PNG-
bild. Praktisk til marketing-mate­
riale eller en snabb sammenlig­
ning. Obs: baggrunden är en del 
av bilden — om du har brug 
for gennemsigtighed, så ekspor­
tér hellre en scen-fil. Opløsning­
en svarer til det interne render-
target, inte din vinduestørrelse 
— bilden er altså ofte skarpe­
re, end det ser ud i vinduet. 
Eventuelle upscaling-inställning­
ar (Inspector → Enhancements) 
regnes också med.
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M20 Viewport > Copy Camera Info

VA R

Menulinjen → Viewport → Copy Camera Info.

T E K N I S K T

Læser den aktuelle viewport-kamera-pose (posi
tion, look-at-punkt, up-vektor) og FOV-värden fra 
kamerastyringen og skriver dem som flerlinje-tekst i 
udklipsholderen. Formatet er læseligt for mennesker 
(label = value pr. linje), inte JSON. Praktisk til at re
producere en specifik visning til debug-formål eller 
dele den med support.

KO R T  S AG T

Kopierer den aktuelle kamera-
position og kigge-retning som 
tekst i udklipsholderen. Om du 
f.eks. vil visa en medudvikler, 
hvorfra et sted i scenen ser sært 
ud, så indsætter du blot teksten i 
en mail eller et chat-vindue. For­
matet er læseligt for mennesker 
(én linje pr. värde), inte JSON. 
Mest tænkt til bug-rapporter el­
ler support-forespørgsler.

M21 Viewport > Background > Dark Gray

VA R

Menulinjen → Viewport → Background → Dark Gray.

T E K N I S K T

Sætter viewport-baggrundsfarven til en mørkegrå 
(RGB 0.1/0.1/0.1). Rendereren bruger denna far
ve som baggrund, foran vilken gaussians compo
siteres. Standardfarven vid app-start styres av 
Settings-muligheden S3 „Default Viewport Back
ground”.

KO R T  S AG T

Farver 3D-viewportens baggrund 
mørkegrå. Standardvalget til de 
fleste scener — giver god kon­
trast både til lyse og mørke 
gaussians, uden at øjet hænger 
fast i en ren sort- eller hvidflade. 
Farven overtages också i scre­
enshots (M19) og orbit-videoer 
(M31). Om Dark Gray er for kede­
ligt for dig, så prøv Black (M22) 
eller White (M23) til sammenlig­
ning. Hvilken farve der er aktiv 
vid app-start, kan du fastlægge i 
indstillingerne (S3).
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M22 Viewport > Background > Black

VA R

Menulinjen → Viewport → Background → Black.

T E K N I S K T

Sætter viewport-baggrundsfarven til rent sort (RGB 
0/0/0). Hjælper, om scenen har mange lyse floaters, 
og du vil identificere dem, eller til marketing-materi
ale med mørk look-and-feel.

KO R T  S AG T

Sort baggrund. Godt til meget ly­
se scener, eller om du vil kigge 
ind i Edit Mode og leder efter små 
lyse gaussians (floaters), der för­
svinner i det grå. Også ideelt til 
marketing-materiale med mørkt, 
dramatisk look. Farven brændes 
ind i screenshots og orbit-video­
er — om du har brug for gennem­
sigtighed til en senere composit, 
er sort det dårligste valg. Til mør­
ke floaters skift den anden vej til 
White (M23).

M23 Viewport > Background > White

VA R

Menulinjen → Viewport → Background → White.

T E K N I S K T

Sætter viewport-baggrundsfarven til rent hvidt 
(RGB 1/1/1). Nyttig, om scenen overvejende har 
mørkt indhold, og du vil se mørke floaters (typiskt 
outdoor-baggrundsstøj).

KO R T  S AG T

Hvid baggrund. Praktisk, om mo­
tivet hellre kommer til sin ret 
lyst-på-mørkt, eller for at hitta 
mørke outliers, som du därefter 
kan fjerne i Edit Mode (M15). Vid 
outdoor-scener er hvid ofte mere 
användbar end sort, fordi de ty­
piske outdoor-floaters er mørke. 
Som vid de andre baggrundsmu­
ligheder overtages farven i scre­
enshots og videoer.

M24 Viewport > Reset Camera

VA R

Menulinjen → Viewport → Reset Camera.

T E K N I S K T

Nulstiller viewport-kameraet, forlader training-ca
mera-visningen og stopper auto-rotationen. Der
med er kameraet tilbage på startpositionen (typiskt: 
foran scenen, let oppefra), auto-rotationen er sluk
ket, og om rendereren just viste training-kameraet 
(en av SfM-poserne), går den tilbage til free-kame
raet.

KO R T  S AG T

Bringer viewport-kameraet til­
bage til startpositionen. Om du 
har vildet væk under rundrejsen 
eller skubbet scenen ud av bilden 
— et klik her, og du ser igen, vad 
du ska se. Slår samtidig auto-
rotationen fra, om den kører, og 
vender tilbage fra et fastfrosset 
training-kamera til den frie vis­
ning. Sådan får du i alle tilfælde 
en ren genstart av visningen.

18 / 221



R A D I A N C E K I T Kapitel 1 — Menulinje

Export-menuen

Figur 5:  Export-menuen med tre undermenu-grupper — 3D Formats, Media og Photogram
metry

Otte eksportmål plus to fotogrammetri-eksporter, grupperet i tre sektioner (3D Formats, 
Media, Photogrammetry). De første seks bygges via en fælles helper-rutine, som åbner 
en gem-dialog og registrerer eksporten i format-kataloget. Photogrammetry-posterne 
har individuel logik. Alle photogrammetry- og några 3D-eksporter er kun tilgængelige i 
fuldversionen.

M25 Export > 3D Formats > Export PLY…

VA R

Menulinjen → Export → 3D Formats → PLY (⌘E).

T E K N I S K T

Åbner en gem-dialog med default-filnavn 
gaussians.ply . Vid OK skrives den aktuelle 

gaussian-cloud i det standardiserede ASCII/bina
ry-PLY-format — kompatibel med SuperSplat, Poly
Cam, PlayCanvas og alle gængse 3DGS-viewere. 
Fulde SH-koefficienter, fuld præcision (Float32 pr. 
felt). Filstørrelse ofte flere hundrede MB vid ≥ 500K 
gaussians.

KO R T  S AG T

Gemmer din 3D-scen som stan­
dard-PLY-fil. Det er det mest 
universelle format — næsten en­
hver software kan indlæse det, 
fra SuperSplat over PolyCam til 
PlayCanvas. Filerne blir dock sto­
re, ofte flere hundrede mega­
byte. Brug PLY, om du vil arbejde 
videre i fuld kvalitet eller arkive­
re. Om du vil dele scenen via 
nettet, så kig hellre på SPZ (M27) 
eller Compressed PLY (M26) — de 
er væsentligt mindre.
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M26 Export > 3D Formats > Export Compressed PLY…

VA R

Menulinjen → Export → 3D Formats → Compressed 
PLY.

T E K N I S K T

Skriver gaussian-cloud’en i Compressed-PLY-for
matet med custom-kvantisering av position-, scale-, 
rotation- og SH-felterne. 5–10× mindre filer end 
ukomprimeret PLY (M25) med minimale visuelle 
tab. Kompatibel med SuperSplat (som læser Com
pressed-PLY-standarden) og PlayCanvas. Standard
filnavn gaussians_​compressed.ply.

KO R T  S AG T

Som almindeligt PLY, men 5–10 
gange mindre. Kvaliteten förblir 
næsten den samme. Brug det, 
om du vil dele filen online el­
ler sender den pr. e-mail. Fung­
erer direkte med SuperSplat og 
PlayCanvas. Om dit målsystem 
har brug for endnu mindre fi­
ler (mobil, browser-demoer), så 
vælg SPZ (M27) i stedet — det er 
endnu mere aggressivt kompri­
meret. Til fuld redigeringskvali­
tet vælg det ukomprimerede PLY 
(M25).

M27 Export > 3D Formats > Export SPZ…

VA R

Menulinjen → Export → 3D Formats → SPZ.

T E K N I S K T

Skriver gaussian-cloud’en i SPZ-formatet — det av 
Niantic udgivne komprimerede splat-format med 
aggressiv kvantisering (~90 % mindre end ukom
primeret PLY). Optimeret särskilt til web-viewere 
og mobile apps. Kompatibel med Niantic Splatt3R, 
gsplat.js og Niantic-browser-vieweren.

KO R T  S AG T

Ett av de mindste formater. Ca. 
10× mindre end et almindeligt 
PLY. Brug det särskilt, om du vil 
visa scenen i en browser eller via 
mobil-app. Til maksimal kvalitet 
er PLY det bedre valg. SPZ er ud­
viklet av Niantic og fungerer di­
rekte med gsplat.js, Splatt3R og 
Niantic-web-vieweren. På grund 
av den stærke komprimering kan 
du inte længere uden videre vi­
deretræne SPZ-filer — til redige­
ring vælg PLY.
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M28 Export > 3D Formats > Export glTF…

VA R

Menulinjen → Export → 3D Formats → glTF.

T E K N I S K T

Skriver en .glb -fil (binary-glTF) med 
KHR_gaussian_splatting-extensionen. Standardkon
form, egnet til pipelines, der bruger glTF-engines 
som Babylon.js eller Three.js og implementerer 
KHR_gaussian_splatting-extensionen.

KO R T  S AG T

Gemmer scenen i glTF-forma­
tet, som mange 3D-programmer 
og web-engines forstår — forud­
sat at de understøtter Gaussian-
Splatting-udvidelsen. Om du har 
en specifik 3D-pipeline (f.eks. 
Three.js eller Babylon.js), der for­
står det, är det dit format. Filen 
kommer ud som binær .glb  — 
en enkelt pakke, der innehåller 
alt. Til klassiske splatting-work­
flows er PLY eller SPZ som regel 
det bedre valg, fordi flere værk­
tøjer forstår dem direkte.

M29 Export > 3D Formats > Export .splat…

VA R

Menulinjen → Export → 3D Formats → .splat.

T E K N I S K T

Skriver Antimatter15- .splat -formatet — fast stør
relse 32 bytes pr. gaussian (position som 3× 
Float32, scale som 3× Float32, rotation som 4× 
Uint8 normaliseret quaternion, RGB+Opacity som 
4× Uint8). Ingen SH-koefficienter højere end DC. 
Mindste fil med browser-direkte-kompatibilitet. Til 
gsplat.js og antimatter15s online-demo-viewer.

KO R T  S AG T

Det simpleste web-viewer-for­
mat. Lille og straks visningsklart 
i enhver browser. Mister dock 
detalje-belysningen (højere SH-
koefficienter går tabt — splat’en 
ser ens ud fra enhver synsvinkel 
i stedet for at reagere på lyset). 
Til maksimal web-performance 
är det godt, til fotorealisme sna­
rere SPZ eller PLY. Fungerer med 
antimatter15-online-vieweren og 
gsplat.js. Hver gaussian optager 
fast 32 bytes, vilket gör formatet 
simpelt og kompatibelt — men 
just på bekostning av detaljedyb­
den.
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M30 Export > 3D Formats > Export SOG…

VA R

Menulinjen → Export → 3D Formats → SOG.

T E K N I S K T

Skriver gaussian-cloud’en i SOG-formatet. SOG 
(„Self-Organizing Gaussian”) er PlayCanvas-forma
tet med texture-atlas-layout og WebP-komprime
ring av de kvantiserede data. Skalerer med 15–20× 
bedre størrelsesforhold end PLY. Eksporten kalder 
internt cwebp  som eksternt værktøj — därför i 
sandbox-varianten (App Store) potentielt begræn
set.

KO R T  S AG T

Meget lille format til PlayCan­
vas-workflows. Ca. 15–20 gange 
mindre end PLY, fordi dataene 
pakkes i et texture-atlas-layout 
og WebP-komprimeres. Om du 
inte har en PlayCanvas-workflow, 
er SPZ eller Compressed PLY som 
regel det bedre valg. Eksporten 
kalder internt cwebp  som ek­
sternt værktøj — i App Store-ver­
sionen (sandbox) kan detta trin 
være begrænset.

M31 Export > Media > Export Orbit Video…

VA R

Menulinjen → Export → Media → Orbit Video.

T E K N I S K T

Rendrer et 360°-orbit omkring scenens center og 
enkoder den som MP4 (H.264) eller MOV (HEVC, alt 
efter systemstandard). I modsætning til M18 (live-
recording) er stien her fast — varighed vælges i 
Settings eller i Simple-Mode-eksport-trinet.

KO R T  S AG T

Genererer automatisk en drejevi­
deo omkring din scen. Ingen ma­
nuel bevægelse nødvendig. Godt 
til sociale medier eller en snabb 
demo. Om du selv vil styre kame­
raet, så brug Record Turntable 
Video (M18) i stedet. Stien er 
fast: en fuld 360°-orbit omkring 
scenens center, varighed vælger 
du i indstillingerne eller i Simp­
le-Mode-eksport-trinet. Videoen 
udgives alt efter system som 
H.264-MP4 eller HEVC-MOV.
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M32 Export > Media > Export Web Viewer…

VA R

Menulinjen → Export → Media → Web Viewer.

T E K N I S K T

Pakker en standalone-HTML-viewer (gsplat.js-base
rat) plus gaussian-dataene base64-kodet i en en
kelt .html -fil. Filen kører offline i enhver moderne 
browser — ingen server-afhængigheder, ingen ek
sterne URL’er. Filstørrelsen er ca. faktor 1.3 større 
end SPZ-varianten (på grund av base64-overhead).

KO R T  S AG T

Gemmer din scen som selvstar­
tende hjemmeside. Dobbeltklik 
på HTML-filen → browseren åb­
ner → færdig interaktiv 3D-scen. 
Fungerer uden internet, kan sen­
des pr. mail, är den enkleste 
måde at dele resultatet med 
venner eller kunder. Filen inne­
håller den komplette gsplat.js-vi­
ewer og gaussian-dataene i ett 
enkelt dokument — intet hen­
tes fra nettet. Filstørrelsen er 
ca. en tredjedel større end en 
SPZ-eksport, til gengæld behøver 
modtageren inte yderligere soft­
ware.

M33 Export > Photogrammetry > Export SfM (transforms.json)…

VA R

Menulinjen → Export → Photogrammetry → Export 
SfM (transforms.json).

T E K N I S K T

Egen eksport-sti (inte via fælles helper-rutine), fordi 
ingen gaussian-cloud, men SfM-resultatet ekspor
teres. Åbner en gem-dialog med transforms.json  
som default og content-type json . Vid OK skrives 
en nerfstudio-kompatibel transforms.json  med 
kamera-intrinsics, poser (som 4×4-matrix i NeRF-
konvention) og frame-stier. Hjælpetekst i UI’en 
påminder om, at træningsbillederne ska kopieres 
med som sibling-mappe images/​. Aktiv kun, när et 
SfM-resultat foreligger, og fuldversionen er oplåst.

KO R T  S AG T

Om du vil bruge SfM-resulta­
tet videre i en anden softwa­
re som nerfstudio, Brush, gs­
plat eller OpenSplat, eksporterer 
du her kamera-positionerne. Læg 
dine träningsbilder dessutom i 
en images/​-mappe vid siden 
av transforms.json -filen — 
annars kan målprogrammet inte 
knytte bilderna. Posten er grånet 
ud, så længe der inte finns SfM-
resultat, og spærret i free-trial-
versionen. Til COLMAP-workspa­
ce-workflowen tag M34 i stedet.
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M34 Export > Photogrammetry > Export SfM (COLMAP Workspace)…

VA R

Menulinjen → Export → Photogrammetry → Export 
SfM (COLMAP Workspace).

T E K N I S K T

Åbner en gem-dialog med default-navn 
colmap-workspace  (uden extension, fordi det är 

en mappe). Skriver et standard-COLMAP-workspa
ce med sparse/​0/​cameras.bin, images.bin , 
points3D.bin . Tillader at åbne en i RadianceKit 

beregnet eller importeret SfM-rekonstruktion i and
re værktøjer som Postshot, Nerfstudio eller Mes
hroom, eller vid en A/B-re-run at indlæse den igen 
som færdigberegnet input i selve RadianceKit (via 
M5) — sparer regnetid. Aktiv kun, när et SfM-resul
tat foreligger, og fuldversionen er oplåst.

KO R T  S AG T

Som M33, men i COLMAP-forma­
tet i stedet for nerfstudio. Om 
du bruger Postshot, Meshroom, 
Nerfstudio eller et andet værk­
tøj med COLMAP-workflow, är det 
din eksport. En praktisk sideef­
fekt: du kan indlæse denna map­
pe igen senere via M5 i Radiance­
Kit og spare SfM-regnetiden vid 
nästa kørsel — särskilt vid store 
scener en tidsgevinst på timer. 
Som M33 kun tilgængelig, när et 
SfM-resultat foreligger, og spær­
ret i free-trial-versionen.

Help-menuen

Figur 6:  Help-menuen med dokumentations-, mappe- og analyse-poster

Syv poster: to dokumentationsvinduer (User Guide, Keyboard Shortcuts), tre mappe-
genveje (Training Logs, Exports, Storage) og tre analyse-vinduer (Pareto Dashboard, 
Holdout Analysis, BayesOpt Console). Apple-typiskt optræder Help-menuen helt til 
højre. Standard-Help-menuen erstattes helt av RadianceKits egen variant.

24 / 221



R A D I A N C E K I T Kapitel 1 — Menulinje

M35 Help > User Guide

VA R

Menulinjen → Help → User Guide (⌘?).

T E K N I S K T

Åbner User Guide-vinduet. Det visar en navigation 
med emne-sidebar og scroll-detaljområde vid de
fault-størrelse 860×640. Indholdet er statisk hentet 
(inte parsed fra Markdown).

KO R T  S AG T

Åbner app-intern vejledning. Om 
du inte vil slå alt op i denna 
manual, hittar du de viktigaste 
trin direkte i programmet. Vej­
ledningen er bygget op som et 
eget vindue med emne-sidebar 
— du kan altså målrettet hoppe 
til enkelte emner. Indholdet er 
kortere end denna håndbog og 
koncentrerer sig om de hyppigs­
te workflows.

M36 Help > Keyboard Shortcuts

VA R

Menulinjen → Help → Keyboard Shortcuts (⌘/).

T E K N I S K T

Åbner Keyboard Shortcuts-vinduet — et simpelt 
scroll-layout med alle app-genveje, grupperet efter 
top-niveau-menu. Default-størrelse 440×560. Ind
hold er ligeledes statisk hentet.

KO R T  S AG T

Åbner et vindue med den kom­
plette liste over alle tastaturgen­
veje. Om du f.eks. inte kan huske, 
med vilken tast man starter træ­
ningen, så kig der. En sammen­
fatning står också sidst i detta 
kapitel. Listen er grupperet efter 
top-niveau-menu, så du snabbt 
hopper til det rigtige område. 
Hjælpsom, om du just er vid at 
skifte fra muse- til tastatur-stil.

M37 Help > Open Training Logs…

VA R

Menulinjen → Help → Open Training Logs… (⇧⌘L).

T E K N I S K T

Beregner log-mappen som ~/​Documents/​
RadianceKit/​Logs, opretter den om nødvendigt og 
åbner den i Hittar. Hver träningskörning skriver en 
egen JSONL-fil training_​YYYY-MM-DD_​HHmmss.jsonl 
dertil.

KO R T  S AG T

Åbner i Hittar mappen med al­
le hidtidige træningsprotokoller. 
Om något er gået galt, eller du vil 
se efter, hvornår præcis træning­
en konvergerede til vilken värde, 
hittar du det her i JSONL-filer. Pr. 
träningskörning oprettes præcis 
én fil med tidsstempel — den kan 
du också læse i andre værktøjer 
eller sende pr. mail til support. 
Om du vil have en grafisk evalue­
ring, er Pareto Dashboard (M40) 
den bedre indstigning.
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M38 Help > Open Exports Folder…

VA R

Menulinjen → Help → Open Exports Folder…

T E K N I S K T

Analogt med M37, men med ~/​Documents/​
RadianceKit/​Exports. Oprettes vid første auto-test-
kørsel eller vid første klik; därefter lander stan
dardstierne av alle auto-test-eksporter dér (f.eks. 
autotest_​<timestamp>.ply). Manuelt via gem-dialo
gen valgte eksporter går IKKE nødvendigvis herind, 
men der, hvor brugeren gemmer det — därför er 
denna mappe särskilt interessant for auto-tests.

KO R T  S AG T

Åbner mappen, hvor appen læg­
ger sine egne eksporter (särskilt 
auto-test-kørsler). Om du har 
lagt en eksport manuelt et andet 
sted med gem-dialogen, är den 
der og inte i denna mappe. Prak­
tisk til rensning eller for att se 
efter, hvor meget plats tidlige­
re test-eksporter optager. Om du 
har brug for et komplet overblik 
inklusive logs og scen-bundles, 
så tag i stedet Manage Storage 
(M39).

M39 Help > Manage Storage…

VA R

Menulinjen → Help → Manage Storage…

T E K N I S K T

Åbner storage-browseren (se kapitel 4 Auxiliary 
Windows, ID’er W7–W12). Lister alle persistere
de scener, training-logs, eksporter og caches i 
~/​Documents/​RadianceKit/​-mappen med størrelse, 
muliggør reveal-in-Hittar og move-to-trash pr. post.

KO R T  S AG T

Åbner en vindue-browser, der vi­
sar dig, hvor meget plats Radian­
ceKit optager på din disk — pr. 
scen, log og eksport. Du kan slet­
te enkelte ting direkte uden at 
skulle gå til Hittar. Praktisk ef­
ter længere brug, när disken blir 
fuld — tidligere logs og auto-
test-eksporter kan summe op til 
flere gigabyte. Via reveal-in-Hit­
tar kommer du altid också til den 
klassiske visning.
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M40 Help > Pareto Dashboard…

VA R

Menulinjen → Help → Pareto Dashboard… (⇧⌘D).

T E K N I S K T

Åbner Pareto-dashboardet (se kapitel 4, ID’er W13–
W22). Dashboardet indlæser alle JSONL-training-
logs fra ~/​Documents/​RadianceKit/​Logs/​, ordner 
dem efter scen og preset og tegner et Pareto-scat
ter-plot (standard: loss vs gaussians, valgfrit loss vs 
wallclock eller PSNR vs iterationer).

KO R T  S AG T

Åbner et overblik over alle hid­
tidige trænings-kørsler som dia­
gram. Du ser straks, vilken kørsel 
der har leveret den bedste balan­
ce mellan kvalitet og størrelse. 
Praktisk, om du vil sammenligne 
olika presets med hinanden. Som 
standard visar diagrammet loss 
mod gaussian-antal — du kan 
dock också skifte til wallclock-tid 
eller PSNR. Dataene kommer fra 
JSONL-training-loggene (M37); jo 
flere kørsler du har, desto mere 
udsigelig blir evalueringen.

M41 Help > Holdout Analysis…

VA R

Menulinjen → Help → Holdout Analysis… (⇧⌘H).

T E K N I S K T

Åbner holdout-analyse-vinduet (se kapitel 4, ID’er 
W23–W29). Indlæser en transforms.json , tegner 
kamerorna som 3D-globe og tillader train/test-fold-
splits (angulært eller lineært, 2–8 folds). Output är 
en fold-assignment.json, som træningen kan bruge 
i de respektive training-configs som test-sæt.

KO R T  S AG T

Hjælper dig med at opdele dine 
kamera-optagelser i trænings- 
og test-sæt — så du objektivt 
kan måle, hvor god din scen er 
(på bilder, som træningen inte 
har set). Snarere et forsknings- 
og benchmark-værktøj. Kamera­
erne visas som 3D-globe; du kan 
vælge mellan 2 og 8 folds, enten 
jævnt i vinklen eller lineært over 
rækkefølgen. Resultatet är en lil­
le JSON-fil, som træningen så 
bruger som test-sæt.
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M42 Help > BayesOpt Console…

VA R

Menulinjen → Help → BayesOpt Console… (⇧⌘B).

T E K N I S K T

Åbner BayesOpt-konsollen (se kapitel 4, ID’er W30–
W39). Indlæser foruddefinerede søgerum (f.eks. 
„MCMC scale-reg + opacity-reg + ssim”), kører 
bayesian-optimization- trials asynkront og visar 
konvergenskurve og trial-log live.

KO R T  S AG T

En indbygget auto-tuner-konsol. 
I stedet for manuelt at prøve oli­
ka parametre av kan appen lade 
det køre selv natten over og fore­
slå dig de bedste värden til din 
scen til sidst. Meget avanceret 
værktøj — til de fleste workflows 
är en god preset (se kapitel 7) 
tilstrækkelig. Du vælger et forud­
defineret søgerum (f.eks. „MCMC 
scale-reg + opacity-reg + ssim”) 
og ser live konvergenskurven 
samt trial-loggen. Regn med fle­
re timer til dage afhængigt av 
opsætningen.

Note: Cmd-Z i Edit-menuen

Siden maj 2026 understøtter Project Navigator i Expert Mode sletning av importerede 
bilder via minus-knap eller backspace-tast og fortryden via Cmd-Z . Denne Cmd-Z-
handling optræder i macOS-Edit-menuen (som leveres av SwiftUI) som „Undo Remove 
Image”, så længe et slettet bild stadig kan gendannes. Den registreres via det standard
konforme system, inte i ; därför er der ingen egen M-ID-post i inventaret.
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Tastaturgenveje i översikt

Menupost Genvej

File > Open Scene… ⌘O

File > Save Scene… ⌘S

File > Import COLMAP / Metashape Workspace… ⇧⌘I

File > New Project ⇧⌘N

Mode > Simple Mode ⌘1

Mode > Expert Mode ⌘2

Training > Start Training ⇧⌘T

Viewport > Enter/Exit Edit Mode ⇧⌘E

Viewport > Toggle Auto-Rotation ⌘⌥T

Viewport > Save Screenshot ⇧⌘S

Export > 3D Formats > PLY ⌘E

Help > User Guide ⌘?

Help > Keyboard Shortcuts ⌘/

Help > Open Training Logs… ⇧⌘L

Help > Pareto Dashboard… ⇧⌘D

Help > Holdout Analysis… ⇧⌘H

Help > BayesOpt Console… ⇧⌘B

Edit-menu (systemleveret, i Expert Mode vid aktivt Project-Navigator-valg):

Handling Genvej

Undo Remove Image ⌘Z

Remove Selected Image Backspace / Delete
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K A P I T E L

Kapitel 2 — Inspector (Expert View)

Figur 7:  Eksperttilstand tom — Project Navigator til venstre (Images 0, Cameras, Log), tom 
viewport i midten, Inspector til højre med Presets/Training Configuration/Enhancements/

Training Metrics-sektioner

Tom Inspector före import: Venstre sidebar visar images-counter 0 og drop-hint 
„Drop images here / or tap + to import”. Inspector til højre er fuldt funktionel, men 
presets er kun informative (ingen aktiv träning). Default-preset „Preview” (5K iters) 
er markeret. Camera Alignment på Apple Photogrammetry, Densification Classic, SSIM 
Weight 0.20, Render Scale 50 %. Empty-states i Training Metrics („Start training to see 
live metrics”) og Loss History („Loss curve will appear during training”).
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Figur 8:  Inspector med 60 flowers-bilder indlæst — image-sidebaren visar de første filnavne 
frame_0001.jpg ff, header „60 images ready”

Inspector efter import: Header-status „60 images ready”. Image-sidebaren lister alle 
60 importerede frames ( frame_0001.jpg  til frame_0945.jpg , hver 16. frame fra det 
960-cam-buket-datasæt som subset til hurtige iterationer). Auto-render-scale-logikken 
tjekker bild-opløsningen (1536×2048 = 3.1 MP) og tilpasser Render Scale därefter. 
Play-knappen (grøn, nederst til venstre) er nu aktiv og starter træningen med den aktive 
preset.

Figur 9:  Inspector mid-training — live-viewport visar flowers-buket- rekonstruktion, metrik-
bar nederst (Loss / LR / Gaussian-Count / Iterationer), preset-card „Preview” med „Modifi

ed”-badge, om parametre er ændret

Inspector under träning: Titellinjen visar globalt fremskridt „RadianceKit — Training 
NN %”. Viewporten rendrer den løbende gaussian-rekonstruktion i realtid (opdateret 
hver 50 iterationer — live-preview-interval kan justeres i Settings → General → Training 
→ Live Preview). Metrik-bar under viewporten: aktuel loss, learning rate, gaussian-
count og iterationer-counter (f.eks. 1.600/5.000 vid Preview-preset). Inspector-preset-
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card „Preview” bærer „Modified”-badge, så snart en parameter afviger fra den indbyg
gede default. Sidebaren „Log” indsamler SfM- og training-stage-events.

Figur 10:  Inspector efter trænings-afslutning — viewporten visar færdig flowers-buket-
rekonstruktion (2.991 gaussians efter 5K iterationer på 13 s), titellinje „Training Complete — 

2.991 Gaussians”

Inspector efter träning: Titellinjen visar endeligt gaussian-antal (her 2 991 — meget 
kompakt, fordi den syntetiske Blender-buket-scen på lys baggrund har enkel geome
tri). Viewporten visar den færdige punktmoln — orbital drag-navigation aktiv (roterer 
omkring scenens midtpunkt). Training-Metrik-sektionen er nu fyldt med slutværdier, 
loss-history-charten visar forløbet av de samlede 5 000 iterationer. Eksport-sektionen 
nederst er nu aktiv (alle format-knapper enabled).

Inspectoren är den højre sidebar i Expert Mode (⌘2). Den samler alle træningsrelevante 
parametre i syv sammenklappelige sektioner. Default-rækkefølgen fra øverst til nederst 
vid første start er: Look, Presets, træningskonfiguration, metrikker, loss-diagram, En
hancements og Export. „Look”-sektionen (post-training-billed- justeringer) er den reale 
UI-omdøbning av den tidligere „Finishing”-sektion — dens interne enum- rawValue  
förblir av persistens-grunde „Finishing”, den viste overskrift hedder „Look”. Hver sektion 
kan klappes sammen vid klik på headeren, rækkefølgen kan omarrangeres via træk-
og-slip (InspectorView.swift:81-97). Vid første start er alle syv sektioner sammen­
klappede (inspectorCollapsedSections defaulter til Set(InspectorSection.allCases)); 
app-state husker derefter klap- og rækkefølge-præferencerne på tværs av app-start.

En række betjeningselementer fra Inspectoren optræder också i næsten identisk form 
i indstillingerne (kapitel 3) — typiskt SfM-backend, sky-masking og lignende defaults. 
Adskillelsen er bevidst: indstillingerne leverer den app-globale skabelon for nyligt 
oprettede projekter, Inspectoren overskriver dessa värden for det aktuelt åbne projekt. 
Den, der kender betjeningslogikken i den ene side, kan bruge den anden blindt.

Den venstre kolonne i Expert Mode — Project Navigator — hører inte til Inspectoren, 
men er dens direkte nabo. Der kan importerede bilder vælges med klik, ses i Quick-Look 
med mellemrumstasten og slettes via minus-knappen eller delete-tasten (med Cmd-
Z til at fortryde). Inspectoren følger det aktuelle sidebar-valg med kontekstspecifikke 
detalje-informationer, men de syv hovedsektioner förblir altid tilgængelige.
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Look-sektion (L1–L5)

Look-sektionen (intern rawValue  fortsat „Finishing”) er den øverste Inspector-sektion 
og samler post-training -billedjusteringerne ét sted. Alle regulatorer arbejder ikke-
destruktivt: hver slider anvender FinishingPass  på ny på et uforandret pristine-snap
shot (original-DC-farve, -opacity, -skalering) — justeringen er dermed idempotent, inte 
kumulativ. Resultatet vises live i viewporten (WYSIWYG, nøjagtigt som den senere 
eksport) og bliver bagt ind i hver eksport. Sektionen er først efter afslutningen av et 
trænings-løb tilgængelig (inden står „Available after a training run completes.”); dens 
värden nulstilles vid hver ny træning. Så længe en eksport kører, er alle regulatorer 
låst — et lock-hint „Locked while exporting — the file uses the current settings.” vises, 
og GroupBoxen er disabled.

L1 Saturation-slider

VA R

Inspector → Look-sektion → GroupBox → Satura
tion.

T E K N I S K T

Slider 0.5–1.2, visning tocifret (f.eks. „1.00″). Skale
rer SH-DC-chroma av hver Splat omkring luminans-
värdet: 1.0 = uforandret, < 1.0 = afmættet (farven 
trukket mod gråtone), > 1.0 = kraftigere. Matema
tisk tilbageregnes DC-farven fra pristine-snapshot
tet ( desaturateDC ), så gentaget skub inte summe
rer op. Blev valideret på DJI-drone-materiale (Pens
ford-viadukten), der har tendens til at overtegne — 
drone-defaulten ligger på 0.82. Virker kun på farve-
basen (SH-grad 0), højere SH-koefficienter förblir 
urørte.

KO R T  S AG T

Hvor kraftige farverne i den fær­
dige Splat er. 1.00 lader alt væ­
re som trænet, värden derunder 
trækker farven mod grå — godt 
til drone- eller video-materiale, 
der ofte kommer overmættet ud. 
Värden over 1.0 gör det krafti­
gere. Du kan skubbe frem og 
tilbage så meget du vil, uden at 
noget „skruer sig op”, fordi ap­
pen altid regner på ny fra det 
uforandrede original-stand. Live 
synligt i viewporten og nøjagtigt 
sådan i eksporten.
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L2 Splat length-slider

VA R

Inspector → Look-sektion → GroupBox → Splat 
length.

T E K N I S K T

Slider 0.3–1.0, visning tocifret. Trækker de tre ska
lerings-akser av hver gaussian i log-rummet mod 
deres middelværdi ( shortenScale , faktor alpha ): 
1.0 = uforandret, mindre värden gör aflange „nå
le”-Splats rundere, 0 ville være rene kugler. Angri
ber nål-agtige, overstrakte Splats uden at ændre 
den samlede størrelse og reducerer derved typis
ke „konfetti”-artefakter. Anvendt fra pristine-snap
shottet (original-log-skalering), derfor idempotent. 
Kommuterer med Splat size (L3), fordi begge arbej
der i log-rummet.

KO R T  S AG T

Gör overlange, splintrede Splats 
rundere. 1.00 lader formen være 
som trænet, lavere värden stu­
ver de langtrukne „nåle” til run­
dere klatter — det beroliger kor­
nede rekonstruktioner, plaget av 
konfetti-artefakter. Den samlede 
størrelse förblir den samme, det 
handler kun om aflangheden. La­
der sig fareløst kombinere med 
Splat size (L3).

L3 Splat size-slider

VA R

Inspector → Look-sektion → GroupBox → Splat size.

T E K N I S K T

Slider 0.5–2.0, visning tocifret. Skalerer hver gaussi
an uniformt på alle tre akser ( sizeScale ): 1.0 
= uforandret, < 1.0 = mindre/tættere/skarpere, > 
1.0 = større/„fluffigere” (fylder huller mellem Splat
sene). Da skaleringerne ligger i log-rummet, realise
res multiplikationen som en additiv log(factor)
-offset — det kommuterer med Splat length (L2), 
fordi en konstant offset lader afvigelsen-fra-mid
delværdien være urørt. Fra pristine-snapshottet, alt
så idempotent. Ny i denne version.

KO R T  S AG T

Skalerer alle Splats jævnt stør­
re eller mindre. 1.00 er den 
trænede tilstand, värden derun­
der gör punktmolnen tættere og 
skarpere, värden derover dækker 
huller mellem Splatsene (virker 
blødere/ „fluffigere”). Praktisk til 
optisk at lukke en hullet rekon­
struktion eller omvendt afdække 
mere detalje. Forlig sig problem­
frit med Splat length (L2) — 
begge regulatorer påvirker inte 
hinanden.
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L4 Fade far region (med sub-slidere)

VA R

Inspector → Look-sektion → GroupBox → Toggle 
„Fade far region” plus sub-sliderne „Fade start ×ra
dius” og „Fade floor”.

T E K N I S K T

Toggle, der aktiverer et radialt opacity-fald med 
distancen fra kamera-tyngdepunktet — de svagt ob
serverede „Far-konfetti” i baggrunden blendes ud. 
Kun til orbit-optagelser: toggle’en er disabled, om 
finishingContext.fadeEligible er false (lineære 
flyvninger, for få eller degenererede kameraer); så 
vises i stedet for sub-sliderne hintet „Far-fade ap
plies only to orbit captures (not this scene).” Egnet
heden afgøres via azimut-dækning av kamera-posi
tionerne (en orbit omkredser tyngdepunktet og fyl
der mange kompas-sektorer, en lineærflyvning kun 
~2). To sub-slidere styrer geometrien: Fade start 
×radius (1.0–3.0) sætter indre-radius som mul
tiplum av orbit-radius, indenfor hvilken fuld opacity 
gælder; Fade floor (0.0–1.0) er opacity-faktoren 
langt hinsides fade-radius. Vigtigt: fade’en spring­
er sky-dome-området over (de frosne gaussians 
med indices [0, frozenCount)), så den bevidste bag
grunds-kuppel inte dimmes med.

KO R T  S AG T

Blender de svampede rester 
ud i scenens yderkant — ne­
top de „Far-konfetti”-klatter, der 
vid rundt-om-optagelser svæver 
langt bagved. Virker kun vid æg­
te orbit-/omkredsnings-optagel­
ser; vid lige drone-flyvninger el­
ler for få kameraer er kontakten 
grålig, og et hint forklarer hvor­
for. Er den aktiv, kommer to fin­
regulatorer til: „Fade start ×radi­
us” fastlægger, fra vilken afstand 
(som multiplum av omkreds-
radius) udblendingen begynder, 
„Fade floor” hvor stærkt de fjer­
ne Splats til slut endnu er synlige 
(0 = helt væk, 1 = uforandret). En 
bevidst rekonstrueret sky-dome 
(I44) röres dabei aldrig — himlen 
bevares.
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L5 Reset finishing-knap

VA R

Inspector → Look-sektion → GroupBox → „Reset fi
nishing” (nederst, lille knap).

T E K N I S K T

Nulstiller alle Look-settings til defaults 
(FinishingPass.Settings() = Saturation 1.0, fade 
fra, Splat length 1.0, Splat size 1.0) og udløser 
med det samme et fornyet finishing, så viewporten 
springer tilbage til den uforandrede trænede til
stand. controlSize(.small). Da hele Look-stakken 
regner idempotent fra pristine-snapshottet, er „til
bage til default” nøjagtigt det oprindelige trænings-
output — intet kvalitetstab vid gentaget frem og 
tilbage. Som alle regulatorer i sektionen låst under 
en kørende eksport.

KO R T  S AG T

Stiller med ét klik alle Look-regu­
latorer tilbage til standard (Satu­
ration 1.00, fade fra, begge Splat-
slidere på 1.00) — viewporten 
visar derefter igen nøjagtigt det 
friskt trænede resultat. Praktisk, 
om du har leget dig fast og vil 
starte rent forfra. Fordi appen 
altid regner fra original-standen, 
er der dabei intet kvalitetstab. 
Mens en eksport kører, er knap­
pen (som sliderne) låst.

Presets-sektion (I1–I11)

Presets-sektionen är den snabbaste måde at anvende en afprøvet konfiguration. 
Indbyggede presets (Capture Class, Classic, MCMC, Hybrid) leverer reproducerbare 
startpunkter fra 560+ dokumenterede experiment; egne presets kan gemmes, ekspor
teres, importeres og deles. Listen er grupperet efter kategorier (Capture Class, Classic, 
MCMC, Hybrid, Custom), og mere end én kategori kan være foldet ud samtidigt. Via 
kontekstmenu-mekanismen (højreklik på en linje) er eksport, duplikering og — vid egne 
presets — sletning tilgængelig.
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I1 Save…-knap

VA R

Inspector → Presets-sektion → Save…-knap (ac
tion-bjælke nederst).

T E K N I S K T

Åbner en popover med tekstfelt og save-/cancel-
knapper. Den aktuelle TrainingConfig-tilstand per
sisteres som ny brugerdefineret preset (JSON-ko
det, gemt på tværs av appen). Save- operationen 
kopierer alle 81 trænings-parametre plus den aktu
elle densification-strategi. Presetet lander automa
tisk i kategorien Custom, uafhængigt av vilken ind
bygget preset det blev afledt fra. Tomme navne og 
rene whitespace-input forkastes. Allerede eksiste
rende navne afvises inte — hvert preset har sit eget 
interne ID, dobbelte navne er teknisk tilladt, men 
praktisk forvirrende.

KO R T  S AG T

Sikrer din aktuelle konfiguration 
som genbrugelig preset. Tryk på 
knappen, skriv et navn i popo­
veren og klik Save — alle 81 pa­
rametre inklusive densification-
strategi lander under det valgte 
navn i Custom-kategorien. Brug 
det, om du har gjort dig umage 
og inte vil sidde og famle forfra 
vid nästa projekt. Særligt prak­
tisk til tilbagevendende opsæt­
ninger som „Drone 4K” eller „In­
dendørs snabb”. Dobbelte navne 
er teknisk tilladt, men praktisk 
forvirrende — vælg hellre något 
sigende.

I2 Preset Name TextField

VA R

Save-popover → tekstfelt „Preset Name”.

T E K N I S K T

Simpelt tekstfelt med afrundet ramme, bred form. 
Værdien overtages som preset-navn vid klik på 
save-knappen. Ingen længdebegrænsning i UI’en, 
men det gemte navn ska være JSON-kodbart og 
visningsbart i UI-listerne — emoji og specialtegn 
fungerer. Indholdet nulstilles automatisk til en tom 
streng vid åbning av popoveren. Save-knappen för
blir deaktiveret, så længe feltet efter trim er tomt. 
Der er ingen auto-suggest og ingen forudfyldning 
med navnet på den aktuelt aktive preset.

KO R T  S AG T

Her taster du navnet til din pre­
set. Vælg något sigende som 
„Drone 4K 30fps” eller „Inden­
dørs snabb” — det hjælper dig 
senere med at hitta det igen 
i Custom-kategorien. Emoji og 
specialtegn er tilladt, en hård 
længdebegrænsning er der inte. 
Så længe feltet er tomt eller kun 
innehåller mellemrum, förblir sa­
ve-knappen grånet ud. Vid forny­
et åbning av popoveren er feltet 
tomt igen — der er ingen forud­
fyldning med det aktive preset-
navn.
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I3 Cancel-knap (save-dialog)

VA R

Save-popover → Cancel-knap (til venstre).

T E K N I S K T

Lukker popoveren uden att spara. Forkaster tekst
feltets indhold — vid nästa åbning nulstilles det igen 
til tomt via save…-knap-logikken (I1). Standard but
ton-stil, ingen bekræftelsesdialoger, ingen hotkeys. 
Den aktuelle TrainingConfig förblir uændret, da sa
ve-stien slet inte blev udført.

KO R T  S AG T

Lukker save-popoveren uden att 
spara något. Om du har skif­
tet mening, taster forkert eller 
åbnede dialogen vid et uheld 
— bare klik Cancel. Din aktuel­
le tränings-konfiguration förblir 
uændret, fordi der endnu inte er 
skrevet något. Vid nästa åbning 
av popoveren starter navnefel­
tet tomt igen. Ingen sikkerheds­
spørgsmål, ingen hotkey — bare 
klik og væk.

I4 Save-knap (save-dialog)

VA R

Save-popover → Save-knap (til højre, prominent 
stil).

T E K N I S K T

Udløser den egentlige persistering. Validerer endnu 
en gang inte-tomt navn (defensiv check) og skri
ver därefter den aktuelle TrainingConfig som JSON 
ind i app-lageret. Lukker därefter popoveren. Blå 
fremhævet, grånet ud så længe tekstfeltet er tomt. 
Om gemningen mislykkes (f.eks. fordi app-lageret 
er fuldt — meget usandsynligt), er der i øjeblikket 
ingen synlig fejldialog; presetet ville så bare inte op
træde vid nästa app-start.

KO R T  S AG T

Med klik på Save overtager 
du navnet og skriver din ak­
tuelle opsætning væk som ny 
preset. Popoveren lukker, prese­
tet optræder straks i Custom-
kategorien av preset-listen og 
kan fra nu av aktiveres vid 
klik. Knappen er blå fremhævet 
( borderedProminent ) og för­
blir grånet ud, så længe nav­
nefeltet er tomt. Om gemning­
en mislykkes (f.eks. UserDefaults 
fuld), er der ingen synlig fejl­
dialog — presetet ville så bare 
mangle vid nästa app-start.
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I5 Export…-knap

VA R

Inspector → Presets-sektion → action-bjælke → Ex
port…-knap.

T E K N I S K T

Eksporterer det aktuelt valgte preset som 
.radiancepreset -fil (internt JSON). Deaktiveret, 

om intet preset er valgt. Vid klik åbner appen en 
save-dialog med forudgivent filnavn (preset-navn 
+ .radiancepreset -extension). Det gemte format 
innehåller den komplette TrainingConfig plus meta
data (navn, kategori, ID, built-in-flag). Dobbeltklik 
i Hittar åbner appen — men inte automatisk impor
ten; brugeren ska bruge import-knappen (I6).

KO R T  S AG T

Vælg en preset i listen og klik 
Export — så kan du gemme den 
som .radiancepreset -fil og 
f.eks. sende den til en kollega 
eller overføre den til en anden 
Mac. Modtageren indlæser den 
derovre med Import…-knappen 
(I6). Fungerer lige godt for built-
ins og dine egne custom-presets. 
Knappen er grånet ud, så længe 
der intet er klikket i listen. Tip: 
via kontekstmenuen (I8) går det 
endnu snabbare — der behøver 
du inte vælge presetet først.

I6 Import…-knap

VA R

Inspector → Presets-sektion → action-bjælke → Im
port…-knap.

T E K N I S K T

Åbner en fildialog, der kun tillader 
.radiancepreset -filer (multivalg deaktiveret). Vid 

valg indlæses JSON-filen, valideres og indsættes i 
Custom-kategorien — med nyt internt ID, så der inte 
opstår kollisioner med built-ins. Importen sætter au
tomatisk kategorien til Custom, selv om det ekspor
terede preset oprindeligt var en built-in. Beskadige
de eller inkompatible filer med ældre skemaversion 
afvises i stilhed uden fejldialog (konsol-log giver 
dock besked).

KO R T  S AG T

Indlæse en .radiancepreset
-fil fra disk. Nyttig, om någon 
sender dig en afprøvet opsæt­
ning, eller om du selv vil holde di­
ne yndlings-presets synkrone på 
tværs av flere Mac’er. Importere­
de presets lander altid i Custom-
kategorien — också om de oprin­
deligt blev eksporteret fra built-
ins. Beskadigede eller forældede 
filer ignoreres i stilhed; i konsol- 
loggen står så grunden. Multivalg 
i dialogen er deaktiveret, så kun 
én fil pr. klik.
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I7 Preset-linje (klik-aktivering)

VA R

Inspector → Presets-sektion → hver preset-linje i 
hver kategori.

T E K N I S K T

Klik på en preset-linje erstatter alle felter i Trai
ningConfig med værdierne fra presetet, husker ID 
for det aktive preset og nulstiller modified-status. 
Aktiv-fluebenet foran linjen optræder kun, när pre
setet er valgt OG umodificeret. Så snart en värde 
i TrainingConfig ændres (slider, stepper, toggle i 
de andre Inspector-sektioner), optræder et orange 
„Modified”-badge bag navnet. Indbyggede presets 
kan inte overskrives — vid modifikation ska en egen 
kopi oprettes via save-knappen (I1).

KO R T  S AG T

Klik på en linje aktiverer prese­
tet og overtager alle dér gemte 
värden i de aktuelle trænings-in­
ställningar. Fluebenet foran nav­
net visar, vilken preset der er 
aktiv lige nu. Så snart du där­
efter justerer en slider, stepper 
eller toggle i de andre sektioner, 
optræder et orange „Modified”-
badge bag navnet — fordi din 
opsætning nu afviger fra pre­
setet. Built-in-presets kan inte 
overskrives; om du vil beholde 
ændringer, så opret en egen kopi 
via Save…-knappen (I1) eller dup­
liker presetet (I9).

I8 Kontekstmenu „Export…”

VA R

Højreklik på hver preset-linje → første post „Ex
port…”.

T E K N I S K T

Identisk funktionalitet som I5 (Export…-knap), men 
mere bekvemt tilgængelig — uden at presetet ska 
vælges først. Eksporterer direkte det preset, der 
blev klikket på i linjen. Fungerer ens for alle preset-
kategorier (built-in eller Custom), ingen begræns
ning. Eksporten innehåller built-in-flag og original
kategori, men vid re-import mappes kategorien som 
beskrevet under I6 til Custom.

KO R T  S AG T

Hurtig vej til eksport — høj­
reklik på det ønskede preset 
og vælg „Export…”. Sparer om­
vejen via klik-først og så tryk 
på Export…-knappen. Fungerer 
ens for alle kategorier, också 
for built-ins. Den genererede 
.radiancepreset -fil er iden­

tisk med den fra I5; vid senere 
re-import lander den automatisk 
i Custom-kategorien.
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I9 Kontekstmenu „Duplicate”

VA R

Højreklik på hver preset-linje → anden post „Dupli
cate”.

T E K N I S K T

Kloner presetet ind i Custom-kategorien. Genererer 
et nyt internt ID, vedhæfter „ Copy” til navnet og 
gemmer kopien. Fungerer också for built-in-presets 
— klonen er så redigerbar. Originalen förblir urørt. 
TrainingConfig kopieres värde-for- värde (JSON-
roundtrip), så der inte består referenceforbindelser 
mellan original og kopi.

KO R T  S AG T

Skaber en redigerbar kopi av 
et preset i Custom-kategorien. 
Praktisk, om du f.eks. vil have 
det indbyggede „Quality”-preset 
som udgangspunkt og så bare 
lige flytte SSIM-slideren en smu­
le. Workflow: duplicate, omdøb 
(kontekstmenu eller ny Save…-
kørsel), tilpas, færdig. Originalen 
förblir urørt — du kan altid vende 
tilbage til den. Fungerer också 
for built-ins, vilket är den eneste 
måde at overtage deres värden 
som basis og samtidig gøre dem 
redigerbare på.

I10 Kontekstmenu „Delete”

VA R

Højreklik på egne preset-linjer → sista post „Dele
te” (rød, destruktiv).

T E K N I S K T

Kun synlig for custom-presets. Built-ins kan inte 
slettes. Posten er markeret som destruktiv, visas 
rød i kontekstmenuen og placeres efter en divider, 
så den inte klikkes vid et uheld. Der finns ingen 
bekræftelsesdialog — et klik sletter presetet med 
det samme. Det slettede preset kan inte gendannes 
(Cmd-Z virker inte her — undo finns i den aktuelle 
build kun for billedlisten, inte for preset-operatio
ner). Var det slettede preset just aktivt, förblir den 
aktuelle TrainingConfig uændret, kun det aktive pre
set-valg nulstilles.

KO R T  S AG T

Slette egne presets. Vid built-ins 
(Quick, Preview, Balanced, Quali­
ty, Ultra Detail, Drone / Aerial, 
360° Walkaround, Photo / Object 
osv.) er „Delete” slet inte synlig 
— dem kan du inte komme til at 
slette vid et uheld. Advarsel: der 
er ingen sikkerhedsspørgsmål og 
ingen undo, ett klik og presetet 
er væk. Om du er i tvivl, så træk 
først en sikkerhedskopi på disk 
via Export… (I5/I8) — den kan du 
altid importere igen. Var presetet 
just aktivt, förblir din Training­
Config uændret, kun fluebenet 
försvinner.
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I11 Kategori-header (udfold/sammenklap)

VA R

Inspector → Presets-sektion → hver kategori-
header (Capture Class, Classic, MCMC, Hybrid, 
Custom).

T E K N I S K T

Klap-status pr. kategori med olik default: den ku
raterade Capture Class-gruppe starter foldet ud, 
Classic, MCMC, Hybrid og Custom starter sammen­
klappet. Status persisteres inte — vid app-genstart 
er alle kategorier igen i default-tilstand. Chevron-pi
len roterer animeret. Tallet til højre i headeren visar 
antallet av presets i denna kategori. Klik-hit-arealet 
omfatter hele headerområdet.

KO R T  S AG T

Folde kategorier ind og ud for at 
holde preset-listen overskuelig. 
Vid app-start er Capture Class-
gruppen åben, Classic, MCMC, 
Hybrid og Custom er lukkede. 
Klik på headeren (hele området 
er klikbart), og listen kører op el­
ler i med en kort chevron-anima­
tion. Det lille tal til højre visar, 
hvor mange presets der ligger i 
kategorien. Efter genstart av ap­
pen er default-tilstanden tilbage 
— appen gemmer bevidst inte 
denna klap-inställning.

Trænings-konfigurations-sektion (I12–I22)

Figur 11:  Crop kun training-konfigurations-sektion — Camera Alignment (Apple Photogram
metry aktiv, Native (Beta) inaktiv), Densification (Classic aktiv), Max Iterations 5.000 / 

Densify Until 3.500 med link-symbol, SSIM Weight slider 0.20, Render Scale slider på 100 % 
(1.536×2.048 = 3.1 MP)

Her lander de centrale håndtag: vilket SfM-backend der ska beregne, hvordan densifi
cation arbejder, hvor mange iterationer, hvor stor SSIM-vægtningen er. Vid MCMC-
strategi optræder to ekstra toggles („MCMC Quality” og „Auto-scale by scen”), som 
skjules i Classic-tilstand. Vid Native-SfM-backend kommer FOV-override-feltet til, som 
kun behøves til video-frames uden EXIF-brændvidde.
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I12 Camera Alignment-vælger

VA R

Inspector → træningskonfiguration → Camera Align
ment (segmenteret vælger øverst).

T E K N I S K T

Segmenteret vælger med to muligheder: Apple Pho
togrammetry og Native (Beta). Valget bestemmer 
det anvendte SfM-backend vid nästa kamera-re
konstruktion. Det påvirker samtidigt, vilka andre In
spector-elementer der er synlige: Native visar dess
utom FOV-overriden (I13), der kun behøves vid EX
IF-løse video-frames. Obs: vid meget store outdoor-
optagelser kan du indlæse resultatet fra et eksternt 
værktøj (Metashape eller COLMAP) via workspace-
import — se kapitel 1 (M5) og kapitel 9 (Q3, Q6).

KO R T  S AG T

Her vælger du, hvordan ka­
mera-positionerne rekonstrueres 
— den viktigaste kontakt for 
slutkvaliteten. Apple Photogram­
metry är den hurtige standard 
og rækker fuldt ud til de fles­
te objekt-scanninger. Native (Be­
ta) är den App Store-konfor­
me egenudvikling, god til orbits 
og turntable-scener, og kræver 
vid EXIF-løse video-frames FOV-
overriden (I13). Vid meget store 
outdoor-sæt kan du alternativt 
beregne kamerorna i Metashape 
eller COLMAP og indlæse resulta­
tet via workspace-importen. De­
taljer og anbefalinger pr. scene­
type hittar du i kapitel 9.

I13 FOV Override-felt (Native SfM)

VA R

Inspector → træningskonfiguration → FOV Override 
(kun synlig vid Camera Alignment = Native).

T E K N I S K T

Numerisk tekstfelt (range 0-170°), default 0 = auto
matisk bestemmelse fra EXIF eller heuristik. Manuel 
indtastning er nødvendig, om input-bilderna er ud
trukket fra en video, der inte innehåller brændvidde-
metadata. Typiske värden: iPhone Wide ≈ 73°, DJI 
Mavic Wide-Crop ≈ 70°, drone med fuldformatsen
sor ≈ 84°. Værdien klampes til [0, 170] — värden 
udenfor stuves direkte tilbage. Påvirker kun den na
tive SfM-pipeline (Q4/Q5); Apple Photogrammetry 
ignorerer denna värde helt.

KO R T  S AG T

Om dine bilder inte har EXIF (ty­
piskt vid udtrukne video-frames), 
så skriv in her kameraets hori­
sontale synsfelt i grader. Tom­
melfingerværdier: iPhone Wide ≈ 
73°, DJI Mavic Wide-Crop ≈ 70°, 
drone med fuldformatsensor ≈ 
84°. Ett 0 lader appen gætte selv 
— det går ofte godt, men kan 
gå skævt vid sjældne optikker. 
Värden over 170° stuves automa­
tisk tilbage. Feltet er kun synligt 
og kun virksomt, om du har valgt 
Native som Camera Alignment 
(I12) — Apple Photogrammetry 
ignorerer det helt.
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I15 Densification-vælger

VA R

Inspector → træningskonfiguration → Densification 
(segmenteret vælger, altid synlig).

T E K N I S K T

Skifter mellan de to densification-strategier: Clas
sic (original 3DGS-metode med clone/split/prune 
og gradient- tærskel) og MCMC (Stochastic Gra
dient Langevin Dynamics med relocation, NeurIPS 
2024). Vid skift fra Classic til MCMC sætter ap
pen automatisk MCMC-specifikke felter til afprø
vede default- värden (reg-weights = 0, MCMC-
cap-multiplier 3.0, sample-/ noise-schedule). Uden 
denna automatiske initialisering led sessioner med 
gamle presets under 1.4.4-MCMC-collapse-bug’en 
(460K→5 gaussians, watchdog-kill). Vælger-valget 
bestemmer dessutom, vilka Inspector-elementer der 
er synlige — vid MCMC optræder I16/I17. Detaljeret 
felt-virkning i kapitel 6, T11–T16 (Classic) og T61–
T73 (MCMC).

KO R T  S AG T

Det centrale strategivalg 
for, hvordan gaussian-antallet 
vokser. Classic er godt tunet fra 
459 experiment, leverer hurtige 
resultater av høj kvalitet og be­
høver inte at kende MCMC-felter­
ne. MCMC är den nyere tilgang 
(NeurIPS 2024), mere reprodu­
cerbar og undviger manuel th­
reshold-justering — til gengæld 
regner den ca. 6× længere vid 
sammenlignelig kvalitet. Vid skift 
til MCMC sætter appen automa­
tisk sikre defaults, så træningen 
inte ender i 1.4.4-collapse. Detal­
jer om strategifelterne står i ka­
pitel 6 (T11–T16 Classic, T61–T73 
MCMC).

I16 MCMC Quality-toggle

VA R

Inspector → træningskonfiguration → MCMC Quality 
(kun vid Densification = MCMC).

T E K N I S K T

Slår gradient-accumulation til 2 trin (aktiv) eller 1 
trin (inaktiv). Akkumulerer gradienterne fra to på 
hinanden følgende kamera-views, före optimizer-
step udføres. Empirisk (session 33, V544a) reduce
rer det den endelige L1-fejl med ca. 6 % (0.0246 
med Quality vs 0.0261 uden, vid 3-trial-gennemsnit 
på Horse-Full-MCMC). Prisen: fordoblet träningstid. 
Vid meget lange træninger (200K iterationer) fører 
det til yderligere 10+ minutters ventetid — så kun 
værd, om de sista par procent kvalitet virkelig er 
nødvendige. Påvirker kun træningen, inte eksport
formatet eller viewport-visningen.

KO R T  S AG T

Quality-mode for MCMC med gra­
dient-accumulation over to vi­
ews. Gör slutresultatet empirisk 
ca. 6 % bedre (L1 0.0246 i ste­
det for 0.0261 i Horse-testen), 
koster til gengæld dobbelt så 
lang tid. Om du ändå kører en 
200K-MCMC-träning (gerne 2 ti­
mer), kommer der endnu en knap 
time oveni. Værd vid endelige 
showcase-renderinger eller mod 
slutningen av en quality-sweep-
session, i daglig workflow snare­
re inte. Kun synlig, när Densifica­
tion står på MCMC (I15).
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I17 Auto-scale by scen-toggle

VA R

Inspector → træningskonfiguration → Auto-scale by 
scen (kun vid MCMC).

T E K N I S K T

Om aktiv, skaleres den effektive max-gaussians- 
overgrænse med SfM-init-point-count × MCMC-
cap-multiplier (default 3.0). Eksempel: SfM leverer 
250K initpunkter, basis-cap = 150K, multiplier 3.0 → 
effektiv overgrænse = max(150K, 750K) = 750K. Om 
deaktiveret, gælder strengt kun basen. Blev indført 
til v1.4.5, fordi store outdoor-optagelser med over 
1000 frames og tilsvarende høj SfM-punktdensitet 
med den stive 150K-cap-default udsultede densifi
cationen — overflødige punkter blev tilbage, nye fik 
inte lov at opstå. Default OFF i custom- presets, 
ON i MCMC-built-ins. Påvirker kun til træningstids
punkt, inte i eksporten.

KO R T  S AG T

Lader maksimumstallet av 
gaussians vokse med scenestør­
relsen (mere præcist: med antal­
let av SfM-initpunkter). Vid små 
scener mærker du næsten ingen 
skillnad, vid store outdoor-sce­
ner är det ofte afgørende for kva­
liteten — annars „kvæles” træ­
ningen, fordi default-overgræn­
sen på 150K er alt for lav til 
scenen. Blev specifikt indført 
til v1.4.5, efter at meget sto­
re outdoor-sæt (over 1000 fram­
es) synligt hang fast på cap’et. 
Vid MCMC-built-in-presets alle­
rede slået til på forhånd; i egne 
presets slukket som default.

I18 Max Iterations-stepper

VA R

Inspector → træningskonfiguration → GroupBox → 
Max Iterations.

T E K N I S K T

Stepper med range 1 000–100 000, skridtstørrelse 1 
000. Bestemmer det samlede antal optimizer-itera
tioner. Lineært korreleret med træningstiden (halve
ring = ca. 50 % tid). Empiriske sweet-spots: 20K 
(Classic Balanced, L1≈0.028), 40K (Classic Quality, 
L1≈0.023), 200K (MCMC Full, L1≈0.0246). Over 40K 
vid Classic giver i gennemsnit næppe forbedring — 
diminishing returns. Vid ændring trækkes Densify 
Until proportionalt med, om link-funktionen (I19) er 
aktiv (default-ratio: 0.5, dvs. Densify-Until = Max/2).

KO R T  S AG T

Hvor mange trænings-skridt der 
køres — mere er bedre, men 
koster också lineært mere tid. 
Tommelfingerregel: 20 000 for 
god kvalitet, 40 000 for opti­
mum vid Classic-strategi (dero­
ver giver det i gennemsnit næp­
pe mere). MCMC kræver markant 
mere, 200 000 er her standard. 
Fordobling av iterationer fordob­
ler groft træningstiden. Vid aktiv 
link-knap (I19) trækkes Densify 
Until proportionalt med — prak­
tisk altid det, du vil.
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I19 Link/Unlink-knap (Densify ↔ Iterations)

VA R

Inspector → træningskonfiguration → GroupBox → 
lille link-knap mellan Max Iterations og Densify Until.

T E K N I S K T

Toggle-knap, der fryser forholdet mellan Densify 
Until og Max Iterations. Vid aktiv (link-ikon fremhæ
vet) trækkes Densify Until proportionalt med vid 
hver ændring av Max Iterations. Vid unlink (link-
plus-ikon) förblir værdierne uafhængige. Default er 
linked, fordi det afspejler den typiske korrelation 
— om du trækker træningen til dobbelt iterationer, 
vil du som regel också lade densificationen køre 
proportionalt længere. Forholdet beregnes vid in
ställning av link-knappen ud fra den aktuelle värde; 
et typiskt forhold er 0.5 (Densify-Until = halve itera
tions-antal).

KO R T  S AG T

Lille klamme-knap mellan Max 
Iterations og Densify Until. 
Når aktiv (link-ikon fremhæ­
vet), vandrer de to värden sam­
men — fordobler du iterations, 
fordobles också Densify Un­
til i samme forhold. Om inte 
( link.badge.plus -ikon), kan 
du sætte dem uafhængigt. Stan­
dard er linket, fordi det afspejler 
den typiske korrelation — læng­
ere träning kræver som regel 
också længere densification-fa­
se. Til 99 % av tilfældene lad det 
være låst.

I20 Densify Until-stepper

VA R

Inspector → træningskonfiguration → GroupBox → 
Densify Until.

T E K N I S K T

Stepper med range 500–50 000, skridtstørrelse 
500. Bestemmer iterations-indekset, hvorfra der in
te længere kommer nye gaussians til via clone/
split (Classic) eller relocation (MCMC). Efter opnåel
se forfines kun position og farve. Højere värden = 
flere gaussians = større fil, længere pr.-iteration-
tid (+30-60 % GPU-tid pr. skridt). Typiske värden: 
15K (til 30K max-iter), 20K (til 40K), 100K (til 200K 
MCMC). Vid aktiv link (I19) skaleres automatisk 
med. Virker forskelligt vid Classic vs MCMC: Classic 
stopper væksten helt, MCMC stopper relocation- lo
gikken, men sample-/noise-adaptation kører videre.

KO R T  S AG T

Op til vilken iteration nye gaussi­
ans måste tilføjes — vid Clas­
sic via clone/split, vid MCMC via 
relocation. Därefter handler det 
kun om farve- og form-forfining 
av de eksisterende punkter. Hø­
jere = mere detalje, men också 
større fil og +30-60 % GPU-tid 
pr. skridt. Typiske värden: 15K 
(til 30K max-iter), 20K (til 40K), 
100K (til 200K MCMC). Hænger 
normalt via link (I19) på Max Ite­
rations — sjældent meningsfuldt 
at afkoble det manuelt.
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I21 SSIM Weight-slider

VA R

Inspector → træningskonfiguration → GroupBox → 
SSIM Weight.

T E K N I S K T

Slider 0.0–1.0 i 0.05-skridt, visning som „0.20″. 
Blander L1-loss (0.0) og SSIM-loss (1.0). L1 stram
mer lysstyrken pr. pixel, SSIM den strukturelle lighed 
(kanter, lokale statistikker). Default 0.2 er værdien 
fra det oprindelige 3DGS-paper (Kerbl 2023) og 
reverse-engineered som robust kompromis i talrige 
sessioner. Højere värden (0.5+) foretrækker detal
jebevarelse, men kan ignorere lokale lysstyrkefejl. 
Lavere värden (< 0.1) fører til detaljetab vid skarpe 
kanter. SSIM-beregningen kører i shaderen med et 
11×11-gaussian-vindue. Performance: vid 0.0 (kun 
L1) er træningen ca. 8-12 % snabbare, fordi SSIM-
beregningen i shaderen springes over.

KO R T  S AG T

Hvor stærkt strukturel billed­
lighed (kanter, lokale mønstre) 
vægtes i forhold til ren lysstyrke­
sammenligning. 0.2 er standar­
den fra det oprindelige 3DGS-pa­
per og rækker til næsten alle sce­
ner. Højere (0.5+) vid fine struk­
turer som hår, pels eller vegeta­
tion — der hjælper mere struk­
turvægt. Lavere (0.0) gör træ­
ningen ca. 8-12 % snabbare, for­
di SSIM-beregningen i shaderen 
springes over, men koster detalje 
vid skarpe kanter. Den, der inte 
har en god grund til ændring, la­
der 0.2 stå.

I22 Render Scale-slider

VA R

Inspector → træningskonfiguration → GroupBox → 
Render Scale.

T E K N I S K T

Slider 0.25–1.0 i 0.25-skridt, visning som „100 %”. 
Skalerer training-rendering-opløsningen relativt til 
kildebillede-størrelsen. Største håndtag på perfor
mance: 50 % reducerer GPU-tid med ca. 75 % (fordi 
4× færre pixel), 25 % med ca. 94 %. Gradient-
tærsklen skaleres automatisk med. Under slideren 
optræder en live-opløsnings-visning i MP (f.eks. 
„2304×1296 (3.0 MP)”). Om den aktuelle värde 
afviger fra den rekommenderade, indkobles i orange 
skrift „— recommended: 50 %”. Anbefalingen sigter 
på ~3 MP effektiv upplösning — det område, Apple 
Silicon GPU’er behandler mest effektivt. 4K-kildebil
leder får f.eks. automatisk 25 % rekommenderat, 
FullHD-bilder 100 %. En ændring udløser dessutom 
buffer-reallokationen.

KO R T  S AG T

Med vilken upplösning træningen 
rendrer — et av de største per­
formance-håndtag. Fuld (100 %) 
giver bedste kvalitet, men koster 
vid store bilder meget GPU-tid. 
Halv (50 %) sparer ca. 75 % GPU-
tid, fordi der beregnes fire gange 
færre pixel — perfekt til 4K-kil­
der. Under slideren ser du den 
effektive upplösning i megapixel; 
appen sigter på rundt 3 MP, fordi 
det kører mest effektivt på Apple 
Silicon. Om din värde afviger fra 
det, indkobler appen et orange 
„recommended”-hint — som re­
gel kan det betale sig at følge.
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Enhancements-sektion (I26–I29, I42–I44)

Figur 12:  Crop kun Enhancements-sektion — tre rækker: Post-Training Compactification 
(toggle til), Viewport Scaling (segmenteret picker Off/MetalFX/Lanczos), Perceptual Loss 

(slider på „Off”). Hver række med undertitel forklarer funktionen

Enhancements-sektionen grupperer tre features, der förbättrar billedkvalitet uden at 
ændre selve kerne-trænings-loopet. De første to (I26-I27) er post-training- eller view­
port-trin: compactification rydder op efter träningsslut, Viewport Scaling er en ren 
viewport-renderer, der inte påvirker den løbende träning. Perceptual Loss (I29) er trods 
sektion-tilhørsforholdet en træningsbestanddel — den aktiveres under træningen som 
ekstra loss-term, deraf adskillelsen fra viewport-toggles via en divider. Per v1.6 har 
sektionen även en Outdoor-grupp (I42–I44: Sky Masking, Mid-Training Floater Cleanup, 
Reconstruct Sky Dome) — träningsalternativ mot himmel-floaters som tidigare bodde i 
Inställningar-fönstret och nu sitter här per projekt.
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I26 Post-Training Compactification-toggle

VA R

Inspector → Enhancements → Post-Training Com
pactification.

T E K N I S K T

Aktiverer V443-post-processing: efter afslutningen 
av trænings-iterationerne slettes gaussians med 
opacity under 0.01 (1 % synlighed). Empirisk re
ducerer det filstørrelsen med ~55-58 % vid nul 
synligt kvalitetstab — fordi dessa gaussians visuelt 
ändå inte bidrager. Compactificationen kører som 
GPU-compact- pas og varer afhængigt av gaussian-
count brøkdele av sekunder til få sekunder. Påvirker 
inte trænings-performance. Om denna toggle er 
slukket, eksporteres också usynlige gaussians — 
kun relevant, om du vil bruge formatet til endnu et 
trænings-stage (Continue Training), annars spild av 
lagerplads.

KO R T  S AG T

Rydder op efter træningen i 
gaussians, du ändå inte kan se 
(opacity under 1 %). Gör eksport-
filerna omtrent halvt så store 
( 55-58 % størrelsesreduktion) 
uden synligt kvalitetstab. Kører 
som kort GPU-pas efter sista ite­
ration, varer kun brøkdele av se­
kunder til få sekunder. Bør prak­
tisk altid være tændt — den 
eneste grund til at slukke det 
er, om du senere vil fortsætte 
træningen via Continue Training 
og ska beholde också usynlige 
gaussians. Vid normale eksport-
workflows lad det bare stå.
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I27 Viewport Scaling-picker

VA R

Inspector → Enhancements → Viewport Scaling 
(segmenteret picker med tre muligheder: Off, Metal
FX, Lanczos).

T E K N I S K T

En enkelt segmenteret picker, der vælger view
port-upscaleren — de tre muligheder er gensidigt 
udelukkende. Om trænings-opløsningen (via I22 
Render Scale) er lavere end viewport-størrelsen, 
skalerer den valgte tilstand det rendrede frame 
op til visningsstørrelsen. Off = simpel bilineær 
strækning. MetalFX = Apples ML-baserede spatial 
upscaler, den skarpeste mulighed (ML-modellen er 
optimeret til skarpe kanter), overhead ca. 1-2 ms 
pr. frame på M3-GPU’er. Lanczos = Apples Metal 
Performance Shaders med 8-tap-sinc-resampling, 
klassisk uden ML, minimal overhead (< 0.5 ms), 
kvalitet under MetalFX, men uden den ML-typiske 
„blødgøring” av fine linje-strukturer. Renderer-pipe
linen omkonfigureres live vid skift — synlig med det 
samme, uden genstart. Baggrund: tidligere var det 
to separate toggles (MetalFX + Lanczos), der kunne 
være tændt samtidigt — en modstridende tilstand, 
hvor MetalFX stille gik forbi Lanczos. Pickeren fjer
ner denne tilstand; en eventuelt fra ældre sessioner 
arvet „begge-til”-tilstand heler sig selv vid næste 
skift til MetalFX. Påvirker kun live-viewporten, inte 
rendrede eksporter (orbit-video, screenshots) — de 
rendres i fuld kildeopløsning.

KO R T  S AG T

Skærper live-bilden op i viewpor­
ten — särskilt nyttigt, om du ar­
bejder med reduceret tränings-
upplösning (Render Scale 50 %, 
se I22). Tre trin, hvoraf kun ét 
altid er aktivt: „Off” strækker 
bare pixlerne, „MetalFX” bruger 
Apples machine-learning til de 
skarpeste kanter (praktisk altid 
det bedste valg), „Lanczos” er 
det klassiske filter uden ML — 
tag det som fallback, om MetalFX 
i en scen glatter linjer ud eller 
visar artefakter. Griber live, uden 
genstart. Virker kun i live-view­
porten, inte på eksporterede or­
bit-videoer eller screenshots — 
de rendres i fuld kildeopløsning. 
Anderledes end før kan du inte 
længere vælge to tilstande sam­
tidigt vid et uheld.
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I29 Perceptual Loss-slider

VA R

Inspector → Enhancements → Perceptual Loss.

T E K N I S K T

Slider 0.0–0.2 i 0.01-skridt, visning vid 0.0 som 
„Off”, annars som „0.05” osv. Aktiverer en ekstra 
loss-term, der sammenligner multi-skaleret gaussi
an-blur av renderingen med ground-truth-bilden 
(3 blur-skalaer). Fanger strukturelle skillnader, som 
L1+SSIM alene inte genkender. V460-implemente
ring. Empirisk förbättrar en värde på 0.05-0.1 L1-
scoren i sessioner med et par procent, men koster 
~5 % träningstid (ekstra forward-pas genom blur-
kernerne). Over 0.15 blir træningen ustabil, og L1 
försämras igen (loss-term’en dominerer optimering
en). Virker under træningen, inte i post-processing 
— trods placering i „Enhancements”-sektionen er 
det altså inte en ren opgradering bagefter.

KO R T  S AG T

En ekstra loss-andel, der tjekker 
strukturel billedlighed via tre oli­
ka uskarphedstrin. Hjælper sär­
skilt vid scener med fine struk­
turer som hår, stof eller vegeta­
tion, fordi den fanger mønstre, 
L1+SSIM alene inte ser. Mindre 
värden er sikrere — 0.05 til 0.1 
er sweet spot, over 0.15 blir 
træningen ustabil, og loss’en för­
sämras igen. Vid 0 (Off) er funk­
tionen helt slukket og koster in­
tet; aktiv sluger den ca. 5 % trä­
ningstid til det ekstra forward-
pas genom blur-kernerne. Vir­
ker trods „Enhancements”-sek­
tionen direkte under træningen, 
inte først i post-processing.
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I42 Sky Masking

VA R

Inspector → Enhancements (Outdoor-grup
pen) → Toggle „Sky Masking”. Bound: 
AppState.trainingConfig.skyMaskingEnabled (per 
projekt, @DefaultFalse ). Default: false .

T E K N I S K T

Aktiverer pre-training Apple-Vision-baserat sky-
pixel-segmentering. Før tränings-start ekstraheres 
sky-regionen for hvert input-kamera via Apple-
Vision-Foreground-Mask (Sky = Background) og til
knyttes det pågældende kamera som pr.-pixel-mas
ke. Under træningen multipliceres loss-bidraget pr. 
pixel med komplementet av sky-masken — sky-pixel 
bidrager 0 til gradienten, så gaussians, der projice
rer ind i himlen, inte modtager optimerings-signaler 
og dermed inte blir „tættere” eller „lysere”. Reduce
rer floaters (mørke klumper i himlen) vid outdoor-/
drone-scener signifikant. Koster ~3% L1-regression 
vid klassisk 40K-träning (se memory/​dev_​outdoor-
floater-reduction.md). Kun meningsfuld vid outdo
or-scener med klart genkendelig himmel; vid inden
dørs scener eller hvid baggrund identificerer sky-
segmenteringen forkerte områder og blokerer valide 
loss-signaler. Värdet sparas nu per projekt (inte 
längre app-globalt) och följer presetet / scen-filen.

KO R T  S AG T

Vid outdoor-optagelser med him­
mel i bilden opstår der ofte sorte 
eller farvede klumper i himlen — 
såkaldte „floaters”. Denne mulig­
hed registrerer automatisk, hvor 
himlen er, og siger til træning­
en: „Lad himlen være i fred.” 
Fungerer rigtig godt vid drone­
flyvninger og landskabsscener. 
Vid indendørs rum eller mørke 
baggrunde kan det forringe bil­
den — så tænd kun, om der fak­
tisk er rigtig himmel att se. De­
taljer: memory/​dev_​outdoor-
floater-reduction.md.
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I43 Mid-Training Floater Cleanup

VA R

Inspector → Enhancements (Outdoor-gruppen) → 
Toggle „Mid-Training Floater Cleanup”. Bound: 
AppState.trainingConfig.floaterCleanupEnabled 
(per projekt, @DefaultFalse ). Default: false .

T E K N I S K T

Aktiverer vid klassisk 40K-träning (preset „P4 Qua
lity”) to ekstra density-control-passes: vid iteration 
20,000 og vid iteration 30,000. Begge passes gen
nemsøger alle gaussians efter tre kriterier: (a) 
meget lav opacity (standard 0.005), (b) lille screen-
space-størrelse, (c) ingen loss-bidrag i de senaste 
1000 iterationer. Gaussians, der opfylder alle tre 
betingelser, purges. Effekt: ~5–15% færre gaussi
ans vid träningsslut, synligt færre mørke klumper 
i himlen vid drone-/outdoor-scener. Koster ~1–3% 
L1-regression vid nærbillede-indoor-scener, därför 
inte aktiveret som default. Værdien huskes på tværs 
av genstart (i modsætning til S7). De to cleanup-
iterationer (20K, 30K) er hårdt definerede og kan 
p.t. inte ændres via UI; vid kortere træninger (f.eks. 
P2 Preview 5K) har toggle’en ingen effekt, fordi 
den aldrig när iterations-mærkerne. Nyt: Toggle’en 
er kun betjenbar, når den aktive preset bruger Clas­
sic-densifieren (densificationStrategy ==
.classic). Vid MCMC eller Hybrid er den di­
sabled, og et inline-hint vises, fordi dessa strate
gier ändå selv behandler døde gaussians (MCMC 
via relocation, Hybrid via kombineret reloc-/noise- 
logik) — de manuelle cleanup-passes ville der væ
re virkningsløse hhv. kontraproduktive. Kode-refe
rence: RadianceKitApp.swift, General-fanen. Detal
jer: memory/​dev_​outdoor-floater-reduction.md.

KO R T  S AG T

Under træningen opstår der någ­
ra gange „døde” gauss-punkter, 
som inte længere bidrager til bil­
ledkvaliteten, men optager min­
ne. Denne mulighed rydder op to 
gange under en lang träning (vid 
20K og 30K iterationer) og fjer­
ner dessa lig. Vid outdoor-scener 
med himmel är det særligt nyt­
tigt, fordi det er der, de fleste flo­
aters samles. Vid små træninger 
eller nærbilleder av møbler är det 
snarere inte nødvendigt. Kontak­
ten kan kun tændes, når din pre­
set bruger Classic-densifieren — 
vid MCMC- eller Hybrid-presets 
er den grålig (med en kort forkla­
ring), fordi de selv rydder op i 
deres døde punkter.
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I44 Reconstruct Sky Dome

VA R

Inspector → Enhancements (Outdoor-gruppen) 
→ Toggle „Reconstruct Sky Dome”. Bound: 
AppState.trainingConfig.skyDomeEnabled (per pro
jekt, @DefaultFalse ). Default: false .

T E K N I S K T

Aktiverer pre-training sky-dome-projektionen 
(V549e MVP). Efter SfM og före tränings-start ek
straheres for hvert input-kamera den i S7 fælles 
brugte Apple-Vision-sky-maske fra bilden, sky-pix
lene av-projiceres med kamera-intrinsics på en vir
tuel kugleoverflade (standard-radius 8× scen-radi
us). På denna kugle initialiseres ~5000 nye gaussi
ans med farve-middelværdier fra de projicerede 
sky-pixler, meget stor skalering (1.0 i scen-enheder) 
og start-opacity 0.95. Disse 5000 gaussians er inte 
en sky-mask i klassisk forstand — de tränas som al
le andre, men holdes via den høje start-opacity i et 
tyndt ska. Resultat: vid 360°-novel-views i outdo
or-/drone-scener fremstår faktiske himmelfarver og 
skyformationer i stedet for mørke konfetti-klumper. 
Værdien huskes på tværs av genstart. Kun menings
fuld vid outdoor-scener med mindst 360°-kamera
dækning; vid rene object-captures uden himmel har 
det ingen effekt. Status: eksperimentel, bredere A/
B-validering på tværs av yderligere outdoor-sæt 
udestår.

KO R T  S AG T

I stedet for at træningen 
forsøger at „gætte” himlen ud 
fra de få synlige pixler (vilket 
fører til floaters), projicerer Radi­
anceKit himmel-pixlerne direkte 
på en virtuel kugle omkring sce­
nen, före træningen starter. Når 
du så drejer den færdige scen i 
360°, ser du rigtig himmel i ste­
det for sorte klumper. Fungerer 
kun vid outdoor-optagelser, hvor 
der faktisk er himmel i bilden. 
Vid stue-scanninger eller studie­
optagelser bringer det intet.
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Metrik-sektion (I30–I38)

Figur 13:  Crop kun Training Metrics-sektion efter afsluttet träning på buket (5K iterationer, 2 
991 gaussians endelig) — tabel med trænings-metrikker (Iteration, Loss, SSIM Loss, Combi

ned Loss, Gaussian Count, Learning Rate, Elapsed, ETA)

Mens en träning kører, visar metrik-sektionen ni live-värden fra trænings-loopet. Før 
start av en träning er sektionen tom („Start training to see live metrics”). Alle värden 
opdateres hver ~30 iterationer (opdaterings-frekvens for streamen). Sektionen er read-
only — intet element kan klikkes eller ændres. Til dybere analyse trækkes JSONL-
trænings-loggene under ~/​Documents/​RadianceKit/​Logs/​ ind (script python3 scripts/​
analyze_​logs.py best 5).
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I30 Iteration

VA R

Inspector → Metrikker → Iteration. Read-only.

T E K N I S K T

Visning i formatet „4523 / 40000″ — aktuel itera
tion over total planlagte iterationer. Tæller synkront 
med trænings-loopet, der pusher værdierne hver 
~30 iter. Det andet tal svarer til max-iterations-vær
dien på start-tidspunktet; det ændres inte længere, 
selv om brugeren justerer stepperen därefter — 
den løbende kørsel bruger sin egen snapshot-kopi. 
Om appen via training-menuen lægger iterationer 
på (Continue Training +5K/+10K/+20K), øges næv
neren.

KO R T  S AG T

Hvor træningen lige nu står. 
„4523 / 40000″ betyder: 4523 av 
40 000 skridt er genom, altså 
ca. 11 % færdig. Tallet til venstre 
tæller op i sekundtakt; om det 
står stille i minutter, hænger træ­
ningen — som regel et tegn på 
GPU-throttling eller en konkurre­
rende app. Tallet til højre svarer 
til max-iterations-værdien (I18) 
vid træningens start og ændres 
inte længere, selv om du justerer 
stepperen senere. Vid Continue 
Training (+5K/+10K/+20K) vokser 
den med de ekstra skridt.

I31 Loss

VA R

Inspector → Metrikker → Loss. Read-only.

T E K N I S K T

Float-värde med seks decimaler (f.eks. 
„0.024385″). Måler den kombinerede L1+SSIM-loss 
(blanding kontrolleres via I21 SSIM Weight) plus 
valgfrit Perceptual Loss (I29) og andre regularizere. 
Skalaen er inte absolut, men scen-afhængig — kræ
ver for de fleste sammenligninger samme datasæt. 
Typiske slutværdier vid gode konfigurationer:
• Classic Quality 40K iters: 0.022–0.025 (Horse, 

Truck, Garden)
• MCMC Full 200K iters: 0.024–0.028
• Outdoor drone 30K: 0.030–0.060 (geometri-be

tinget dårligere)
• Indendørs lejligheder: 0.018–0.025

Värden over 0.10 efter 5K iterationer indikerer SfM-
problemer (dårlige kamera-positioner) — afbryd og 
lav SfM på ny.

KO R T  S AG T

Hvor langt det rendrede bild sta­
dig afviger fra originalen — kom­
bineret av L1, SSIM og evt. Per­
ceptual Loss. Mindre er bedre. 
Under 0.03 er som regel rigtig 
godt, under 0.05 stadig okay, 
outdoor-scener ligger geometri-
betinget snarere vid 0.03-0.06. 
Over 0.10 efter flere tusinde ite­
rationer er et advarselssignal — 
som regel skyldes det kamera-
rekonstruktionen (SfM har inte 
klappet pænt). Skalaen er in­
te absolut, men scen-afhængig; 
lav kun sammenligninger inden 
for samme datasæt. Om tallet 
pludselig springer opad, er der 
som regel sket en gradient-ex­
plosion-event.
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I32 Learning Rate

VA R

Inspector → Metrikker → Learning Rate. Read-only.

T E K N I S K T

Visning i scientific notation (f.eks. „1.60e-04″). 
Aktuel inlärningshastighet for position-parametrene 
(3DGS har seks uafhængige LR’er for position, SH-
DC, SH-rest, opacity, scale, rotation — her visas 
position-LR’en som repræsentativ värde). Default-
startværdi 1.6e-4, der over en exponential-decay 
sjunker ned til ~1.6e-6 i træningens slutning. Forfal
det kan justeres via LR-schedule-feltet i trænings-
konfigurationen (T-felt i kap. 6). Om LR’en blir 
usædvanlig høj (f.eks. 1e-3 eller mere efter 10K 
iterationer), kan det indikere en fejlindlæst konfigu
ration.

KO R T  S AG T

Hvor store optimerings-skridte­
ne er lige nu — konkret lærings­
raten for gaussian-positionerne. 
Starter vid 1.60e-04 og sjun­
ker eksponentielt til ca. 1.60e-06 
vid träningsslut („1.60e-06″ = 
0.0000016). Forløbet kører auto­
matisk, du behöver inte justere 
her. Om værdien efter 10 000+ 
iterationer stadig er større end 
1e-3, er der sannolikt indlæst en 
fejlagtig config — afbryd träning 
og vælg preset på ny. Internt 
har 3DGS seks uafhængige inlär­
ningshastigheter (position, SH-
DC, SH-rest, opacity, scale, rota­
tion); her ser du kun position-
LR’en som stedfortræder.

I33 SH Degree

VA R

Inspector → Metrikker → SH Degree. Read-only.

T E K N I S K T

Heltal 0-3. Spherical-harmonics-grad for farvere
præsentationen. Begynder vid 0 (kun DC-kompo
nenten, dvs. retnings-uafhængig farve pr. gaussian 
— altså bare en RGB-konstant) og stiger progressivt 
til 3 i træningens forløb. Standard-schedule hæver 
graden vid 1000/2000/3000 iterationer med 1 hver. 
SH-3 svarer til 48 farve-koefficienter pr. gaussian (3 
RGB-channels × 16 SH-basisfunktioner). Højere SH-
grad = mere retnings-afhængig refleksion (blanke 
overflader ser korrekt olika ud under olika syns
vinkler), men också mere minne og långsammare 
träning.

KO R T  S AG T

Hvor kompleks farvefremstilling­
en pr. gaussian er lige nu. Starter 
vid 0 (kun en retnings-uafhæng­
ig farve pr. punkt) og trækkes 
trinvis op til 3 — typiskt vid ite­
ration 1000, 2000 og 3000. Trin 
3 betyder 48 farve-koefficienter 
pr. gaussian og tillader retnings-
afhængige refleksioner, altså at 
blanke overflader fra olika syns­
vinkler ser korrekt olika ud. Du 
behöver inte aktivt røre vid det, 
schedulen kører automatisk. Hø­
jere grad koster mere minne og 
forsinker træningen en smule — 
men det er prisen for realistiske 
højlys.
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I34 Gaussians

VA R

Inspector → Metrikker → Gaussians. Read-only.

T E K N I S K T

Aktuelt antal gaussians i modellen, formateret med 
locale-separator (f.eks. „524.318″). Vækst:
• Classic: starter vid SfM-init-punkterna (typiskt 

50K-300K), vokser via clone/split tills kort före 
Densify Until, därefter statisk tills träningsslut 
(modulo pruning)

• MCMC: sample-punkter tilføjes tills MCMC-cap’et, 
därefter kun relocation

Healthy slutværdier:
• Classic Quality: 400K-700K (Horse 524K, Garden 

800K)
• MCMC Full: præcis på cap’et (default 150K, med 

auto-scale multiplier × SfM-count alt efter scen 
500K-1.5M)

Vid MCMC falder tallet til < 60 % av cap’et → 
anomali (collapse-indikator, peger på for aggressive 
regularizere).

KO R T  S AG T

Hvor mange gaussian-punkter 
3D-modellen har lige nu. Vokser 
under træningen, tills Densify 
Until (I20) er nået; därefter för­
blir tallet praktisk konstant. Fle­
re punkter = mere detalje, men 
också større fil og långsammare 
rendering i viewporten. 500.000 
gaussians är en typiskt mid­
delværdi for Classic-Quality på 
en mellemstor scen; MCMC Full 
lander alt efter auto-scale (I17) 
vid 500K til 1.5M. Om tallet vid 
MCMC pludselig falder under 60 
% av cap’et, är det en collapse- 
indikator — som regel for ag­
gressive regularizere.

I35 GPU Memory

VA R

Inspector → Metrikker → GPU Memory. Read-only.

T E K N I S K T

Skøn av gaussian-bufferens hukommelsesforbrug 
som gaussian-count × 616 bytes (formateret i me
mory-style). 616 bytes är den empiriske størrelse 
av en fuldt udstyret gaussian (position, skalering, 
rotation, opacity, SH-koefficienter grad 3, gradient-
akkumulator). Visningen fanger inte renderer- over
head (tile-buffer, sort-buffer, backward-buffer) — 
det reelle GPU-lagerbehov ligger typiskt 2-3× over 
denna värde. Vid 500K gaussians: vist ~290 MB, 
reelt ~700 MB. Vid 1.5M gaussians: vist ~880 MB, 
reelt ~2.5 GB. På M3 Max med 64+ GB unified 
memory ukritisk, på M3 Pro med 18 GB allerede en 
grænse.

KO R T  S AG T

Ett skøn over, hvor meget GPU-
minne gaussians selv optager — 
rundt 616 bytes pr. punkt. Det 
faktiske GPU- forbrug er 2-3× hø­
jere end vist, fordi rendereren 
också lægger egne tile-, sort- 
og backward-buffers til. På en 
MacBook med 16-18 GB unified 
memory bør du holde dig under 
500K gaussians; med M3 Max el­
ler Studio (64+ GB) kan du lätt 
køre 1.5M og mere. Om træning­
en pludselig crasher, eller syste­
met swapper, er grænsen som re­
gel nået her — skru Render Scale 
(I22) ned eller reducer Densify 
Until (I20).
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I36 Speed

VA R

Inspector → Metrikker → Speed. Read-only.

T E K N I S K T

Iterationer pr. sekund med en decimal („24.3 it/s”). 
Beregnes av træneren som glidende gennemsnit 
over de senaste ~100 iterationer. Typiske värden:
• Quick-preset (1K iters): 80-120 it/s (kort, ingen 

steady-state)
• Classic 20K @ 1.0 Render Scale (Truck-scen, M3 

Max): 25-35 it/s
• Classic 20K @ 0.5 Render Scale: 80-120 it/s
• MCMC 200K @ 0.5 Render Scale: 25-50 it/s 

(långsammare pga. relocation)
• Vid 1M+ gaussians og fuld upplösning: < 10 it/s

Faldende speed i træningens forløb er normalt 
— flere gaussians = mere compute pr. iteration. 
Pludselige fald (f.eks. fra 30 → 5 it/s) indikerer GPU-
thermal-throttling eller konkurrerende apps.

KO R T  S AG T

Hvor snabbt træningen kører, i 
iterationer pr. sekund. Står ty­
piskt vid 20-50 it/s, vid reduce­
ret Render Scale (50 %) og små 
scener också 80-120 it/s. Falder 
genom træningen ganske natur­
ligt, fordi flere gaussians = mere 
arbejde pr. iteration. Pludselige 
fald (f.eks. 30 → 5 it/s) indike­
rer GPU-thermal-throttling eller 
konkurrerende apps — browser-
faner med video, Time Machine-
backup, Photos-indeksering. At 
holde appen i forgrunden og luk­
ke baggrundsprogrammer hjæl­
per ofte. Vid 1M+ gaussians og 
fuld upplösning er under 10 it/s 
normalt.

I37 Elapsed

VA R

Inspector → Metrikker → Elapsed. Read-only.

T E K N I S K T

Allerede forløbet tid som „4:23″ (m:ss) eller 
„1:23:45″ (h:mm:ss). Format-switch fra 1 time. Må
ler kun den rene träningstid, inte de forudliggende 
faser (SfM-beregning, bild-import). Vid pause/resu
me kører uret videre — det er altså wall-clock, inte 
CPU-tid.

KO R T  S AG T

Hvor længe træningen allerede 
har kørt, som ren stopur (wall-
clock-tid). Format er „m:ss” til 
en time, därefter „h:mm:ss”. Inte 
„CPU-tid”, men „hvor længe har 
vi ventet” — så också pause-
tider tæller med. Måler kun den 
rene tränings-fas, inte den fo­
rudliggende SfM-beregning eller 
bild-importen. Hjælpsom til sam­
menligning med ETA (I38) — om 
Elapsed markant overskrider den 
oprindelige ETA, er træningen 
blivit långsammare et sted end 
planlagt.

59 / 221



R A D I A N C E K I T Kapitel 2 — Inspector (Expert View)

I38 ETA

VA R

Inspector → Metrikker → ETA. Read-only.

T E K N I S K T

Estimeret resttid som „17:42″ eller „1:12:35″. Bereg
ning: (Max Iterations − aktuel iteration) / iterationer-
pr.- sekund. Visar „–”, när speed lige er nul (helt i 
starten eller vid pause). Estimatet tilpasses inte den 
typiske forlangsomning mod träningsslut — särskilt 
vid MCMC og Classic med store Densify-Until-vär
den har træningen tendens til at bli långsammare, 
fordi flere og flere gaussians kommer ind i bilden. 
Reelt blir det typiskt 10-20 % over start-ETA.

KO R T  S AG T

Hvor længe der förmodligen sta­
dig ska ventes — beregnet ud 
fra de tilbageværende iterationer 
og den aktuelle speed (I36). Ett 
groft skøn: om Mac’en pludselig 
blir långsammare (flere gaussi­
ans fra densify-fasen, thermal- 
throttling, andre apps), kan det 
vare længere end vist. Appen 
indregner inte den typiske for­
langsomning mod träningsslut, 
så det reelle slut lander som re­
gel 10-20 % over start-ETA. Læg 
15 % ekstra ind, så passer det 
som regel. Visar „–”, när speed 
lige er 0 (træningens start eller 
pause).
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Loss-diagram-sektion (I39–I41)

Figur 14:  Crop kun Loss History-sektion efter afsluttet träning — Current 0.0064, Min 
0.0035 (grøn), blåt forløb fra 0.027 (iteration 1) til 0.0035 (iteration 5K) med karakteristisk 

knæk omkring iter 200, derunder Gaussian Count-chart orange

Loss-diagram-sektionen visualiserer trænings-forløbet over tid. Den består av to 
charts: et loss-curve-chart (stort, øverst, blå) og et gaussian-count-chart (mindre, 
nederst, orange). Begge bygges op live under træningen og persisterer tills nästa 
trænings- start. Før første träning er området tomt („Loss curve will appear during 
training”). Charts er rene SwiftUI-path-tegninger (ingen Swift-Charts-framework), så de 
också rendrer flydende vid 100K+ punkter.
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I39 Current Loss (visning)

VA R

Inspector → loss-diagram → venstre label-område 
„Current: 0.0287″. Read-only.

T E K N I S K T

Float-värde av det sista loss-sample-punkt, forma
teret med fire decimaler. Identisk med I31 (Loss i 
metrics-sektionen), bare her mere kompakt forma
teret. Kilden er loss-history — en liste, der får en 
post pr. ~30 iterationer. Kun endelige värden opta
ges i listen — NaN/Infinity (meget sjældent, i tilfælde 
av gradient-explosion-bug) filtreres.

KO R T  S AG T

Den aktuelle loss-värde i kor­
tere skrivemåde end i metrics-
sektionen (fire decimaler). Ind­
holdsmæssigt identisk med I31, 
men her sidder visningen direk­
te vid loss- charten og giver dig 
den præcise tal-värde, mens du 
iagttager kurven. Opdateres som 
alle live-metrikker hver  30 itera­
tioner. NaN- eller infinity-värden 
(ekstremt sjældne vid gradient- 
explosion-bugs) filtrerer appen 
automatisk fra. Nyttig for inte at 
skulle hoppe til den anden sek­
tion, mens du kigger på diagram­
met.

I40 Min Loss (visning)

VA R

Inspector → loss-diagram → højre label-område 
„Min: 0.0245″ (grøn). Read-only.

T E K N I S K T

Minimum av alle nogensinde sete loss-värden i den 
aktuelle träningskörning. Genberegnes live ud fra 
loss-history — ingen separat persistens. Visas med 
grøn skrift, fordi „Min” = „best so far”. Den stiple
de grønne linje vid chartens nederste rand marke
rer denna Y-position visuelt. Vid continue-training- 
sessioner starter min-sporingen forfra — den gamle 
history erstattes i UI’en av den nye (inte vedhæftet). 
Om den aktuelle träning kører dårligere end den fo
regående, kan min-visningen altså være større end 
det forrige slutresultat.

KO R T  S AG T

Den laveste loss-värde, denna 
träning hidtil har set — grønt 
vist, fordi „best so far”. Den 
stiplede grønne linje vid char­
tens nederste rand markerer 
också denna position visuelt. Om 
den aktuelle kurve just ligger 
markant over, er der med lidt 
held endnu en forbedring; som 
regel er min dock det slutresul­
tats-tegn, der senere interesse­
rer dig. Vid continue- training-
sessioner starter min-sporingen 
forfra, fordi den gamle history 
erstattes i UI’en av den nye — 
min-værdien kan dermed se dår­
ligere ud end det forrige slutre­
sultat.
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I41 Gaussian Count Chart

VA R

Inspector → loss-diagram → andet chart derunder 
(orange). Read-only.

T E K N I S K T

Linje-diagram av gaussian-antallet over trænings- 
iterationerne. Kilde: gaussian-count-history (liste av 
(iter, count)-par, fyldt av træneren hver ~30 iter). 
Y-skala dynamisk mellan minimum og maksimum av 
history’en. Vid Classic- strategi ser kurven typiskt 
sådan ud: jævnt stigende tills Densify Until, därefter 
flad (med små pruning-udsving). Vid MCMC: stejl 
stigning tills cap, därefter horisontal linje (relocation 
holder tallet konstant). Om kurven falder trods aktiv 
träning, prunner densificationen for aggressivt — 
tegn på forkerte defaults eller en kendt MCMC-col
lapse-bug (v1.4.4-hotfix-tema).

KO R T  S AG T

Hvordan antallet av gaussians 
udvikler sig over trænings-tiden 
— det mindre orange chart under 
loss-kurven. Vid Classic-strategi 
stiger linjen jævnt, tills Densify 
Until (I20) er nået, därefter för­
blir den flad med små pruning-
udsving. Vid MCMC svirrer den 
stejlt op til cap’et og förblir där­
efter horisontal, fordi relocation 
holder tallet konstant. Om kur­
ven trods aktiv träning pludselig 
knækker nedad, er densificatio­
nen for aggressiv vid pruning 
— klassisk tegn på MCMC-collap­
se- bug’en fra v1.4.4. Så hjælper 
app-opdatering eller skift tilbage 
til Classic.

Hvordan læser man loss-kurven?

Loss-charten är det viktigaste diagnose-værktøj i Inspectoren — ingen anden indikator 
visar så direkte, om træningen skrider nyttigt frem eller hænger fast. Den typiske sunde 
form er et snabbt fald i de første 1000-3000 iterationer (fra ~0.15 til ~0.05), efterfulgt 
av et långsamt, jævnt fald til träningsslut (til 0.020-0.030). Logaritmisk virker kurven 
som en glat diagonal.

Vad betyder et plateau vid loss’en? Om kurven over flere tusinde iterationer förblir 
flad, er der to mulige læsninger: (a) træningen er „konvergeret” — loss’en kan inte 
længere falde signifikant, fordi modellen er så god, som den kan bli med de givne data 
og inställningar. Det er ønsket; det er „færdig”. (b) Træningen „hænger” — loss’en kan 
egentlig stadig falde, men optimeringen stagnerer (lokalt minimum, inlärningshastighet 
for lille, densification slukket). At skelne: om loss-værdien ligger i et typiskt godt områ
de (0.020-0.030 vid indoor/object, 0.040-0.060 vid outdoor), og kurven har varit flad i 
5K iterationer, är det konvergeret. Om værdien er markant højere end vid sammenligne
lige scener (f.eks. 0.08), hænger den fast.

Advarsel: gaussian-plateau ≠ loss-plateau. Ett plateau i gaussian-antallet betyder 
inte „träning er færdig”. Det betyder kun, at densificationen er holdt op med at tilføje 
nye punkter — enten fordi er nået (Classic), eller fordi MCMC-cap’et er fuldt. Træningen 
kører bagefter videre og forfiner kun de eksisterende punkter. Det egentlige „færdig”-
signal læser du av loss-kurven og iteration-visningen (I30), inte her.

Tommelfingerregel til afbrydelse: Om loss-kurven efter 5000+ iterationer ligger over 
0.08 og næppe falder mere, er SfM-rekonstruktionen med høj sandsynlighed skæv. 
Afbryd träning, slå op i kapitel 9, om det valgte SfM-backend passer til scenen, skift 
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evt. til COLMAP/Native, start så på ny. Bedre at investere 10 minutter i bedre SfM end 2 
timers träning med dårlig kamera- justering.

Hvornår række ud efter Inspectoren?

Hurtig-reference: vilken sektion + vilka controls til vilket typiskt use-case?
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Common-task Sektion Control-ID’er

Afmætte den færdige Splats 
farver

Look L1 (Saturation)

Runde nål-/konfetti-Splats Look L2 (Splat length)

Fylde en hullet sky / forstørre 
Splats

Look L3 (Splat size)

Udblende fjerne „Far-konfetti” 
vid orbits

Look L4 (Fade far region)

Forkaste Look-justeringer Look L5 (Reset finishing)

Indlæse forudfremstillet 
opsætning

Presets I7 (klik på linje)

Gemme egen opsætning Presets I1 → I2 → I4

Dele opsætning med kolleger Presets I5 (eksport) eller I6 (import)

Skifte SfM-backend (f.eks. for
di Apple-PG er for ustabil)

træningskonfigura
tion

I12 (se kap. 9)

Behandle video-frames uden 
EXIF- brændvidde

træningskonfigura
tion

I13 (FOV-override)

COLMAP-performance: GLO
MAP i stedet for klassisk

træningskonfigura
tion

I14

Skifte fra Classic til MCMC træningskonfigura
tion

I15

Lade træningen køre længere træningskonfigura
tion

I18 (Max iter) + I20 (Densify 
Until) — koblet via I19

Halvere GPU-tid træningskonfigura
tion

I22 (Render Scale til 50 %)

Trænings-kvalitet +6 % 
(MCMC)

træningskonfigura
tion

I16 (MCMC Quality)

Outdoor-scen med mange 
SfM- punkter

træningskonfigura
tion

I17 (Auto-scale by scen)

Opsætte / skifte COLMAP-sti træningskonfigura
tion

I23 / I24 / I25

Gøre eksport-filer mindre Enhancements I26 (lad altid være tændt)

Skarpere viewport uden ekstra 
träningstid

Enhancements I27 (Viewport Scaling → Metal
FX)

MetalFX glatter for meget → al
ternativ

Enhancements I27 (Viewport Scaling → Lan
czos)

Sista kvantitet detalje vid fine 
strukturer

Enhancements I29 (Perceptual Loss 0.05-0.1)

Overvåge träning Metrikker I30 (fremskridt), I36 (tempo), 
I38 (resttid)Vurdere kvalitet tidligt Metrikker I31 (Loss < 0.05 efter 5K = 

god)
Mistanke om SfM-problem Metrikker + loss-

chart
I31 + I39 (Loss > 0.08 efter 5K 

→ SfM på ny)
Skelne konvergens vs hængen

de
loss-diagram I39 + I40 (læs loss-plateau)Genkende densification-pro

blem
loss-diagram I41 (gaussian-kurve falder → 
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K A P I T E L

Kapitel 3 — Inställningar

Indstillingsvinduet åbnes via RadianceKit → Indstillinger… eller standardgenvejen 
⌘, . Det innehåller to faner: General og AI Helpers. I modsætning til Inspector-

værdierne fra kapitel 2 virker indstillingerne fra detta vindue app-globalt (på tværs av 
alle projekter) — de persisteres og overlever app-genstart. General-fanen grupperer tre 
indholdsmæssige sektioner: Interface, Viewport og Training. (De tre Outdoor-Floater-
kontakter — Sky Masking, Mid-Training Floater Cleanup, Reconstruct Sky Dome — 
som tidigare bodde her, flyttade per v1.6 till Expert-Inspectorns Enhancements-sektion, 
där de nu sparas per projekt; se kapitel 2, I42–I44.) AI-Helpers-fanen tænder for on-de
vice-machine-learning-hjælperne (Vision, CoreML) til SfM- og trænings-forbehandling.

Tidligere betjeningselementer til samlet aktivering eller deaktivering av alle AI-helpers 
finns inte længere i den aktuelle version — de er därför inte dokumenteret her. Også det 
tidligere „Coming Soon”- område til endnu inte leverede hjælpere er fjernet og refereres 
inte her.
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General-fanen

Figur 15:  Inställningar → General-fanen med brugerflade, viewport, training og experimen
tal-sektion
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S1 Default Mode

VA R

Settings → General → Interface → Default Mode-
vælger. Bound:. Default: .simple .

T E K N I S K T

Styrer, vilken av to UI-tilstande appen åbner i vid 
nästa opstart. „Simple Mode” är den guidede wi
zard-workflow i 4 trin (Import → Processing → Pre
view → Export, dokumenteret i kapitel 10 under Z1–
Z4), „Expert Mode” det klassiske tre-panel-layout 
med Navigator, 3D-viewport og Expert-Inspector fra 
kapitel 2. Værdien huskes på tværs av genstart. 
Identisk virkning som menuen Mode → Simple Mode 
(⌘1) / Mode → Expert Mode (⌘2), bortset fra at 
menuen skifter den løbende session, mens denna 
vælger sætter standarden for fremtidige sessioner. 
Begge tilstande tilgår samme projekt-state — pro
jekter, kameraer og træningskonfiguration bevares 
vid tilstandsskift. Tilstandsspecifikke værktøjslinje
knapper gen-rendres med det samme.

KO R T  S AG T

Her vælger du, vilken brugerflade 
RadianceKit starter op med näs­
ta gang. „Simple Mode” er be­
gyndertilstanden: fire klare trin, 
forudvalgte inställningar, næsten 
ingen valg. „Expert Mode” är det 
fulde værktøjskasse-layout med 
alle håndtag, du ser i kapitel 2. 
Du kan til enhver tid skifte frem 
og tilbage via menuen „Mode”, 
uden at bilder eller træningsf­
remskridt går tabt.

S2 Language

VA R

Settings → General → Interface → Language-væl
ger. Bound:. Default: .system  (følger macOS-spro
get).

T E K N I S K T

Vælger visningssproget for hele app-UI’en, uaf
hængigt av macOS-systemsproget. RadianceKit er 
lokaliseret til 17 sprog ( de , en , pl , en-AU , 
ar-SA  plus 12 yderligere). Vid „System” følger ap

pen macOS-sproget. Vid et eksplicit valg huskes 
sprogindstillingen på tværs av genstart; fuld virk
ning kræver som regel en app-genstart, fordi lokali
serings-bundles kun indlæses vid opstart. De 298 
dokumenterede lokaliseringsnøgler i projektet med
tages alle, inklusive alle tekster i sub-views og hjæl
pe-tooltips.

KO R T  S AG T

Om din Mac kører på engelsk, 
men du hellre vil have den dans­
ke RadianceKit-brugerflade (eller 
omvendt), stiller du det her. De 
fleste tekster skiftes med det 
samme. Nogle dialoger optræder 
først på det nye sprog efter en 
app-genstart.

68 / 221



R A D I A N C E K I T Kapitel 3 — Inställningar

S3 Viewport Background

VA R

Settings → General → Viewport → Background-væl
ger. Bound:. Default: .darkGray  (RGB 0.1, 0.1, 0.1).

T E K N I S K T

Sætter standardbaggrundsfarven for 3D-viewpor
ten. Tre muligheder: „Dark Gray” (RGB 0.1, 0.1, 0.1 
— default), „Black” (0, 0, 0) og „White” (1, 1, 1). 
Indstillingen persisterer standarden for nye projek
ter og sessioner på tværs av genstart og opdaterer 
samtidig den kørende Metal-renderer med det sam
me. Identiske muligheder finns i menuen Viewport 
→ Background (M21, M22, M23), men Settings-
vælgeren sætter standarden, mens menuen skifter 
den løbende visning. Vigtigt for screenshots og 
demo-videoer: hvide baggrunde fremhæver grønne/
blå floaters tydeligere, mørke baggrunde er bedre til 
rene render-optagelser.

KO R T  S AG T

Farven bag dine 3D-modeller i 
forhåndsvisningsvinduet. Mørke­
grå er standard og passer til 
de fleste scener. Hvid er godt 
til screenshots, sort virker mere 
elegant til render-optagelser. Du 
kan til enhver tid skifte farven 
via menuen „Viewport → Back­
ground” for den løbende scen 
— denna inställning fastlægger 
kun, vilken farve der ska være ak­
tiv vid nästa åbning.

S4 Auto-Rotate After Training

VA R

Settings → General → Viewport → Toggle „Auto-
Rotate After Training”. Bound:. Default: false .

T E K N I S K T

Starter umiddelbart efter träningsslut en kontinu
erlig turntable-rotation av viewport-kameraet om 
scenens tyngdepunkt (standard-rotationshastighed 
~0.3 rad/s). Praktisk användbar til demo-sessioner, 
A/B-sammenligninger og til direkte at vurdere fra 
360°-perspektiv, om der er opstået „floaters” vid 
scen-kanten. Effekten er visuelt identisk med menu
en Viewport → Toggle Auto-Rotation (M16, ⌘⌥T), 
bortset fra at toggle’en her udløser adfærden auto
matisk efter träningsslut i stedet for manuelt. Lader 
sig senere afbryde til enhver tid via menuen eller vid 
klik i viewporten (som pauser rotationen). Har ingen 
indflydelse på trænings-performance — rotationen 
kører først, när træningen er færdig.

KO R T  S AG T

Når aktiveret roterer 3D-scenen 
automatisk, så snart træningen 
er færdig — som en karrusel. 
Rart, om du om morgenen efter 
en natlig träning straks ser resul­
tatet i bevægelse uden selv at 
skulle klikke. Vid lange sessioner, 
hvor du blot overvåger træning­
en, så lad hellre være.
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S5 Live Preview Interval

VA R

Settings → General → Trai
ning → Live Preview-vælger. Bound: 
AppState.trainingConfig.livePreviewInterval. 
Default: 0  (Off).

T E K N I S K T

Bestemmer, med vilket iterations-interval det løben
de træningssnapshot rendres ind i 3D-viewporten. 
Fire diskrete värden: 0 („Off”), 50, 250, 1000 
iterationer. Vid aktiv Live Preview kopierer træne
ren Gaussian-bufferen fra GPU’en til en separat 
render-buffer og udløser en viewport-redraw. Vid 
„Off” opdateres viewporten først efter trænings-
afslutning. Performance-omkostning: hver 50 itera
tioner ~5–10% långsammare på M3 Ultra, hver 250 
iterationer ~1–2% långsammare, hver 1000 iteratio
ner umålelig. Memory-overhead konstant ~2 GB til 
snapshot-bufferen, uafhængigt av intervallet. Vær
dien fungerer som standard for nye træninger; efter 
tränings-start visar trænings-Inspectoren den reelle 
live-värde for den pågældende träning. Vid interval 
50 är det visuelle indtryk en flydende „opvækst” av 
punktskyen, vid 1000 virker det hakkende.

KO R T  S AG T

Mens træningen kører, kan du 
vælge, hvor ofte 3D-visningen 
opdateres. „Off” betyder: ing­
en opdatering under træningen 
(hurtigst). „Every 50 Iterations” 
visar næsten i realtid, hvordan 
din scen opstår (lidt långsamma­
re). Til afslappet zen-kigning vid 
små træninger er „Every 250″ et 
godt kompromis.
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S6 Throttle Delay

VA R

Settings → General → Training → Throttle-vælger. 
Bound: AppState.trainingConfig.throttleDelayMs. 
Default: 0  (Off).

T E K N I S K T

Indsætter en kunstig forsinkelse i millisekunder 
mellan tränings-iterationer. Fire diskrete värden: 0 
(„Off”), 2 („Light”), 5 („Moderate”), 10 („Eco”). 
Mening: vid længere træninger (flere timer) blir 
GPU’en annars belastet 100 %, vilket fører til mærk
bart långsammare system-UI (musemarkøren hak
ker, andre apps blir trægme). Throttle-forsinkelsen 
giver GPU’en pauser, hvor andre opgaver kan udfø
res. Performance-omkostningen er betragtelig: vid 
5 ms throttle varer en typiskt 40K-träning omkring 
50–80% længere end uden throttle. I performance-
tilstanden „Eco” (10 ms) er forsinkelsen pr. iteration 
længere end selve iterationen — faktor 2–3× lång
sammare. Vid aktiv throttle visas der under vælge
ren en bemærkning: „Throttle is on. Training will be 
slower than usual.” Selve appen reagerer inte mærk
bart bedre — kun andre apps har gavn av det.

KO R T  S AG T

Om din Mac blir for varm un­
der en lang träning, eller andre 
programmer blir for trægme, så 
slå en bremse til her. „Off” gi­
ver GPU’en fuld gas (hurtigst). 
„Light” indlægger en lille pause 
mellan hvert skridt (lidt långsam­
mare, men systemet reagerer be­
dre). „Eco” är den stærkeste 
bremse — god til nat-træninger 
på en MacBook, der inte ska bli 
for varm.
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AI-Helpers-fanen

Figur 16:  Inställningar → AI-helpers-fanen med master-kontakt og sub-toggles
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S11 AI Helpers enabled (Master)

VA R

Settings → AI Helpers → første sektion → Toggle „AI 
Helpers enabled”. Bound:. Default: true .

T E K N I S K T

Master-kontakt over alle AI-helpers-funktioner i pi
pelinen. Når slukket, springer import- og SfM-pipe
linen alle ML-baserade forbehandlingsstadier helt 
over — intet Apple-Vision- kald, ingen CoreML-mo
del-load, ingen NPU-opvågning. Når tændt, konsul
teres de individuelle sub-toggles (S12–S13). Værdi
en huskes på tværs av genstart. Påvirker følgen
de stadier: (a) frame-quality- pre-check före SfM 
(S12), (b) loop-closure-detektion (S13). Vigtigt: vid 
slukket er de to sub-toggles deaktiveret og vi
suelt grånet ud. Footer-bemærkning understreger, 
at alle AI-helpers strikt kører on-device — ingen 
bild-upload, ingen sky-behandling. Privatlivsgaran
tien kommer vid udelukkende brug av Apple-Vision-
framework (lokalt på Neural Engine) og CoreML-mo
deller, der ligger direkte i app-bundlen.

KO R T  S AG T

Hovedkontakten for alle funk­
tioner, der internt bruger AI/
machine-learning. Standard er 
„tændt”, fordi hjælperne sparer 
en masse tid, uden at dine bilder 
forlader Mac’en. Om du vil have 
dem helt slukket (f.eks. for at 
spare strøm, eller fordi din Mac 
inte har NPU), så sluk dem her 
— så blir de to under-muligheder 
härunder automatisk grå og gör 
inte længere något.
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S12 Frame quality check

VA R

Settings → AI Helpers → Available-sektion → Toggle 
„Frame quality check”. Bound:. Default: true .

T E K N I S K T

Aktiverer frame-quality-screeneren (fase 3.11), som 
före SfM-kaldet analyserer hver importeret frame. 
Pipeline-trin pr. frame: (a) Laplacian-variance-fil
ter fra Apple Vision (sløringsdetektion — tærskel 
~150), (b) histogram-baserat over/under-ekspone
rings-check (tærskel: >5% pixel vid 0 eller 255), (c) 
blank-frame-detect (standardafvigelse < 5 over alle 
pixel). Frames, der består alle tre tjek, går direkte 
genom. Frames, der fejler mindst ett tjek, udløser 
en modal bekræftelsesdialog, der lister hvert pro
blematisk frame med thumbnail og begrundelse og 
spørger, om det ska fjernes. Vigtigt: ingen automa
tisk sletning — dialogen er altid påkrævet, brugeren 
beholder den sista beslutning. Performance: ~50 
ms pr. frame på M3 Ultra, kører parallelt. Vid slukket 
sendes alle frames uprøvet videre til SfM. Vid deak
tiveret master (S11) er denna toggle visuelt grånet 
ud og uden virkning. Shipped status ifølge memory: 
SHIPPED 2026-05-23.

KO R T  S AG T

Før den egentlige träning kigger 
appen på hvert foto: är det rys­
tet? helt mørkt eller hvidt? tomt? 
Om ja, spørger den dig, om du 
vil smide bilden ud — den fjer­
ner aldrig något automatisk. Det 
sparer mange timer senere, for­
di et eneste totalt rystet bild 
några gange kan ødelægge hele 
træningen. Standard er „tændt”, 
fordi indsatsen er næsten nul, og 
gavnen er stor.
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S13 Loop closure detection

VA R

Settings → AI Helpers → Available-sektion → Toggle 
„Loop closure detection”. Bound:. Default: true .

T E K N I S K T

Aktiverer Apple-Vision-Feature-Print-baserat loop-
closure-detektion. For hver importeret frame bereg
nes en ~768-dimensional feature-vektor, som re
præsenterer en neural indlejring av bildindholdet. 
Därefter sammenlignes alle feature-prints parvis 
via cosine-similarity. Par med similarity > 0.85 og 
afstand i frame-index > 50 (altså inte-naboliggen
de frames) identificeres som „loop-closure-kandi
dater” og skrives i en sidecar-JSONL-fil i projekt
mappen. Kun informativ — den importerede bild-se
kvens modificeres inte. Mening: giver SfM-solveren 
(särskilt COLMAP) et hint om, at dessa frames hører 
sammen i klyngen i 3D-rummet. For native SfM 
er sidecar-informationen p.t. kun dokumenterende; 
COLMAP bruger hintsene internt via custom mat
ches-file (manuel integration mulig, inte automatisk 
koblet). Performance: ~200 ms pr. frame på M3 
Ultra, kører parallelt. Vid slukket genereres ingen 
feature-prints. Vid deaktiveret master (S11) visuelt 
grånet ud.

KO R T  S AG T

Når du går rundt om et objekt 
og til slut lander vid startpunk­
tet igen, hjælper det compute­
ren enormt att veta det. Denne 
mulighed registrerer automatisk, 
vilka av dine fotos der er optaget 
„næsten fra samme standpunkt”, 
og skriver det i en lille hjælpefil. 
SfM-værktøjer (särskilt COLMAP) 
kan bruge denna information til 
at levere en renere 3D-rekon­
struktion. Standard er „tændt”, 
fordi det kører uden din ind­
blanding og inte ændrer något 
vid dine bilder.

Inspector-spejls-settings

De øvrige settings-poster (S17–S33) fra inventartabellen er spejlinger fra Expert-
Inspectoren og dokumenteret i kapitel 2 (Inspector-Controls I12–I29). De optræder 
inte fysisk i indstillingsvinduet, men er kun listet i inventaret, fordi de kører via 
TrainingConfig -properties, der persisteres via, og dermed formelt har settings-karak

ter. For indholdsmæssige forklaringer henvises der dertil.

75 / 221



R A D I A N C E K I T Kapitel 3 — Inställningar

Hvornår vad?

Setting Gyldighedsområde Persistens

S1 Default Mode App-globalt App-genstart

S2 Language App-globalt App-genstart

S3 Viewport Back
ground

App-globalt (default) + runtime App-genstart

S4 Auto-Rotate Af
ter Training

App-globalt App-genstart

S5 Live Preview In
terval

Default for nye træninger App-genstart

S6 Throttle Delay Default for nye træninger App-genstart

S11 AI Helpers 
Master

App-globalt App-genstart

S12 Frame quality 
check

App-globalt App-genstart

S13 Loop closure 
detection

App-globalt App-genstart

App-globalt = virker på alle projekter. Default for nye træninger = virker kun på den näs
ta oprettede träning, løbende sessioner förblir uændrede. Aktuel träning = virker med 
det samme på den løbende tränings-konfiguration, men persisterer inte uden eksplicit 
reimport.
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K A P I T E L

Kapitel 4 — Hjælpevinduer

Foruden hovedvinduet (3D-viewport plus Inspector) forvalter RadianceKit syv yderligere 
vinduer, der alle åbnes via Help-menuen. Listen er fra top til bund: User Guide (⌘?), 
Keyboard Shortcuts (⌘/), Open Training Logs… (åbner inte et app-vindue, men Hittar; 
därför inte yderligere behandlet her), Manage Storage…, Pareto Dashboard… (⇧⌘D), 
Holdout Analysis… (⇧⌘H), BayesOpt Console… (⇧⌘B). Tre av dem — Dashboard, 
Holdout, BayesOpt — er selvstændige analyse-værktøjer. De har hver deres egen 
view-model-stack, læser eller skriver JSON-filer på disk, og for hver finns der et CLI-
argument, hvor du kan få vinduet til at pege direkte på en bestemt fil vid app-start 
( --dashboard-dir , --holdout-file , --bayesopt-autorun ).

De fire enkle vinduer (User Guide, Keyboard Shortcuts, Manage Storage, plus underme
nu-punkterna Open Training Logs / Open Exports Folder) får pr. styreelement en kort 
post. De tre analyse-vinduer er mere udførligt dokumenteret — hver med en indledning, 
der forklarer, vad du ser i vinduet, hvornår du bør åbne det, og hvordan du fortolker det 
viste bild.

Sidst i kapitlet er der et krydshenvisnings-afsnit til hovedvinduets Inspector: vad du 
fornuftigt kan aflæse i live- loss-charten og gaussian-count-visningen under en køren
de träning.

77 / 221



R A D I A N C E K I T Kapitel 4 — Hjælpevinduer

User Guide (W1–W4)

Figur 17:  User Guide-vindue med sidebar til venstre og rendret markdown- indhold til højre

Vad det er: Ett indbygget hjælpevindue, der rendrer den medfølgende 
guide_<sprog>.md . Sproget afledes av indstillingerne (fanen General → Language) el

ler, om „System” står der, av macOS-sprogpræferencerne. Layout er klassisk: til venstre 
sidebar med alle overskrifter, til højre brødteksten.

HVORNÅR ÅBNE  Når du har brug for en snabb påmindelse om et enkelt punkt — altså 
som stikordsersrtning. Den udførlige reference er denna manual; det indbyggede hjæl
pevindue er snarere det, en --help  på kommandolinjen ville være. Den opdateres vid 
hver app-udgivelse, men holdes indholdsmæssigt overfladisk.
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W1 NavigationSplitView (sidebar + detalje)

VA R

Help → User Guide (⌘?).

T E K N I S K T

Tospalte-layout med smal sidebar (mindst 180 pt 
bred) til indholdstræet og et scrollbart detaljeområ
de til selve markdown-indholdet. Vinduet har en mi
nimumsstørrelse på 700 × 500 pt. Vid første åbning 
indlæser vinduet den passende guide_<lang>.md  
fra app-bundlen (fallback guide_en.md ), parser 
den til blok-records (overskrifter H1–H4, afsnit, 
lister, tabeller, separator-linjer) og udtrækker sepa
rat overskriftsstrukturen til sidebaren. Inline-forma
tering (fed, kursiv, code-span) rendres via den 
indbyggede markdown-engine. Sproget læses fra 
app-indstillingerne, med specialtilfældet kinesisk 
( zh-Hans ) og brasiliansk portugisisk ( pt-BR ), som 
bevares som fulde locale-tags, fordi dessa varianter 
adskiller sig fra zh og pt.

KO R T  S AG T

Den indbyggede hjælpetekst, til 
venstre emnelisten, til højre in­
dholdet. Sproget indstilles au­
tomatisk efter dine system-set­
tings. Fungerer offline, men er 
bevidst kun en kortversion — 
den fulde reference er denna 
manual.

W2 List (heading-sidebar)

VA R

Venstre kolonne i User Guide-vinduet.

T E K N I S K T

Liste over alle H2- og H3-overskrifter i det aktuelle 
markdown-dokument. H2-poster optræder uden in
drykning med medium skriftsnit, H3-poster med 16 
pt indrykning til venstre og reduceret foreground-
stil. H4 og dybere ignoreres, fordi dybden annars 
gör sidebaren uoverskuelig. Anker-ID’er genereres 
fra heading-teksten via slugifisering (lowercase + 
mellemrum til streger + filtrering på bogstaver/tal/
streger — samme algoritme, som GitHub bruger til 
sine markdown-ankre, så också eksterne URL’er til 
dok potentielt ville lande på samme anker). Listen 
bruger native macOS-stil.

KO R T  S AG T

Navigationsbjælken i venstre si­
de. Tryk på en post, og du hopper 
til afsnittet.
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W3 Button (heading → anker-spring)

VA R

Pr. sidebar-linje en knap.

T E K N I S K T

Hver sidebar-post är en knap, der sætter det aktu
elle anker, men optisk ser ud som en liste-post. En 
observator-variabel udløser så scroll-springet til det 
tilsvarende anker med en blød animation over 0,3 
s. Efter springet nulstilles anker-værdien, så nästa 
klik på samme anker udløser igen (annars ville ob
servatoren inte udløse på ny, fordi værdien inte har 
ændret sig).

KO R T  S AG T

Klik fører dig til det rigtige sted i 
teksten til højre.

W4 ScrollView (detalje-indhold)

VA R

Højre kolonne.

T E K N I S K T

Scrollbart, vertikalt stablende indholdsområde med 
lazy rendering, fordi længere guides lätt kan have 
over 200 markdown-blokke — en inte-lazy variant 
ville instantiere dem alle samtidigt. Hver blok får 
et eget ID, enten heading-ankeret (for hopbare H1–
H3) eller en index-pladsholder. Maksimumbredde 
er 720 pt, padding 32 horisontalt / 24 vertikalt, 
så lange linjer bevarer et godt læsbart layout. 
Tabeller rendres celle-vis med horisontale stacks 
og separator-linjer; inline-kode av den indbyggede 
markdown-engine. Egentlige kodeblokke behandles 
aktuelt som paragraph — en kendt begrænsning vid 
hjælpevinduet.

KO R T  S AG T

Selve hjælpeteksten. Scrollbar, 
godt læselig bredde, klar typo­
grafi.
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Keyboard Shortcuts (W5–W6)

Figur 18:  Keyboard Shortcuts-vindue — fem grupper Navigation/Views/Capture/ Editor/Trai
ning med hotkey-kolonne til venstre og beskrivelse til højre

VAD BILDEN VISAR  Statisk reference-liste i fem sektioner. Navigation: Mouse Drag (orbit/
fly), Shift+Drag/Right-Drag (pan), scroll (zoom), WASD (fly-through- bevægelse), Q/
E (op/ned), F (toggle orbit/fly), dobbeltklik (re-center), Cmd+scroll (FoV-justering). Vi­
ews: R (reset camera), T (auto-rotation), P (camera playback), B (background- cycle), 
0–9 (spring til training-cam 1=10 %/5=50 %/0=last), venstre/højre pil (prev/next cam). 
Capture: S (screenshot til desktop), V (turntable-video), C (copy camera info). Editor: 
Tab (edit-mode), klik/træk (paint-select), Option+klik (deselect), X / Delete (slet selek
tion), Cmd-Z (fortryd sista sletning), [ / ] (pensel mindre/større), Esc (ophæv selektion). 
Training: Start, Pause/Resume, Cancel, Continue +5K/+10K/+20K via menu-genvejene i 
M9–M14.

Vad det er: En enkel statisk översikt over alle tastaturgenveje — Navigation, Views, 
Capture, Editor, Training. Indhold er hårdkodet i, ingen markdown-loading.
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HVORNÅR ÅBNE  Når du leder efter den snabbaste vej til at gøre något i viewporten. 
WASD-fly-through, R til camera-reset, B til background-cycling — alle står her.

W5 ScrollView (indholdsområde)

VA R

Help → Keyboard Shortcuts (⌘/).

T E K N I S K T

Ett enkelt scroll-område med en vertikal liste i. Pad
ding 20 hele vejen rundt, ingen sidebar-navigations-
tree (listen er kort nok). Indhold er grupperet i fem 
sektioner (Navigation, Views, Capture, Editor, Trai
ning). Pr. tastekombination en linje med oversætte
lig tekst i begge kolonner. Venstre kolonne (tasteko
de) fastgjort til 180 pt bredde, så beskrivelserne 
til højre förblir vertikalt aligned. Ingen interaktion 
ud over scrolling — klik på en linje udløser intet, 
tastegenvejene er ægte tastatur- modifiers i menu
en og på viewporten.

KO R T  S AG T

Tabel over alle shortcut-tas­
ter. Statisk fusklapp til snabbt 
opslag.

W6 VStack (shortcut-sektioner)

VA R

Inden for ScrollView.

T E K N I S K T

Venstrejusteret stablede sektioner med 16 pt 
afstand. Inden for de fem sektioner hver heading + 
linje-følge. Headings bruger en sekundær subhead
line-stil — bevidst inte title-format, fordi sektionerne 
inte behøver att vara navigerbare. Indhold er bevidst 
fladt (ingen disclosure, ingen search, ingen filter), 
så komponenten kører uændret på enhver macOS-
version, og filen förblir læselig.

KO R T  S AG T

Grupperingen av taster efter 
funktion (Navigation, Views, Edi­
tor og så videre).
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Manage Storage (W7–W12)

Figur 19:  Manage Storage-vindue — header visar „693 items · 16.74 GB total”, tabel med 
export-PLY-filer sorteret efter dato, hver med format-pille + filnavn + størrelse + dato

VAD BILDEN VISAR  Tabelvisning av alle filer, som RadianceKit forvalter. Header tæller 693 
items, 16.74 GB samlet størrelse. Toolbar øverst: „Show in Hittar” + „Refresh”. Hver linje: 
PLY-ikon, filnavn (f.eks. training_​20260527T211321Z.ply), export-dato, størrelse (varie
rer 7 KB til 218 MB), forstørrelses- ikon (reveal) og papirkurv-ikon (move to trash). Filer 
er sorteret efter dato, nyeste øverst. I denna demo-optagelse dominerer PLY-eksporter, 
fordi der er arbejdet meget med --benchmark .

Vad det er: En disk-usage-översikt for alt, vad RadianceKit lægger under ~/​Documents/​
RadianceKit/​ — logs, exports, scenes, capture-bundles (fra iOS-companion), imports 
(staging-kopier av input-bilderna). Pr. post en størrelse i bytes og to knapper: „vis i 
Hittar” og „flyt til papirkurv”. Det er INGEN automatisk rensning — appen sletter intet 
selv; du beslutter pr. post.

HVORNÅR ÅBNE  Når disken blir fuld. Især logs samles (en JSONL pr. trænings-forsøg, 
plus _​qualityMetrics.json); exporterne också (PLY 100 % rå data, en pr. eksport). 
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Også användbar efter et crash, hvor imports-staging-mappen har gamle kopier av 
input-bilderna liggende (se „disk-pressure incident” i dev_​v549f-needle-reduction.md).

W7 Knappen „Show in Hittar”

VA R

Header øverst til højre i storage-browser-vinduet.

T E K N I S K T

Åbner hele RadianceKit-mappen (~/​Documents/​
RadianceKit/​) i Hittar, så du kan se mappestruk
turen direkte og också manipulere den med Hittar 
selv. Handlingen åbner et nyt Hittar-vindue og skif
ter inte til app-sandbox-containeren — ~/​Documents/​
RadianceKit/​ är det regulært app-tilgængelige 
Documents-domæne, ingen sandboxed-container-
sti.

KO R T  S AG T

Åbner mappen i Hittar, så du selv 
kan håndtere filerna.

W8 Knappen „Refresh”

VA R

Header, vid siden av Hittar-knappen.

T E K N I S K T

Udløser en baggrunds-scanning, der kører på en 
bruger-initieret asynkron task, så scanningen av 
store mappetræer inte blokerer UI’en. Selve gen
nemgangen går hver kendt undermappe (Logs, Ex
ports, Scenes, Captures, Imports) genom og gene
rerer en storage-post pr. direkte barn. Pr. post bes
temmes den rekursive størrelse — helst det faktiske 
diskforbrug (inklusive APFS-hardlinks-sharing) med 
fallback på den logiske filstørrelse.

KO R T  S AG T

Læser listen på ny, om du i mel­
lemtiden har slettet eller tilføjet 
något i Hittar.
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W9 List (storage-poster)

VA R

Hovedindhold under headeren.

T E K N I S K T

Liste med detta layout pr. linje: kategori- speci
fikt SF-symbol-ikon (dokument for logs, upload-pil 
for exports, terning for scenes, tray for imports), 
navn + undertitel (kind-label + formateret modifi
kations-dato), bytes-counter til højre (højrejusteret, 
monospaced), reveal-knap (forstørrelses- symbol), 
trash-knap (papirkurv). Sortering: primärt efter kind 
(scenes først, så exports, logs, captures, imports, 
other), sekundært efter modifikationsdato faldende 
(nyeste øverst). Om scanningen stadig kører, visar 
stedet i stedet et „Scanning…”- fremskridt. Om intet 
blev fundet, en empty-state-visning med tray-ikon.

KO R T  S AG T

Liste over alle dine RadianceKit-
data, sorteret efter type og aktu­
alitet. Pr. post ser du størrelsen 
og kan slette direkte.

W10 Row-knap „Reveal in Hittar”

VA R

Pr. linje, forstørrelses-symbol til højre.

T E K N I S K T

Åbner Hittar og vælger den specifikke post (fil eller 
mappe). Forskel fra W7: W7 åbner rod-mappen; 
W10 markerer præcis denna ene post. Praktisk 
workflow: identificér en stor post, klik på forstørrel
sen, kopiér den så f.eks. til et eksternt volume.

KO R T  S AG T

Springer i Hittar direkte til denna 
post, så du snabbt hittar den.

W11 Row-knap „Move to Trash”

VA R

Pr. linje, papirkurv-symbol til højre for forstørrelsen.

T E K N I S K T

Udløser bekræftelses-dialog-boksen (W12). Først 
efter bekræftelse kører macOS-standard-operatio
nen „flyt til papirkurv” (altså reversibel, ingen direk
te sletning). Efter vellykket trash fjernes posten fra 
listen, og total-byte-counteren opdateres. Vid fejl 
indkobles en modal fejldialog.

KO R T  S AG T

Flytter posten til papirkurven. Di­
alog spørger først.
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W12 ConfirmationDialog (slette-bekræftelse)

VA R

Udløses av W11, visas som macOS-sheet.

T E K N I S K T

Standard bekræftelsesdialog med dynamisk titel 
„Delete <navn>?” og en besked-linje, der eksplicit 
påminder om, at posten lander i papirkurven og 
kan gendannes derfra (tills papirkurven tømmes). To 
knapper: „Move to Trash” som destruktiv handling 
(vist rødt) og „Cancel” med automatisk Esc-binding. 
Dialogen er non-modal i den forstand, at den kun 
blokerer detta vindue, inte hele appen — det er 
macOS-standard for reversible sletninger.

KO R T  S AG T

Sikkerhedsspørgsmål före slet­
ning. „Move to Trash” er reversi­
belt — så længe papirkurven inte 
er tømt.

Pareto Dashboard (W13–W22)

Figur 20:  Pareto Dashboard — tom tilstand före report-import

Tom tilstand (efter første åbning) — empty-state med call-to-action „Open Reports 
Folder…”. Datapunkterne optræder, så snart trænings-reports er indlæst, se nästa shot.
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Figur 21:  Pareto Dashboard med 129 indlæste benchmark-reports — Gaussians vs PSNR 
med Pareto-front, Scene/Strategy/Mip-filter

VAD BILDEN VISAR  Header-toolbar visar „129 reports of 129″ (alle reports i den valgte 
mappe blev parsed med succes — 21 yderligere filer kunde inte parses pga. ældre 
format, se hint-listen til højre). Akser: X-Axis-vælger på Gaussians , Y-Axis-vælger på 
PSNR (dB) . Scatter-plot: grønne punkter = Classic-strategi, blå punkter = MCMC. Den 

stiplede Pareto-front- linje løber langs de bedst opnåede PSNR-värden og plateauer 
omkring PSNR≈30 dB fra ca. 500K gaussians. Filter-chips til højre: 7 scener (bicycle, 
bonsai, family, flowers, kitchen, stump, truck), 2 strategier (classic, mcmc), 3 Mip-
splatting-muligheder (All, On, Off). I øjeblikket er alle filtre åbne, därför den tætte 
punkt-klynge.

Vad det er: Ett multi-run-sammenligningsværktøj. Du har i fortiden tränat flere scener 
eller samme scen med olika presets — hver av dessa træningskørsler producerer 
(om du har givet --benchmark  med eller kaldt via benchmark-funktionen) en JSON-
report-fil, der bl.a. innehåller final-PSNR, SSIM, LPIPS, gaussian-count og wallclock-tid. 
Dashboardet indlæser en hel mappe av sådanne reports samtidigt og plotter dem som 
2D-scatter med valgbare akser. Derudover tegnes Pareto-fronten (mængden av inte-
dominerede punkter) som stiplet linje.

HVORNÅR ÅBNE  Efter du har oprettet mindst tre eller fire trænings-reports. Med færre 
punkter er frontier-linjen inte sigende. Typisk use-case: du har prøvet at rekonstruere 
en outdoor-scen og har spillet P3 Balanced (Classic), P4 Quality (Classic), P7 MCMC 
Quality og P9 Outdoor (tuned) genom efter hinanden — nu vil du vide, vilken konfigu
ration der leverer bedste PSNR pr. sekund träningstid, eller vilken der kræver færrest 
gaussians til given PSNR.

SÅDAN FORTOLKES DET  Begge akser kan frit vælges (X-akse:,, psnr , ssim , lpips , …; 
Y-akse ligeså). Pareto-front-logikken i ParetoFront2D.indices vid for hver metrik, om 
„mindre = bedre” (f.eks. LPIPS, Loss, Time) eller „større = bedre” (PSNR, SSIM) — 
linjen løber altså alt efter akse-valget fra nederst til venstre til øverst til højre eller fra 
øverst til venstre til nederst til højre, altid langs den bedste opnåede kombination. Ett 
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punkt er Pareto-optimalt, om INTET andet punkt i BEGGE dimensioner er mindst lige så 
godt (altså intet andet dominerer det). Pareto-optimale punkter ligger på linjen, andre 
punkter til højre/over (alt efter akseorientering). Punkter PÅ linjen er de ægte kandidater 
til „bedste preset”; punkter LANGT fra linjen er spildt träningstid.

FILTER-CHIPS  Du kan begrænse valget til en bestemt scen (om du f.eks. kun vil sam
menligne outdoor-runs), til en bestemt strategi (Classic eller MCMC), eller Mip-splatting 
til/fra (relevant efter fase Q1.5, hvor Mip förblir som opt-in advanced flag).

 Du har tre reports for „truck”-scenen under ~/​Documents/​RadianceKit/​Reports/​: 
Run A (P4 Quality, 40K iter, 524K Gs, 105 s, PSNR 23.4), Run B (P7 MCMC, 200K iter, 
150K Gs, 693 s, PSNR 24.6), Run C (P9 Outdoor, 100K iter, 1.25M Gs, 312 s, PSNR 
25.8). Sæt X-aksen til trainingTime, Y-aksen til PSNR. Run B ligger øverst til højre, 
Run C endnu længere mod øverst til højre, Run A nederst til venstre. Pareto-fronten 
forbinder A og C — begge inte-dominerede. Run B er „lost” (C er bedre i både time OG 
PSNR). Indsigt: for „truck” er MCMC-default’en inte værd det; enten snabb+ok (A) eller 
lang+meget god (C). Gem konfigurationen fra C som egen preset (Inspector → I1 Save 
Preset).

Nästa handling: Gem bedste konfiguration som preset. Konkret: kig på Pareto-
punkterna (hover visar PSNR/SSIM/LPIPS/Gs/ Time i tooltippet), beslut vilken time-vs-
quality-tradeoff der passer dig bedst, åbn den tilhørende report (filnavnet innehåller 
run-timestampet), kopiér dens tränings-konfiguration i en ny run eller gem den efter 
nästa trænings-session som preset via Inspectoren.

W13 Knappen „Open Reports Folder…”

VA R

Toolbar øverst til venstre.

T E K N I S K T

Åbner en mappe-vælger med opfordringen „Select 
a folder containing benchmark .json reports”. Efter 
bekræftelse kører en baggrunds-task, der parser 
alle .json -filer i mappen sekventielt. Fejlagtige re
ports (defekt JSON, forkert skema) samles og visas 
nederst i sidebaren som „N file failed to parse” — 
intet crash. Om der kommer et andet klik, mens en 
første load stadig kører, afbrydes den tidligere task, 
så der inte skrives to resultater ind i state samtidigt.

Også via CLI: --dashboard-dir /​sti/​til/​reports 
indlæser mappen direkte vid app-start.

KO R T  S AG T

Vælger mappen, hvor di­
ne benchmark-reports ligger. 
Standardstien er ~/​Documents/​
RadianceKit/​Reports/​. Ind­
læser så alle JSON’er på en gang.
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W14 Vælger „X-Axis”

VA R

Over charten, til venstre.

T E K N I S K T

Menu-vælger med alle tilgængelige metrik-akser i 
dashboard-modulet (PSNR, SSIM, LPIPS, gaussian-
count, träningstid og så videre). Default er gaussi
an-count. Vid skift nulstilles det hoverede punkt, 
fordi en hidtil highlightet position i det gamle akse-
koordinatsystem inte længere giver mening efter ak
seskift. Vælgeren er begrænset til indholdsbredden, 
så den inte spænder over hele bredden.

KO R T  S AG T

Hvilken metrik der ska stå på den 
vandrette akse. Som regel „trä­
ningstid” eller „gaussian-antal”, 
fordi det er de „omkostninger”, 
du vil sammenligne.

W15 Vælger „Y-Axis”

VA R

Over charten, vid siden av X-Axis.

T E K N I S K T

Identisk med W14, bortset fra at default er PSNR. 
Akse-valget gemmes uafhængigt, så brugeren ock
så kan vælge sludder-kombinationer (X=PSNR, 
Y=PSNR — ville kaste alle punkter ned på en dia
gonal). Sådanne kombinationer fanges dock inte; 
bevidst beslutning, fordi en sammenligning „SSIM 
vs PSNR” sagtens kan være interessant for att se, 
hvor konsistent metrikkerne opfører sig.

KO R T  S AG T

Vad der står på den lodrette ak­
se. Normalt „PSNR” eller „SSIM” 
som kvalitetsmål.

W16 Toggle „Show Pareto Front”

VA R

Til højre for akse-vælgerne.

T E K N I S K T

Standard macOS-toggle. Når aktiv, tegnes ud over 
punktskyen i Pareto-charten en linje med den be
regnede 2D-Pareto-front. Stil: stiplet (stregmønster 
4–4), grå halvtransparent, linjestyrke 1,5 pt. Pareto-
beregningen kører på hovedtråden — vid det typiske 
antal reports (≤ ~50) är det problemfrit snabbt. 
Når toggle er fra, udelades linjen, så kun de nøgne 
punkter står.

KO R T  S AG T

Visar linjen, der går genom de 
„hidtil bedste” punkter. Om lin­
jen er i vejen (f.eks. fordi du kun 
vil sammenligne de enkelte tra­
des), så sluk den.
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W17 Chips „Scene”-filter

VA R

Højre sidebar i dashboard-vinduet.

T E K N I S K T

Filter-chips for hver scen, der optræder i de indlæs
te reports. Eget flow-layout, der automatisk ompak
ker chips i flere linjer, så snart bredden er udnyttet. 
Aktive chips får accent-baggrund, inaktive en neu
tral standard-material-baggrund. Multivalg er muligt 
(set-semantik); om ingen chip er valgt, gælder alle 
scener som „lukket ind” — dvs. set-logikken er 
„tomt valg = alt”, inte „tomt valg = intet”.

KO R T  S AG T

Klik på et scen-navn filtrerer 
punkterna til kun denna scen. 
Multivalg muligt. Tom = alle sce­
ner.

W18 Chips „Strategy”-filter

VA R

Under scen-filteret i sidebaren.

T E K N I S K T

Præcis som W17, men for trænings-strategier — 
typiskt de to värden „classic” og „mcmc”, afledt 
fra strategy- feltet i benchmark-report-JSON’erne. 
Hjælpsom, om du har blandet reports fra begge 
strategier og kun vil se den ene type (f.eks. „vis kun 
MCMC-runs, fordi jeg har udelukket Classic”).

KO R T  S AG T

Filter efter Klassisk eller MCMC. 
Som standard er begge aktive.
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W19 Chips „Mip-Splatting”-filter

VA R

Under strategy-filteret i sidebaren.

T E K N I S K T

Treværdigt filter (i stedet for set som W17/W18): 
„All” / „On” / „Off”. Baggrund: Mip-splatting blev 
evalueret i fase Q1.5 som eksperimentel multi-skale
ring, og den endelige verdict var „ingen pæn win 
gennemgående; beholdt som opt-in flag”. Når du 
laver Mip-on/off-sammenligninger, vil du ofte kunde 
adskille meget skarpt. Derfor det dedikerede ternæ
re filter med tilstandene „lad alt genom”, „kun Mip 
til”, „kun Mip fra”. Sidebar-sektionen indkobles kun, 
om der er mindst én Mip-report OG mindst én inte-
Mip-report i data-mængden (annars giver filtrering
en ingen mening).

KO R T  S AG T

Om du vil sammenligne Mip-
splatting til/fra, treværdigt filter 
her. Ellers ignorer.

W20 ChipButton (filter-toggle, all/on/off)

VA R

Helper-component, bruges i W17/W18/W19.

T E K N I S K T

Minimalistisk knap-wrapper. Indhold: label-tekst 
med caption-skriftgrad og padding 10 horisontalt / 
5 vertikalt. Baggrund betinget: när aktiv → app-ac
centfarve med hvid tekst; annars neutral standard-
material-baggrund med sort tekst. Formen är en 
capsule (pilleformet). Plain-buttonstyle, så capsule-
materialet inte overdækkes av en system-border.

KO R T  S AG T

De runde filter-knapper selv. Op­
tisk som et iOS-tag.
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W21 Chart (Pareto-scatter)

VA R

Midten av dashboardet.

T E K N I S K T

Swift-Charts-diagram med to lag: 1. et punkt pr. re
port — position fra de valgte X- og Y-metrikker, far
ve efter strategy, symbol efter Mip-status. Symbol-
størrelse normalt 80, highlightet 200 (när ID svarer 
til den aktuelt hoverede report).
2. en linje for Pareto-fronten, kun om toggle er 

tændt.

Chart-overlay: et transparent rektangel registrerer 
musebevægelse; pr. frame bestemmes den eukli
disk nærmeste punktposition i plot-frame, og den 
hoverede report opdateres, om distancen er under 
24 px (annars nulstillet). Sådan får du tooltippet 
uden klik — hover rækker.

KO R T  S AG T

Det egentlige scatter-diagram. 
Hvert punkt är en träningskör­
ning. Hover for detalje-tooltip.

W22 Tooltip (hover-detalje)

VA R

Under charten, indkoblet vid hover.

T E K N I S K T

Horisontalt stack: scen-navn (headline), strategy- 
tag (caption), separator-linje, så PSNR/SSIM/LPIPS/
Gs/Time-metrikker i hver en lille vertikal gruppe (la
bel + monospaced värde). Om Mip var aktiveret, 
dessutom et „Mip”-capsule-tag i accentfarve. Bag
grund halvtransparent blur, afrundet rektangel med 
8 pt radius. Visas kun, när musen faktisk er over et 
punkt. Forsvinder automatisk vid forlading.

KO R T  S AG T

Detalje-kortet nederst, när du fø­
rer musen over et punkt. Visar al­
le kvalitetsmetrikker og run-kon­
figurationen på en gang.

92 / 221



R A D I A N C E K I T Kapitel 4 — Hjælpevinduer

Holdout Analysis (W23–W29)

Figur 22:  Holdout Analysis — tom tilstand före indlæsning av en transforms.json

Tom tilstand med empty-state og call-to-action „Open transforms.json…”. Accepterer 
NeRF-Studio- og Instant-NGP-format.

Tom tilstand (efter første åbning) — kamera-markørerne optræder, så snart en 
transforms.json  er indlæst, se nästa shot.

Figur 23:  Holdout-globe med 100 NeRF-Blender-mic-kameraer, 5 folds à 20 kameraer, 
Angular-strategi aktiv

VAD BILDEN VISAR  Header visar indlæst fil (transforms_​train.json) og cam-count („100 
cameras”). Venstre sidebar: strategy-vælger med to muligheder — Angular
(longitudinal) aktiv (justerer folds efter længde-/breddesektorer på sfæren, så hver 
test-fold er geometrisk tæt) vs Linear
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(round-robin) (rækkefølge-baserat, alle k’te frames som test-sæt). k-Folds-slider står 
på 5, test-fold-vælger på fold 1. Export-knap genererer en fold-assignment.json 
til Nerfstudio/Instant-NGP. Midter-panel: 3D-globe-projektion av alle 100 kameraer — 
grønne punkter = train, røde punkter = aktuel test-fold (fold 1 med 20 kameraer). Højre 
sidebar (Angular Correlation): pr. fold 20 cams + Mean Nearest Angle (fold 1: 7.9°, fold 
2: 7.8°, fold 3: 7.7°, fold 4: 7.0°, fold 5: 6.3°) — mindre värde betyder, at kamerorna inden 
for denna fold ligger tæt sammen, altså at holdout-splittet er rumligt kohærent.

Vad det er: En 3D-visualizer for din kamera-arrangement med cross-validation-logik. 
Du indlæser en transforms.json  (standardformatet fra Nerfstudio / Instant-NGP for 
kameraposer), appen læser alle kameraer, projicerer deres kigge-retninger på en en
hedskugle og visar dem som små kugle-markører på en virtuel globus. Därefter opdeler 
den kamerorna i k  folds (efter valgt strategi: angular eller linear), markerer grønt 
for træningsdelen og rødt for testdelen (holdout) og beregner pr. fold en angular-corre
lation-score, der fortæller dig, hvor langt test-folden ligger fra trænings-folden i kigge-
vinkel-rummet.

HVORNÅR ÅBNE  Når du vil lave holdout-evaluering — altså: hvor godt generaliserer 
din model til usete kigge-vinkler? Standard i træningen er „every-8th view som hol
dout” (Mip-NeRF360-konvention), men det är en meget lineær opdeling. Om dine bilder 
f.eks. er tidsmæssigt klyngede (først én side av objektet, så den anden), er „every-8th” 
inte repræsentativ — en tilfældig sekvens-position lander i testen, men alle dens naboer 
er i træningen, det er for lätt. Med „angular” stratificerer man i stedet over kigge-vinkel-
rummet: hver fold innehåller kameraer fra alle dele av orbitten, så testen virkelig prøver 
generaliserings-huller.

SÅDAN FORTOLKES DET  Angular vs Linear:
• Angular (standard): opdeler kamerorna efter longitudinalvinkel (φ-koordinat omkring 

Y-aksen) i k  lige sektorer. Fold 0 er kameraer med φ ∈ [0°, 360/k°), fold 1 de 
nästa, og så videre. Fordel: hver fold dækker en delegnet av orbitten; test-folden er 
rumligt kompakt, men bredt fordelt over verdens-datasættet. God til klassiske orbit-
optagelser.

• Linear (round-robin): fold-index = (image_index modulo k). Det är den simple „every-
k-th”-opdeling. Fungerer, om billedrækkefølgen ingen spatial bias har (f.eks. tilfældigt 
sorterede droneoptagelser). Fungerer dårligt, när bilderna klyngеr tidsmæssigt.

I 3D-globussen ser du straks: grønne punkter (träning) og røde punkter (test). Om de 
røde punkter alle klynger sig i et hjørne, er holdout dårlig (ingen god generaliserings-
test). Om de ligger jævnt mellan de grønne, är den god. Angular-correlation- scoren pr. 
fold (højre sidebar, i grader) fortæller dessutom: mindre värde = testen er tæt på træ
ningen (hver test-kamera har en nær tränings-kamera, let test); større värde = testen er 
langt fra træningen (hårdere generalisering).

 Du har optaget din truck-scen med 251 bilder, eksporterer via menupunkt M33 
(Export SfM transforms.json) en nerfstudio-fil. Åbn holdout-vinduet (⇧⌘H), indlæs 
JSON’en via „Open transforms.json…”, kig på globussen. k=5 (default) giver dig 5 folds. 
Klik på „Fold 3” — se, om de røde markører er nogenlunde jævne. Om ja: „Export fold-
assignment.json”, læg den eksporterede fil i reports-mappen, og vid nästa training-run 
med --benchmark  (eller tilsvarende Inspector-inställningar) bruges præcis denna fold-
opdeling som test-holdout — i stedet for standarden „every-8th”.
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W23 Knappen „Open transforms.json…”

VA R

Toolbar øverst til venstre.

T E K N I S K T

Åbner en filvælger, begrænset til JSON-filer. Efter 
bekræftelse indlæser holdout-modulet filen. Loade
ren parser både nerfstudio-formatet (kamera-intrin
sics plus liste over frames med billedstier og trans
form-matrix) og instant-ngp-formatet (samme op
bygning). Pr. frame udtrækkes kigge-retningen fra 
transform-matricen (kameraets z-akse i lokalbasis) 
og gemmes. Om parsning fejler, visas en fejlmedde
lelse i status-området.

Også via CLI: --holdout-file /​sti/​til/​
transforms.json starter vinduet direkte med ind
læst fil.

KO R T  S AG T

Indlæser din kamera-pose-JSON. 
Standard er Nerfstudio- og 
Instant-NGP-eksporter. Radian­
ceKit selv kan eksportere 
transforms.json via menu → Ex­
port → SfM.

W24 Vælger „Strategy” (angular/linear)

VA R

Venstre sidebar, øverst.

T E K N I S K T

Radio-vælger med to muligheder: Angular og Linear. 
Strategy-skift udløser automatisk en gen-beregning 
av folds. Kigge-retningerne är en liste over 3D-
enhedsvektorer på sfæren; angular-strategien proji
cerer dem på longitudinalvinklen φ og sorterer, line
ar-strategien laver bare en modulo-opdeling over 
frame-index.

KO R T  S AG T

Angular til jævne orbit-optagel­
ser (standard, sikkert), Linear 
kun om dine bilder inte klynger 
rumligt.
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W25 Slider „k Folds”

VA R

Venstre sidebar, i midten.

T E K N I S K T

Slider fra 3 til 10, skridtstørrelse 1. Vid ændring ud
løses fold-beregningen automatisk, så folds-listen, 
train/test-indices og pr.-fold-scoren beregnes med 
det samme. Den valgte värde visas som monospa
ced-digit-tekst til højre for labelet.

Tommelfingerregel: k=5 er standard (giver dig 20 
% test pr. fold, vilket er almindeligt for cross-valida
tion). k=10 om du har meget data og brug for flere 
folds til statistisk sigende värde. k=3 om du har lidt 
data.

KO R T  S AG T

Hvor mange folds opdelingen 
har. 5 er standard og passer 
næsten altid.

W26 Vælger „Test Fold”

VA R

Venstre sidebar, under k-slideren.

T E K N I S K T

Menu-vælger. Muligheder er dynamisk 0..<k, label 
„Fold 1″ til „Fold N” (altså 1-indexed i UI’en, 0-in
dexed internt). Om den tidligere valgte index er ≥ k 
(f.eks. fordi du har reduceret k fra 10 til 5), nulstilles 
den automatisk til 0. Den valgte test-fold visas rødt i 
globussen, alle andre grønt.

KO R T  S AG T

Hvilken fold der lige nu er test-
folden. Du kan klikke dig genom 
og se, hvordan hver enkelt fold 
ser ud i globussen.

W27 Knappen „Export fold-assignment.json”

VA R

Venstre sidebar, nederst.

T E K N I S K T

Åbner en gem-dialog med default-filnavn fold-
assignment.json. Efter bekræftelse koder holdout-
modulet den aktuelle opdeling til et JSON-skema 
(per-frame fold-tildeling plus strategy-meta-blok). 
Denne fil kan så gives med til nästa träning med 
--benchmark , så samme holdout bruges til den 

endelige metrik-evaluering. Skrivefejl visas som fejl
tekst; succes i grøn tekst som „Saved to (filename)”.

KO R T  S AG T

Gemmer den aktuelle train/test-
opdeling som JSON. Denne fil 
kan du så give direkte med vid 
træningen, så samme test-sæt 
bruges igen.
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W28 SCNView (3D camera globe)

VA R

Midter-panel i holdout-vinduet.

T E K N I S K T

SceneKit-globus-view. Scenen består av: en wire
frame-kugle (radius 1.0, 36 segmenter, mørkegrå), 
tre farvede akse-stumper (rød/grøn/blå for X/Y/Z, 
hver 1.2 lang) og pr. kamera en lille markerkugle 
(radius 0.03) vid den tilsvarende kigge-retnings-
position på enhedskuglen (let udenfor, så den inte 
försvinner I wireframe-kuglen). Markørerne genop
bygges IKKE vid hver fold-ændring — genopbygning 
er kun nødvendig, när frame-listen ændres (altså 
när en ny JSON indlæses). I stedet kører en in-pla
ce-opdatering av materialefarverne pr. update: rødt 
for test-index, grønt for träning, lysgrå om hverken 
eller. Sådan förblir slider-tikker performante också 
vid N > 1000 kameraer.

Kamera-styringen er aktiveret — du kan rotere glo
bussen med musen, zoome, panorere. Belysning 
sørger for, at markørerne inte ser flade ud. Bag
grund er mørkegrå.

KO R T  S AG T

3D-globussen med kamera-posi­
tionerne. Grøn = träning, rød = 
test, lysegrå = inte tildelt (fore­
kommer inte, alle kameraer hører 
til et sted). Med musen kan du 
rotere globussen og zoome.

W29 FoldCard (tap to select fold)

VA R

Højre sidebar, „Angular Correlation”-sektion.

T E K N I S K T

Pr. fold en kort-view — afrundet rektangel med 6 
pt radius, padding 10, vertikalt layout med to linjer 
(øverst „Fold N” + kamera-antal, nederst „Mean 
nearest angle:” + värde i grader). Baggrundsfarve 
betinget: aktiv fold = accentfarve halvtransparent, 
inaktive = neutralt standard-material. Tap vælger 
folden, og globussen farver om live.

„Mean nearest angle”-scoren är den gennemsnitlige 
mindste vinkel pr. test-kamera til den nærmeste trä
nings-kamera (i radian internt beregnet, vist i grader 
i UI’en).

KO R T  S AG T

Pr. fold et lille kort til højre 
med antal kameraer og gennem­
snitsafstanden til den nærmeste 
tränings-kamera. Klik på det væl­
ger denna fold som test.
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BayesOpt Console (W30–W39)

Figur 24:  BayesOpt-konsol — tom tilstand före trial-start

Tom tilstand med search-space-vælger (RadianceKit defaults
(6-dim)), trial-budget-slider (default 40), random-seed (42) og tre empty-panels for 
convergence-chart, trial log og search- space-parameter-liste.

Tom tilstand (efter første åbning) — convergence-chart og trial-tabel fylder sig, så snart 
en run er startet, se nästa shot.

Figur 25:  BayesOpt-konsol efter 40 trials — convergence-chart stiger stejlt tills trial 15, Best 
Value 0.9943, trial log med init/bo/restart-tags

VAD BILDEN VISAR  Status øverst til højre „Finished — best 0.9943 after 40 trials”. Venstre 
sidebar: search-space- vælger på RadianceKit defaults (6-dim), trial-budget 40, ran
dom seed 42. Parameter-liste visar de seks hyperparametre, der ska tunes, med deres 
værdiområder: mipSmoothing3DScale [0.05, 0.5], mipFilter2DVariance [0.1, 0.6], 
densifyGradThreshold [5e-07,

5e-06], ssimWeight [0.05, 0.5], mcmcNoiseScale [1e-05, 0.0001], 
mcmcRelocationInterval [50, 200]. Midt: convergence-chart (X = trial-index 1–40, Y 
= objective value 0–1) — grå punkter = initial samples (LHS), blå punkter = BayesOpt-
acquisition, orange punkter = restart-trials (#22 og #31). Bedste-värde-linjen stiger 
stejlt til trial ~7, därefter kun marginal forbedring til trial 15, fra da av fladt plateau vid 
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0.99+. Højre sidebar: trial-log #1–#34 med score + tag (init/bo/restart). Save- Best-
Config-knappen øverst til højre skriver bayesopt-best.json .

Vad det er: En Bayes-optimerings-konsol til hyperparameter-søgning. Bayes-Opt är en 
automatisk metode, der forsøger at hitta det optimale punkt for en ukendt funktion med 
så få experiment som muligt — typiskt: „vilken kombination av mcmcMaxGaussians, 
capMultiplier, ssimWeight og gradThreshold giver den bedste PSNR for min scen-klas
se?” I stedet for et grid på 6^4 = 1296 trials prøver Bayes-Opt ca. 40–100 informerede 
trials og kommer dermed tæt på optimum.

Vigtigt: Den aktuelt leverede version i appen kører inte optimeringen mod ægte træ
nings-runs (det ville tage dage), men mod et syntetisk demo-objektiv — et multi-modalt 
landskab med hill-climbing-karakter plus let noise. Det er bevidst sådan: vinduet ska 
visa dig optimizerens adfærd (konvergens-forløb, sample-punkter, best-so-far) og lade 
dig forstå search-space- definitionerne. Til ægte trænings-drevne BayesOpt-kørsler 
(som udført i fase Q7 for scen-class-presets) bruges et separat offline CLI-workflow; 
vinduet er live-UI-varianten.

HVORNÅR ÅBNE  Tre anvendelses-tilfælde: 1. Du vil forstå, hvordan BayesOpt arbejder — 
så start en demo-run og iagttag convergence-charten. 2. Du planlægger en ny scen-
klasse (f.eks. „akvarier” eller „antikke møbler”), som de indbyggede 10 presets inte 
passer perfekt til. Definér mentalt et søgerum, tjek det her med „Bowl demo” eller 
„Densify”-preset, eksportér så best-config som JSON og brug det som startpunkt for 
en ægte trænings-run.
3. Du vil inspicere de default-search-spaces, der er defineret i

RKBayesOpt-pakken (Mip-subset, RadianceKit defaults) — de listes i parameter-panelet 
i venstre sidebar.

SÅDAN FORTOLKES DET

• Convergence-chart (midter-kolonnen): Y = bedste hidtil opnåede objective-funk
tion-värde. X = trial-index. I starten stejlt stigende (BayesOpt prøver de initial-
samples tilfældigt, några av dem er heldige), därefter tiltagende fladt, fordi nær-
optimum-regionen er udtømt. Om linjen förblir flad i 20+ trials, kan du stoppe kørslen 
— flere trials giver intet mere. De enkelte punkter i charten er de individuelle trial-
värden (altså inte „best so far”), farvet efter fase: grå = initial sample, blå = bayesopt 
acquisition, orange = restart.

• Trial-tabel (højre kolonne): #1, #2, #3, … hver med värde og fase-tag. Det hidtil 
bedste trial er markeret med en gul stjerne. Ud fra tabellen kan du identificere best-
trial og se dets parameter-värden senere vid eksport.

• Search-space-inspector (venstre sidebar): visar for det valgte preset alle parame
ter-navne og deres søgeområder [lo, hi] . Om du står vid presetet „RadianceKit 
defaults (6-dim)”, ser du f.eks. „densifyGradThreshold [5e-7, 5e-6]” — altså log-
uniform mellan dessa to värden.

 Vælg preset „RadianceKit defaults (6-dim)”, trial-budget 40, seed 42. Klik „Start”. 
Iagttag: de første 8 trials er grå (initial samples, LHS-Latin-Hypercube), de følgende 
blå (BayesOpt-erhvervet). Convergence-charten blir stejl til trial ~15, därefter flader 
den ud. Vid trial ~30–40 stabiliseres den bedste värde. Klik „Save Best Config” — 
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en bayesopt-best.json  gemmes med preset-navn, trial-index, värde og de dekodede 
parameter-värden. Denne JSON kan du så manuelt overtage i din preset-definition.

W30 Knappen „Start”

VA R

Toolbar til venstre, i idle/finished-state.

T E K N I S K T

Nulstiller trial-listen, skifter til running-state, gene
rerer en ny run-ID (til stale-detection vid flere start-
klik) og opretter en frisk pause-gate. Därefter star
ter en baggrunds-task, der kører optimizeren som 
asynkron stream. Initial- samples-størrelsen følger 
av min(8, budget /​ 4 + 1) — altså typiskt 8 
Latin-Hypercube-samples vid budget ≥ 28, færre 
vid lille budget. Trial-updates modtages inkremen
telt og vedhæftes listen. Stale-run-beskyttelse: om 
et andet start-klik i mellemtiden sætter run-ID på 
ny, kastes updates fra den gamle run væk.

Primary-action-stil til den prominente knap-look.

KO R T  S AG T

Starter en frisk optimerings-kør­
sel med det aktuelle søgerum, 
budget og seed.

W31 Knappen „Pause”

VA R

Toolbar til venstre, i running-state.

T E K N I S K T

Sætter pause-gate aktiv og skifter til paused-state. 
Den egentlige effekt: runneren venter i et 50-
ms-polling-loop, före den evaluerer nästa objective-
funktion. Det betyder, at et igangværende trial føres 
til ende (det er syntetisk og varer kun mikrosekun
der), men intet yderligere trial startes. Så snart 
resume kører, fortsætter den, hvor den slap.

KO R T  S AG T

Holder kørslen tilbage. Aktuel be­
regning løber til ende, så pauser 
den.
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W32 Knappen „Stop”

VA R

Toolbar til venstre, i running- og paused-state.

T E K N I S K T

Afbryder runner-tasken, nuller referencen, løser pa
use-gate (om stadig paused), og skifter til finished-
state (om trials finns) eller idle-state (om ingen). 
De allerede beregnede trials förblir synlige i listen 
— stop sletter dem inte. Destruktiv knap-rolle visar 
knappen rød, fordi den afbryder kørslen.

KO R T  S AG T

Afbryder kørslen endeligt. Trials 
förblir synlige, du kan stadig 
eksportere best-config.

W33 Knappen „Resume”

VA R

Toolbar til venstre, i paused-state.

T E K N I S K T

Løser pause-gate og skifter tilbage til running-state. 
Runner-tasken kører allerede (den venter jo i pol
ling-loopet); så snart loopet bemærker, at pausen er 
ophævet, kører den videre og starter nästa trial.

KO R T  S AG T

Fortsætter en paused kørsel.

W34 Knappen „Save Best Config”

VA R

Toolbar til højre, altid synlig (men deaktiveret, om 
ingen bestTrial finns).

T E K N I S K T

Åbner en gem-dialog med default-filnavn 
bayesopt-best.json , begrænset til JSON. Efter 

bekræftelse bygges en payload-dictionary: preset-
navn, trial-index, värde (objective- score), para
metre (dictionary av dekodede parameter-navne 
→ värden). Dekodningen projicerer de normalisere
de søgerum- koordinater i [0,1]^d tilbage til det 
oprindelige værdiområde (med log-uniform/linear/
integer-skalaer tilsvarende). JSON-output er pretty-
printed med sorterede keys. Vid skrivefejl ignoreres 
det (i den aktuelle demo-version) stille — ingen er
ror-UI, fordi det är en demo-sti.

Knappen förblir grå, så længe ingen trial er kørt.

KO R T  S AG T

Gemmer parameter-værdierne 
for det hidtil bedste trial som 
JSON. Du kan så manuelt over­
tage dessa värden i din preset-
konfiguration.
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W35 Vælger „Search Space”-preset

VA R

Venstre sidebar, øverst.

T E K N I S K T

Menu-vælger med fire preset-muligheder:
• „RadianceKit defaults (6-dim)” — det fulde stan

dard-søgerum med alle Q7-hyperparametre.
• „Mip subset (2-dim)” — kun mipSmoothing3DScale 

[0.05, 0.5] log-uniform og mipFilter2DVariance 
[0.1, 0.6] linear. Nyttig, om du vil tune Mip-splat
ting for en scen-klasse.

• „densify-until + ssim-weight + grad-th
resh” — tre densify-relevante parametre 
(densifyGradThreshold log-uniform, ssimWeight  
linear, densifyUntilIter  integer).

• „Bowl demo (1-dim)” — pædagogisk single-pa
rameter-søgerum til „sådan virker BayesOpt”-de
moer.

Mens en kørsel er aktiv, kan søgerummet inte skif
tes (ville forvirre optimizeren).

KO R T  S AG T

Hvilket hyperparameter-søgerum 
BayesOpt gennemsøger. Stan­
dard er „RadianceKit defaults”. 
Til målrettede Mip-tuning-forsøg 
„Mip subset”. Til at forstå, hvor­
dan BayesOpt arbejder, „Bowl de­
mo”.

W36 Slider „Trial Budget”

VA R

Venstre sidebar, under search-space-vælgeren.

T E K N I S K T

Slider fra 10 til 200, skridtstørrelse 5. Default 40. 
Det betyder: BayesOpt måste maksimalt lave N tri
als. Heraf er de første par initial samples (Latin-Hy
percube), resten er ægte BayesOpt-trials. Tommel
fingerregler i praksis: et søgerum med d dimensio
ner kræver ca. 10d til 20d trials for et godt optimum. 
Vid 6-dim defaults altså 60–120, vid 2-dim Mip-
subset 20–40, vid 1-dim Bowl-demo 10–20.

Under kørslen er slideren deaktiveret.

KO R T  S AG T

Hvor mange optimerings-forsøg 
maksimalt. Flere forsøg = bedre 
løsning, men koster mere tid. 40 
er god default for demo-objecti­
ve.

102 / 221



R A D I A N C E K I T Kapitel 4 — Hjælpevinduer

W37 Slider „Random Seed”

VA R

Venstre sidebar, under budget-slideren.

T E K N I S K T

Slider fra 1 til 100, skridtstørrelse 1. Default
42. Seedet sendes både til de initiale Latin-Hyper

cube-samples og

til noise-komponenten i demo-objective. Reprodu
cerbarhed: samme seed + samme søgerum + sam
me budget giver præcis identisk trial-sekvens. Nyt
tig til „får alle dine kolleger samme kørsel, om de 
bygger demoen efter?”. Under kørslen deaktiveret.

KO R T  S AG T

Styrer den tilfældige generator. 
Samme seed = samme kørsel — 
til at reproducere.

W38 Chart (convergence)

VA R

Midt-kolonnen i vinduet.

T E K N I S K T

Swift-Charts-diagram med to lag: 1. en linje for 
„best-value-so-far” pr. trial — en monotont stigende 
eller konstant kurve i accentfarve. 2. et punkt pr. tri
al med den individuelle objective-värde, farvet efter 
fase. Symbol-størrelse
40. Tre fase-labels: „init” (grå), „bo” (blå), 

„restart” (orange).

En lille legende visar fase-farverne øverst til venst
re. Om trial-listen er tom (före første start), visas 
i stedet en empty-state-visning med chart-ikon og 
hintet „Press Start to begin a BayesOpt run.”.

KO R T  S AG T

Forløbs-charten. Den ubrudte 
linje er „bedste hidtil fundne løs­
ning”; punkterna er de enkelte 
forsøg. Om linjen förblir flad i 
lang tid, har BayesOpt fundet op­
timum.
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W39 Table (trial log)

VA R

Højre kolonne i vinduet.

T E K N I S K T

Scroll-område med lazy stablede trial-linjer. Pr. 
linje et horisontalt stack: trial-nummer (3-cifret mo
nospaced, til venstre), värde (monospaced, højre
justeret, 70 pt bred), fase-tag (capsule, fyldt med 
fase-farve vid 25 % opacity), valgfrit en gul stjerne, 
om detta trial är det aktuelt bedste. En auto-scroll-
mekanisme springer automatisk til enden, så snart 
et nyt trial kommer til — så du kan medlæse live-
forløbet i skærmens bund uden selv at scrolle.

KO R T  S AG T

Tabellen over alle forsøg. Vär­
de, fase, stjerne for det bedste. 
Scroller automatisk med, nye tri­
als optræder nederst.

Hovedvindue: loss-forløb og gaussian-count (I39–I41, 
krydshenvisning)

Tre av Inspector-visningerne i hovedvinduet fortjener en egen forklaring, fordi de ses 
konstant under en kørende träning, og der er viktiga tommelfingerregler for, hvornår 
forløbet ser sundt ud. Visningerne er i Inspectoren under „Loss Chart”-sektionen (se 
kapitel 2 — Inspector) og supplerer holdout-analysen fra hjælpevinduet ovenfor.

Hvornår er loss-kurven sund? En sund loss-kurve visar tre faser: (1) Warmup — i de 
første 200–500 iterationer falder loss’en stejlt fra højt (typiskt 0.15–0.25 for L1+SSIM-
kombineret afhængigt av scenen) til ca. halvdelen. Om loss’en IKKE falder i denna fase, 
er input som regel forkert (bilder defekte, SfM-positioner dårlige, antal initial-gaussians 
for lille). (2) Densification — mellan ~500 og densifyUntilIteration (klassisk 15K, MCMC 
til 20K eller 25K) falder loss’en videre, ofte med små spring nedad, när densify- opera
tionerne indsætter nye gaussians, og optimizeren udnytter dem. Gaussian-count stiger 
i denna fase. (3) Förfining — därefter kører loss’en ud i en fladere hale. Typiske slut
værdier: Tanks-&-Temples Truck med P4 Quality lander vid L1 ≈ 0.023, Horse med Full 
Classic V546 vid L1 ≈ 0.0230, outdoor-Mip-NeRF360-scener ofte dårligere (0.04–0.07).

Vad betyder et plateau? Ett plateau (loss-kurven løber horisontalt over flere tusinde 
iterationer) har to fortolkninger: (a) modellen er konvergeret, yderligere träning giver 
intet mere — det är den gode situation. (b) Modellen er stuck (lokalt minimum, dårlig 
gradient-information, et cap vid buffer-grænsen) — den dårlige situation. Begge ser 
identiske ud i charten. Skelnen: kig på gaussian-count. Om den också er flad OG tæt 
på MCMC-cap’et (f.eks. 150K av 150K vid .fullMCMC ), er du vid grænsen — enten 
hæv cap’et eller acceptér plateauet. Om gaussian-count stadig vokser, men loss’en inte 
falder, hænger den fast.

Hvornår afbryde vs videretræne? Tommelfingerregel: 10K iterationer uden forbedring 
av min-loss → afbryd, yderligere iterationer er spildt. Før: kan du via Cmd+T (training-
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menuen → Continue Training → +5K iterations) stadig hænge en forlængelse på, om du 
ser grænsemæssig forbedring. Advarsel: vid MCMC er plateauet ofte ægte — cap’et är 
den naturlige grænse.

Gaussian-count-plateau er IKKE et „færdig”-signal. Det betyder kun, at MCMC har 
nået cap’et, eller at Classic densification er udtømt. Det egentlige „færdig”-spørgsmål 
stilles først av holdout-analysen — PSNR/SSIM/LPIPS på et uafhængigt test-sæt, evalu
eret i holdout-vinduet (W23–W29) eller via --benchmark -flag.

PSNR/holdout er sandheden, loss kun proxy. Loss’en er en relativ metrik: den falder, 
mens din model tilpasser sig trænings-views. En lav loss betyder dock inte automatisk 
god model — om modellen har lært trænings-bilderna udenad (overfitting), ville loss’en 
være lille, men PSNR på usete views (holdout) ville være dårlig. Derfor: til den endelige 
kvalitetsbedømmelse kig altid på holdout-metrikker, inte på end-loss alene.

Tommelfingerregel-boks

• User Guide og Keyboard Shortcuts er statisk hjælp — vid stikordsspørgsmål snabbt, 
til dybde brug denna manual.

• Manage Storage åbnes, så snart disken falder under 10 % fri plats. Logs og imports-
staging er de sædvanlige syndere.

• Pareto Dashboard er først meningsfuldt efter mindst tre eller fire trænings-reports. X-
akse = omkostninger (time / Gs), Y-akse = kvalitet (PSNR / SSIM). Pareto-fronten visar 
de effektive kombinationer.

• Holdout Analysis bruges, före du offentliggør PSNR-benchmarks med andre — det 
sikrer dig, at dit test-sæt virkelig er repræsentativt.

• BayesOpt Console er primärt et lærings- og inspektions-værktøj til søgerum-defini
tioner. Til ægte trænings-drevet hyperparameter-tuning brug offline CLI-workflowen.

• Loss-plateau og gaussian-count-plateau ska fortolkes adskilt. Cap-grænse er inte et 
„færdig”-signal. Ægte kvalitet måler kun holdout-PSNR.

• 10K iterationer uden min-loss-forbedring → stop träning.
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K A P I T E L

Kapitel 6 — Tränings-konfiguration

Figur 26:  Preview-preset eksporteret som JSON og vist i TextEdit — felter id/name/catego
ry/version/createdAt/description, trainingConfig med alle relevante parametre (maxIterations 

5000, densifyUntilIteration 3500, ssimWeight 0.20, renderScale 0.50, strategy classic, ca
meraAlignment applePhotogrammetry, densifyGradThreshold 2.0e-06, opacityResetInterval 

3000, minOpacity 0.005, seks bool-toggles)

VAD BILDEN VISAR  En typiskt preset-JSON-eksport. Top-level-felter: id  (UUID), name , 
(classic | mcmc | sceneClass | custom), (skema-version), (timestamp), (fri tekst). Det 
indlejrede -objekt innehåller de for reproducerbarhed kritiske parametre — vid import 
deserialiseres hele blokken til TrainingConfig -strukturen, og defaults fra app-versio
nen fylder de felter, der mangler i JSON’en (f.eks. efter app-opdatering). Den, der 
overdrager en preset til en anden Mac, sender simpelthen denna JSON-fil.

TrainingConfig -strukturen er hjertet i hver träningskörning i RadianceKit. Den samler 
hver parameter, der påvirker træningen — fra max iterations-antallet over de otte 
inlärningshastigheter til specialfelter for MCMC, Mip-splatting, curriculum og scen-
aware cap-logik. Du redigerar den i sidebaren under tränings-konfigurations-sektionen 
(Expert View), gemmer den som preset eller giver den videre som JSON-eksport til en 
anden Mac. Vid träning fryses præcis detta objekt og overgives til GPU-backend.

106 / 221



R A D I A N C E K I T Kapitel 6 — Tränings-konfiguration

Dette kapitel er reference-materiale til power-users og script-forfattere. Det lister alle 
81 offentlige felter, de 9 statiske presets og den ene offentlige metode. Kildefil er 
TrainingConfig.swift — vid tvivl gælder den dér gemte doc-comment og initializer-
default’en som source-of-truth.

O B S  ·  U I  V S .  P R E S E T/ C L I

Kun 12 av de 81 felter har en direkte slider, toggle eller vælger i Inspectoren (sand
boxed App Store-build): T1, T2, T17, T20, T22, T38, T56–T58, T60, T61, T73. 
De resterende 69 felter sættes via den valgte preset (kapitel 7) og kan kun over
skrives direkte via CLI-flag (se kapitel 5). Denne adskillelse er tilsigtet: defaults 
förblir stabile og produktionsafprøvede, power-users har ändå en flugtluge. Om et 
felt særligt interesserer dig: kig først i kapitel 2 (Inspector) og kapitel 5 (CLI), om 
du kan nå det uden JSON-pillerier.

Innehållsförteckning:

1. Iteration (T1–T2)
2. Learning rates (T3–T10)
3. Densification — Classic (T11–T16)
4. Loss (T17–T20)
5. SH-grad-progression (T21)
6. Performance (T22–T25)
7. Diagnos och punktmoln-förberedelse (T26–T30)
8. Regularisering (T31–T37)
9. Förfining (T38–T44)

10. Sky-dome (T45–T48)
11. Adam + LR-schedule (T49–T55)
12. Post-processing + Apple AI (T56–T60)
13. MCMC-densification (T61–T73)
14. Mip-splatting (Q1.5) (T74–T76)
15. Adaptive densification (Q5) (T77–T79)
16. Curriculum (Q6) (T80–T81)
17. Statiska presets (TP1–TP9)
18. Metod:
19. Vilket fält till vad? (fusklapp)
20. Farliga fält
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Iteration (T1–T2)

T1 maxIterations

D E TA L J E R

Default: 30 000 (initializer), 35 000 ( .full ), 200 
000 ( .fullMCMC ) Range: 1 000 – 500 000 (UI-sli
der), ingen hård øvre grænse i logikken Defined in:

T E K N I S K T

Samlet antal tränings-iterationer, som backend går 
igenom. En iteration består av et forward-render 
av et enkelt tränings-kamera, et backward-pas 
over alle loss-komponenter (L1 + SSIM + valgfrie 
regulariseringer + sky-mask) og et Adam-optimi
zer-skridt. Dette tal virker direkte ind på andre 
schedules: position-læringsraten følger en cosine-
annealing-kurve fra 0 til enten T1  selv eller til 
T49 positionLRScheduleEndIteration; densification 
stopper vid T2 densifyUntilIteration; MCMC-no
ise-decay slutter vid T69 mcmcNoiseDecayEnd; SH-
degree-opgraderinger sker vid de tre i T21  define
rede markeringer. Vid klassisk densification ligger 
det empirisk fundne sweet spot vid 20 000–35 000 
iterationer (sessioner 1–32, V546-tests), vid MCMC 
vid 60 000–200 000 (V534). En drastisk forhøjelse 
ud over de i presets gemte värden giver sjældent 
ekstra kvalitet — Adam-momentum mætter, og uden 
LR-decay-ende stagnerer loss’en. Omvendt fører 
underskridelse av ~5 000 til ufuldstændigt konver
gerede geometrier (density-control har for lidt tid til 
klon/split).

KO R T  S AG T

Hvor længe appen regner. Fle­
re iterationer = bedre resultat, 
men på et tidspunkt inte længere 
mærkbart bedre, til gengæld me­
get længere. Presets er valgt så­
dan, at du uden at tænke har en 
god värde: Quick 1 000, Preview 
5 000, Balanced 20 000, Quality 
35 000, MCMC Quality 200 000. 
Om du selv drejer på det, gælder: 
vid MCMC måste du gerne højt op 
(100 000–200 000), vid Classic 
inte over 40 000 — giver så inte 
mere.
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T2 densifyUntilIteration

D E TA L J E R

Default: 15 000 (initializer), 5 000 ( .full ), 160 
000 ( .fullMCMC ) Range: 0 – Defined in:

T E K N I S K T

Iteration, hvorfra densification holder op. Tills da 
klones, splittes og prunes gaussians efter reglerne 
parametriseret i T11–T16  (Classic) eller T67–T70  
(MCMC); därefter förblir gaussian-antallet konstant, 
og kun positioner, rotationer, skaler, opaciteter 
og SH-koefficienter optimeres (refinement-fase). I 
3DGS-originalpapiret ligger værdien vid 50 % av 
T1 , i RadianceKits .full -preset vid kun ~14 % (5 

000 av 35 000) — følge av V310/V338-experiment, 
der viste, at videre densifiering efter 5 000 iteratio
ner snarere försämrar resultatet (flere floaters, mere 
lagerbehov, ingen kvalitetsgevinst). MCMC derimod 
lader relocation køre til 80 % av T1  (V504b), fordi 
MCMC inte producerer skadelige floaters. Om T2  
vælges for lille (< 1 000), opstår der for få gaussi
ans; for stor vid Classic (> 50 % av T1 ) fører til 
overgrowth og RGB-saturation-outliers (se outdoor-
overtraining-findings).

KO R T  S AG T

Hvor længe appen måste genere­
re nye gaussians. Därefter forfi­
nes kun det, der allerede er. Vid 
klassisk träning med 35 000 ite­
rationer er 5 000 her den rigtige 
värde — alt derover gör scenen 
mere plumret. Vid MCMC är det 
80 % av samlede iterationer (alt­
så 160 000 vid 200 000-kørsel). 
Om du ændrer Quality-preset, lad 
hellre detta felt være.
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Learning rates (T3–T10)

T3 positionLearningRate

D E TA L J E R

Default: 0.00016 Range: 1e-7 – 1e-3 (rekommen
derat) Defined in:

T E K N I S K T

Adam-inlärningshastighet for XYZ-positionen av 
hver gaussian vid tränings-start (iteration 0). Følger 
en cosine- annealing-kurve og sjunker i træningens 
forløb til T4 positionLearningRateFinal. Default 
0.00016 stammer fra 3DGS-originalpapiret (Kerbl 
et al. 2023) og kan i RadianceKit inte skaleres 
med bild-opløsningen — positionen bevæger sig i 
verdens-koordinatsystemet, inte i pixel-rummet. En 
markant forhøjelse (> 0.0005) bevirker, at gaussi
ans springer over lange distancer, og loss’en blir 
ustabil; värden markant under (< 0.00005) fører til, 
at fejl-initialiserede punktskyer aldrig hittar deres 
plats. V414 testede en fordobling av init-værdien → 
16.8 % dårligere L1-loss; V544a-tuning bekræftede 
paper-default’en som optimal. Obs: vid .fullMCMC  
lader vi denna värde bevidst stå vid default — 
MCMC har brug for konstante inlärningshastigheter 
til sin relocation-logik, så tuning her giver intet.

KO R T  S AG T

Hvor snabbt splat-punkterna 
måste bevejse sig i rummet. 
Standardværdien er meget ve­
ljusteret og kræver i virkelig­
heden ingen ændring. Kun om 
splats i bilden „flagrer” eller et 
helt hjørne mangler, fordi intet vil 
bevæge sig dertil, ville lærings­
raten være et punkt at dreje på 
— men så passer typiskt något 
andet allerede inte (kamera-po­
sitioner, initial-punktmoln).
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T4 positionLearningRateFinal

D E TA L J E R

Default: 0.0000016 (initializer + paper), 0.000016 
( .full , .fullMCMC  — 10× højere) Range: 0 – De­
fined in:

T E K N I S K T

Slutværdi for position-LR-cosine-annealing-kurven. 
Nås enten vid T1 maxIterations  eller, om sat, vid 
T49 positionLRScheduleEndIteration. RadianceKits 
.full -preset bruger 0.000016 — altså 10× højere 

end paper-default’en 0.0000016. V420-experiment 
viste, at 0.5× av slutværdien (0.000008) försämrar 
loss’en med 6.4 %; V414 viste, at 2× init-värde 
försämrar den med 16.8 %. Den høje slutværdi er 
inte tradeoff, men bevidst valg: vid for stærk decay 
mister gaussians under refinement-fasen evnen til 
at tilpasse sig nytilkomne densification-kandidater. 
Via V431/V433-udvidelsen kan schedule-fasen for
kortes ( T49 < T1 ), så T4  allerede nås före trä
ningsslut, og resten av træningen kører vid konstant 
mini-LR — typiskt konfiguration: T49 = 20 000 , 
T1 = 35 000 , refinement altså vid 0.000016 i 15 

000 iterationer.

KO R T  S AG T

Hvor långsam position-lærings­
raten blir i slutningen av træ­
ningen. Vi har bevidst sat den 
mindre aggressivt end original­
papiret — splats kan stadig 
wackle lidt til slutningen, det gör 
dem skarpere. Om du drejer på 
det: højere = mere urolige splats 
i slutningen, lavere = splats kan 
inte længere tilpasse sig, när nye 
dukker op.
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T5 shDCLearningRate

D E TA L J E R

Default: 0.0025 (initializer + paper), 0.005 ( .full  
og alle MCMC-presets — 2×) Range: 0.0001 – 0.05 
Defined in:

T E K N I S K T

Adam-inlärningshastighet for DC-andelen (degree 
0, altså konstant albedo) av spherical-harmonic-
farven. SH-DC svarer til den retnings-uafhængige 
grundtone av en gaussian, så at sige „basisfarven”. 
V176- og V188-experiment fandt 2× højere end 
paper-default’en optimal — snabbare farve-konver
gens, særligt fordi SH-DC vid kort träning (5 000 
iterationer) annars inte kommer i form. I modsæt
ning til de geometriske LR’er har SH-DC ingen 
decay; læringsraten förblir konstant over alle itera
tioner (eller følger kun den valgfri extended-phase-
decay fra T51 ). V416 testede en firedobling til 0.01 
→ 6.4 % dårligere loss vid beta2=0.99-Adam.

KO R T  S AG T

Hvor snabbt grundfarven for hver 
splat tilpasser sig. Værdien ænd­
rer man næsten aldrig selv — 
presets har den rigtige värde. 
Højere ville gå snabbare, men 
kan føre til ustabile farver.

T6 shRestLearningRate

D E TA L J E R

Default: 0.000125 (initializer + paper), 0.00025 
( .full  og MCMC — 2×) Range: 0.000001 – 0.005 
Defined in:

T E K N I S K T

Adam-inlärningshastighet for SH-koefficienterne av 
højere orden (degree 1, 2, 3 — altså de view-direc
tion-afhængige farveandele, der sørger for højlys, 
refleksioner og blød skygning). 20× mindre end T5  
ifølge paper-konvention, fordi dessa koefficienter 
vokser kvadratisk i antal (3 for degree 1, 5 for de
gree 2, 7 for degree 3 → i alt 15 floats pr. gaussian) 
og uden mindre inlärningshastighet ville overmættte 
bilden. Frigives i to trin — tills første markering i T21 
shDegreeUpgradeIterations er kun degree 0 aktiv 
(altså kun T5 ), därefter 1, senere 2, til sidst 3. Lave 
värden her er særligt viktiga på scener med meget 
diffus belysning; vid meget blanke overflader (billak, 
vand) giver det ingen mening at dreje på det — SH- 
repræsentationen selv er begrænset.

KO R T  S AG T

Hvor snabbt de retnings-af­
hængige farve-effekter (reflek­
sioner, glans) lærer. Som stan­
dard meget lille, fordi annars 
blanker alt. Værdien lader man 
bedre stå — den, der vil få bedre 
højlys, er bedre tjent med MCMC 
og længere träningstid end med 
denna LR.
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T7 opacityLearningRate

D E TA L J E R

Default: 0.05 (initializer + paper), 0.1 ( .full , 
MCMC — 2×) Range: 0.001 – 1.0 Defined in:

T E K N I S K T

Adam-inlärningshastighet for logit-opaciteten av 
hver gaussian. Appen gemmer opacity som ube
grænset float-värde og transformerer den med 
sigmoid til [0, 1]; LR’en virker i logit-space. Pa
per-default 0.05 er efter V50-tests (best single-
run L1 0.1664) genoprettet, V71 reverterede V67′s 
0.025. V188-fordoblingen til 0.1 gör pruning mere 
effektiv — døde gaussians falder snabbare under 
T14 pruneOpacityThreshold. V418 viste: 0.05 med 
beta2=0.99-Adam er 7.1 % dårligere end 0.1 — vek
selvirkningen med Adam-konfigurationen er inte tri
viel. Lave värden (< 0.01) fører til, at „døde” gaussi
ans ligger evigt rundt og bruger minne; for høje 
värden (> 0.5) kan føre til opacity-explosion, därför 
klampes logit-værdien i optimizeren til [−15, 3] (se 
note „Opacity Explosion Prevention” i CLAUDE.md).

KO R T  S AG T

Hvor snabbt splats blir gen­
nemsigtige eller uigennemsigti­
ge. Vigtigt for opryddningen — 
splats, der inte bidrager med nå­
got, ska försvinna snabbt, så der 
inte opstår en slør. Standardvær­
dien passer, kun professionelle 
ændrer den.

T8 opacityLearningRateFinal

D E TA L J E R

Default: 0.0 (= „ingen decay”) Range: 0 eller 0.001 
– Defined in:

T E K N I S K T

Valgfri cosine-decay-slutværdi for opacity-LR’en 
(V427). Når 0.0, er decay deaktiveret, og opacity-
LR’en förblir konstant vid T7  over hele træningen. 
V427 testede en decay 0.1 → 0.01 — resultat 11.5 
% dårligere loss; reverteret, deraf default’en „fra”. 
Hypotesen bag feltet: i refinement-fasen kunde 
konstant opacity-LR føre til oscillation, så splats, 
der allerede har nået det rigtige mål for transpa
rens, forskydes igen av tilfældige gradient-udsving. 
Empirisk bekræftes det inte — logit-clamping-logik
ken fanger det ändå. Feltet förblir tilgængeligt for 
fremtidige experiment; också meget lange MCMC-
kørsler (> 500K iterationer) kunde drage nytte av 
det.

KO R T  S AG T

Om opacity-læringsraten ska bli 
mindre mod slutningen. Stan­
dard: nej. Vi har prøvet det, var 
dårligere, lader det deaktiveret. 
Bli vid 0.
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T9 scaleLearningRate

D E TA L J E R

Default: 0.005 (initializer + paper), 0.01 ( .full , 
MCMC — 2×) Range: 0.0001 – 0.1 Defined in:

T E K N I S K T

Adam-inlärningshastighet for de tre skala-kompo
nenter av hver gaussian i log-space (RadianceKit 
gemmer log(scale), så skalaerne förblir positive). 
Paper-default 0.005, i RadianceKit fordoblet til 
0.01 for bedre skala-konvergens vid de optimere
de inlärningshastighet-konfigurationer. V423-expe
riment: 0.005 med beta2=0.99-Adam → 18.7 % 
dårligere loss og synligt for få gaussians (density-
control kunde inte klone, fordi skala- updates var 
for långsamma). Skala kontrollerer udstrækningen 
av hver gaussian — for snabb læring fører til „need
le”-gaussians (ekstremt lange tynde splats, se T34 
scaleRatioPruneThreshold), for långsam læring la
der splats förbli for kompakte, og density-control 
ska splitte for ofte.

KO R T  S AG T

Hvor snabbt formen for splats til­
passer sig. Standard er god. Om 
du skruer det op, får du gerne 
„nåle”-splats — ekstreme lange 
tynde dråber, der får bilden til at 
floate.

T10 rotationLearningRate

D E TA L J E R

Default: 0.001 (initializer + paper), 0.002 ( .full , 
MCMC — 2×) Range: 0.0001 – 0.05 Defined in:

T E K N I S K T

Adam-inlärningshastighet for de fire quaternion-
komponenter av hver gaussian. Quaternion’en nor
maliseres igen i hvert optimizer-skridt efter Adam-
update’en (L2-norm = 1) — annars ville kovarians
matricen bli degenereret. RadianceKit fordobler pa
per-default’en i quality-presets, fordi rotation har 
mindre absolutte gradient-magnituder end skala / 
position (på enhedssfæren förblir hvert skridt kort), 
og uden 2× ville rotationen i 35 000-iterations-
vinduet være markant under- konvergeret. V188 do
kumenterer. På NeRF-Blender-scener (Lego, Chair) 
virker rotation særligt — objekternes kanter retter 
sig først korrekt ud efter 5 000–10 000 iterationer.

KO R T  S AG T

Hvor snabbt splats lærer at dreje 
— altså komme i den rette ret­
ning på overfladen av et objekt. 
Standard passer. Sagt anderle­
des: om splats ser ud som skrå 
klodser i stedet for at lægge sig 
om overfladen, er træningstiden 
snarere for kort, inte denna inlär­
ningshastighet for lav.
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Densification — Classic (T11–T16)

T11 densifyGradThreshold

D E TA L J E R

Default: 0.000002 (initializer, kalibreret for 0.5× 
upplösning), 0.0000011 ( .full , kalibreret for 1.0×), 
0.000004 ( .quickTest , kalibreret for 0.25×), 2e-7 
( .fullClassicPaper ) Range: 1e-8 – 1e-3 (opløs
ningsafhængig) Defined in:

T E K N I S K T

Tærskel for L2-normen av den skærmrums-projice
rede gradient dMean2D , over vilken en gaussian 
markeres til klon eller split. Den absolutte vär
de afhænger direkte av trænings-opløsningen — 
dMean2D  skalerer ca. som 1/upplösning² (flere pixel 

= mindre per-pixel-gradienter). Derfor kræver hvert 
T22 trainingRenderScale-trin en kalibreret tærskel: 
0.25× → 4e-6, 0.5× → 2e-6, 1.0× → 5e-8 … 
1.1e-6 ( .full ). Paper-default 0.0002 er NDC-nor
maliseret og inte direkte sammenlignelig i Radiance
Kits world-space-pipeline. Med V440 indkoblet T52 
adaptiveDensifyThreshold-flag kan værdien bereg
nes i runtime ud fra p98 i den aktuelle gradient-for
deling — men V440 testede det på rigtige scener og 
producerede 63 K gaussians (katastrofalt pruning-
tab); flaget förblir fra. Q5 (T77–T79) leverer en 
alternativ adaptiv logik via rolling median. Dette felt 
er inte ufarligt — halvering genererer 2–4× flere 
gaussians (minne-pres, OOM-risiko); fordobling kan 
under-densificere scenen.

KO R T  S AG T

Hvor følsom appen er, när den 
ska beslutte, om et splat er for 
lidt repræsenteret og ska mang­
foldiggøres. Lav värde = mere 
følsom = flere splats. Højere = 
færre splats. Det är en av de 
farligste värden overhovedet: for 
lav, og Mac’en fyldes med millio­
ner av splats og crasher måske. 
Lad feltet være, eller ændr det 
kun i skridt på 10 %.
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T12 densifyFromIteration

D E TA L J E R

Default: 500 Range: 100 – 5 000 Defined in:

T E K N I S K T

Første iteration, fra vilken densification blir aktiv. 
Før det sker kun „nøgen” læring på den initiale 
SfM-punktmoln, uden at nye gaussians genereres. 
Default 500 stammer fra 3DGS-papiret og giver 
initialiseringen tid til at stabilisere sig — om der 
allerede densificeres fra iteration 0, klones forkert 
positionerede SfM-punkter mange gange, före de 
overhovedet hittar deres rigtige plats. V349 testede 
1000 → let dårligere loss; default’en er optimal.

KO R T  S AG T

Hvornår appen første gang be­
gynder at klone splats. Før det 
lærer den kun på de allerede 
tilstedeværende punkter. 500 er 
standardværdien — giver appen 
tid nok til først at orientere sig, 
före den mangfoldiggør.

T13 densifyInterval

D E TA L J E R

Default: 100 (initializer, MCMC), 200 ( .full ) 
Range: 50 – 1 000 Defined in:

T E K N I S K T

Hvor mange iterationer der ligger mellan to den
sification-skridt. Vid paper-default 100 — hver 
100 iterationer evalueres listen av densify-kan
didater, klones/ splittes, og samtidig fjernes lis
ten av prune-kandidater (sigmoid(opacity) < T14 
pruneOpacityThreshold). V112-tests fandt 200 som 
optimal for .full  — det aflaster GPU’en, fordi fær
re reorganisations-pas kører, og giver hver gaussian 
mere tid til at falde til ro efter en klon-handling. 
V417 testede 100 med beta2=0.99 → 5.8 % dårlige
re (957 K gaussians, overdensificering). Vid MCMC 
fortolkes samme felt som relocation-interval; se T67 
mcmcRelocationInterval for den MCMC-specifikke 
logik.

KO R T  S AG T

Hvor ofte appen kigger efter nye 
splats. 100 = ofte, 200 = mellan. 
Højere betyder: hvert splat har 
længere tid til at indrette sig, fö­
re det mangfoldiggøres igen. Det 
er godt. At sænke til 50 kan op­
tage GPU’en vedvarende uden, at 
det blir nævneværdigt bedre.
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T14 pruneOpacityThreshold

D E TA L J E R

Default: 0.005 (initializer, paper, MCMC), 0.001 
( .full ) Range: 0.0001 – 0.1 Defined in:

T E K N I S K T

Sigmoid-opacitets-tærskel, under vilken en gaussi
an slettes vid nästa densification-step. Virker sam
men med T7 opacityLearningRate og logit-clamp-
logikken i optimizeren. V393 sænkede default’en 
fra 0.005 til 0.001 i .full  — følge: splats, som 
kun spiller en rolle under eksotiske kigge-vinkler, 
bevares længere og bidrager til SH-detalje. V394 
testede 0.0001 → let dårligere (for lidt pruning, min
ne spildt). Vigtigt: density-control ska ALTID prune, 
selv om buffer-kapaciteten allerede er fuld av and
re tiltag (se „Density Control Must Always Prune” 
i CLAUDE.md) — annars akkumulerer døde gaussi
ans, og count fryser fast.

KO R T  S AG T

Hvornår et splat regnes som 
„gennemsigtigt nok” til at bli 
slettet. 0.005 er paper-standar­
den, vi har i Quality 0.001 — altså 
vi giver splats en længere chan­
ce. Det gör blødt lys og svage 
skygger bedre at fremstille. At 
sætte højere (over 0.01) lader 
splat-antallet snabbt synke — 
kan være meningsfuldt vid min­
ne-knaphed, men koster detalje.

T15 opacityResetInterval

D E TA L J E R

Default: 3 000 (initializer + paper), 100 000 
( .full  = reelt deaktiveret), 200 000 ( .fullMCMC  
= deaktiveret) Range: 1 000 – 100 000+ Defined in:

T E K N I S K T

Hver hvor mange iterationer nulstilles opaciteten av 
alle gaussians til en lav värde (~0.01) — en foran
staltning fra 3DGS-papiret for at vurdere „frosne” 
splats på ny. V194 viste, at med RadianceKits war
mup + stochastic-trænings-setup + 2× inlärnings
hastigheter koster opacity-reset 5.5 % kvalitet, og 
logit-clamp dækker reset-funktionen allerede. Der
for i .full  praktisk deaktiveret (100 000 > 35 
000 = aldrig udløst). V421 testede reset hver 3 000 
med beta2=0.99 → 4.9 % dårligere; reverteret. Vid 
.fullClassicPaper  (Q1.5-A, paper-tro test) er det 

bevidst sat tilbage til 3 000 — det var en av de 
håndtag, hvormed paper-magnitude-gaussian-bud
getterne skulle nås.

KO R T  S AG T

Hver hvor mange iterationer ap­
pen nulstiller synligheden av alle 
splats til „næsten usynlig” — 
en slags reset-knap for opacity. 
Vid os deaktiveret (värde så høj, 
at det aldrig sker), fordi andre 
mekanismer gör det overflødigt. 
Kun vid paper-tro experiment at 
slå til.
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T16 maxScreenSize

D E TA L J E R

Default: 0.0 (= deaktiveret) Range: 0 (off) eller > 0 
Defined in:

T E K N I S K T

Maksimal skærmrums-størrelse (i projicerede pixel), 
som en gaussian måste nå, före den tvunget split
tes. Værdien er sat til 0 (V48 testede og revertere
de) — RadianceKits density-control bruger i stedet 
world-space-skala-tærsklen fra dMean2D -logikken. 
Forbliver i feltkataloget, fordi fremtidige experiment 
med Mip-splatting (T74–T76) eller scen-specifikke 
splatting-strategier kunde drage nytte av det. Akti
vering (värde > 0, f.eks. 20) ville tvinge splats, der 
er blivit meget store på skærmen, til at dele sig 
— relevant vid store, glatte vægoverflader, hvor et 
enkelt riesensplat tilbyder for lidt detalje.

KO R T  S AG T

Begrænsning på, hvor stort et 
enkelt splat måste bli på skær­
men. Vid os fra. Tændt ville det 
bevirke, at kæmpe flade splats 
(f.eks. på en væg) tvinges til at 
deles i flere små. Lad det væ­
re fra, om inte der udtrykkeligt 
eksperimenteres med det.
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Loss (T17–T20)

T17 ssimWeight

D E TA L J E R

Default: 0.2 (initializer + paper + .full ), 0.05 (alle 
MCMC-presets) Range: 0.0 – 1.0 Defined in:

T E K N I S K T

Vægt av D-SSIM-andelen i den kombinerede loss-
funktion loss = (1 - λ) * L1 + λ * D-SSIM, 
hvor λ = T17 . 3DGS-paper-default 0.2 er optimal 
for Classic-densification — V383 testede 0.3 → 
28.9 % dårligere, V373b bekræftede 0.2 som sweet 
spot. For MCMC blev det i V521b/V534 uafhæng
igt fastslået: 0.05 er optimal, fordi MCMC via sin 
stokastiske eksploration har brug for en stærkere 
L1-signal-andel — højere SSIM-vægte ville udvande 
relocation-beslutningerne. SSIM er markant dyrere 
at beregne end L1 (lokale 11×11-vinduer over hele 
bilden); RadianceKit bruger en MPS-accelereret im
plementering, der blir under 1 ms pr. 1080p-bild. 
Q7-BayesOpt-sweeps fandt scen-specifikke optima 
mellan 0.05 ( .outdoorPreset : 0.082) og 0.171 
( .indoorPreset ).

KO R T  S AG T

Hvor viktigt appen ud over „hver 
pixel stemmer” också hittar 
„strukturer er ens”. 0.2 er stan­
darden og leverer et godt bild. 
Lavere = pixel-nøjagtigere, men 
kan få blødere overgange. Højere 
= mere strukturligt, men detaljer 
blir blødere. Lad presets afgøre.
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T18 ssimWeightRefinement

D E TA L J E R

Default: 0.0 (= „intet skift, behold ssimWeight”) 
Range: 0 eller 0 – 1.0 Defined in:

T E K N I S K T

Valgfri SSIM-värde for refinement-fasen efter T2 
densifyUntilIteration. V428 testede 0.2 → 0.3 i 
refinement → 16 % dårligere loss (både L1 og SSIM 
forværredes); reverteret, deraf default 0.0. Hypote
sen bag feltet var, at efter densification — när der 
inte længere opstår nye gaussians — en stærkere 
SSIM-andel ville maksimere den strukturelle skarp
hed. Empirisk forkert: at hæve SSIM-vægten bety
der indirekte at sænke L1-vægten, og L1 är det mar
kant mere sigende signal i final-refinement-fasen. 
Feltet förblir tilgængeligt for fremtidige experiment 
med perceptual loss (T60) eller edge- loss (T19), 
hvor en refinement-specifik loss-komposition kunde 
være meningsfuld.

KO R T  S AG T

Specialindstilling til anden 
tränings-fas (refinement ef­
ter splat-mangfoldiggørelse). Vid 
0.0: samme SSIM-vægtning som 
före. At dreje giver empirisk in­
tet, därför fra.

T19 edgeLossWeight

D E TA L J E R

Default: 0.0 (= deaktiveret) Range: 0 eller 0.001 – 
1.0 Defined in:

T E K N I S K T

V437-eksperimental-loss: vægt av en Sobel-gradi
ent-domæne-L1-loss, der sammenligner billedkan
ter direkte (ground-truth-Sobel vs render-Sobel) 
ud over L1+SSIM. Hypotese: kant-information är 
en perceptuel hjørnesten av billedkvalitet, og en 
eksplicit term burde opmuntre gaussians til bedre 
at træffe kanterne. Test-resultater: vægt 0.1 → 11 
% dårligere loss, 0.01 → kvalitets-neutral, men 10 
% långsammare. Sobel-passet koster et yderlige
re MPS-forward på ground-truth og render. Derfor 
permanent deaktiveret. Fremtidigt use-case: scener 
med hårde kunstige kanter (arkitektur, møbler, ren
deringer) kunde profitere — Q7-scen-class-presets 
pickede det dock inte, men skalerede i stedet SSIM-
vægten.

KO R T  S AG T

Eksperimentel tilføjelse, der gör 
kanter ekstra viktiga. Giver empi­
risk intet. Forbliver fra.
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T20 skyMaskingEnabled

D E TA L J E R

Default: false (initializer og alle presets) Range: 
boolean Defined in:

T E K N I S K T

Slår sky masking til. Derved maskeres sky-regi
onen i hvert bild via Apple Vision Framework 
(VNGenerateForegroundInstanceMaskRequest), og 
loss’en i detta område sættes til nul. Mening: out
door-scener lider ofte under, at blå/grå/hvide sky-
pixler får appen til at placere gaussians præcis 
dér — vilket uppfattas som „floater”. Uden sky-
mask ville loss’en i detta område aldrig bli nul, 
fordi himlen i bilden varierer let, og appen evigt 
forsøger at genskabe det med splats. Vision-
masken beregnes en gang pr. kamera före træning
en og holdes i RAM. Aktiveres typiskt sammen med 
T45 skyDomeEnabled  (UI-logik i settings-viewet). 

Vid indendørs-scener eller syntetiske renderinger 
lader man stå fra — masken ville dér fejlagtigt gen
kende lofter eller vægge som „sky”.

KO R T  S AG T

Slår en specialtilstand til for 
udendørs- optagelser: himlen ig­
noreres under træningen, så 
der inte forsøges genskabt med 
splats. Anbefales for hver uden­
dørs scen. Lad være vid inden­
dørs eller vid 3D-renderinger fra 
Blender.
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SH-grad-progression (T21)

T21 shDegreeUpgradeIterations

D E TA L J E R

Default: [1_​000, 2_​000, 3_​000] (initializer), 
[2_​000, 5_​000, 8_​000] ( .full , MCMC), 
[1_000, 2_000]  ( .preview  — degree 3 sprung

et over) Range: [Int] , hver värde i 
[0, maxIterations] , monotont stigende Defined 

in:

T E K N I S K T

Iterationer, hvor den aktive SH-degree skiftes op fra 
0→1, 1→2, 2→3. Før første markering er kun DC-
komponenterne aktive (altså T5 shDCLearningRate), 
efter første markering DC + 3 degree-1-koeffici
enter, efter anden markering + 5 degree-2-koeffici
enter, efter tredje markering alle 15 koefficienter. 
Lager-behovet pr. gaussian vokser i trin — 4 floats 
→ 16 floats → 36 floats → 64 floats. Quality-pre
sets udskyder optrapningerne i forhold til initializer-
defaults (V228), fordi geometrien ska stabilisere sig 
først, före farve- detaljerne med deres højere fre
kvens kommer på. V384 testede [1K, 2K, 3K]  for 
.full  → 9.3 % dårligere — bekræfter forsinkelsen. 
.preview  kapper vid degree 2, fordi degree 3 inte 

konvergerer i 5 000 iterationer og kun bruger opti
mizer-kapacitet. Q6 (T80–T81) tilbyder en alternativ 
curriculum-logik, der dynamisk overskriver denna 
liste.

KO R T  S AG T

På vilka punkter i træningen ap­
pen lærer, at farver kan se olika 
ud fra olika synsvinkler (højlys, 
refleksioner). Først sent — så 
formen først stemmer, så farven. 
Værdierne i presets er sat sådan, 
at det fungerer godt. Lad være 
med at ændre något, medmindre 
du vid nøjagtigt hvorfor.
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Performance (T22–T25)

T22 trainingRenderScale

D E TA L J E R

Default: 1.0 (initializer, .full , MCMC, scen-class), 
0.5 ( .preview ), 0.25 ( .quickTest ) Range: 0.05 – 
2.0 (typiskt 0.25, 0.5, 1.0) Defined in:

T E K N I S K T

Render-upplösning vid träning relativt til trænings
billedernes oprindelige upplösning. Vid 0.5 nedska
leres hvert bild til 50 % bredde × 50 % højde 
(altså 25 % av pixlerne), og gaussian-renderingen 
sker i denna mindre upplösning. Reducerer både 
minne- og regneindsats kvadratisk. Vigtigt: T11 
densifyGradThreshold ska passe til den valgte upp
lösning — gradient-magnituderne skalerer med 1/
upplösning², därför har .quickTest  (0.25×) en me
get højere tærskel (4e-6) end .full  (1.0×, 1.1e-6). 
RadianceKit advarer vid meget store bilder og til
passer automatisk — 3-MP-mål-upplösning. Vid ek
streme 4K-input-bilder ville 0.5 eller endda 0.25 
være meningsfuldt, annars kører selv Mac’en kun i 
CPU-compaction.

KO R T  S AG T

Hvor store bilderna er vid træ­
ningen. 1.0 = original, 0.5 = halv 
størrelse. Halv størrelse = fire 
gange snabbare, men de fineste 
detaljer mangler. Presets vælger 
den rigtige värde; vid ekstremt 
store input-bilder (over 12 mega­
pixel) skifter appen automatisk 
ned.

T23 resolutionWarmupScale

D E TA L J E R

Default: 0.0 (= deaktiveret) Range: 0 eller 0.1 – De­
fined in:

T E K N I S K T

V133-optimering: træn densification-fasen (iter 0 til 
T2 ) i en lavere upplösning end refinement-fasen. 

V308 har deaktiveret den igen for .full , fordi 
tids-gevinsten vid T22 = 1.0  og cosine-annealing 
var marginal, og kvaliteten led minimalt. Forbliver i 
feltkataloget, fordi den kunde bli meningsfuld igen 
vid 4K-input og lange trænings-kørsler — Q6 cur
riculum (T80) har taget en lignende logik op, men 
dér är den koblet til LR-schedulen. Om aktiveret og 
T80 curriculumResolutionRamp ligeledes true, vin
der Q6 og overskriver denna värde.

KO R T  S AG T

Spesial-feature: i første træ­
ningshalvdel læres med mindre 
bilder, i den anden med store. 
Sparer tid. Fra, fordi den nyere 
Q6-variant løser det bedre.
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T24 tileSize

D E TA L J E R

Default: 16 Range: 8, 16, 32 Defined in:

T E K N I S K T

Størrelse av rasteriserings-tiles i pixel. Gaussian-
splatting-renderingen er tile-baserat: bilden opde
les i 16×16-pixel-fliser, hver flise samler de for den 
relevante gaussians, sorterer dem efter dybde og 
blender dem ind. 16 er standard, som praktisk talt 
alle 3DGS-implementeringer bruger, og er hardko
det i RadianceKits Metal-kerneler; en ændring av 
denna värde ville kræve re-kompilering av shaderne 
og er inte effektiv i den aktuelle stand. Forbliver 
som felt, om en fremtidig engine-version understøt
ter tile-size dynamisk.

KO R T  S AG T

Intern render-parameter. Stan­
dard 16, lad være at ændre.

T25 throttleDelayMs

D E TA L J E R

Default: 0 (initializer, .full , MCMC, scen-class), 
0 ( .preview ) Range: 0 – 100 Defined in:

T E K N I S K T

Kunstig forsinkelse mellan tränings-iterationer i mil
lisekunder. 0 = fuld hastighed (standard). Højere 
värden gör Mac’en mere „brugelig” under træning
en vid, at GPU/CPU regelmæssigt får pusterum — 
andre apps’ brugervenlighed stiger, men træningsti
den också lineært med forsinkelsen. Typiske värden: 
1–2 ms („let” throttling, +5 % träningstid, Mac 
føles mere responsive), 5 ms („mellan”, +15 % 
träningstid), 10+ ms („Eco”, potentielt fordoblet trä
ningstid). Tilbydes i Inspectoren under „Performan
ce”, men er inte i standard-visningen — se backlog 
dev_ux-backlog.md , der foreslår at fjerne den fra 

Expert View, fordi den misforstået forlænger træ
ningstiden dramatisk.

KO R T  S AG T

Hvor mange millisekunder pau­
se appen tager mellan trænings-
skridt. 0 = ingen pause, hurtigst 
muligt. Højere värden gör Mac’en 
bedre brugelig under træningen 
— men træningen varer så också 
længere. På en M3 Ultra eller Mac 
Studio kan du lade den stå på 0; 
på en MacBook Air ville 2 eller 5 
være en god värde.
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Diagnos och punktmoln-förberedelse (T26–T30)

T26 depthDistortionWeight

D E TA L J E R

Default: 0.0 (= deaktiveret) Range: 0 eller 0.0001 – 
0.05 Defined in:

T E K N I S K T

V366-eksperimental: vægt av en depth-distortion- 
regulariserings-loss. Straffer gaussians, der langs 
en render-stråle ganske vist er dybt stablede, 
men konceptuelt hører til samme overflade — det 
opmuntrer koncentrerede dybdefordelinger og re
ducerer floaters. Tests: 0.01 → 4.5 % dårligere, 
0.001 → 8.1 % dårligere. Den teoretiske fordel — 
multi-view-konsistens förbättras — afspejler sig in
te i L1-loss’en, fordi hypotesen implicit antager, at 
SfM-geometrien er korrekt, og gaussians kun ska 
„stables”. I praksis er SfM-punktskyen som regel 
den svageste komponent, inte stablingen. Forbliver 
tilgængelig for multi-view-datasæt med særligt rene 
poser (synthetic, Mip-NeRF 360 med ground truth).

KO R T  S AG T

Eksperimentel feature til at und­
vika flere splats bagved hinan­
den på samme sted. Inte aktive­
ret, fordi testene inte har givet 
något.

T27 singleViewOverfit

D E TA L J E R

Default: false Range: boolean Defined in:

T E K N I S K T

Diagnose-flag: om true, bruges i hver tränings-
iteration tvunget kamera-index 0 i stedet for en 
tilfældig fra camera-pool’en. Mening: om modellen 
inte engang kan overfitte en enkelt view (altså 
loss’en på view 0 inte går mod nul selv efter 
10 000 iterationer), er der en fundamental bug i 
forward/backward-passet. Denne kontakt blev brugt 
intensivt under udviklingen av Metal-shaderne og 
differentiable- rasterizer-kernels — V42–V47-fasen. 
I dag kun tilgængelig som sanity-check, om någon 
har modificeret backend-kode og vil lave en regres
sion test. Via CLI med --single-view .

KO R T  S AG T

Test-tilstand for udviklere. De 
kan dermed tjekke, om appen 
overhovedet kan lære fra ÉT bild. 
Irrelevant for almindelige bruge­
re, lad altid være fra.
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T28 maxCameras

D E TA L J E R

Default: 0 (= „brug alle kameraer”) Range: 0 eller 1 
– N Defined in:

T E K N I S K T

Diagnose-grænse fra V43: træn kun med de første 
N kameraer, ignorer alle yderligere. Mening oprinde
ligt: teste hypotese, at for mange kameraer skaber 
gradient-konflikter (for mange modstridende loss-
signaler for samme gaussian). Test-resultat: ingen 
systematisk fordel vid kunstig begrænsning — flere 
frames bringer praktisk talt altid mere kvalitet. For
bliver som CLI-flag ( --max-cameras N ) til målrette
de experiment, f.eks. „fungerer træningen på de 
første 100 bilder av en 1 500-bild-droneflyvning?” 
Inte eksponeret i UI.

KO R T  S AG T

Diagnose-felt for udviklere — 
brug kun de første N bilder, 
ignorer resten. Almindelig bru­
ger har inte brug for det, vär­
de 0 = alle bilder. Flere bilder 
= bedre resultat (se feedback_​
more-frames-better.md).

T29 maxInitialPoints

D E TA L J E R

Default: 0 (= „brug alle SfM-punkter”) Range: 0 
eller 1 000 – 200 000+ Defined in:

T E K N I S K T

V54-sikring: begrænser antallet av initiale SfM-
punkter, som træningen starter med. Tætte COL
MAP- rekonstruktioner kan producere > 60 000 
punkter, vilket vid store initial-skalaer fører til 200–
300 gaussians pr. pixel-overlap — det giver et 
„tågefelt”, hvor træningen inte konvergerer. Sub
sampling til ~16 000 punkter (hard-cap-logik i 
tränings-motor) bringer initial-densiteten på niveau 
med, vad reference-3DGS bruger, og reducerer 
overlap dramatisk. Sættes automatisk vid meget 
tætte SfM’er; via CLI med --max-points N .

KO R T  S AG T

Hvor mange start-punkter fra ka­
mera- rekonstruktionen der bru­
ges. Vid meget tætte rekonstruk­
tioner (mere end 60 000) be­
grænser appen automatisk til 16 
000 — annars er der for meget 
tåge i starten. Du behöver inte 
sætte det; appen klarer det.

126 / 221



R A D I A N C E K I T Kapitel 6 — Tränings-konfiguration

T30 cameraClusterOutlierMultiplier

D E TA L J E R

Default: 10.0 (alle presets — aldrig overskrevet) 
Range: 1.0 – 100.0 Defined in:

T E K N I S K T

Multiplikator for camera-cluster-outlier-filteret, in
dført i fase 3.10 A.1. Før træningen beregner 
tränings-motor centroidet for alle kamera-positio
ner og den maksimale distance for et kamera fra 
centroidet. SfM-punkter, om distance fra centroidet 
overskrider multiplier × maxCameraDistance, kas
seres som outliers. Default 10× bevarer adfærden 
fra före fase 3.10. En subtil bug: tighter SfM (kame
raer tættere sammen) → mindre → mindre tærskel 
→ flere punkter kasseres som outliers. Looser SfM 
→ større tærskel → færre punkter kasseres. Dette 
är en av årsagerne til fase-3.9-funnel-vs-training-
anti- korrelationen: bedre SfM kan downstream føre 
til dårligere träning, fordi for mange initial-punkter 
dræbes. Feltet ligger som CLI-override (--camera-
cluster-outlier-multiplier) til A.3-sweeps; inte 
eksponeret i UI. Värden under 5 er som regel for 
restriktive, over 20 virkningsløse.

KO R T  S AG T

Specielt filter, der kasserer punk­
ter fra rekonstruktionen, som lig­
ger langt væk fra kamera-skyen. 
10 = appen er generøs, beholder 
næsten alt. Forhøjelse kan være 
meningsfuld, om langt fjerntlig­
gende punkter (bjerge i det fjer­
ne) i bilden ser ud som svævende 
klumper. At sætte lavere kun i 
nødtilfælde — du mister dybde-
detalje.
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Regularisering (T31–T37)

T31 coarseToFineBlurRadius

D E TA L J E R

Default: 0 (= deaktiveret) Range: 0 eller 1 – 10 De­
fined in:

T E K N I S K T

V369-eksperimental: box-blur-radius, der i starten 
av densification-fasen anvendes på ground-truth-
bilden og lineært reduceres til slutningen av densifi
cation ( T2 ) til 0. Hypotese: coarse-to-fine-träning 
— først lære grove strukturer, så detaljer — skulle 
give stabilere geometri. Tests: r=3 → 9.6 % dårlige
re, r=1 → 5.1 % dårligere. Grunden til mislykket: 
densification beslutter baserat på bild-domæne-
gradienter, og blur reducerer just de signaler, der 
er viktiga for „her ska klones”. Forbliver i feltkata
loget til fremtidige tests med andet density-control-
skema.

KO R T  S AG T

Eksperimentel „først-grov-så-
detaljeret”- tilstand. Har intet gi­
vet, förblir fra.

T32 scaleRegWeight

D E TA L J E R

Default: 0.0 (= deaktiveret) Range: 0 eller 0.0001 – 
0.05 Defined in:

T E K N I S K T

V370-eksperimental: L1-regularisering på verdens-
rumlig skala. Straffer gaussians, der blir for store — 
hindrar „mega-splats”, der dækker hele vægoverfla
der med en gaussian. Tests: 0.01 → 200 % dårligere 
loss (2 M gaussians, total eksplosion), 0.001 → 214 
% dårligere. Grunden: skala- regularisering kommer 
i konflikt med density-control — mindre skalaer be
tyder, at flere gaussians bruges, så density-control 
splitter oftere, vilket igen betyder mere gradient-
arbejde. Disabled, men dokumenteret til Mip-splat
ting-experiment (T74): i denna kontekst kunde en 
skala-undergrænse være meningsfuld.

KO R T  S AG T

Regularisering, der tvinger splats 
til at förbli små. Har udløst splat-
eksplosioner i tests (millioner av 
splats). Inte aktivere.
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T33 anisotropyRegWeight

D E TA L J E R

Default: 0.0 (= deaktiveret) Range: 0 eller 0.0001 – 
0.05 Defined in:

T E K N I S K T

V445-eksperimental: penalty på max(scale)/
min(scale)-forholdet, ska forhindre ekstremt langs
trakte „needle”-gaussians, der uppfattas som flo
aters. Tests: 0.01 → 69 % dårligere, 0.001 → 
15 % dårligere. Grunden: regulariseringen tving
er splats mod „runde” former, vilket på en flad 
overflade (væg, bord, gulv) er just forkert — 
dér er en flad, bred gaussian mere effektiv end 
en kugleformet. Disabled. V549f tilbød med T34 
scaleRatioPruneThreshold en alternativ, mere mål
rettet tilgang, som ligeledes blev reverteret.

KO R T  S AG T

Regularisering, der straffer for 
lange tynde splats. Lyder fornuf­
tigt, var dock dårligere i tests. 
Fra.

T34 scaleRatioPruneThreshold

D E TA L J E R

Default: 0.0 (= deaktiveret) Range: 0 eller 5.0 – 
100.0 (typiskt 10.0 – 30.0) Defined in:

T E K N I S K T

Eksperimentel post-training-pruning, der sletter 
hver gaussian, om max(scale)/min(scale)-forhold 
overskrider den her satte lineære tærskel. Sigter 
på ekstremt langstrakte „needle/disc”-floaters, der 
inte kan elimineres vid regularisering alene. I testen 
fjernede pruning floaters som håbet, men samtidig 
också fornuftige flade splats på vægge og gulve 
— bilden blev hullet. Derfor fra som default, CLI-fla
get (--scale-ratio-prune N) förblir tilgængeligt til 
målrettede experiment. Anbefalede värden, om man 
ändå vil teste: 30 (meget konservativ, fjerner kun 
ekstreme outliers), 10 (aggressiv, koster detalje).

KO R T  S AG T

Forsøg på at filtrere helt langs­
trakte splats fra efter træningen. 
Var netto-negativ i tests — floa­
ters væk, men också detalje væk. 
Fra.
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T35 opacityRegWeight

D E TA L J E R

Default: 0.0 (= deaktiveret) Range: 0 eller 0.0001 – 
0.05 Defined in:

T E K N I S K T

V446-eksperimental: binary-cross-entropy-penalty, 
der trækker opacity mod 0 eller 1 (altså væk fra 
„halv- transparent”). Hypotese: skarpere opacitets
fordeling ville förbättra billedklarhed. Test med T33 
kombineret → regularisering koster kvalitet, begge 
deaktiveret. Disabled. Advarsel: i 1.4.3-beta dukke
de en bug op, der havde præcis detta felt med en 
default-värde-ændring (initializer = 0.01), vilket før
te til mass-extinction av gaussian-count (460 K → 5 
på en iteration). Siden 1.4.4 fast på 0.0 som default.

KO R T  S AG T

Regularisering, der gör splats en­
ten helt transparente eller helt 
solide. Giver intet, kan endda 
bli farligt (1.4.3-bug mass-extin­
ction). Lad stå på 0.

T36 opacityDecayFactor

D E TA L J E R

Default: 0.0 (initializer = deaktiveret), 0.9995 
( .full , .classicBalanced  — HTGS-standard) 
Range: 0 (off) eller 0.95 – 1.0 Defined in:

T E K N I S K T

V546-implementering av HTGS-skemaet (Hierarchi
cal Time-Gating, Eurographics 2025): hver T37 
opacityDecayInterval iterationer multipliceres sig
moid-opaciteten av hver gaussian med denna fak
tor. 0.9995 × 100 anvendelser giver ~95 %-tilbage 
pr. densification-fase — et let, men stabilt ne
dadgående tryk på alle opacities, der pålideligt 
lader svagt bidragende gaussians synke mod T14 
pruneOpacityThreshold. Resultat: 14 % bedre L1-
loss på Horse Full (3-trial-avg V546) i forhold til 
V438 uden decay. Kun aktiv under densification-fa
sen (tills T2 ), därefter kører træningen videre uden 
decay, så de i refinement etablerede opaciteter för
blir stabile. Bruges inte vid MCMC (MCMC har egne 
mekanismer via T67 mcmcRelocationInterval
1. T68 mcmcDeadOpacityThreshold).

KO R T  S AG T

„Blid falmen” av alle splats 
over træningstiden. Gör inaktive 
splats snabbare transparente, så 
de fjernes vid opryddning. Var 
den viktigaste quality-håndtag i 
V546-opdateringen: 14 % bedre. 
Indbygget i Quality-preset. Anbe­
fales inte at dreje på selv, fordi 
præcist afbalanceret.
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T37 opacityDecayInterval

D E TA L J E R

Default: 50 Range: 10 – 500 Defined in:

T E K N I S K T

Iterations-interval, hvor T36 opacityDecayFactor 
anvendes. HTGS-paper-default 50, beholdt i 
.full . Lange intervaller (>200) ophæver effekten 

delvist, fordi der mellan to anvendelser sker nok 
gradient-updates til, at opacity stiger igen. Korte 
intervaller (<20) gör decay for aggressiv. Kun aktiv i 
densification-fasen.

KO R T  S AG T

Hvor ofte „falmen” anvendes. 50 
= hver 50 iterationer et lille fal­
me-skridt. Passer.

Förfining (T38–T44)

T38 gradientAccumulationSteps

D E TA L J E R

Default: 1 (= „en view pr. Adam-skridt”) Range: 1 – 
8 Defined in:

T E K N I S K T

V424-feature: antal views, om gradienter akkumule
res, före et Adam-update udføres. Vid > 1  kører 
appen på en separat, „unfused” backward-project-
sti, der summerer gradienterne i en separat buffer; 
den endelige anvendelse skalerer med 1/N for at 
holde magnituden konstant. V424 testede 2-view 
→ kvalitets-neutral, men 10 % långsammare (fordi 
unfused-stien er dyrere end fused-stien). Reverte
ret for .full , men bevidst brugt til MCMC — 
.fullMCMC  kører med, men V544a-tests viste, at 

quality-gappet til Classic skrumper til 5 % (i stedet 
for 11 %). I initializer-default 1, i aktuelle preset 1, 
förblir CLI-flag ( --accum-steps N ).

KO R T  S AG T

Hvor mange bilder appen ser, fö­
re den tilpasser splats. 1 = hvert 
bild enkeltvis. Højere = se flere 
bilder samtidigt og anvend så en 
middelværdi. Giver intet i stan­
dardtilfældet; vid MCMC kan 2 
hjælpe lidt.
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T39 testViewIndices

D E TA L J E R

Default: []  (= tom, alle views bruges til träning) 
Range: Set<Int> , vilkårlig delmængde av camera-
indices Defined in:

T E K N I S K T

V546-feature: sæt av camera-indices, som IKKE 
bruges til träning, men gemmes som holdout til 
PSNR/SSIM/LPIPS- evaluering. Sættes automatisk, 
när --benchmark -CLI-flaget er aktivt: så hver ot
tende view fra index 0 (LLFF-standard, identisk 
med Mip-NeRF-360- og 3DGS-paper-konventio
ner). Uden benchmark tom — træningen bruger alle 
views. Forsigtighed: manuel inställning av detta felt 
uden forståelse for indekserne kan gøre benchmar
ket ubrugeligt (f.eks. om alle indices over N sættes, 
mens der kun er N-50 views → ingen holdouts → 
ingen evaluering). Vid egen preset-eksport persiste
res testViewIndices inte, fordi det er scen-afhæng
igt og annars ville efterlade meningsløse värden 
mellan olika datasæt.

KO R T  S AG T

Hvilke bilder der „udelades” vid 
træningen for senere at bruges 
til kvalitetsmåling. Du sätter inte 
det selv; --benchmark -flaget 
gör det automatisk (hvert otten­
de bild er test). Om du sætter eg­
ne indekser: farligt, kan forfalske 
benchmarket.

T40 refinementPruneInterval

D E TA L J E R

Default: 0 (= deaktiveret) Range: 0 eller 100 – 5 
000 Defined in:

T E K N I S K T

V425-feature: hver N iterationer i refinement- fa
sen (efter T2 ) køres et yderligere prune-pas, 
der fjerner gaussians med sigmoid(opacity) < T41 
refinementPruneOpacityThreshold. Mening: under 
densification er der regelmæssige density-control-
kald, därefter inte længere — gaussians, om opacity 
fortsætter med at synke, förblir dock i bufferen. 
V425 testede og reverterede: den ekstra pruning 
korrelerede med V426 (two-phase densification, li
geledes afsluttet i 0-gaussians-cascade failure). Di
sabled. CLI-flag tilgængelig til experiment; om akti
veret, er 1 000 eller 2 000 fornuftige värden.

KO R T  S AG T

Yderligere opryddning under re­
finement-fasen. Giver intet, för­
blir fra.
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T41 refinementPruneOpacityThreshold

D E TA L J E R

Default: 0.0 (= „brug T14 ”) Range: 0 eller 0.001 – 
0.1 Defined in:

T E K N I S K T

V425b: separat opacity-tærskel til refinement- pru
ning. Efter densification har de fleste gaussians nå
et en markant højere opacity (> 0.001), så standard- 
T14 pruneOpacityThreshold ville være for slap. Om 
T40  aktiv, bestemmer detta felt den egne tærskel. 

Vid 0.0 anvendes T14  fortsat. Kun relevant, om 
T40 > 0.

KO R T  S AG T

Tærskel for den yderligere re­
finement- opryddning (se T40). 
Begge felter inte aktive, altså ir­
relevant.

T42 midTrainingCompactificationIterations

D E TA L J E R

Default: []  (= deaktiveret) Range: [Int] , värden 
i (densifyUntilIteration, maxIterations) Defi­
ned in:

T E K N I S K T

V549-feature: eksplicitte iterations-punkter un
der refinement-fasen, hvor et compactification-
pas køres (fjerner sigmoid(opacity) < 0.01 + 
outlier-skala-gaussians, samme logik som T56 
postTrainingCompactification). Mening: lange re
finement-faser kan visa confetti-/floater-akkumula
tion, om SH så overfitter på view-specifikke arte
fakter. Typisk konfiguration om aktiveret: [10000, 
20000, 30000] for 40K Classic. MEN: V549-A/
B-tests på Family-dataset viste i alle konfiguratio
ner dårligere L1: [10K,20K,30K]@0.01  → −48 % 
count, men +36 % L1; [20K,30K]@0.005  → −44 
% count, men +45 % L1; [20K,30K]@0.001  → −17 
% count, men +87 % L1. Derfor disabled. CLI-flag 
--mid-compact "10000,20000" tilgængelig, om man 
foretrækker den visuelle floater-tradeoff (mindre 
confetti i viewporten) over loss-regressionen.

KO R T  S AG T

Imellem-opryddninger under 
træningen. I tests gjorde oprydd­
ningen slutresultatet dårligere 
(ganske vist færre floaters, men 
också mindre detalje). Fra, kan 
tændes via CLI, om floaters ge­
nerer dig mere end et lidt mere 
plumret bild.
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T43 frustumCullEnabled

D E TA L J E R

Default: false Range: boolean Defined in:

T E K N I S K T

V549b-feature: efter träning fjernes alle gaussians, 
der ligger uden for foreningen av alle trænings
kamera-frusta. Sådanne gaussians blev aldrig be
grænset av loss-signalet og er altid floaters. Særligt 
effektivt for scener, hvor novel-viewet ligger bag 
eller vid siden av kamerastien (f.eks. bagsiden av 
en lineær droneflyvning) — floaters dér blir ald
rig synlige i træningsfasen, men meget vel vid 
senere bevægelse i 3D-vieweren. V549b A/B på 
droneflyvninger positive resultater, därför tilgænge
lig som opt-in. Default false, fordi vid object-captu
res med fuld orbit-coverage omfatter frustum-fore
ningen hele scenen, og featuren fjerner intet — 
tilbydes i settings under „Floater Reduction” og 
också i Q9 Outdoor-preset implicit testet over T44 
frustumCullExpansion (Q7-BayesOpt aktiverede det 
dock inte, fordi outdoor-sky-dome løser samme 
problem bedre).

KO R T  S AG T

Specialfilter til droneflyvninger 
eller lineære optagelser: efter 
træningen slettes splats, der inte 
blev „set” i något kamera. Valgfri 
tænd i settings. Vid enkle objekt- 
optagelser unødvendigt.

T44 frustumCullExpansion

D E TA L J E R

Default: 1.1 Range: 1.0 – 2.0 Defined in:

T E K N I S K T

NDC-margin for T43 frustumCullEnabled. 1.0 ville 
skære præcis vid billedkanten, vilket ville beskære 
vaklende splats vid billedkanten for meget. 1.1 = 
10 % padding ud over den præcise kamera-framing 
— giver lidt tolerance for randpixler, der i en let 
forskudt novel-view ändå kunde bli synlige. Värden 
> 1.2 gör cullen praktisk talt virkningsløs, fordi det 
udvidede frustum omfatter meget mere rum.

KO R T  S AG T

Hvor strengt det ovenfor be­
skrevne filter beskærer. 1.1 = lidt 
sikkerhedsafstand til billedkan­
ten. Lad værdien stå.
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Sky-dome (T45–T48)

T45 skyDomeEnabled

D E TA L J E R

Default: false (initializer + alle presets undtagen P9 
Outdoor) Range: boolean Defined in:

T E K N I S K T

V549e-feature: före tränings-start genereres en 
kugleformet punktmoln (Fibonacci-sphere med 
T46  sample-points), placeret i en radius av T47 
skyDomeRadiusMultiplier × scene_​extent omkring 
scenens midtpunkt og initialiseret med farverne 
fra de sky-maskerede pixler i alle træningskame
raer (se T20 skyMaskingEnabled). Disse sky-dome-
gaussians indsættes i begyndelsen av gaussian-
bufferen og „fryses” under træningen (position/ska
la/rotation-gradienter = 0, kun SH og opacity förblir 
optimerbare). Effekt: i stedet for sorte „confetti”-
områder i det fjerne ser brugeren en rigtig himmel 
i novel-views. V549e-MVP fungerer meget godt på 
drone- og landskabsscener; i P9 Outdoor-preset 
default-on. Vid indendørs scener lad stå fra — sfæ
ren ville hænge meningsløst uden for rummet.

KO R T  S AG T

Slår en kunstig „himmelkuppel” 
til omkring scenen. Gör uden­
dørs-optagelser meget pænere: 
i stedet for sorte klumper vid 
billedkanten visar appen den rig­
tige himmel. Pligt for droneflyv­
ninger og landskaber, menings­
løs for indendørs rum.

T46 skyDomeSampleCount

D E TA L J E R

Default: 5 000 Range: 1 000 – 50 000 (typiskt 2 
000 – 10 000) Defined in:

T E K N I S K T

Antal Fibonacci-sphere-sample-punkter på sky-do
me- sfæren. Højere värden → tættere sky-dome 
(bedre vid store upplösningar og meget synlig him
mel), men mere lagerbehov. 5 000 er sweet spot 
for 4K-renderinger; vid lavere upplösningar rækker 
2 000–3 000. Punkterne initialiseres efter cosine-
distance til hver træningskamera-view-vektor med 
de tilsvarende sky-maskerede pixler — sample-
points, om view-cone inte ser något kamera, förblir 
med lav opacitets-startværdi bagved, men ændres 
inte i træningen (frosset).

KO R T  S AG T

Hvor tæt den kunstige himmel er. 
5 000 punkter rækker normalt. 
Mere = bedre overgang i det fjer­
ne, men koster lidt minne.
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T47 skyDomeRadiusMultiplier

D E TA L J E R

Default: 30.0 (initializer + de fleste presets), 59.0 
(P9 Outdoor, Q7-BayesOpt-optimum) Range: 5.0 – 
200.0 Defined in:

T E K N I S K T

Radius av sky-dome-sfæren relativt til scenens 
udstrækning (= middel-distance mellan kamera-po
sitionerne). 30 = kuglen har 30 gange diameteren 
av kamera-skyen. For lille (< 5) → sky-dome interfe
rerer med selve scenen (f.eks. lander et sky-dome-
splat i forgrunden); for stor (> 100) → float32- 
præcisionstab på sky-dome-positionerne, vilket ud
løser render- glitches i det fjerne. Q7-BayesOpt på 
Bicycle (Mip-NeRF 360) fandt 59.0 som scen-spe
cifikt optimum for outdoor — det tyder på, at stan
dard-30.0 er for lille til dybe landskaber, og sky- 
dome-pixlerne i billedkant-områder rendrer synligt 
som „væg”.

KO R T  S AG T

Hvor langt væk den kunstige 
himmelkuppel ska være. 30 = 
ret langt. Vid store landskaber 
er 50–60 bedre (Outdoor-preset 
gör det automatisk). For lille ville 
være, som om man har klumper 
direkte foran linsen.

T48 frozenGaussianCount

D E TA L J E R

Default: 0 (= ingen frosne gaussians) Range: 0 
eller 1 – T46  Defined in:

T E K N I S K T

Antal gaussians i begyndelsen av bufferen, om posi
tion/skala/rotation-gradienter sættes til nul i optimi
zeren — de förblir rumligt stive over hele træningen. 
Density- control måste inte klone, splitte eller pru
ne dem. Bruges til sky- dome-injection (se T45 ): 
om sky-dome er tændt, sættes detta felt automa
tisk til T46 skyDomeSampleCount. Manuel inställning 
er mulig (f.eks. for at fryse en forhåndsplaceret 
punktmoln fra en LiDAR-scanning), men inte direkte 
tilgængelig i UI. Vigtigt: de første N gaussians i buf
feren er altid de frosne — rækkefølgen i bufferen 
afgør, inte et eksplicit index.

KO R T  S AG T

Hvor mange splats i begyndelsen 
der er faste og inte måste be­
væge sig. Sættes automatisk til 
sky-dome-antallet, när sky-dome 
er tændt. Du behöver inte selv 
dreje på det.
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Adam + LR-schedule (T49–T55)

T49 adamResetIteration

D E TA L J E R

Default: 0 (= deaktiveret) Range: 0 eller 100 – De­
fined in:

T E K N I S K T

V430-feature: iteration, hvor Adam-optimizer- mo
mentum-akkumulatorerne (m1, m2) nulstilles. Bi
as-korrektion därefter kører med (iter - 
adamResetIteration) i stedet for med iter . V430 
testede reset vid 5 000 (efter densification- slut) → 
12.8 % dårligere loss. Grund: Adam-momentum, der 
har bygget sig op under densification, bærer infor
mation om de typiske gradient-magnituder og acce
lererer refinement-fasen. At kaste det væk koster de 
første ~500 iterationer refinement i konvergens. Di
sabled. Forbliver CLI-flag til forskningseksperimen
ter.

KO R T  S AG T

Reset-knap for det interne 
Adam-optimerers „minne”. Har 
skadet i tests, förblir fra.

T50 positionLRScheduleEndIteration

D E TA L J E R

Default: 0 (initializer = „brug maxIterations”), 20 
000 ( .full  — cosine slutter vid 20K trods maxI
ter=35K), 30 000 ( .fullClassicPaper ) Range: 0 
eller 1 000 – Defined in:

T E K N I S K T

V431-feature: iteration, hvor cosine-annealing- kur
ven for position-LR när sit minimum. Om 0, är det 
identisk med T1 maxIterations . Om > 0, kører 
schedulen til denna värde og förblir därefter kon
stant vid T4
positionLearningRateFinal. Det tillader en „exten
ded refinement phase” med minimal, men konstant 
inlärningshastighet — forfiner positioner långsamt 
uden fornyet decay. .full  gör det (schedule- slut 
vid 20K, träning kører til 35K), V434c/V434d be
kræftede: 15K og 25K begge ca. lige gode, 20K 
minimalt optimal. Bruges i forbindelse med T51  vi
dere for också at modificere inte-position-LR’erne i 
extended phase.

KO R T  S AG T

Hvornår appen holder op med 
yderligere at sænke position-
læringsraten. Om lavere end 
maksimum-iteration, kører där­
efter med konstant mini-rate 
— det forfiner meget långsamt, 
men meget stabilt. Indbygget i 
Quality-preset, du behöver inte 
dreje.
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T51 extendedPhaseLRDecay

D E TA L J E R

Default: 0.0 (= deaktiveret, konstante LR’er) 
Range: 0 eller 0.01 – 1.0 Defined in:

T E K N I S K T

V433-feature: minimal multiplikator for inte- posi
tion-LR’erne (skala, rotation, opacity, SH) i „exten
ded phase” — altså: efter T50  er nået, og position-
LR er allerede vid T4 . Om 0.1, cosine-decayes 
skala/rotation/ opacity/SH for deres del fra 1.0 (= 
deres standard-LR) til 0.1× av deres standard. Om 
0.0 (default), förblir de konstante. V457 testede 
fuldt decay (0.0 = decay-til-nul) mod intet-decay og 
fandt: avg 0.0400 (2 runs) = samme loss som V438 
uden decay. Adfærd renere med decay, men inte 
målbart bedre. Derfor disabled. Forbliver i CLI som 
--nonpos-lr-scale F.

KO R T  S AG T

I den sene refinement-fase också 
gøre farve- og form-inlärnings­
hastigheter mindre. Gör træning­
en „stabilere”, men empirisk inte 
bedre. Fra.

T52 adaptiveDensifyThreshold

D E TA L J E R

Default: false Range: boolean Defined in:

T E K N I S K T

V440-eksperimental: om true, beregner appen i 
hvert densification-skridt p98 av den aktuelle gradi
ent-fordeling og bruger det som dynamisk tærskel 
(klampet til mindst 0.5× av den konfigurerede värde 
fra T11 , så det inte skejser for langt ud). Hypotese: 
automatisk tilpasning til aktuel scen-fase ville gøre 
density-control mere robust — f.eks. strengere pru
ning i starten, slappere senere, eller omvendt. V440 
testede og reverterede: katastrofalt fald til 63 K 
gaussians (mass-pruning, fordi p98 i de første itera
tioner er ekstremt højt, og så overskrider næsten 
intet tærsklen). Den faste tærskel er allerede godt 
kalibreret, dynamisk tilpasning skader mere end den 
gavner. Q5 (T77) tilbyder en alternativ adaptiv logik 
via rolling median, der omgår problemet.

KO R T  S AG T

Adaptiv version av densify-
tærsklen. I tests katastrofal 
(splat-antallet styrtdykkede til 
63K). Fra. Q5 har en bedre vari­
ant av det.
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T53 mergeAfterDensification

D E TA L J E R

Default: false (initializer), true ( .full , 
.classicBalanced , .fullClassicPaper ) Range: 

boolean Defined in:

T E K N I S K T

V438-feature: vid slutningen av densification-fasen 
(iter T2 ) udføres et engangs-merge-pass, der 
sammenfatter nærtliggende gaussians med lignen
de skala og farve. Reducerer gaussian-antallet med 
typiskt 5–15 % uden synligt kvalitetstab. Mening: 
efter intensiv kloning opstår klynger av kvasi- iden
tiske gaussians, der inte bidrager med något nyt 
— merging frigør optimizer-kapacitet til andre områ
der. Standard i Classic-quality-presets. Bruges inte 
vid MCMC, fordi MCMC via sin relocation-logik slet 
inte lader sådanne klynger opstå.

KO R T  S AG T

I slutningen av splat-mangfol­
diggørelses-fasen sammenfattes 
kloner, der er næsten iden­
tiske. Reducerer datamængde 
uden synlig effekt. Som standard 
tændt i Quality- preset.

T54 densifyPhase2FromIteration

D E TA L J E R

Default: 0 (= deaktiveret) Range: 0 eller T2  – T1  
Defined in:

T E K N I S K T

V426-eksperimental: muliggør en anden densifica
tion-fase, der efter refinement-pausen starter vid 
denna iteration og kører til T55 . Hypotese: efter en 
refinement-fase har gradient-akkumulatorerne sta
bilere magnitudes og kan mere præcist sige, vilka 
områder der stadig har brug for yderligere gaussi
ans. V426 testede og reverterede: two-phase den
sification faldt i 0-gaussians-cascade-failure (kom
bineret med V425 refinement-pruning ødelagde det 
bufferen). Disabled. CLI-flag tilgængelig til experi
ment.

KO R T  S AG T

Anden mangfoldiggørelses-run­
de efter pause. Har udryddet 
splat-beholdningen i tests. Fra.
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T55 densifyPhase2UntilIteration

D E TA L J E R

Default: 0 Range: 0 eller T54  – T1  Defined in:

T E K N I S K T

Slutning av V426-two-phase-densification. Kun re
levant om T54 > 0 . Begge felter sammen disabled.

KO R T  S AG T

Slutning av anden mangfoldiggø­
relses-runde (se T54). Begge fra.

Post-processing + Apple AI (T56–T60)

T56 postTrainingCompactification

D E TA L J E R

Default: true (i alle production-presets), false 
( .quickTest , .preview ) Range: boolean Defined 
in:

T E K N I S K T

V443-feature: efter träningsslut fjernes gaussi
ans med sigmoid(opacity) < 0.01 hårdt (de bi
drager praktisk talt inte længere til bilden). Re
ducerer gaussian-count med typiskt 58 % og 
eksport-filstørrelse med 55 % uden synligt kvali
tetstab. Som standard aktiv i production-presets 
— slutresultatet ska kunde leveres så kompakt 
som muligt. I .quickTest  fra, fordi en diagno
se-kørsel ändå inte eksporteres. I modsætning 
til T42 midTrainingCompactificationIterations 
(V549) hittar compactificationen først sted vid slut
ningen — refinement kan tills da bruge alle gaussi
ans.

KO R T  S AG T

Opryddning efter træningen: 
næsten usynlige splats fjernes. 
Gör eksport-filen ca. halvt så stor 
uden kvalitetstab. Pligt-feature, 
lad fra kun i diagnose-kørsler.
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T57 metalFXUpscaling

D E TA L J E R

Default: false Range: boolean Defined in:

T E K N I S K T

V444-feature: aktiverer Apples MetalFX spatial 
upscaler i stedet for bilineær interpolation i 3D-
viewer-output. Om træningsopløsning < viewport-
størrelse (f.eks. träning på 0.5×, viewport-visning 
i fuld upplösning), kan MetalFX levere et mar
kant skarpere bild. Ændrer sig live i viewpor
ten, ingen genoptræning nødvendig. Udelukker T58 
mpsLanczosScaling — MetalFX har forrang. Anbe
faling: tænd, om bilden i vieweren virker „udvasket” 
sammenlignet med den forventede detalje.

KO R T  S AG T

Apple-ML-baserat bild-skarpning 
i 3D- vieweren. Hjælper, om du 
har tränat i lavere upplösning og 
visar resultatet i fuld skærm. Li­
ve-toggle, prøv.

T58 mpsLanczosScaling

D E TA L J E R

Default: false Range: boolean Defined in:

T E K N I S K T

V444-feature: MPSImageLanczosScale til viewport- 
skalering i stedet for bilineær interpolation. Lanczos 
är en klassisk sinc-baserat resampling-metode, der 
leverer markant skarpere resultater end bilineær 
med minimal overhead. Live- toggle. Overskrives av 
T57 , om begge er tændt.

KO R T  S AG T

Klassisk skarpningsmetode til 
3D-vieweren (Lanczos). MetalFX 
(T57) er ML-baserat og som regel 
bedre; Lanczos er et mindre ag­
gressivt alternativ.
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T59 livePreviewInterval

D E TA L J E R

Default: 50 (initializer og de fleste presets) Range: 
0 (off) eller 10 – 5 000 Defined in:

T E K N I S K T

Hvor ofte under træningen 3D-vieweren opdateres 
med de aktuelle gaussians. 50 = hver 50 iterationer 
et nyt render i vieweren — godt nok til at iagttage 
fremskridt uden at sinke træningen. 0 = vieweren 
opdateres slet inte (baggrunds- träning, max has
tighed). Typisk tilpasning: vid .quickTest  ned til 
10 (man vil se hvert skridt), vid lange MCMC-kørsler 
op til 500–2000 (update-overhead i sum mærkbar).

KO R T  S AG T

Hvor ofte 3D-forhåndsvisningen 
opdateres under træningen. 50 
= hver 50 iterationer. Højere = 
sjældnere = lidt snabbare, men 
du ser sjældnere fremskridt. 0 = 
ingen forhåndsvisning (for mak­
simal hastighed).

T60 perceptualLossWeight

D E TA L J E R

Default: 0.0 (= deaktiveret) Range: 0 eller 0.001 – 
0.5 Defined in:

T E K N I S K T

V444-future-feature: vægt av en perceptuel loss-
term via MPSGraph (VGG-lignende lille netværk). 
Ville fange strukturel og teksturel lighed på et 
højere semantisk niveau end L1+SSIM — typiskt 
i forsknings-pipelines, hvor „pixel- perfect” er 
mindre viktigt end „ser realistisk ud”. Implemen
tering stadig udestående (kode-stub finns, men 
forward- pass inte implementeret). Default 0.0. For
bliver i feltkataloget til fremtidig aktivering; CLI-flag 
--percep-weight F  reserveret.

KO R T  S AG T

Planlagt feature, der med AI-
hjælp tilstræber „naturligt udse­
ende” i stedet for „pixel-præcis”. 
Endnu inte færdigimplemente­
ret.
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MCMC-densification (T61–T73)

T61 densificationStrategy

D E TA L J E R

Default: .classic  (initializer + Classic-presets), 
.mcmc  (alle MCMC-presets + scen-class) Range: 
.classic  eller .mcmc  Defined in:

T E K N I S K T

Vælger mellan Classic-densification (klon/split/ pru
ne, Kerbl et al. 2023) og MCMC-densification 
(stochastic gradient Langevin dynamics med re
location, Kheradmand et al. NeurIPS 2024). 
Vid .classic  evalueres T11–T16 , vid .mcmc  
T62–T73 . Forsigtighed vid skift: Classic-defaults og 

MCMC- defaults er totalt anderledes kalibreret — 
den, der flipper vælgeren i Expert View uden at 
indlæse en passende preset, risikerer 1.4.3-bug-stil 
mass-extinction (460 K → 5 i en iteration, fordi 
MCMC-OpacityReg på 0.01 dræber Classic- opa
cities). Derfor er MCMC-init-defaults bevidst „blød
gjorte” (alle reg-värden 0.0).

KO R T  S AG T

Hvilken algoritme der bruges til 
at mangfoldiggøre splats. Clas­
sic = oprindelig metode (snabbt, 
mange splats). MCMC = nye­
re metode (långsammare, langt 
færre splats, til gengæld mere 
kompakt). Presets vælger den 
rigtige. Selv kun omstille, om 
du också indlæser den passende 
preset (P5–P7 eller P8–P10).
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T62 mcmcMaxGaussians

D E TA L J E R

Default: 150 000 (initializer + .fullMCMC  + 
.mcmcBalanced ), 100 000 ( .mcmcPreview ), 1 

500 000 ( .fullMCMCMip  — Mip-splatting-variant 
med 10× budget), 1.19 M ( .renderPreset ), 1.25 
M ( .outdoorPreset ), 670 K ( .indoorPreset ) 
Range: 0 (= „brug buffer-kapacitet”) eller 10 000 – 
5 000 000 Defined in:

T E K N I S K T

Hård overgrænse for antallet av gaussians vid 
MCMC-strategi. Antallet vokser gradvist med 
T70 mcmcGrowthRate  (typiskt 5 %) pr. relocation-

step op til detta cap. V473/V531 fandt 150 K 
som sweet spot — over 200 K udvander splat- 
kvaliteten (for mange små, overflødige gaussians), 
under 100 K förblir scenen under-densificeret. Vid 
meget store scener (f.eks. 1 545-foto-droneflyvning 
med 158 K SfM-init) er 150 K for lavt — där
för 1.4.5-udvidelsen T72 mcmcCapMultiplier + T73 
mcmcAutoScaleByScene. Q7-BayesOpt fandt scen-
specifikke optima mellan 670 K (Indoor) og 1.25 M 
(Outdoor). Vid värde 0 bruger engine den fulde buf
fer-kapacitet som cap.

KO R T  S AG T

Maksimum antal splats vid 
MCMC. 150 000 er standarden og 
rækker til de fleste scener. Out­
door- og render- presets (P8, P9) 
går op til 1+ million for mere de­
talje-rige scener. At sætte op kan 
bringe detalje, koster minne; ned 
er snarere en nødbremse.

T63 mcmcNoiseScale

D E TA L J E R

Default: 0.00005 (5e-5 = paper-default) Range: 
1e-6 – 1e-3 Defined in:

T E K N I S K T

Multiplikator for det gaussiske støj, der i hver 
MCMC-iteration adderes til positionen av hver 
gaussian (SGLD- logik). Højere = mere eksplo
ration (gaussians vandrer mere, hittar potentielt 
bedre pladser), lavere = mere udnyttelse (gaussi
ans förblir, hvor de allerede er gode). V467 og 
V536 bekræftede 5e-5 som optimal — 1e-5/2e-5 
for lidt eksploration, 1e-4 for meget (splats lø
ber ud). Cosine-decayes over træningstiden til T69 
mcmcNoiseDecayEnd — vid slutningen av decay-om
rådet er støj reelt 0, og gaussians konvergerer.

KO R T  S AG T

Hvor meget tilfældigt „wackeln” 
appen tillader splats, så de selv 
hittar den bedste plats. Stan­
dardværdien er optimalt testet. 
Om du skruer det op, blir splats 
urolige.
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T64 mcmcOpacityRegWeight

D E TA L J E R

Default: 0.0 (= deaktiveret i RadianceKit defaults, 
paper: 0.01) Range: 0 eller 0.001 – 0.05 Defined in:

T E K N I S K T

MCMC-specifik L1-penalty på opacity. Paper-default 
0.01 (trykker ubrugte gaussians mod nul, gör dem 
tilgængelige for relocation). V464b viste dock: uden 
reg är det målbart bedre i RadianceKit (session 
28 bekræftet). Grund: pruning-kriteriet defineret 
med T68 mcmcDeadOpacityThreshold rækker alene — 
en yderligere L1-penalty tvinger också værdifulde, 
lav-opacity- gaussians til at dø. Derfor default 0. 
Advarsel: i 1.4.3-beta-build var initializer-default’en 
fejlagtigt 0.01, vilket resulterede i mass-extinction-
bug’en (se T61-forklaring); siden 1.4.4 fastsat på 
0.0.

KO R T  S AG T

MCMC-specialregularisering. Fra, 
fordi den anden MCMC-mekanis­
me (tærskel i T68) allerede dæk­
ker det. Lad stå på 0.

T65 mcmcScaleRegWeight

D E TA L J E R

Default: 0.0 (= deaktiveret, paper: 0.01) Range: 0 
eller 0.001 – 0.05 Defined in:

T E K N I S K T

MCMC-specifik L1-penalty på skala-egenværdier. 
Paper-default 0.01. V464b: uden reg bedre, samme 
begrundelse som T64. Disabled i alle RadianceKit-
MCMC-presets. Advarsel som vid T64: 1.4.3-bug.

KO R T  S AG T

Som T64, men for splat-størrelse. 
Fra.
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T66 mcmcRelocationInterval

D E TA L J E R

Default: 100 (initializer + alle MCMC-presets, pa
per-standard), 155 (P9 Outdoor — Q7-BayesOpt-
optimum) Range: 50 – 500 Defined in:

T E K N I S K T

Iterations-interval, hvor MCMC reloacerer dø
de gaussians (sigmoid(opacity) < T68 
mcmcDeadOpacityThreshold) til nye positioner. V537 
testede 50 (for forstyrrende, loss svinger) og 200 
(marginalt dårligere, MCMC mister reaktionsevne). 
100 er optimal. Q7-BayesOpt på Bicycle fandt 155 
som scen- specifikt optimum for outdoor — de let 
længere intervaller giver Adam mere tid til at inte
grere nyplacerede gaussians, före nästa reloc-event 
sætter dem under pres.

KO R T  S AG T

Hver hvor mange iterationer 
MCMC flytter de døde splats et 
andet sted hen. 100 er standard. 
Du behöver inte dreje selv — 
Outdoor-preset har allerede den 
optimale värde.

T67 mcmcWarmupIterations

D E TA L J E R

Default: 500 Range: 100 – 5 000 Defined in:

T E K N I S K T

Antal initial-iterationer, hvor ingen MCMC- reloca
tion endnu sker. Først efter denna warmup begyn
der reloc- logikken. Mening: i de første iterationer er 
opacity-værdierne endnu inte afbalancerede — om 
der startedes direkte med reloc, ville gaussians bli 
placeret de forkerte steder og straks skulle flyttes 
igen, vilket ødelægger Adam-momentum. Paper-de
fault 500. RadianceKit overtager denna värde, fordi 
V464b viste, at den er robust.

KO R T  S AG T

Hvor mange iterationer MCMC 
først „lander”, före det begynder 
at omplacere splats. 500 er stan­
dard og passer.
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T68 mcmcDeadOpacityThreshold

D E TA L J E R

Default: 0.005 (initializer, paper-standard), 0.01 
( .fullMCMC  og alle MCMC-presets — V535-opti
mum) Range: 0.001 – 0.05 Defined in:

T E K N I S K T

sigmoid(opacity)-tærskel, under vilken en gaussian 
regnes som „død” og kommer i betragtning til re
location. V535 fandt 0.01 som optimal (0.005 margi
nal, 0.02 dårligere). Højere = mere aggressiv reloc 
(flere gaussians flyttes), lavere = mere forsigtig. 
0.01 svarer ca. til „0.5 % visuel synlighed”. P10 Indo
or bruger via Q7-BayesOpt 0.0142 som optimum.

KO R T  S AG T

Fra vilken gennemsigtighed et 
splat regnes som „dødt”, så 
MCMC flytter det et andet sted 
hen. 0.01 er optimal i vores tests. 
Du behöver inte dreje selv.

T69 mcmcNoiseDecayEnd

D E TA L J E R

Default: 0 (initializer = „ingen decay”), 160 
000 ( .fullMCMC  = 80 % av 200K), 96 000 
( .mcmcBalanced  = 80 % av 120K), 40 000 
( .mcmcPreview ) Range: 0 eller 1 000 – Defined in:

T E K N I S K T

Iteration, hvor T63 mcmcNoiseScale -støj dæmpes 
fuldstændigt til nul (cosine-decay fra iter 0 til her). 
V497c/V502 fandt 80 % av maxIterations optimal 
— giver MCMC nok eksplorations-tid, men lader de 
sista 20 % gå til konvergens uden støj. 0 = konstant 
støj over alle iterationer (sjældent meningsfuldt, 
MCMC kan så inte konvergere).

KO R T  S AG T

Hvornår det tilfældige „wackeln” 
av splats holder op. I MCMC-pre­
sets vid 80 % av samlede itera­
tioner — først eksploration, så 
konvergens. Lad værdien stå.
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T70 mcmcGrowthRate

D E TA L J E R

Default: 0.05 (paper-standard = 5 %) Range: 0.01 – 
0.2 Defined in:

T E K N I S K T

Vækstrate av MCMC-populations-targetet pr. 
relocation-step. Logikken: vid hver reloc-
event øges mål-populations-størrelsen med 
(1 + growthRate) , tills T62 mcmcMaxGaussians (el

ler den per T72/​T73 skalerede variant) er nået. 
V512/V522 fandt 0.05 som optimal — højere värden 
fører til for snabb vækst (gaussians indsættes, före 
Adam-momentum kan integrere dem), lavere til un
der-densificerede scener til sidst.

KO R T  S AG T

Hvor snabbt splat-antallet vid 
MCMC vokser. 5 % pr. skridt er 
optimal. Lad værdien stå.

T71 mcmcSigmoidK

D E TA L J E R

Default: 100.0 Range: 10.0 – 500.0 Defined in:

T E K N I S K T

Sigmoid-sharpness-parameter for MCMC-noise- at
tenuation. I SGLD-skridtet dæmpes per-gaussian-
støjen med — højt-opake gaussians (om logit er po
sitiv) får eksponentielt mindre støj end lavt-opake. K 
= 100 er skarp, sprich overgangen fra „fuld-noise” 
til „ingen-noise” sker meget snabbt omkring opacity 
0.5. V484–V487 fandt K = 100 optimal — mindre 
värden (10–50) lader också højt-opake gaussians 
wackle med (ødelægger konvergerede gaussians), 
større (> 500) gör overgangen kunstigt hård, og 
døde gaussians flyttes slet inte mere.

KO R T  S AG T

Specialparameter, der bestem­
mer, hvor skarpt MCMC adskiller 
mellan „gennemsigtig nok til at 
flytte” og „solid, rør inte”. Stan­
dardværdien er optimal. Inte dre­
je på.
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T72 mcmcCapMultiplier

D E TA L J E R

Default: 3.0 (initializer + .fullMCMC ), 2.0 
( .mcmcPreview ), 2.5 ( .mcmcBalanced ), 2.98 (P8 
Render), 5.32 (P9 Outdoor), 1.76 (P10 Indoor) 
Range: 0 (= deaktiveret) eller 1.0 – 10.0 Defined in:

T E K N I S K T

1.4.5-feature: scen-adaptiv cap-skalering. Om T73 
mcmcAutoScaleByScene true, beregnes det effektive 
cap som (klampet til buffer-kapacitet). Baggrund: 
vid store scener (f.eks. 1 545-foto-droneflyvning → 
158 K SfM-init) er T62 = 150 000  for lavt — densi
ty-control ville slet inte kunde vokse. Med multiplier 
3.0 skaleres cap’et i detta exempel til 474 K (158 K 
× 3.0). Q7-BayesOpt fandt scen- specifikke optima: 
outdoor profiterer av høj multiplier (5.32 → ~830 
K cap vid 156 K bicycle-init), indoor nøjes med 
1.76 (vægge mætter snabbare). Fuld upplösning av 
cap’et se -metoden.

KO R T  S AG T

Multiplikator, der tilpasser splat-
cap’et automatisk til scen-stør­
relsen. Stor scen = flere start­
punkter = højere cap. Standard 
3× passer til de fleste scener; 
Outdoor-preset går op til 5× 
(store dybde-områder), Indoor til 
1.76× (vægge begrænser ändå).

T73 mcmcAutoScaleByScene

D E TA L J E R

Default: true (initializer + alle MCMC-presets) 
Range: boolean Defined in:

T E K N I S K T

1.4.5-feature: master-switch for scen-aware cap- 
logikken (se T72 +). Om false, bruges udelukkende 
T62 mcmcMaxGaussians som cap (tilbage til 1.4.4-ad
færd). Som standard tændt, fordi mass-extinction-
problemerne vid store scener fra 1.4.3 annars kom
mer tilbage. Manuelt deaktivere kun, om du eksplicit 
vil sætte et hårdt cap — f.eks. for at träna en 150 K-
variant, om slutstørrelse kan planlægges.

KO R T  S AG T

Slår automatisk tilpasning av 
splat-cap’et til scen-størrelsen 
til. Som standard tændt. Lad fra 
kun, om du selv vil have nøjagtigt 
et bestemt splat-antal.

Mip-splatting (Q1.5) (T74–T76)

Status: Q1.5 blev 2026-05-25 efter 14 autonome iterationer
1. overnight-1.5M-confidence-check kasseret som „closed no-win”
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(max Δ@2× = +0.27 dB, original-gate krævede ≥ +1.5 dB middelværdi over 0.5×/2×, 
FAILT på 0/11 pair-scenes). Felterne förblir opt-in til forskningseksperimenter; alle 
production- presets har. Se verdict: docs/​plans/​2026-05-25-phase-q1.5-final-
verdict.md.

T74 useMipSplatting

D E TA L J E R

Default: false (alle production-presets), true 
( .fullMCMCMip  — forsknings-sibling) Range: boo
lean Defined in:

T E K N I S K T

Aktiverer Mip-splatting (Yu et al. CVPR 2024): 
3D-smoothing-filter + 2D-filter + α-kompensation, 
der begrænser per-gaussian-frekvensen til Nyquist-
grænsen av den tætteste træningskamera-samp
lingsrate. Teoretisk mål: eliminering av aliasing vid 
rendering i off-training-skalaer (0.5× eller 2× av 
træningsopløsningen). Aktiveret i preprocess- og 
backward- projection-shaderne, funktionelt korrekt 
verificeret i Q1.5-D- test. Men: det originale ac
ceptance-gate (Δ@1× ≥ +0.3 dB OG avg(Δ@0.5×, 
Δ@2×) ≥ +1.5 dB) blev inte nået på någon av de 
11 pair-scenes. Maksimalt observeret: family 750K 
classic Δ@2× = +0.270 dB. Outdoor-scener (Truck, 
Flowers) viste endda forværring 1× og 0.5×. Hypote
se: 3D-smoothing konkurrerer med MCMC-reloca
tion vid high-Gs. Feltet förblir til fremtidig multi-
scale-re-eval med korrekt Mip-NeRF-360-metodo
logi (se O3-backlog i benchmark-stien).

KO R T  S AG T

Aliasing-filter fra et 2024-paper. 
Teoretisk fedt, praktisk har det 
intet givet i vores tests og någ­
ra gange endda skadet. Forbliver 
tilgængelig for eksperimentører, 
men vi rekommenderar det inte. 
Lad fra.
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T75 mipSmoothing3DScale

D E TA L J E R

Default: 0.2 (paper-default) Range: 0.05 – 1.0 De­
fined in:

T E K N I S K T

3D-smoothing-skala-parameter (Yu et al. §3.3, pa
per- default 0.2). Større = mere world-space-
udjævning pr. gaussian (= mere anti-aliasing, men 
också mere blur i default-skalaen), mindre = skarpe
re, men mere modtagelig for aliasing. Konsulteres 
kun, om T74 useMipSplatting = true. I Q1.5-tests 
inte yderligere optimeret — A/B-gate’en havde alle
rede tabt med paper-default 0.2, yderligere sweeps 
ville være nytteløse.

KO R T  S AG T

. Om du inte har tændt Mip, irre­
levant.

T76 mipFilter2DVariance

D E TA L J E R

Default: 0.3 (= præcis V242-legacy-adfærd) 
Range: 0.1 – 1.0 Defined in:

T E K N I S K T

2D-Mip-filter-varians, der adderes til Σ_2D- diago
nalen (varians direkte, inte kvadreret). 0.3 er præcis 
V242-legacy-værdien, der före Mip-splatting var 
hardkodet i kerneler. Om T74 useMipSplatting = 
false, ignorerer kernel denna värde fuldstændigt og 
skriver det hardkodede 0.3 — så baselinen inte kan 
regredere (Codex-round-1-S3-1-garanti). Om, bru
ges den her satte värde. Forbliver i feltkataloget til 
Mip-sweeps.

KO R T  S AG T

Yderligere Mip-splatting-para­
meter. Vid Mip-fra: irrelevant.
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Adaptive densification (Q5) (T77–T79)

T77 adaptiveDensification

D E TA L J E R

Default: false Range: boolean Defined in:

T E K N I S K T

Q5-feature: rolling-median-tracker som alterna
tiv til faste T11 densifyGradThreshold. Om 
true, overskrives den aktuelle tærskel i hvert 
densify-step med median(seneste N avgGrad-
samples) × T79 adaptiveDensifyMultiplier. N 
= T78 adaptiveWindow . Strengere end V440 p98 
(den katastrofale 63 K-pruning-fælde), median + 
2× sidder omtrent vid p70–p80 av gradient-for
delingen i steady state. Q5-tests: alenestående 
FAIL 0/3 scener, men sammen med Q6 (se T80/
T81) PASS 1/3 scener — bundtet Q5+Q6 blev 
2026-05-25 godkendt som opt-in og aktiveres via 
CLI --adaptive-densify . Q6 er her „carrier” av 
kvalitetsgevinsten, Q5 bidrager snarere til stabilitet.

KO R T  S AG T

Selvlærende densify-tærskel. I 
stedet for en fast indstillet 
følsomhed tilpasser appen sig 
scenen. Alene testet inte bedre, 
sammen med curriculum’et fra 
Q6 dock ja. Tænd begge sammen, 
eller begge fra.

T78 adaptiveWindow

D E TA L J E R

Default: 1 000 Range: 100 – 10 000 Defined in:

T E K N I S K T

Rolling-median-vindue i densification-events (IKKE 
iterationer — hvert T13 densifyInterval-step leve
rer et sample). Default 1 000 — betyder vid, at 
de senaste 100 000 tränings-iterationer bidrager 
til medianen, altså typiskt hele træningshistorikken 
tills her. Tidlig fase (före T78  samples): tracker 
returnerer nil → fallback på fast tærskel T11 . Kun 
relevant om.

KO R T  S AG T

Hvor mange gamle densify-skridt 
der indgår i medianen for T77. 
Standard 1000 er god. Kun rele­
vant om Q5- adaptive tændt.
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T79 adaptiveDensifyMultiplier

D E TA L J E R

Default: 2.0 Range: 1.0 – 4.0 Defined in:

T E K N I S K T

Multiplikator på rolling-median for den adaptive 
tærskel. Default 2.0 svarer ca. til p70–p80 av den 
typiske gradient-fordeling. Lavere = mere aggressiv 
vækst (flere kloner), højere = strengere (færre klo
ner). Q5-tests i range 1.5–3.0 — 2.0 bedste default. 
Kun relevant om.

KO R T  S AG T

Faktor for T77/T78. Standard 2.0 
= strengere end typiskt median. 
Inte dreje på.

Curriculum (Q6) (T80–T81)

T80 curriculumResolutionRamp

D E TA L J E R

Default: false Range: boolean Defined in:

T E K N I S K T

Q6-feature: tränings-upplösning starter vid 0.5× og 
skifter vid T50 positionLRScheduleEndIteration /​ 
2 (eller T1 maxIterations /​ 2, om T50 inte er 
sat) til T22 trainingRenderScale. Bruger den i 
Q1.5.1 udviklede resize/​restoreImageBuffers-infra
struktur. Overskriver T23 resolutionWarmupScale, 
om aktiveret. Q6 er godkendt som „carrier av kvali
tetsgevinsten” i Q5+Q6-bundtet (se T77) — den 
trinvise opløsningsforøgelse giver appen tid til at 
hitta grov geometri på den lavere upplösning, före 
den går over til det fine detalje-arbejde. Via CLI: --
curriculum-resolution.

KO R T  S AG T

„Først grov, så fin” for trænings­
opløsningen. Halv upplösning i 
første halvdel, så fuld upplös­
ning. Hjælper i visse scener, i 
andre inte — bedst tændt sam­
men med T81.
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T81 curriculumSHProgression

D E TA L J E R

Default: false Range: boolean Defined in:

T E K N I S K T

Q6-feature: 
overskriver T21 shDegreeUpgradeIterations med 
[maxIter/​4, maxIter/​2, maxIter*3/​4], fordeler alt
så SH- optrapningerne jævnt over træningstiden 
i stedet for at front- loade dem. Hypotese: sta
bil geometri etableres före color-detail- eksplosion, 
vilket positionerer view-direction-afhængige glans- 
effekter mere præcist. Q5+Q6 sammen PASS 1/3 
scener, Q6 som carrier av gevinsten (Q5 alene 
FAIL). Via CLI: --curriculum-sh .

KO R T  S AG T

„Først form, så farve” — glans-
effekterne frigives først sent i 
træningen, så splats først hittar 
deres position og størrelse. Kan 
tændes sammen med T80; alene 
bringer det inte helt så meget.

Statiska presets (TP1–TP9)

Her kun de strukturelle skillnader til initializer-default’en. Den fulde marketing-beskri
velse av de elva UI-presets P1–P11 hittar du i kapitel 7.

TP1 .preview

D E TA L J E R

Diagnose-/forhåndsvisnings-preset til systemer ≥ 
10 GB RAM. Overrides i forhold til initializer: - 30 
000 → 5 000 - 15 000 → 3 500 (70 % av maxIter) 
- 1.6e-6 → 1.6e-5 (10× højere, mindre aggressiv 
decay) -,,,, hver 2× (V176) - 3 000 → 100 000 
(reelt fra, V172: reset ødelægger korte træninger) 
- [1K, 2K, 3K]  → [1K, 2K]  (V182: degree 3 kon
vergerer inte i 2K iter) - 1.0 → 0.5

KO R T  S AG T

enhver vilkårlig initial vurdering 
av en nyligt importeret bild-se­
rie — 2–3 min ventetid, därefter 
rækker resultatet til et binært 
spørgsmål „er Quality-kørsel det 
værd?”.
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TP2 .full

D E TA L J E R

Production-Quality Classic. Overrides: - 30 000 → 
35 000 (V550: 40K-tests Truck-overtraining +10.7 
% Gs vid −1.3 % L1) - 15 000 → 5 000 (V310 
sweet spot, V338 7K worse) - Alle LR’er 2× (V188) 
- 1.6e-6 → 1.6e-5 (V45 10×) - 2e-6 → 1.1e-6 (V335) 
- 100 → 200 (V112) - 0.005 → 0.001 (V393) - 3 
000 → 100 000 (V194 disabled, V421 confirmed) - 
[1K, 2K, 3K]  → [2K, 5K, 8K]  (V228 delayed) - 

0.0 → 0.9995 (V546 HTGS, 14 % forbedring) - 50 
(uændret, V546) - false → true (V438) - 0 → 20 
000 (V431) - true (V443, allerede initializer-default 
for .full )

KO R T  S AG T

enhver standard-foto-optagelse 
(objekt, lille rum, skulptur) med 
< 500 bilder. Den i V546 annon­
cerede 14 % loss- forbedring i 
forhold til V438 blev 3-trial-gen­
nemsnit bekræftet på Horse Full.

TP3 .fullClassicPaper

D E TA L J E R

Q1.5-A-test-sibling av TP2, paper-tro Classic. Over
rides i forhold til TP2: - 35 000 → 30 000 (paper-
standard) - 5 000 → 15 000 (paper: 50 % av maxI
ter) - 1.6e-5 → 1.6e-6 (paper-default) -,, tilbage til 
paper defaults (0.05, 0.005, 0.001) - 1.1e-6 → 2e-7 
(kalibreret for ~1-2M Gs på Bicycle) - 200 → 100 
(paper) - 0.001 → 0.005 (paper-default) - 100 000 
→ 3 000 (paper §5.2, risikabelt — kan udløse V194- 
regression) - 0.9995 → 0.0 (paper har ingen decay)
• 20 000 → 30 000 (cosine kører til 100 % av max

Iter)

KO R T  S AG T

Q1.5-forskningseksperimenter, 
der har brug for paper-magni­
tude-gaussian-budgetter (1–2 M) 
til Mip-splatting- tests. Efter 
Q1.5-„closed no-win”-verdict för­
blir presetet tilgængeligt for ad­
vanced users, men er inte pro­
duction-rekommenderat.
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TP4 .fullMCMC

D E TA L J E R

Production-Quality MCMC. Overrides i forhold til 
initializer:
• 30 000 → 200 000 (V534, MCMC har brug for 5× 

flere iter

end Classic) - 15 000 → 160 000 (V504b 80 % 
av maxIter) - 1.6e-6 → 1.6e-5 - LR-schedule som 
TP2 (alle 2×) - 0.2 → 0.05 (V521b/V534: MCMC 
har brug for stærkere L1-signal) - [1K, 2K, 3K]  
→ [2K, 5K, 8K]  - .classic  → .mcmc  - 150 
000 (allerede i initializer, bekræftet i preset) - 5e-5 
(V467/V536 optimal) - 0.005 → 0.01 (V535 optimal) 
- 0 → 160 000 (80 % av maxIter, V497c/V502) - 
3.0 (allerede i initializer) - true (allerede i initializer) 
- 3 000 → 200 000 (reelt fra, MCMC bruger reloc i 
stedet for reset)

KO R T  S AG T

Web-levering, object-captures 
med detalje-krav, droneflyvning­
er (också när P9 Outdoor er end­
nu bedre). 71 % færre gaussians 
end Classic vid sammenlignelig 
L1.

TP5 .fullMCMCMip

D E TA L J E R

Q1.5-D-test-sibling av TP4, med Mip-splatting + pa
per- magnitude-MCMC-budget. Overrides i forhold 
til TP4:
• mcmcMaxGaussians 150 000 → 1 500 000 (10×, 

paper-magnitude)
• useMipSplatting false → true (Mip-on)

KO R T  S AG T

Alle andre felter identiske med 
TP4. Q1.5 D-PASS på Bicycle 
2026-05-24 (bryder 12-iter-mul­
ti-scale-FAIL-streak). Q1.5-slut­
dom 2026-05-25 ändå closed-
no-win — Mip-splatting- gevinst 
inte reproducerbar over 11 pair-
scenes. Preset förblir opt-in.

TP6 .classicBalanced

D E TA L J E R

Mid-tier Classic. Overrides i forhold til TP2: - 35 
000 → 20 000 (V149: 20K = 30K vid 33 % mindre 
tid) - 20 000 → 0 (cosine kører til maxIter = 20K, 
ingen extended phase)

KO R T  S AG T

Standardtilfælde med kortere 
ventetid. V149 identificeret som 
sweet spot.
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TP7 .mcmcPreview

D E TA L J E R

MCMC-diagnose. Overrides i forhold til TP4: - 200 
000 → 60 000 (V494b) - 160 000 → 48 000 (80 
%) - 150 000 → 100 000 (V473b) - 160 000 → 40 
000 (V494b) - 3.0 → 2.0 (1.4.5: preview = lighter 
scaling)

KO R T  S AG T

snabbt se et MCMC-resultat for 
at vurdere, om TP4 eller en scen-
class-preset är det værd.

TP8 .mcmcBalanced

D E TA L J E R

Mid-tier MCMC. Overrides i forhold til TP4: - 200 
000 → 120 000 (V518) - 160 000 → 96 000 (80 %) 
- 160 000 → 96 000 (80 %) - 3.0 → 2.5 (mellan 
Preview 2.0 og Full 3.0)

KO R T  S AG T

MCMC uden den fulde 200K-
kørsel. ~120 K iterationer er et 
godt kompromis mellan kvalitet 
og ventetid.

TP9 .quickTest

D E TA L J E R

Ren funktionstest. Overrides i forhold til initializer: - 
30 000 → 1 000 - 15 000 → 500 - 2e-6 → 4e-6 
(kalibreret for 0.25× upplösning) - 100 → 50 - 3 000 
→ 100 000 (fra, da alt for kort) - 1.0 → 0.25

KO R T  S AG T

Sanity-check „starter træningen 
overhovedet meningsfuldt?”. Va­
righed < 30 s på M3 Ultra. Ser 
garanteret plumret ud.

Metod:

Signatur: public func resolveMcmcMaxGaussians(initialPointCount: Int, 
bufferCapacity: Int) -> Int Defined in:

TEKNISK  Eneste source-of-truth for spørgsmålet „hvor mange gaussians måste 
MCMC maksimalt lade vokse?”. Beregnes ud fra tre input: det konfigurerede T62 
mcmcMaxGaussians (med mass-extinction-floor 150 000, om 0), (antal SfM- init-punkter) 
og (forhåndsallokeret gaussian- buffer-størrelse). Logik:

1. base = T62 > 0 ? T62: 150_​000 (mass-extinction-floor beskytter mod initializer-
default-bugs som 1.4.3-mass-extinction- hændelsen)

2. Om T73 mcmcAutoScaleByScene && initialPointCount > 0 && T72 
mcmcCapMultiplier > 0:
• scaled = max(base, ceil(initialPointCount × T72)) annars

3. Om bufferCapacity > 0 : return min(scaled, bufferCapacity)

4. Ellers return scaled
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Eksempel: Bicycle (Mip-NeRF 360, 194 foto-frames) → SfM-init ~156 K punk
ter, T62 = 150 000 , T72 = 5.32 , buffer-kapacitet 8 M. Resolved cap = min(8M, 
max(150K, ceil(156K × 5.32))) = min(8M, 830K) = 830 K. Det är det effektive vækst-
cap, som MCMC-relocation-logikken holder sig til.

KORT FORTALT  Beregner det reelle maksimum-splat-antal vid MCMC. Tager din inställ
ning, ser, hvor mange punkter din scen har i starten, og skalerer med multipliceren, om 
automatisk tilpasning er tændt. Sådan tilpasser cap’et sig scenen i stedet for at tvinge 
samme värde til en lille og en gigantisk scen. Du behöver inte selv kalde metoden — 
træningen bruger den internt.

Vilket fält till vad? (fusklapp)

Mål Felter at dreje på

Mere detalje i det 
fjerne

T62 mcmcMaxGaussians højt, T72 mcmcCapMultiplier 5+

Mere detalje gene
relt (Classic)

T1 maxIterations  højt (≤ 40K), T2 densifyUntilIteration ≤ 
14 % av T1

Reducere floaters i 
droneflyvninger

T43 frustumCullEnabled til, T20 skyMaskingEnabled til, 
T45 skyDomeEnabled  til

Pæn himmel i 
udendørs scener

T45 skyDomeEnabled  til, T47 skyDomeRadiusMultiplier 30–60

Mindre eksport-fil Strategi .mcmc  (T61), T56 postTrainingCompactification til, 
T62 mcmcMaxGaussians ≤ 200K

Hurtigere träning T22 trainingRenderScale 0.5, T1 maxIterations  halvere — 
men inte begge!

Bedre højlys T21 shDegreeUpgradeIterations med [2K, 5K, 8K]  (ingen ear
ly-front-load), MCMC + 200K iter

Holde Mac respon
siv

T25 throttleDelayMs 5–10 (koster ~15 % träningstid)

Live-forhåndsvis
ning oftere

T59 livePreviewInterval ned til 10–20

Blødere overgange 
vid skygger

T17 ssimWeight  lidt højt (0.15–0.25), men inte over 0.3

Holde indendørs 
rum kompakt

P10 Indoor-preset (, T72 = 1.76 )
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Farliga fält

Disse felter kan vid fejl-konfiguration føre til OOM, app-crash, mass-extinction av 
gaussians eller ubrugelige benchmark-data. Ska håndteres med forsigtighed:

• T11 densifyGradThreshold — en halvering kan generere 2–4× så mange 
gaussians, vilket snabbt sprænger GPU-lageret. Obs också: ska passe til T22 
trainingRenderScale (1.0× → 1e-6, 0.5× → 2e-6, 0.25× → 4e-6).

• T72 mcmcCapMultiplier — vid store scener med > 200 K SfM-init-punkter og multipli
er > 5 opstår et resolved-cap på millioner av gaussians. På 36-GB-RAM-Mac’er OOM 
muligt. Outdoor-preset 5.32 fungerer kun, fordi Mip-NeRF-360-Bicycle har 156 K init-
punkter → 830 K cap.

• T39 testViewIndices — manuel inställning kan gøre benchmarket ubrugeligt (alle 
indekser > N → ingen holdouts). Lad --benchmark -flaget sætte det.

• T64 mcmcOpacityRegWeight og T65 mcmcScaleRegWeight — i 1.4.3-beta sat til 0.01, 
vilket førte til mass-extinction (460 K → 5 gaussians på en iteration). Siden 1.4.4 
fastsat på 0.0, men manuel forhøjelse kan reproducere problemet.

• T15 opacityResetInterval — om inte 100 000+ (reelt fra) og træningen er kortere 
end 10 000 iterationer, ødelægger reset konvergensen. .preview  har det därför på 
100 000 trods maxIterations = 5 000.

• T54/​T55 densifyPhase2* — two-phase densification er i tests afsluttet i 0-gaussians-
cascade. Lad begge stå på 0.

• T74 useMipSplatting — Q1.5 closed-no-win 2026-05-25, kan endda försämra PSNR 
på några outdoor-scener. Default off, opt-in kun til forskning.

Om et felt står på denna liste, og du vil ændre det, så lav først en sikkerhedskopi 
av din nuværende preset (eksport som JSON), og overvej, om du kan måle resultatet 
reproducerbart — annars vid du bagefter inte, om du har fremkaldt en forbedring eller 
forværring.
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K A P I T E L

Kapitel 7 — Indbyggede kvalitets-
forudindstillinger

Figur 27:  Forudindstillingssektion med alle fire grupper foldet ud — CAPTURE CLASS 
(4 presets: Drone/Aerial, 360° Walkaround, 360° Walkaround (High Detail), Photo/Object), 
CLASSIC (5 presets: Quick/Preview/Balanced/Quality/Ultra Detail), MCMC (3 presets, be

mærkning „No threshold tuning”), HYBRID (1 preset: Balanced (Hybrid))

VAD BILDEN VISAR  Forudindstillingssektion i Inspector, alle fire grupper foldet ud. CAP
TURE CLASS med de fire kuraterede real-world-presets (Drone / Aerial, 360° Walka
round, 360° Walkaround (High Detail), Photo / Object) — det är den primære gruppe 
og i Simple Mode den eneste synlige. CLASSIC med Quick (1K iters), Preview (5K 
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iters, aktivt valg med blåt flueben), Balanced (20K iters), Quality (35K iters) og Ultra 
Detail (35K iters). MCMC med undertitel „No threshold tuning” — MCMC har inte brug 
for densify-until-tærskel: Preview (60K iters, 100K gaussians), Balanced (120K, 150K), 
Quality (200K, 150K). HYBRID med den nye Balanced (Hybrid) (20K iters, 150K gaussi
ans). Footer-action-row: Save…, Export…, Import…

En forudindstilling är en forberedt konfiguration til træningen. RadianceKit leveres 
med tretten indbyggede forudindstillinger i fire grupper: fire Capture-Class-presets 
(P9–P12) — kuraterede, mot rigtigt community-materiale per öje valideret opskrifter 
for virkelige optagelses-arter (drone, 360°-rundtur, foto-objekt) og den primære akse 
siden v1.6 —, fem Classic-presets (P1–P5: Quick/Preview/Balanced/Quality/Ultra Detail), 
tre MCMC-presets (P6–P8) og en Hybrid-preset (P13), som kombinerer Classic- og 
MCMC-strategierne. De tidligere „Scene-Class”-presets (Render/3D, Outdoor, Indoor, 
tunet mod Mip-NeRF-360- og NeRF-Blender-scener i fase Q7) blev trukket tilbage som 
synlig gruppe i v1.6 — den per öje mod rigtigt footage validerede Capture-Class är nu 
den primære akse; de Q7-tunede konfigurationer beholdes kun internt. Du väljer preset
sene i sidebaren under Presets eller i Simple Mode vid import. + -knapperne åbner 
dialoger til at oprette egne forudindstillinger vid siden av — de tretten indbyggede kan 
inte slettes, men gerne duplikeres.

I Expert-View visas forudindstillingerne grupperet efter optagelses-art og strategi (Cap
ture Class / Classic / MCMC / Hybrid). Ett klik på en post skriver den gemte trænings
konfiguration ind i den aktuelle tilstand. Det er inte et snapshot — om du därefter drejer 
på skydeknapper, ændres tilstanden, men selve presetet förblir uændret; en farvet 
bemærkning visar så „modified”.

Hvilken preset der är den rette hvornår, afhænger mest av scenetypen og hardwaren. 
De tre tabeloversigter sidst i kapitlet sammenfatter det.
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P1 — Quick

VA R

Inspector → Presets-sektion → gruppe „Classic” → 
post „Quick”. UUID-suffiks …001 .

T E K N I S K T

Diagnose-preset med 1 000 iterationer, klas
sisk (adaptiv) densification-strategi og en træ
ningsopløsnings-skalering på 0.25× (input-bilden 
formindskes til 25 % före træningen). Ska inte bru
ges til levering av en scen, men snabbt hitta ud 
af, om opsætningen (kamerapositioner, punktmoln, 
bild-serie) overhovedet visar meningsfuld bevægel
se i loss-værdierne. På en M3 Ultra typiskt under 
30 sekunder på 50–200 bilder. Den lille upplösning 
tilslører den ægte billedkvalitet, men holder minnes-
forbrug og render-arbejde meget lavt. Vælges också 
automatisk som default vid første start, om syste
met har mindre end 10 GB RAM.

KO R T  S AG T

Hurtig funktionstest. Billeder 
ind, vent et knap halvt minut, kig 
om scenens rå omrids dukker op. 
Om bilden i vieweren ligner en 
plumret klat — så är det fint, 
det ska det. Om du derimod kun 
ser mørke punkter eller en totalt 
forvrænget form, er kameraposi­
tionerne nok forkerte (se kapitel 
9). Til et resultat, der kan visas, 
har du därefter brug for mindst 
P2 eller P3.

P2 — Preview (Classic)

VA R

Inspector → Presets-sektion → gruppe „Classic” → 
post „Preview”. UUID-suffiks …002 .

T E K N I S K T

5 000 iterationer Classic-densification, 0.5× opløs
nings-skalering, dobbelte inlärningshastigheter i 
forhold til standard. Densification (klon + split) er 
aktiv over de første 2 500 iterationer, därefter kun 
pruning. Default-preset for systemer med ≥ 10 GB 
RAM. På en M3 Ultra typiskt 90 sekunder til 3 mi
nutter på en 200-bild-scen. Giver et brugbart ind
tryk av geometrien og kamera-posen, men teksturer 
er tydeligt blødtegnet — 0.5× render-opløsningen 
lader sig inte direkte omgå vid at träna igen med 
P3 eller P4, fordi læringsraterne er kalibreret til den 
halve upplösning.

KO R T  S AG T

Standarden for „lige kigge en 
gang”. Om du just har importeret 
nye bilder og vil se, om scenen 
overhovedet kan rekonstrueres, 
är det det rigtige trin. Cirka 2–3 
minutters ventetid, därefter kan 
du dreje i 3D-vieweren og vurde­
re, om det er værd at investere i 
flere trænings-pas. Først när for­
håndsresultatet allerede ser godt 
ud, betaler Balanced eller Quality 
sig.
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P3 — Balanced (Classic)

VA R

Inspector → Presets-sektion → gruppe „Classic” → 
post „Balanced”. UUID-suffiks …005 .

T E K N I S K T

20 000 iterationer Classic-densification vid fuld 
bild-upplösning. Densification kører over de første 
15 000 iterationer, fra iter 3 000 med et densify-
interval på 100. Empirisk det „sweet spot” fra de do
kumenterede trænings-sessioner: vid klassisk den
sification på Horse Full og Truck stabiliseres L1-loss 
mellan iter 18 000 og 22 000, en længere träning 
giver inte længere signifikant forbedring under Qua
lity (P4). På en M3 Ultra typiskt 30–60 sekunder på 
200 bilder, 5–8 minutter på 1 000+ bilder.

KO R T  S AG T

Det „gode kompromis”. De fleste 
scener ser allerede gode ud her, 
uden at du ska vente en time. 
Om du vil visa slutresultatet et 
sted (sociale medier, hjemmesi­
de, en kunde-demo), är det ofte 
nok. Først när du vil zoome ind i 
splat-modellen eller har brug for 
detaljer i overfladeteksturen, är 
det værd at hoppe op til P4 Quali­
ty eller P7 MCMC.

P4 — Quality (Classic)

VA R

Inspector → Presets-sektion → gruppe „Classic” → 
post „Quality”. UUID-suffiks …003 .

T E K N I S K T

35 000 iterationer Classic-densification med V546-
„Opacity Decay” (HTGS, Eurographics 2025): efter 
hver densify-cyklus multipliceres opacity av alle ek
sisterende gaussians med en faktor < 1.0, vilket 
pålideligt fjerner gaussians, der er blivit inaktive, vid 
pruning og dermed opnår 14 % bedre L1-loss end 
den klassiske 35 000-kørsel vid samme iter-antal. 
SSIM-loss er aktiveret ( ssimWeight=0.05 ). På en 
M3 Ultra typiskt 2–4 minutter på 200 bilder. Leve
rer på NeRF-Blender (Lego, Chair, Drums) final L1 
≈ 0.023 — bedste Classic-variant i de 560+ doku
menterede experiment. Obs: kræver ~3–5 GB GPU-
minne; på 8-GB-systemer er P3 det sikre valg.

KO R T  S AG T

Den bedste klassiske variant. Le­
verer skarp tekstur og fin geome­
tri, særligt på objekt-optagelser 
(en skulptur, en stol, en vase). 
Vid store outdoor-scener eller 
rum mærker du derimod næsten 
ingen skillnad fra Balanced — 
der är det mere værd at skifte til 
en MCMC-preset (P6–P8) eller en 
Capture-Class- preset (P9–P12) 
end at hoppe fra P3 til P4. Vil du 
have det absolutte maksimum i 
Classic-familien, så tag P5 Ultra 
Detail.
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P5 — Ultra Detail (Classic)

VA R

Inspector → Presets-sektion → gruppe „Classic” → 
post „Ultra Detail”. UUID-suffiks …008 .

T E K N I S K T

Rundt 35 000 iterationer Classic-densification — 
vinderen av held-out-kørselen i kvalitets-matrixen 
(2026-06-10). På alle tre testede Mip-NeRF-360-
scener slår Ultra Detail den indbyggede MCMC-
„Quality”-preset (P8) vid sammenlignelig wall-
clock-tid med rundt +0.94 dB PSNR. Dermed är det 
den stærkeste Quality-preset i Classic-gruppen og 
den skarpeste Classic-variant, RadianceKit leverer. 
På en M3 Ultra typiskt i samme tidsramme som P4 
Quality (2–5 minutter på 200 bilder), men kræver 
lidt mere GPU-minne; på 8-GB-systemer förblir P3 
det sikre valg.

KO R T  S AG T

Det skarpeste Classic-trin og 
held-out-vinderen av vores kva­
litets-tester: på rigtige scener 
rundt en decibel bedre end 
MCMC-„Quality”-varianten — vid 
lignende ventetid. Om du vil ha­
ve maksimal detaljetrohed med 
den velprøvede klassiske densifi­
cation og har nok GPU-minne, är 
det første valg. Rækker minnet 
inte, eller har du brug for en 
så lille eksport-fil som muligt, så 
bliv vid P4 Quality eller en MCMC-
preset.

P6 — Preview (MCMC)

VA R

Inspector → Presets-sektion → gruppe „MCMC” → 
post „Preview”. UUID-suffiks …006 .

T E K N I S K T

60 000 iterationer MCMC-densification (3DGS-
MCMC, NeurIPS 2024) vid et cap på 100 000 
gaussians. MCMC erstatter den heuristiske klon/
split-logik med Markov-Chain-Monte-Carlo-reloca
tion: døde gaussians placeres på ny via sigmoid-
vægtede sampling-dybder, vilket giver et kontrolle
ret og reproducerbart antal gaussians. Cap’et læg
ger låg på det maksimale antal hårdt vid 100K — 
det sparer minne og render-tid, men koster detalje. 
På en M3 Ultra typiskt 5–8 minutter på 200 bilder. 
Egnet som „MCMC-funktionstest” — hjælper med at 
vurdere, om et skift fra Classic til MCMC ville være 
meningsfuldt, före du investerer mere tid i P7 eller 
P8.

KO R T  S AG T

Som P2 Preview, men med den 
nyere MCMC-metode. Leverer of­
te lidt mere kompakte, jævnere 
fordelte splat-skyer end Classic-
varianten. Til en første vurdering 
av en scen rækker de 5–8 minut­
ter som regel. Om du kan lide for­
håndsresultatet, er nästa skridt 
P7 (Balanced) eller direkte P8 
(Quality MCMC).
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P7 — Balanced (MCMC)

VA R

Inspector → Presets-sektion → gruppe „MCMC” → 
post „Balanced”. UUID-suffiks …007 .

T E K N I S K T

120 000 iterationer MCMC vid et cap på 150 000 
gaussians. Det mellemste MCMC-trin — næsten det 
endelige gaussian-antal fra P8 Quality, men kun 
60 % av iterationerne. Empirisk ligger L1-loss i de 
dokumenterede trænings-sessioner på 0.026–0.028 
på Horse Full, mod P8 med 0.0246 — altså rundt 
7 % højere, til gengæld halv ventetid. På en M3 
Ultra typiskt 8–15 minutter på 200 bilder. Bruger 
en metode, der skalerer det effektive gaussian-cap 
til punktdensiteten i input-SfM-punktskyen (se T75 i 
kapitel 6).

KO R T  S AG T

MCMC med ordentlig detaljerig­
dom, men uden den lange fuld-
kørsel fra P8. Til de fleste scener 
rækker det, særligt om du vil 
presse en MCMC-kørsel ind i fro­
kostpause-tidsrammen. Om hu­
kommelsen er knap (f.eks. på M-
processorer med kun 16 GB), så 
bliv her — P8 kræver mere GPU-
minne.

P8 — Quality (MCMC)

VA R

Inspector → Presets-sektion → gruppe „MCMC” → 
post „Quality”. UUID-suffiks …004 .

T E K N I S K T

200 000 iterationer MCMC vid et cap på 150 
000 gaussians, SSIM-loss 0.05, MCMC-noise-decay 
over 80 % av iterationerne. Best-single-run-L1 i de 
560+ experiment: 0.0238 på Horse Full, gennemsnit 
over 3 trials 0.0246 (mod P4 0.0230 på samme 
scen). MCMC leverer samtidig 71 % færre gaussians 
(150K vs ~524K) — afgørende, om du vil levere 
resultatet på nettet, fordi den mindre sky giver mar
kant mindre eksport-filer. Træningstid på en M3 Ult
ra typiskt 20–35 minutter på 200 bilder; på 1 000+ 
bild-sæt nærmere 1–2 timer. Bedste valg, om mak
simal billedkvalitet vid minimal slutstørrelse ønskes.

KO R T  S AG T

Den bedste MCMC-variant. Leve­
rer meget rene, kompakte splat-
skyer — ideelt, när du senere vil 
indlejre resultatet som web-3D-
viewer eller sende det som fil (fi­
len er mindre end vid P4 Quality 
med sammenlignelig optisk kva­
litet). Det kræver dock tålmodig­
hed — på store optagelser over 
en times ventetid. Planlæg det 
snarere som et „natlig kørsel”.
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Figur 28:  CAPTURE CLASS-gruppen foldet ud med alle fire kuraterede real-world-presets 
— Drone / Aerial (MCMC, 40K iters, Cap 1,5 M), 360° Walkaround (MCMC, 40K, Cap 1,5 M), 
360° Walkaround (High Detail) (Hybrid, 40K, Cap 1,5 M, opt-in) og Photo / Object (Hybrid, 

40K, Cap 1,5 M). Denne gruppe står øverst og är i Simple Mode den eneste synlige.

VAD BILDEN VISAR  Inspector med CAPTURE CLASS-gruppen foldet ud — den primære 
preset-gruppe siden v1.6, i Simple Mode den eneste viste. Hver post är en mot rigtigt 
community-materiale per öje valideret opskrift for en konkret optagelses-art (drone, 
360°-rundtur, foto-objekt), inte en värdi tunet mod et akademisk test-sæt. Valg vid klik 
skriver den gemte træningskonfiguration ind i den aktuelle tilstand.

166 / 221



R A D I A N C E K I T Kapitel 7 — Indbyggede kvalitets-forudindstillinger

P9 — Drone / Aerial

VA R

Inspector → Presets-sektion → gruppe „Capture 
Class” → post „Drone / Aerial”. UUID-suffiks …010 .

T E K N I S K T

Capture-Class-preset til luft- og drone-orbits av 
bygninger og landskaber. MCMC-densifier, 40 000 
iterationer, cap 1,5 mio. gaussians, SSIM-loss 0.5 
plus edge-aware-term 0.1. Afgørende er anisotropi-
straffen med vægt 0.003 vid en ratio-tærskel på 6 
— „spaghetti-dræberen” mod de typisk nåleforme
de artefakter, som drone-footage skaber. Valideret 
på en rigtig DJI-4K-droneflyvning over Pensford-vi
adukten (per öje tjekket, inte kun metrisk).

KO R T  S AG T

Til optagelser fra luften — drone­
flyvninger rundt om en bygning, 
over et landskab, langs en faca­
de. Den kraftige anisotropi-straf 
rydder de nåle- eller spaghet­
tiformede artefakter væk, som 
drone-materiale gerne produce­
rer. Om dit materiale er optaget 
fra jorden, passer Photo / Object 
eller en Classic-preset bedre.

P10 — 360° Walkaround

VA R

Inspector → Presets-sektion → gruppe „Capture 
Class” → post „360° Walkaround”. UUID-suffiks 
…011 .

T E K N I S K T

Capture-Class-preset til 360°-walkaround-videoer. 
MCMC-densifier, 40 000 iterationer, cap 1,5 mio. 
gaussians, SSIM-loss 0.5 plus edge-aware-term 0.1, 
blid anisotropi-straf (vægt 0.001 vid ratio-tærskel 
15). Person- og himmel-maske er aktive. Presetet 
forventer en 360°-equirect-video, der internt repro
jiceres til rundt 90° brede perspektiv-crops, før 
træningen starter. Valideret på 8K-360°-rundture 
med selfie-stick (Monument-scene, per öje tjekket).

KO R T  S AG T

Til 360°-rundtur-videoer — du 
går med et 360°-kamera eller en 
selfie-stick gennem et rum eller 
rundt om et objekt. Radiance­
Kit nedbryder selv kugle-panora­
maet til normale synsvinkler og 
masker forbipasserende og him­
mel væk. For maksimal skarphed 
på samme materiale prøv dessu­
den High-Detail-varianten (P11).
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P11 — 360° Walkaround (High Detail)

VA R

Inspector → Presets-sektion → gruppe „Capture 
Class” → post „360° Walkaround (High Detail)”. 
UUID-suffiks …013  (Opt-in).

T E K N I S K T

Opt-in-Capture-Class-preset til 360°-walkaround-
videoer med maksimal detalje. Hybrid-densifier 
(klassisk abs-gradient-klon/split
1. MCMC-noise + relocation), 40 000 iterationer, 

cap 1,5 mio. gaussians,

anisotropi-straf 0.0015 vid ratio-tærskel 15, SSIM-
loss 0.2 og edge-aware-term 0 — den gemte „r50″-
screen-split-opskrift. På 360°-materiale slår det 
standard-MCMC-presetet „360° Walkaround” (P10) 
vid PSNR, LPIPS og synligt konfetti, og det med 
rundt en tredjedel av splat-antallet. Står bevidst 
opt-in vid siden av standard-360-presetet, indtil det 
er valideret på flere scener.

KO R T  S AG T

Det skarpere alternativ til stan­
dard-360-presetet (P10): mere 
detalje, mindre konfetti, markant 
mindre fil. Står bevidst vid siden 
av i stedet for at erstatte det — 
hidtil bekræftet på en håndfuld 
scener. Om din 360°-rundtur er 
rent optaget, prøv dette preset 
først og sammenlign resultatet 
med P10.

P12 — Photo / Object

VA R

Inspector → Presets-sektion → gruppe „Capture 
Class” → post „Photo / Object”. UUID-suffiks …012 .

T E K N I S K T

Capture-Class-preset til objekt-orbits fra skarpe 
enkeltfotos (inte video). Hybrid-t1-densifier (med 
relocation), 40 000 iterationer, cap 1,5 mio. gaussi
ans, SSIM-loss 0.5 plus edge-aware-term 0.1, blid 
anisotropi-straf (vægt 0.001 vid ratio-tærskel 15), 
opacity-decay 0.9995 hver 50 iterationer, ingen 
masking. Valideret på 163 højopløselige 41-MP-
fotos av et skelet (per öje tjekket). Få views (op 
til cirka 600) bliver derved under hybrid-collapse-
tærsklen.

KO R T  S AG T

Til objekt-optagelser fra skarpe 
enkeltfotos — du omrunder en 
skulptur, en model, et produkt 
med kameraet og tager fotos i 
stedet for video. Ingen masking, 
fordi skarpe fotos som regel har 
ren baggrund. Til video-kilder tag 
i stedet et 360°- eller Drone-pre­
set.
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P13 — Balanserad (Hybrid)

VA R

Inspector → Presets-sektion → gruppe „Hybrid” → 
post „Balanserad (Hybrid)”. UUID-suffiks …009 .

T E K N I S K T

20 000 iterationer med Hybrid-densification-strate
gien: klassisk gradient-drevet klon/split placerer ka
pacitet der, hvor lossen behøver den, MCMC-SGLD-
noise bliver vid med at utforske, og døde gaussians 
flyttes i stedet for at gå tabt vid pruning. Opaci
ty-decay (V546) erstatter opacity-resets; en aniso
tropi-straf (vægt 0.001, ratio-tærskel 15) holder nå
leformede splats i skak. Gaussian-cappet skalerer 
med scenen (150K basis, scene-aware ×3.0). Vali
deret på fem scener mod ren MCMC vid samme 
budget: i gennemsnit +0.45 dB PSNR vid 20–30 % 
færre gaussians (stonehenge +1.23, family +0.82, 
garden +0.47 dB). På en M3 Ultra typiskt 5–10 mi
nutter på 200 bilder.

KO R T  S AG T

Et stærkt første valg til et en­
deligt resultat: skarpere detaljer 
end MCMC-presetsene vid en lig­
nende kompakt fil, på en brøkdel 
av P8-træningstiden. Om du kun 
har tid til én kvalitetskørsel og 
ingen av Capture-klasserne klart 
passer, så start her. Classic-pre­
setsene förblir bedre til hurtige 
tests, og Capture-Class-preset­
sene (P9–P12) är første valg, när 
din scen klart matcher en av de 
optagelses-arter.
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Hvornår vilken preset?

Scenarie Første-test Hovedkørsel

Funktionstest av nye bil
der, < 30s

P1 Quick —

Objekt-orbit fra skarpe 
enkeltfotos

P2 Preview P12 Photo / Object

Enkelt-objekt-scan (vi
deo), < 500 fotos

P2 Preview P4 Quality eller P8 Quality 
MCMC

360°-walkaround-video P6 Preview MCMC P10 360° Walkaround 
(skarpt: P11 High Detail)

Luft-/drone-orbit, lands
kab

P6 Preview MCMC P9 Drone / Aerial

Web-levering (lille, kom
pakt)

P2 P8 Quality MCMC (mindste 
fil vid fuld kvalitet)

Skarpe detaljer på kort 
tid, kompakt eksport

P2 eller P6 P13 Balanserad (Hybrid)

Maksimal detaljetrohed, 
Classic-strategi

P3 eller P6 P5 Ultra Detail

Print, marketing, fuld de
talje

P3 eller P6 P4 Quality (Classic) eller 
P5 Ultra Detail
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Hurtig sammenligning
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Pre
set

Stra
tegi

Iters Max-
Gs

Render-
skala

Typisk tid (200 bilder, M3 
Ultra)

Q-sweep

P1 Quick Classic 1 000 ∞ 0.25× ~30 s —

P2 
Pre
vi
ew

Classic 5 000 ∞ 0.5× 2–3 min —

P3 
Ba
lan
ced

Classic20 000 ∞ 1.0× 30–60 s —

P4 Qua
lity

Classic35 000 ∞ 1.0× 2–4 min V546 
HT
GS

P5 
Ult
ra 

De
tail

Classic ~35 
000

∞ 1.0× 2–5 min Matrix 
Δ+0.94 

dB

P6 
Pre
vi

ew MCMC

MCMC60 000 100 
K

1.0× 5–8 min —

P7 
Ba
lan

ced MCMC

MCMC 120 
000

150 
K

1.0× 8–15 min —

P8 Qua
lity MCMC

MCMC 200 
000

150 
K

1.0× 20–35 min V544a

P9 Dro
ne / 
Ae
rial

MCMC40 000 1.5 
M

1.0× 10–25 min Öje / 
Via
dukt

P10 360° 
Wal

karound

MCMC40 000 1.5 
M

1.0× 10–25 min Öje / 
Mo
nu

ment

P11 360° 
Wal

karound 
(High 
De
tail)

Hybrid40 000 1.5 
M

1.0× 10–25 min Öje 
(opt-
in)

P12 Pho
to / 
Ob
ject

Hybrid40 000 1.5 
M

1.0× 10–25 min Öje / 
Ske
let

P13 
Ba
lan
se
rad 
(Hy
brid)

Hybrid 20 000 150 
K

1.0× 5–10 min Matrix 
Δ+0.45 

dB
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Egne forudindstillinger

Via knappen Save… i forudindstillingssektionen (I1 i kapitel 2) gemmer du den aktuelle 
træningskonfiguration som en egen preset. Egne presets er inte „Built-in” og kan omdø
bes, eksporteres (som JSON), deles via træk-og-slip, dupliceres og slettes. De tretten 
indbyggede presets P1–P13 förblir upåvirkede av slet-knappen.

Tommelfingerregel: Om du ændrer något vid en preset, som du vil bruge oftere — sky-
dome tændt, højere SSIM-vægt for en bestemt scen-klasse, afvigende iter-antal — så 
gem varianten som en egen preset. Så vid du straks vid nästa kørsel, at det är en konfi
guration, der afviger fra standarden.
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K A P I T E L

Kapitel 8 — Eksportformater

Figur 29:  Eksportformat-valg i Simple Mode — seks format-kort

Figur 30:  Eksportformat-grid live efter 5K-iter-träning på flowers-buket — alle seks kort 
med dynamisk størrelsesberegning (PLY 742 KB valgt, SPZ 74 KB, glTF 708 KB, .splat 96 KB, 
Orbit Video ~Zero KB, Web Viewer 133 KB), Export History til højre med allerede gemt PLY

Vad bilden visar (2 991 gaussians, SH degree 3, Bjoerns syntetiske Blender-buket 
som IP-clean test-sæt): Størrelsesangivelserne under hvert format-kort beregnes live 
ud fra aktuelt gaussian-antal og format-overhead — inte hårdkodet. Ud av 2 991 gaussi
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ans (SH degree 3) opstår 742 KB PLY, 74 KB SPZ (faktor ~10× mindre via kvantisering), 
708 KB glTF (med KHR_​gaussian_​splatting-extension, därför næsten PLY-ækvivalent), 
96 KB .splat (komprimeret 24-byte-pr.-gaussian-format). Orbit Video visar „~Zero KB”, 
fordi størrelsen først kendes efter MP4-encoding. Web Viewer (133 KB) samler en selv
stændig HTML-fil med indlejret WebGL-viewer og komprimerede splat-data — større 
end rent .splat på grund av viewer-overhead. Export History til højre lister allerede 
afsluttet PLY-eksport („training_20260527T211321Z.ply, 743 KB, 23:13”) med format-
pille og reveal-i-Hittar-action.

En afsluttet träning leverer en gaussian-cloud — en samling på några hundredtusinde 
til millioner av 3D-gauss-fordelinger, der tilsammen rekonstruerer scenen. RadianceKit 
kender ti måder at skrive denna sky til disk på. Seks av dem er rene 3D-dataformater 
(PLY, Compressed PLY, SPZ, SOG, glTF, .splat), et bundler skyen sammen med en fær
dig HTML-viewer (Web Viewer), et renderer en MP4-fil ud av en orbit-kamerakørsel (Or
bit Video), og to eksporterer ingen gaussian-indhold, men kun SfM-resultatet (kamera
positioner og grov punktmoln) til genbrug i andre trænings-pipelines (transforms.json + 
COLMAP-workspace).

Hvilket format der är det rette hvornår, afhænger av målet. Til arkivering av de fulde da
ta uden kvalitetstab tager man PLY. Til web-viewer på egen side rækker som regel .splat 
eller den indbyggede web-viewer. Om filen ska være minimal, betaler SPZ eller SOG sig. 
Til genbrug av SfM-resultatet i Nerfstudio, Postshot eller Brush er transforms.json og 
COLMAP-workspace de rigtige veje.

Alle eksportfunktioner ligger i menuen „Export” og i Simple Mode på det sista wizard-
trin. De fleste formater er fuldt sandbox-konforme og virker i App Store-versionen. Kun 
SOG kræver en ekstern binary ( cwebp ), som inte nødvendigvis er til stede i App Store-
buildet — detaljer se E4.
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E1 — PLY (.ply)

VA R

Menulinjen → Export → 3D Formats → Export PLY… 
(⌘E). Simple Mode: wizard-trin Export → format-
kort „PLY”. Størrelse: typiskt 100 % (referencevær
di). Kompatibel med: SuperSplat, PolyCam, alle 
3DGS-viewere.

T E K N I S K T

PLY är det kanoniske lagringsformat for 3D Gaussi
an Splatting. RadianceKit skriver en binær Little-
Endian-fil med det standardiserede 3DGS-proper
ty-layout: pr. gaussian trekomponent position, tre 
normaler altid sat til nul, tre DC-SH-koefficienter 
( f_dc_0..2 ) for basis-RGB-farven, därefter op til 
45 yderligere SH-koefficienter ( f_rest_0..44 ) i 
den i Kerbl-2023-papiret definerede transponerede 
channel-major-ordning (først alle R-kanal-koeffici
enter, så alle G, så alle B), efterfulgt av logit-
opacitet (rå pre-sigmoid-värden), tre log-space-
skaler og en wxyz-quaternion-rotation. Den maksi
malt eksporterede SH-grad klampes til minimum av 
brugerønske og faktisk lært grad; default er 3 (45 
rest-koefficienter). Før skrivning beregnes payload-
størrelsen i 64-bit integer for at fange overflow vid 
ekstremt store skyer. Filen skrives atomisk, vilket 
vid store skyer kortvarigt optager dobbelt diskplads.

KO R T  S AG T

Det er „originalfilen”. Største fil, 
højeste kompatibilitet, ingen tab. 
Om du inte vid, vilket format du 
ska vælge, så tag PLY — det åb­
nes i næsten alle 3DGS-værktø­
jer. Til 1 million gaussians blir det 
alt efter SH-grad mellan 200 og 
800 MB. Om filen blir for stor, så 
kig på E2 (komprimeret PLY) eller 
E3 (SPZ).
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E2 — Compressed PLY (.ply)

VA R

Menulinjen → Export → 3D Formats → Export Com
pressed PLY…. Simple Mode: format-kort „Compres
sed PLY”. Størrelse: ca. 10–20 % i forhold til 
PLY (5- til 10-gange komprimering). Kompatibel 
med: SuperSplat, PlayCanvas-engine, webbaserede 
viewere.

T E K N I S K T

PlayCanvas-varianten av PLY-formatet med chunked 
kvantisering. Gaussians grupperes i 256-stykker-
chunks. Pr. chunk lægges min/max-bounds for 
position, scale og color separat i headeren; de 
enkelte gaussians refererer deres värden relativt 
til dessa bounds og komprimeres til hver 32 bit: 
position og skala med 11-10-11-bit-pakning, rota
tion som 2-10-10-10-bit „smallest-three”- quaterni
on, farve som 8-8-8-8-RGBA. Højere SH-koeffici
enter kvantiseres med kun 8 bit pr. komponent 
( shCoeffCount * 3  uchar pr. gaussian). Selve for
matet er stadig ASCII-header-PLY og därför prin
cipielt validerbart med PLY-værktøjer, men vertex-
properties er erklæret som uint -felter. SH-grad er 
pr. default 0 (ingen rest-koefficienter) for at maksi
mere komprimeringen — højere SH-grader kan væl
ges eksplicit.

KO R T  S AG T

Den pladsbesparende PLY-vari­
ant. Identisk engine-kompatibili­
tet som almindeligt PLY, men 5 
til 10 gange mindre. SuperSplat 
og PlayCanvas læser det nativt. 
Til web-deployment næsten altid 
bedre end almindeligt PLY. Kvali­
tetstabet via kvantisering er som 
regel inte visuelt mærkbart, så 
længe scenen inte innehåller ek­
stremt højfrekvente detaljer.
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E3 — SPZ (.spz)

VA R

Menulinjen → Export → 3D Formats → Export SPZ…. 
Simple Mode: format-kort „SPZ”. Størrelse: ca. 10 
% i forhold til PLY (90 % mindre). Kompatibel med: 
Niantic Scaniverse, Niantic Spatial Fields, MetalS
platter.

T E K N I S K T

Niantics SPZ-v2-format. Positioner pakkes som 24-
bit-fixed-point (det giver ca. 0,25 mm upplösning), 
skaler som 8-bit-kvantisering i log-rum, rotationer 
som 8-bit-smallest-three (i v2 gemmes kun xyz, 
w afledes i decoderen av quaternion-normen), opa
citeter som sigmoideret 8-bit-värden. DC-SH gem
mes med en SPZ-specifik pakke-formel (dc_​raw * 
0.15 * 255 + 0.5 * 255), højere SH-bånd med 
5 bit (bånd 1) henholdsvis 4 bit (bånd 2-3) pr. koef
ficient. Hele den pakkede binær-blob komprimeres 
därefter med standard-gzip (RFC 1952), vilket gi
ver et gzipped-container-format med magic bytes 
1f 8b . RadianceKit kalder hertil system- gzip , 

fordi Apples indbyggede zlib-API producerer propri
etær Apple-framing, der inte ville være kompatibel 
med SPZ-readerne i Spatial Fields eller MetalSplat
ter. System- gzip  kan stadig spawnes inden for 
macOS-sandboxen.

KO R T  S AG T

Den mindste standardfil. Om du 
kender Niantics Scaniverse — 
det är det format, appen bruger. 
Meget lille, meget indlæsnings­
venlig for mobile apps. Direkte 
brugbar i Niantics egen cloud-
viewer (Spatial Fields). Cirka 90 
% mindre end et PLY med sam­
me data, samtidig næsten inte 
optisk skelnelig for de fleste sce­
ner.
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E4 — SOG (.sog)

VA R

Menulinjen → Export → 3D Formats → Export SOG…. 
Simple Mode: format-kort „SOG”. Størrelse: ca. 5–6 
% i forhold til PLY (15- til 20-gange komprimering — 
den mindste mulighed). Kompatibel med: PlayCan
vas-engine, SuperSplat-editor.

T E K N I S K T

„Spatially Ordered Gaussians” — et PlayCanvas-
format, der gemmer skyen GPU-ready i flere 
lossless-WebP-bilder. Først sorteres alle gaussians 
rumligt via 3D-Morton-code (30-bit Z-order, 10 
bit pr. akse), vilket giver bilderna senere cache-
lokalitet i rendereren. Så kvantiseres positioner 
med symmetrisk log-transformation (for bedre dy
namikomfang) til 16-bit-värden og splittes i to 
RGBA-bilder ( means_l.webp  for de nederste 8 
bit, means_u.webp  for de øverste). Rotationer ko
des som smallest-three med 3×8-bit plus 2-bit-
mode i et RGBA-bild (mode lander i alpha som 
252 + largest ). Skaler og DC-SH kvantiseres hver 

med en 256-indgangs-codebook (percentil-base
rat fordelt over alle värden), indekserne lander i 
scales.webp  og sh0.webp . De fem bilder plus en 
meta.json  med codebooks og bounds pakkes i en 

ZIP-fil (custom-encoder, fordi sandboxen blokerer 
system- zip ) og gemmes med endelsen .sog .

Sandbox-advarsel: SOG är den eneste format-mu
lighed, der kræver en ekstern binary. WebP-enco
der-trinet kalder cwebp  fra /​usr/​local/​bin/​cwebp 
eller /​opt/​homebrew/​bin/​cwebp. Om ingen cwebp-
binary finns, falder koden tilbage på rå PNG-en
coding — men: PNG-fallback fungerer inte i Su­
perSplat. I App Store-versionen evaluér tilgænge
ligheden ud fra build-varianten; i developer-vari
anten ska cwebp være installeret via Homebrew 
( brew install webp ).

KO R T  S AG T

Det allermindste 3DGS-format, 
markant mindre end SPZ. Men: 
kræver cwebp -værktøjet på din 
Mac, fordi RadianceKit selv inte 
kan generere alle billedformater. 
Installer det en gang med Ho­
mebrew, så kører alt. I App Sto­
re-versionen möjligen inte fuldt 
funktionel — om der kommer 
PNG i stedet for WebP ud vid 
eksport, kan du inte åbne filen 
direkte i SuperSplat. Om du ar­
bejder uden Homebrew, så vælg i 
stedet SPZ (E3).
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E5 — glTF (.glb)

VA R

Menulinjen → Export → 3D Formats → Export 
glTF…. Simple Mode: format-kort „glTF”. Størrel­
se: sammenlignelig med PLY. Kompatibel med: 
glTF-viewere med KHR_​gaussian_​splatting-exten
sion (Khronos-draft-standard).

T E K N I S K T

Skriver en selvstændig .glb -binærfil (ingen sepa
rat bin-fil-vedhæftning) i overensstemmelse med 
KHR_​gaussian_​splatting-extension-specifikationen. 
Positioner gemmes som regulære glTF- POSITION -
vertex-data (float3), alle andre attributter (rotation 
som float4, scale som float3, opacity som float, 
SH-koefficienter som float3 × shCoeffCount) lig
ger i yderligere vertex-attributter og refereres via 
extensionen. Vigtigt: glTF bruger højrehåndet Y-up-
koordinatsystem, COLMAP/3DGS arbejder Y-down/
Z-forward. Eksportøren anvender därför en 180-
graders rotation om X-aksen — positioner skrives 
om med (x, -y, -z) , quaternioner tilpasses til 
(w, x, -y, -z) . Det giver en geometrisk korrekt, 

hændet (inte spejlvendt) gengivelse i glTF-viewe
re. JSON- og binærchunks paddes til 4-byte-align
ment, som GLB-standarden kræver.

KO R T  S AG T

Det officielle Khronos-standard­
format for 3D-data, i den fris­
ke udvidelse til Gaussian Splats. 
Fordel: glTF er udbredt i al­
le store 3D-engines (Babylon.js, 
Three.js, Unity, Unreal). Ulempe: 
udvidelsen er i 2026 stadig i 
draft-stadie, mange viewere kan 
den inte endnu. Meningsfuld sär­
skilt, om du integrerer splat-data 
i en eksisterende glTF-pipeline 
eller skriver en viewer, der allere­
de er glTF-i-stand.
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E6 — Splat (.splat)

VA R

Menulinjen → Export → 3D Formats → Ex
port .splat…. Simple Mode: format-kort „.splat”. 
Størrelse: præcis 32 bytes pr. gaussian. Kom­
patibel med: gsplat.js, webbaserede viewere 
(antimatter15-reference), de fleste browser-3DGS-
demoer.

T E K N I S K T

antimatter15- .splat -formatet — 32 bytes pr. 
gaussian, ingen header, ingen indirektion. Layout pr. 
post: 3 × float32 position (verdens-koordinater), 3 × 
float32 scale (exp-transformeret fra log-space i den 
interne buffer), 4 × uint8 RGBA-farve (DC-SH-koef
ficient skaleret med SH_C0 = 0.282...  og klampet 
til [0,255]), 4 × uint8 quaternion (w,x,y,z, normali
seret og kodet som 128 + 128*q  i byte-området). 
Kun DC-SH gemmes — højere SH-bånd kasseres. 
Det gör formatet ekstremt kompakt, men koster de 
view-afhængige farveændringer, der opstår vid re
fleksioner eller spekulære højlys. Skriverækkefølgen 
er præcis cloudens index-rækkefølge (ingen rumlig 
sortering), web-viewere som gsplat.js  rendrer ud 
fra det.

KO R T  S AG T

Formatet att välja, om du vil vi­
sa splat’en i en egen web-viewer 
med gsplat.js . Meget kom­
pakt (32 bytes/gaussian), men 
ingen højere SH-grad — altså 
ingen blanke refleksioner eller fi­
ne farveændringer afhængigt av 
synsvinkel. For de fleste web-
anvendelser ingen sag, fordi DC-
farve fuldstændigt rækker, og 
den manglende view-afhængig­
hed næsten inte ses.
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Figur 31:  Web Viewer åbnet i Firefox — Bjoerns buket-splat renderet med omgivende kame
ra-marker-kugler, browser-tab-bar synlig øverst, ingen CDN-/server-opsætning nødvendig. 
Selvstændig flowers-01.html  åbnet direkte fra Hittar vid dobbeltklik i standardbrow
seren — det indlejrede WebGL2-program rendrer gaussian-cloud’en med det samme uden 
netværk eller server. De sorte markører omkring buketten er trænings-kamerorna, valgfrit 

indkoblelige. Mus-træk roterer, scroll zoomer.
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E7 — Web Viewer (.html)

VA R

Menulinjen → Export → Media → Export Web Vi
ewer…. Simple Mode: format-kort „Web Viewer”. 
Størrelse: splat-data base64-kodet (≈ 4/3 overhe
ad) + ca. 5 KB HTML/JS-shell. Kompatibel med: 
enhver moderne browser med WebGL2 (alle desk
tops, iOS 15+, Android 5+).

T E K N I S K T

Bundler gaussian-cloud’en sammen med en 
fuldstændig inline skrevet WebGL2-renderer i en 
enkelt .html -fil. Der er ingen CDN-afhængighe
der, ingen WASM, ingen anden fil. Cloud’en kodes 
internt først som .splat -binær (samme 32-byte-
logik som E6), därefter base64-indlejret, därefter 
dekodet i browseren med atob . Den indbygge
de renderer laver egen WebGL2-sortering, mus-
orbit-styring og CPU-sortering pr. frame; hele JS-
koden (shadere, matematik, loop) kan ses i out
put-HTML’en. Akse-konventionen på lagring-til-ren
derer-grænsen er præcis den samme som i E5: po
sition (x, -y, -z) , quaternion (w, x, -y, -z) . 
Valgfrit kan et branding-overlay indkobles (free-tier-
kontakt). Da alt er inline, fungerer filen också direk
te fra file:/​/​-protokollen — ingen lokal webserver 
nødvendig til test.

KO R T  S AG T

En enkelt HTML-fil, du kan sende 
til någon pr. mail eller indlejre 
på en hjemmeside. Dobbeltklik 
i Hittar, og browseren visar din 
scen med musedrejning. Ingen 
upload til en sky nødvendig, ing­
en anden fil, ingen server. Ideel 
til kunde-præsentationer, portfo­
lio, mail-vedhæftninger. Ulempe: 
filen blir ca. en tredjedel større 
end et rent .splat  på grund av 
base64-kodningen — til meget 
store scener kan det därför be­
tale sig med separat hosting av 
.splat -filen sammen med en 

standard-viewer.
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Figur 32:  Enkelt frame udtrukket fra flowers-01.mp4 — Bjoerns buket i profil-render, hvid 
platform med kamera-markører synlig, sort baggrund (default-viewport-baggrund, kan æn
dres i Settings). Kameraet kredser om scenen på en parametrisk bane (elevation + afstand 
fast, yaw roterer), varighed typiskt 6–10 sekunder vid 30 eller 60 fps. Frame-upplösning 

skaérbar fra 480p til 8K via VideoPreset.
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E8 — Orbit Video (.mp4/.mov)

VA R

Menulinjen → Viewport → Record Turntable Video 
ELLER menulinjen → Export → Media → Export Or
bit Video…. Simple Mode: format-kort „Orbit Video” 
med varigheds-slider 3–30 s. Størrelse: afhænger 
av varighed, upplösning, bitrate. Kompatibel med: 
alle platforme (H.264 og HEVC er Apple-standard).

T E K N I S K T

Rendrer gaussian-cloud’en langs en parametrisk 
orbit-kamerakørsel og enkoder hvert frame via 
AVAssetWriter til en MP4- eller MOV-fil. Orbit-
konfigurationen styrer rotationshastighed (omdrej
ninger), afstand, elevation, FOV, varighed og ease-
in/out-faktor. Orbit-video-eksporten kører genom 
RadianceKits EGEN ForwardPass med fuld SH-
evaluering — pixel-identisk med in-app-viewporten 
(WYSIWYG). Pr. frame multipliceres verdens-tilpas
ningsmatricen (beregnet av rendereren for at dreje 
de interne koordinater ind i Y-up-orbit-verdenen) 
med kameraet, därefter anvendes en kamera-kon
ventions-vending (camFlip: orbit Y-up → COLMAP 
Y-down). Offscreen-render-target’et trækkes via IO
Surface til en CVPixelBuffer for encoderen. Enco
deren understøtter H.264 og HEVC, konfigurerbar 
bitrate og upplösning fra 480p til 8K. Før første 
frame venter rendereren 200 ms, så den indledende 
splat-sortering er afsluttet. Denne eksport er GPU-
bound — vid 8K og millioner av gaussians ligger 
render-tiden pr. frame på flere sekunder, altså sam
lede render-tider på 10–30 minutter for 6 s video 
muligt.

KO R T  S AG T

En færdig MP4-fil med en drej­
ning omkring din scen. Perfekt til 
sociale medier, marketing, præ­
sentationer. Du kan indstille va­
righed (3–30 sekunder), dreje­
retning og hastighed. Filen kan 
indlejres direkte på YouTube, In­
stagram, i PowerPoint og alle 
andre steder. Går några gange 
långsamt, fordi appen ska rendre 
hvert frame komplet — til en 8K-
video kan du regne med fem til 
tredive minutter, alt efter antal 
gaussians.
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E9 — SfM Transforms (transforms.json)

VA R

Menulinjen → Export → Photogrammetry → Export 
SfM (transforms.json)…. Størrelse: typiskt 1–10 KB 
(kun positioner + intrinsics, ingen bilder, ingen 
gaussians). Kompatibel med: nerfstudio, Brush, 
gsplat, OpenSplat, Meshroom, alle moderne feed-
forward 3DGS-trænere.

T E K N I S K T

Skriver nerfstudio- transforms.json -formatet med 
en liste over kamerapositioner plus delte intrinsics. 
Pr. kamera inverteres view-matricen (RadianceKit-
internt: world-to-camera i COLMAP-konvention), 
därefter spejles kameralokale Y- og Z-basisvekto
rer for at konvertere til nerfstudio-konventionen 
(OpenGL-stil, kamera kigger langs -Z , +Y  er op). 
Den endelige 4×4-matrix lander som row-major 
nested array av doubles i transform_matrix -fel
tet i hvert frame. Intrinsics gemmes på top-niveau 
(brændvidde x/y, hovedpunkt x/y, billedbredde/-høj
de, camera_​model = "OPENCV", plus distortion-coef
ficients k1, k2, p1, p2 ) — bortset fra om ekspor
tøren genkender flere olika intrinsics-sæt, så skri
ves de pr. frame. Billedstier skrives som images/​
<filename> relativt til JSON-filen; brugeren ska 
oprette en sibling-images/​-mappe med træningsfo
toene.

KO R T  S AG T

Denne JSON-fil beskriver for 
hvert foto, hvor kameraet stod, 
og hvor det kiggede hen. Filen 
alene er lille og ubrugelig — den 
anvendes sammen med original­
billederne i en mappe. Nerfstu­
dio, Brush og et par andre træne­
re læser præcis detta format, og 
du kan dermed overdrage dine 
RadianceKit-SfM-resultater til et 
andet værktøj, uden at kamera-
rekonstruktionen ska beregnes 
på ny der. Sparer timer på store 
scener.
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E10 — COLMAP Workspace (sparse/0/)

VA R

Menulinjen → Export → Photogrammetry → Export 
SfM (COLMAP Workspace)…. Størrelse: tre binær
filer sammen typiskt 4–8 MB — points3D.bin  
dominerer (én linje pr. 3D-punkt i sparse-cloud’en), 
images.bin  og cameras.bin  er hver markant 

under 100 KB. Kompatibel med: COLMAP selv, 
Nerfstudio, Postshot, Meshroom, alle værktøjer, der 
forventer et COLMAP-sparse/​-katalog.

T E K N I S K T

Skriver standard-COLMAP-sparse/​0/​-layoutet med 
tre binære filer: cameras.bin , images.bin , 
points3D.bin . Format-reference är den officiel

le COLMAP-dokumentation. cameras.bin  innehål
ler den deduplikerede intrinsics-liste (kameraer 
med identiske intrinsics + billedstørrelse samles til 
en enkelt post); det anvendte camera-model er 
OPENCV  (model 4), med fx/fy/cx/cy plus de fire 

distortion-coefficients k1/k2/p1/p2. images.bin  lis
ter pr. bild positionen som wxyz -quaternion plus 
translation, efterfulgt av kamera-ID og filnavn; ingen 
2D-3D-korrespondancer gemmes. points3D.bin  
innehåller SfM-punktskyen med position, farve 
(0-255 RGB) og default-värden for reprojektion og 
track-length. Alt skrives i Little-Endian. Re-import 
i RadianceKit fungerer via File-menuen → „Import 
COLMAP/Metashape Workspace…” (se Q3 i SfM-
backend-kapitlet).

KO R T  S AG T

Det officielle COLMAP-format. 
Om du vil fortsætte din träning i 
Postshot, Nerfstudio eller en an­
den COLMAP-i-stand software, är 
det vejen. Tre små filer plus dine 
originalbilleder, og målprogram­
met accepterer det, som om COL­
MAP selv havde varit kildepro­
grammet. Flere programmer for­
står det end transforms.json-for­
matet (E9), samtidig lidt mindre 
handy, fordi det er binært i ste­
det for tekstbaseret.
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Hvilket format hvornår?

Mål Format

Web-viewer på egen side E7 Web Viewer (.html)

Web-viewer med gsplat.js E6 Splat (.splat)

Pipeline-genbrug i Postshot / 
Nerfstudio

E9 transforms.json + E10 COLMAP Workspace

SuperSplat-redigering E1 PLY eller E2 Compressed PLY

Niantic Scaniverse / Spatial Fields E3 SPZ

Maksimal komprimering E4 SOG (cwebp påkrævet)

Marketing-/social-video E8 Orbit Video
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Hurtig sammenligning

Format Endelse Sandbox Størrelse (1M gauss) Bedst til

E1 PLY .ply ja ~250 MB Arkiv, højes
te kompati

bilitet

E2 Com
pressed 

PLY

.ply ja ~40 MB Web + Su
perSplat

E3 SPZ .spz ja (gzip-
spawn)

~40 MB Niantic + 
mobil

E4 SOG .sog betinget 
(cwebp)

~20 MB Maksimal 
komprime

ring

E5 glTF .glb ja ~250 MB Khronos-pi
peline

E6 Splat .splat ja ~32 MB gsplat.js 
web-viewer

E7 Web 
Viewer

.html ja ~45 MB Standalone 
browser-fil

E8 Orbit 
Video

.mp4 / .mov ja variabel Social/mar
keting

E9 SfM 
Trans
forms

.json ja ~5 KB Pose-over
dragelse

E10 
COLMAP Workspa

ce

Katalog ja ~4–8 MB Pose-over
dragelse 

binær

Størrelses-kolonnen er grove pejlemærker for 1 mio. gaussians vid SH-grad 3. Reelle 
värden varierer alt efter scenens komprimerbarhed; SH-grad 0 reducerer PLY/glTF med 
faktor 4.
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K A P I T E L

Kapitel 9 — SfM-backends

Figur 33:  Eksperttilstand med Camera Alignment-vælger i Inspector (Apple Photogram
metry / Native (Beta))

Figur 34:  Inspector med Native (Beta) aktiv — Camera Alignment-vælgerens anden mulig
hed valgt, alle andre træningskonfigurationsparametre uændret

VAD BILDEN VISAR  Camera Alignment-vælgeren i Inspector är en segmenteret kontrol 
med to muligheder — Apple Photogrammetry (standard for App Store-builds, fuldt 
sandbox-konform) og Native (Beta) (RadianceKits eget FAST+BRIEF+GLOMAP-pipeline-
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backend, udviklet i fase 3.8/3.9, pr. 2026-05). Native (Beta) er orbit-only valideret 
og snabbare vid ≥1 000 frames end Apple Photogrammetry, men opfylder endnu inte 
fase-3-§5-kvalitetsgaten (finalLoss ≤ 0.0115) — deraf Beta-mærket. Eksterne SfM-
resultater fra Metashape, COLMAP eller anden fotogrammetri-software kan dessutom 
importeres via File-menuen (Q3 COLMAP-tekstformat, Q6 Workspace-import) — væl
geren skifter inte, men de importerede positioner erstatter SfM-resultatet.

SfM står for Structure from Motion. Ud fra en mængde overlappende fotos rekonstru
erer softwaren for hvert bild kameraets position og kiggeretning i et fælles 3D-koordi
natsystem. Undervejs genereres en grov 3D-punktmoln, der initialiserer træningen med 
Gaussian Splatting. SfM-resultatet er input til selve træningen og er afgørende for den 
senere billedkvalitet.

RadianceKit tilbyder fem SfM-veje: to backends indbygget i appen (Q1 Apple Photo
grammetry, Q4/Q5 Native), to import-stier fra eksterne værktøjer (Q3 COLMAP-tekst
format, Q6 binær Workspace-import) samt Q2 COLMAP-binary, der kun er tilgængelig i 
developer-builds uden for App Store. Hvilken der är den rette, afhænger av scenetypen 
(orbit omkring et objekt, indendørs rum, droneflyvning), og av om en ekstern software 
allerede leverer en rekonstruktion.

Q1 — Apple Photogrammetry

VA R

Expert View → Inspector → Træningskonfiguration 
→ Camera Alignment-vælger, posten „Apple Photo
grammetry”.

T E K N I S K T

Indkapsler Apples indbyggede fotogrammetri-fram
ework, som oprindeligt blev udviklet til Object 
Capture. Apple udtrækker internt features med en 
proprietær pipeline (trin er inte offentligt dokumen
teret), verificerer dem via multi-view-matching og 
løser bundle-adjustment på Apple Silicon Neural 
Engine + GPU. Backend’en er fuldt App Store-
konform (ingen ekstern binary, Sandbox=true, on-
device), men leverer kun kamerapositioner plus en 
grov punktmoln — ingen diagnose-metrikker som 
spor-længde eller reprojektionsfejl. Skalerer ifølge 
Apples anbefaling op til et par hundrede bilder. 
Vid mere end ~500 frames i lineære droneflyvning
er eller store outdoor-scener er der reproducerbart 
observeret crashes eller stilstoppende frasortering 
av enkelte kameraer.

KO R T  S AG T

Det är den enkleste vej. Billeder 
ind, app regner. Fungerer rigtig 
godt vid klassiske objekt-scan­
ninger — när du går rundt om et 
møbel eller en skulptur og tager 
50–200 fotos. Vid droneflyvning­
er over landskaber eller vid rig­
tig mange bilder (over 500) blir 
Apples metode dock gerne usta­
bil. Til den slags scener kan du 
afprøve Native-backend’en (Q4/
Q5) eller regne kamerorna i Me­
tashape og indlæse dem via 
Workspace-importen (Q6).
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P OW E R - U S E R

Q2 COLMAP-binary — starter det eksterne COLMAP-program som underproces og 
er därför inte tilgængelig i App Store-versionen (sandbox). Virker kun i developer-
builds uden for App Store. For den kvalitet, COLMAP leverer, finns der i App Store-
versionen Workspace-importen (Q3 eller Q6): kør SfM i COLMAP eller Metashape 
uden for appen, og indlæs resultatet.

Q3 — COLMAP-tekstformat (Metashape / ETH3D)

VA R

Menuen „File → Import COLMAP / Metashape 
Workspace…” (Cmd+⇧+I) ELLER træk-og-slip av en 
mappe med sparse/​0/​cameras.txt.

T E K N I S K T

Læser den standardiserede COLMAP-teksteksport 
— tre tekstfiler cameras.txt , images.txt , 
points3D.txt  i undermappen sparse/​0/​ — 

og konverterer til den interne SfM-resultat-
model. Samme formatdefinition som COLMAP-
binær-eksporten, bare som ASCII i stedet for 
binær. Udskrives av Agisoft Metashape, Reali
tyCapture, PolyCam og ETH3D-benchmark’en i 
præcis detta layout. Parseren deler kamera-mo
del-detektion med binary-parseren (alle gængse 
modeller: SIMPLE_PINHOLE, PINHOLE, OPENCV, 
OPENCV_FISHEYE, FULL_OPENCV). Robust over for 
kommentarlinjer og tomme linjer. Skalerer i tests op 
til ~1 400 kameraer (ETH3D Tunnel) uden proble
mer.

KO R T  S AG T

Om du allerede har arbejdet med 
Metashape, RealityCapture eller 
en anden kommerciel foto-3D-
software og har eksporteret re­
sultatet — kan du indlæse den­
na eksport direkte i RadianceKit 
uden, at appen selv ska regne 
på ny. Det sparer timers vente­
tid. Indlæs blot hele mappen via 
File-menuen eller træk den ind i 
vinduet.
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Q4 — Native SfM (inkrementel)

VA R

Expert View → Inspector → Træningskonfiguration 
→ Camera Alignment-vælger, posten „Native (Be
ta)”. Inkrementel er standardtilstanden for denna 
backend — der finns ingen separat mapper-væl
ger i Inspector. Via CLI kan tilstanden sættes 
eksplicit med --native-sfm  eller --sfm-mapper 
incremental.

T E K N I S K T

Egen GPU-accelereret implementering av he
le SfM-pipelinen: FAST+BRIEF-features EL
LER SuperPoint+LightGlue via CoreML (med 
--coreml-features ), efterfulgt av Hamming-KNN-

matching, RANSAC-fundamentalmatrix, track-buil
ding, initial-par-udvælgelse, two-view-bootstrap 
(F→E plus DLT), grådig inkrementel mapper med 
PnP-registrering og multi-view-triangulering og en
delig bundle-adjustment via Schur-reduceret Le
venberg-Marquardt med Huber-loss og analytiske 
jacobianer over Cholesky-løsning. Fuldt App Store-
konform: ingen ekstern binary, Sandbox=true. Med 
R2-collapse-detektoren, der blev leveret i fase 3.10: 
registrerer appen mindre end 60 % av input-frames 
eller falder points-per-camera-raten under 13, skif
tes der automatisk til den globale mapper (Q5). 
Empirisk ren på orbit-/turntable-scener; vid mere 
generelle bevægelser (droneflyvning, indendørs rum 
med kompleks geometri) er successraten lavere — 
detektoren fanger dock dessa tilfælde. Skalerer på
lideligt op til ~200 kameraer, højere med markant 
længere kørselstid.

KO R T  S AG T

Apples styrker (App Store-
kompatibel, snabb til orbits) 
med yderligere diagnoseværdier. 
Fungerer særligt godt, när du 
som vid en Object Capture går 
rundt om et motiv. Vid mere kom­
plicerede optagelser (droneflyv­
ning eller stue) genkender Radi­
anceKit automatisk, at det inte 
lykkes, og hopper over til den 
globale metode. Mærket „Beta”, 
fordi den stadig afprøves — 
standardanbefalingen er fortsat 
Apple Photogrammetry til simple 
objekt-scanninger og Workspa­
ce-importen (Q3 eller Q6) til kræ­
vende outdoor-sæt.
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Q5 — Native SfM (global)

VA R

Kaldes automatisk, när den inkrementelle mapper 
(Q4) udløser collapse-detektoren (mindre end 60 % 
av input-frames registreret eller points-per-camera-
rate under 13). Manuelt tvangs-aktiverbar kun via 
CLI --sfm-mapper global. I Inspector er den globale 
metode inte tilgængelig via en separat vælger — 
appen beslutter selv, hvornår den skifter.

T E K N I S K T

Global variant av den native pipeline. Først feature-
ekstraktion + matching som i Q4, därefter relativ 
pose-estimering for alle verificerede par, efterfulgt 
av rotation-averaging (synkroniserer alle kamera
rotationer i verdens-koordinatsystemet) og transla
tion-averaging (LSQR-baserat på en matrix-fri spar
se-formulering for at undvika integer-overflow vid 
store kamera-mængder). Skalerer i princippet til ~5 
000 kameraer, i praksis kvalitetsforringet over några 
hundrede kameraer — fase-3.8-§5-akzeptanz-gate-
målingen på K-1351 gav finalLoss 0.07 i stedet for 
de tilstræbte 0.0115. Håndteres som „fallback-tier”: 
kommer i spil, när den inkrementelle mapper dege
nererer, men kontrolleres inte selv på ny for kvalitet.

KO R T  S AG T

Plan-B-stien for den native engi­
ne. Kaldes automatisk, när den 
snabbare inkrementelle sti svig­
ter. Leverer et brugbart resultat, 
men er vid meget store eller 
svære scener sjældent så præcis 
som det, du får fra Metashape el­
ler en ekstern COLMAP-installa­
tion. Om Native blir din standard­
arbejdsgang, kan det i sådanne 
tilfælde betale sig at gå omvejen 
via Workspace-importen (Q3 eller 
Q6).
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Q6 — Metashape / COLMAP-tekst-workspace-import (fase Q7)

VA R

File-menuen → „Import COLMAP / Metashape 
Workspace…” (Cmd+⇧+I). Træk-og-slip av en map
pe med sparse/​0/​cameras.{bin,txt} og images/​.

T E K N I S K T

Genkender automatisk, om en mappe valgt via 
træk-og-slip eller åbn-panelet svarer til et av de 
tre COLMAP-workspace-layouts (sparse/​0/​, sparse/​ 
eller roden), og om rekonstruktionen finns som 
binær ( cameras.bin ) eller tekst ( cameras.txt ). 
Den binære sti bruger COLMAP-binær-parseren, 
tekst-stien ETH3D-loaderen — begge producerer 
samme SfM-resultat-model, og resten av pipelinen 
(importér bilder, start MCMC-träning) er agnostisk 
over for kilden. Billederne åbnes via app-sandbox-
bookmark-systemet security-scoped, så importen 
också virker i App Store-versionen. Specifikt tænkt 
til situationen „Metashape-eksport uden at regne 
rekonstruktionen om”. Detektionen, der nævnes i 
File-menu-posten, advarer i app-loggen, om den 
valgte mappe inte er et genkendeligt workspace.

KO R T  S AG T

Helt specifikt funktionen for Me­
tashape-brugere. Om du har en 
licens til Metashape eller Reali­
tyCapture og har lavet kamera-
rekonstruktionen dér, kan du blot 
trække eksport-mappen ind her 
og straks starte træningen. Spa­
rer flere timers regnetid på store 
scener, fordi RadianceKit så inte 
selv ska lave SfM’en.

Hvilken backend hvornår?

Scenarie Anbefalet backend

Objekt-scan, 50–200 fotos Q1 Apple Photogrammetry

Stor outdoor / drone / 
>500 bilder

Q6 Workspace-import (regn i Metashape eller COLMAP, ind
læs så)

Metashape/RealityCaptu
re-eksport foreligger

Q6 Import (ingen SfM nødvendig)

ETH3D / akademisk COL
MAP-tekstsæt

Q3 COLMAP-tekst-import

Strengt App Store-kon
form + orbit-scen

Q4 Native inkrementel

Q4 fejler Q5 Native global (automatisk)

ETH3D-benchmark-data Q3 (autotest precomputed)
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Hurtig sammenligning

Bac
kend

App Store Sand
box

Ekstern binary Bedst til Max ~ka
meraer

Q1 Apple 
PG

✅ ✅ — Orbit-ob
jekt

~300

Q2 COL
MAP Bi

nary

❌ (kun de
veloper-
build)

— colmap/glomap Outdoor 
stor

~5 000

Q3 COL
MAP-

tekst-im
port

✅ ✅ — Bench-rigs ~1 500

Q4 Nati
ve inkre
mentel

✅ ✅ — Orbit-ob
jekt

~200

Q5 Nati
ve global

✅ ✅ — Q4-fall
back

~1 351

Q6 Workspa
ce-im
port

✅ ✅ — Me
tashape-
genbrug

pr. kilde
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K A P I T E L

Kapitel 10 — Begyndertilstand

Begyndertilstanden (engelsk Simple Mode, Cmd+1) är den guidede arbejdsgang for alle, 
der for første gang rekonstruerer en 3D-Gaussian-Splatting-scen. I stedet for at visa en 
sidebar fyldt med Inspector-felter fører appen genom fire trin: først importeres bilder 
eller en video, og en kvalitets-preset vælges, så kører behandlingen (SfM + träning), 
bagefter kan den færdige scen vurderes i en 3D-forhåndsvisning, og til sidst eksporte
res til det ønskede format. En smal fremskridtsbjælke øverst i vinduet visar til enhver 
tid, vilket trin du befinder dig på.

Sammenlignet med Expert Mode (Cmd+2), som visar alle betjeningsfelter samtidig, 
skjuler begyndertilstanden ubrugte muligheder, giver validerings-advarsler vid for få 
eller dårlige bilder og tilbyder på hvert trin kun de knapper, der er meningsfulde i den 
aktuelle tilstand. Du kan til enhver tid skifte mellan begynder- og Expert Mode (Cmd+1 / 
Cmd+2), hele tilstanden — importerede bilder, valgt preset, igangværende träning, fær
dig punktmoln — bevares og er straks tilgængelig i den anden tilstand.

Z1 — Import (vælg bilder & preset)

Figur 35:  Simple Mode trin 1 — tom drop-zone före bild-import, crumb-trail øverst (Import 
→ Frame Quality → Cameras → Training → Preview → Export), format-pills JPG/PNG/TIFF/

HEIC/MP4/MOV/PLY/SPZ/SPLAT/SCENE/COLMAP

VAD BILDEN VISAR  Crumb-trail (Import aktiv) visar den fire-trins-arbejdsgang. Venstre 
drop-zone med tre CTAs: „Browse Files” (NSOpenPanel), „Try Sample Scene” (bundled 
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demo), „Download Sample Photos (~427 MB)” (Mip-NeRF360 flowers subset). Format-
pills härunder lister alle accepterede filtyper. Til højre „Imported Files” med counter „0 
images” og empty-state „No files imported yet”. Nederst quality-vælger (default: Previ
ew) og „Start Processing” (deaktiveret, så længe ingen bilder er der).

Første trin består i at give appen billedmateriale. Via træk-og-slip i det store, stiplede 
felt i midten, via „Browse Files”-knappen eller via klik på den medleverede sample-scen. 
Til højre optræder en liste over alle importerede bilder med upplösning og filstørrelse; 
nederst i den svævende værktøjslinje vælger du kvalitets-presetet og starter pipelinen 
med „Start Processing”. Validerings-advarsler (rød vid < 3 eller < 10 bilder, orange vid 
10–19) visar, om appen forventer en meningsfuld rekonstruktion eller ej.

C-01 ProgressIndicator (trin-visning)

VA R

Øverst over arbejdsgangen, altid synlig.

T E K N I S K T

Visar en horisontal fremskridtsbjælke over hele pi
pelinen (frame-quality → SfM → träning) med stage-
allokering: frame-quality optager 0–5 % (fase 3.11, 
meget kort), SfM optager 0–30 % av bjælken, 
träning 30–100 %. Vid siden status-tekst og fase-
navngivet procent-visning („SfM 41 %”, „Training 12 
500/20 000”), så brugere inte læser det tilsynela
dende tilbageskridt „41 % SfM → 25 % träning” 
som fejl — bjælken visar hele pipeline-fremskridtet, 
inte sub-stage. ETA-beregning starter, så snart der 
er målt nok trænings-tempo (typiskt efter de første 
100 iterationer). Samme visning bruges också i Ex
pert Mode over Inspectoren.

KO R T  S AG T

Den smalle bjælke helt oppe er 
dit kort genom arbejdsgangen. 
Den fortæller dig inte kun, vad 
appen laver lige nu (justerer ka­
meraer, träning kører, …), men 
också hvor langt den samlet al­
lerede er. Opdelingen er bevid­
st sådan, at kamera-beregningen 
optager den første tredjedel av 
bjælken, og selve træningen de 
to bageste tredjedele — annars 
ville fremskridtet efter SfM virke 
som om det pludselig var tilbage 
vid nul. Du kan altså læne dig til­
bage, et blik på bjælken rækker 
til att se den grove etape. Tek­
sten vid siden av fortæller dig, 
om du lige er i SfM-trinet (f.eks. 
„SfM 41 %”) eller i træningen 
(f.eks. „Training 12 500/20 000”), 
så tallene inte virker forvirrende. 
Om du inte får vist ETA, er træ­
ningen bare endnu for ung — ap­
pen skønner først, så snart den 
har målt nok tempo.
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C-03 DropZoneView (træk-og-slip-område)

VA R

Venstre side av import-trinet, stort stiplet rektangel 
med symbol. Visas i begyndertilstand med labelet 
„Drop photos or a video here”.

T E K N I S K T

Drop-område, der lader symbolet kort hoppe og 
farver baggrunden, så snart drag-items svæver 
over feltet. Accepterer JPG, PNG, TIFF, HEIC, MP4, 
MOV, PLY, SPZ, .splat, .radiancescene-bundles og 
mapper. Drop-routing efter type: bilder samles og 
overgives sorteret, videoer udløser frame-sampling-
stien, splat-filer åbner direkte forhåndsvisningen, 
scen-bundles indlæses. Mapper enumereres, og 
alle indeholdte bilder importeres. Security-scoped 
bookmarks til sandbox-konform adgang optages og 
frigives korrekt. Inte-understøttede endelser visas 
som advarselsbanner i 5 sekunder.

KO R T  S AG T

Det store stiplede felt er hoved­
betjeningen i første trin. Træk 
bare fotos eller en video derind, 
eller en hel mappe — appen ta­
ger alt, vad den kender, og igno­
rerer resten. Når feltet blir blåt, 
og symbolet kort hopper, har 
appen genkendt drag’en. Slip, 
og importen starter med det 
samme: bilder vandrer i listen 
til højre, videoer udløser auto­
matisk frame-sampling-trinet, og 
allerede trænede .ply / .spz /
.splat -filer åbner direkte for­

håndsvisningen. Om et format 
slet inte passer (f.eks. PDF el­
ler BMP), optræder et kort hint 
øverst — appen sluger inte 
ukendt materiale i stilhed.

C-05 Browse Files-knap

VA R

Inden i drop-zonen, prominent knap.

T E K N I S K T

Knap, der åbner macOS-fildialogen med multivalg 
og filtyperne JPG, PNG, TIFF, MP4, MOV, mapper 
samt app’ens eget scen-format. Resultat-URL’er er 
security-scoped og videreføres genom samme im
port-stier som træk-og-slip. Om brugeren vælger en 
mappe, enumeres den rekursivt for bilder.

KO R T  S AG T

Om træk-og-slip er ubekvemt for 
dig, så klik bare denna knap og 
navigér i macOS-fildialogen til 
dine fotos. Du kan vælge flere 
filer samtidig (Cmd-klik på de en­
kelte bilder) eller vælge en hel 
mappe — appen gennemsøger 
så mappen rekursivt for alle un­
derstøttede billedtyper. Det er 
særligt praktisk, om dine op­
tagelser ligger indkapslet i un­
dermapper (f.eks. „shoot-day1/”, 
„shoot-day2/”) — et klik på ho­
vedmappen rækker. Funktionelt 
gör knappen præcis det samme 
som træk-og-slip; vælg bare den 
vej, der er mest bekvem for dig.
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C-06 Try Sample Scene-knap

VA R

Inden i drop-zonen, kun synlig om app-bundlen 
innehåller sample-scenen, og der endnu inte er im
porteret bilder/splats.

T E K N I S K T

Optræder kun, om (a) en sample-scene.splat , 
.spz  eller .ply  finns i app-bundlen OG (b) end

nu ingen bilder/videoer er importeret, og endnu 
ingen punktmoln finns. Vid klik indlæses den færdi
ge punktmoln (foretrukket det mindste format — 
.splat  ~3 MB, .spz  ~1.4 MB, fallback .ply ) 

og sætter efter 400 ms hardkodede kamera-värden 
fra den originale metadata av blomster-scenen til et 
æstetisk meningsfuldt indgangs-perspektiv.

KO R T  S AG T

Om du starter appen for første 
gang og bare vil se, vad der kom­
mer ud til sidst — klik her. Det 
åbner en færdig tränat blomster-
scen, som du straks kan dreje 
og eksportere, uden at appen ska 
regne. Kameraet er forindstillet 
til et æstetisk meningsfuldt in­
dgangsperspektiv, så du straks 
ser något pænt. Perfekt til at 
prøve 3D-styringen og eksport-
trinet risikofrit, före du går løs på 
egne optagelser. Så snart du im­
porterer egne bilder, försvinner 
knappen automatisk — den visas 
kun, så længe projektet er helt 
tomt.

C-07 Download Sample Photos-knap

VA R

Inden i drop-zonen, vid siden av „Try Sample Sce
ne”; samme synligheds-betingelser.

T E K N I S K T

Udløser et download (repo github.com/​bkindler/​
radiancekit-sample-photos), der indlæser ca. 427 
MB med 960 fuld-opløsnings-frames og fodrer ap
pen. Under downloadet er knappen deaktiveret. 
Fremskridtet visas i den øvre progress-bar som 
„Downloading X %” i en egen stage, fordi denna 
stage beholder sin egen 0–100 %-skala og inte 
overlapper det senere SfM-stage.

KO R T  S AG T

Nøjagtigt som sample-scenen, 
kun med udgangsfotos i stedet 
for med det færdige resultat. Så­
dan kan du selv køre hele pipeli­
nen genom en gang og se, hvor 
lang tid SfM og träning faktisk 
tager på din Mac. Downloadet er 
stort (omtrent en halv DVD = 427 
MB), men sker kun en gang — 
bagefter er fotos lokale, og du 
kan genstarte pipelinen vilkårligt 
mange gange med olika presets. 
Mens downloadet kører, visar den 
øvre fremskridtsbjælke den aktu­
elle download-status i procent, 
så du kan vurdere, hvornår det 
går i gang. Tip: tag helst et 
snabbt WLAN eller kablet net der­
til — de 427 MB trækker annars 
ud.
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C-09 Quality Presets-vælger

VA R

Svævende nedre værktøjslinje av import-overlayet, 
til venstre for start-knappen.

T E K N I S K T

Betjeningselement med label „Quality” grupperer 
de tilgængelige presets efter kategori (Classic / 
MCMC / Custom). Indbyggede presets grupperes 
efter kategori; afsnits-headerne er hardkodede. 
Custom-presets kun synlige, om någon finns. Loc
ked-state: presets, der inte er i free-listen (Quick + 

Preview), får et „🔒”-suffiks på navnet, om brugeren 
inte har købt; vid valg springer vælgeren tilbage på 
Preview og åbner automatisk purchase-sheetet. Vid 
valg anvendes presetet, vilket erstatter hele træ
nings-konfigurationen.

KO R T  S AG T

Her vælger du, hvor præcist og 
hvor længe appen ska regne. 
„Quick” og „Preview” kan bru­
ges uden køb og leverer et førs­
te resultat på få minutter — 
ideelt til at teste, om dine bil­
der overhovedet er meningsful­
de. „Balanced” og „Quality” kræ­
ver fuldversionen og leverer mar­
kant rene modeller, men tager til 
gengæld timer i stedet for minut­
ter. MCMC är en anden strategi, 
der klarer sig med færre gauss- 
splats — godt, om du senere 
vil eksportere modellen kompakt 
eller lægge på nettet. Premium-
presets genkender du på det lille 
låse-symbol vid navnet; trykker 
du på en uden licens, spring­
er vælgeren tilbage på Preview, 
og købs-sheetet åbnes automa­
tisk. Tommelfingerregel: start al­
tid med Preview, kig på resulta­
tet, og beslut så, om det er værd 
at lave en længere kørsel.

C-10 Start Processing-knap

VA R

Svævende nedre værktøjslinje av import-overlayet, 
til højre for preset-vælgeren.

T E K N I S K T

Knap, der förblir grå, så længe hverken bilder eller 
en video er importeret. Vid klik startes pipelinen, 
og stage-maskinen skifter til rækkefølgen frame-
quality → SfM → träning. Knappen selv har ingen 
yderligere status; en kørende behandling optræder i 
stedet som separat behandlingsskærm.

KO R T  S AG T

„Sæt i gang”-knappen. Så længe 
den er grå, mangler der stadig in­
put-bilder eller en video. Så snart 
du har trukket fotos ind, blir den 
aktiv, og du klikker den for at 
starte SfM og träning efter hi­
nanden. Derfra overtager appen 
hele forløbet, og du lander auto­
matisk på behandlingsskærmen 
(Z2). Du behöver inte klikke yder­
ligere — først efter trænings- 
slut skifter appen tilbage til for­
håndsvisningen (Z3). Om du om­
bestemmer dig, kan du också 
därefter til enhver tid afbryde via 
Cancel.
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C-11 Video Sampling-slider

VA R

Højre billedliste, kun synlig om en video (i stedet for 
bilder) er importeret.

T E K N I S K T

Skydeknap 0.5 fps – 30 fps i 0.5-skridt. Vid ændring 
opdateres frame-densiteten, og dessutom beregnes 
antallet av mål-frames (mindst 10) ud fra den
sitet og videolængde. Skydeknappen ligger uden 
for billedlisten, fordi liste-elementer ville blokere 
muse-events fra skydeknapper. Under skydeknap
pen står de beregnede mål-frames („247 frames”) 
og videolængden („1m23s video”). Tooltip advarer: 
„Doubling the density doubles the number of fram
es and increases SfM time by ~100 %.”

KO R T  S AG T

Om du har importeret en video i 
stedet for fotos, beslutter denna 
skydeknap, hvor mange enkelt­
billeder appen ska trække ud av 
videoen. Flere bilder = bedre kva­
litet, men lineært mere regnetid. 
Til en 30-sekunders orbit-video 
er 5 fps (150 bilder) en god start; 
vid 1-minuts-optagelser rækker 3 
fps ofte fuldt ud. Under regulato­
ren visar appen live, hvor mange 
frames der kommer ud vid den 
aktuelle inställning — så ser du 
straks, om du rammer det fornuf­
tige område på ca. 100–300 bil­
der. Om resultatet blir dårligt, så 
træk regulatoren til højre og prøv 
igen; fordobling av frame-raten 
fordobler dock också groft SfM-
varigheden.

C-12 Clear All-knap

VA R

Højre billedliste, nederst til højre; kun synlig om bil
der er importeret.

T E K N I S K T

Rød knap. Klik åbner en bekræftelsesdialog med 
titel „Clear all imported files?” og besked „N images 
will be removed.”. Bekræftelse tømmer alle impor
terede bilder/videoer, staging-mapper, punktskyen, 
trænings-status, SfM-resultatet og alle caches; sta
gen springer tilbage til import. Vid Cancel bevares 
alt. Dialogen er konfigureret som inte-destruktiv de
fault-sti (destruktiv knap markeret rød).

KO R T  S AG T

Om du vil starte helt forfra, 
så klik her. Bekræftelses-spørgs­
målet optræder, fordi sletningen 
kasserer alle aktuelle importer 
inklusive evt. allerede beregnede 
kameraer og trænings-resultater 
— du kan inte fortryde det. Me­
ningsfuldt, om du vil udskifte det 
valgte billedmateriale helt eller 
komme av med et gammelt pro­
jekt, före du starter et nyt. Obs: 
at tage et enkelt bild ud sker via 
listen til højre (se nästa punkt), 
inte via denna knap. Dine filer 
på disken slettes inte — appen 
glemmer kun sine referencer.
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C-13 File List ForEach (enkelt-bild-fjern)

VA R

Højre billedliste, hver post.

T E K N I S K T

Liste over de importerede bilder med swipe-to-de
lete. Pr. bild en linje med ikon, filnavn, upplösning 
(„1920 × 1080″) og filstørrelse (formateret KB/MB). 
Opløsningen kommer fra en metadata-cache, der 
asynkront fyldes fra bild-headerne, så brugerfladen 
inte blokeres. Slet- handlingen tilbyder macOS-ty
piskt swipe-delete (trackpad-swipe til venstre på en 
linje) samt tastatur-delete vid markeret linje. Obs: 
den udvidede image-delete-sti med eksplicit minus-
knap, backspace og Cmd-Z til at fortryde blev kun 
i Expert Mode tilføjet i Project Navigator — i begyn
dertilstand blir det vid swipe-delete.

KO R T  S AG T

Listen til højre visar hvert im­
porteret bild med upplösning og 
filstørrelse — praktisk for med 
ett blik att se, om du har blan­
det højopløsningsmateriale med 
lavopløsningsmateriale. For at 
tage et enkelt bild ud, så swipe 
det til venstre med to fingre på 
trackpadet — som i iOS Mail — 
eller vælg det og tryk Delete. Ap­
pen sletter inte selve filen; den 
tager den blot ud av det aktuel­
le projekt. Om du har brug for 
en rigtig minus-knap eller Cmd-
Z-fortryd, så skift til Expert Mode 
(Cmd+2), der finns det i Project 
Navigator. I begyndertilstanden 
blir det bevidst vid det enkle swi­
pe-pattern.

C-15 Validation Warnings (3-trins-tier)

VA R

Under billedlisten, over Clear-All-knappen.

T E K N I S K T

Tre efter hinanden følgende tærskler baserat på an
tallet av importerede bilder (kun aktiv, om bilder 
finns, og ingen video): - < 3 bilder: rødt banner 
(red octagon), tekst „At least 3 images are required. 
Camera alignment cannot be computed from fewer 
images.” - 3–9 bilder: rødt banner, tekst „With fewer 
than 10 images, SfM often fails and the trained scen 
tends to overfit […]. 15–20 images minimum recom
mended; 30+ for object captures.” - 10–19 bilder: 
orangefarvet banner (warning triangle), tekst „Wor
kable, but quality usually improves with 20+ images 
and good coverage around the scen.”

Fra 20 bilder försvinner banneret. Tærskelværdier 
er hardkodede og baserat på empiriske 560+-træ
nings-experiment.

KO R T  S AG T

Appen kigger på, hvor mange bil­
der du har importeret, og giver 
dig en farvet vurdering. Rødt be­
tyder: det blir med høj sandsyn­
lighed inte til något — enten kan 
SfM inte beregne kameraer, eller 
træningen overfitter på for lidt 
materiale. Orange betyder: kan 
måske lykkes, men regn inte med 
top-kvalitet, fordi algoritmen hit­
tar lidt overlap mellan bilderna. 
Intet banner betyder: gode fo­
rudsætninger, du har nok materi­
ale. Om du vil have virkeligt rene 
modeller, så sigt efter mindst 
30–50 jævnt fordelte optagelser 
omkring dit motiv — gerne mar­
kant flere vid udendørs-scener 
eller store rum. Du kan star­
te trods advarsel, men bliv in­
te overrasket, om SfM afbryder 
uden kommentar, eller modellen 
ser hullet ud.
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C-16 COLMAP Workspace Detection

VA R

Vid drop av en mappe — ingen synlig knap, men 
detektions-logik.

T E K N I S K T

Vid drop av en mappe tjekkes det, om den inne
håller et av de tre kanoniske workspace-layouts: 
sparse/​0/​cameras.bin, sparse/​cameras.bin eller di
rekte cameras.bin  i roden. Om det er tilfældet, 
afbrydes standard-bild-enumerationen, og i stedet 
åbnes en modal alert, der spørger brugeren, om 
den eksisterende rekonstruktion ska bruges, eller 
bilderna ska sendes genom Apple Photogrammetry 
på ny. Samme sti också for tekst-format-workspa
ces (cameras.txt) og ETH3D-eksporter. Se kapitel 9 
backend Q6 for detaljer. Virker i begyndertilstand 
præcis som i Expert Mode.

KO R T  S AG T

Om du allerede har arbejdet 
med Metashape, RealityCapture 
eller COLMAP og har ladet ka­
mera-beregningen køre der, kan 
du bare trække eksport-map­
pen ind her. RadianceKit gen­
kender automatisk på indholdet, 
at det er et COLMAP-workspa­
ce (det tjekker for sparse/​0/​, 
cameras.bin  osv.) og spør­

ger dig, om det ska overtage 
den færdige beregning eller selv 
regne på ny. At overtage spa­
rer timers ventetid på store 
scener, fordi SfM springes helt 
over — træningen starter straks. 
Også tekst-format-workspaces 
(cameras.txt) og ETH3D-ekspor­
ter genkendes. Denne funktion 
er tilgængelig i begyndertilstand 
liksom i Expert Mode; flere detal­
jer står i kapitel 9 under backend 
Q6.

Hvornår til nästa trin?

Du kan klikke Start Processing, så snart (a) mindst ett bild eller en video er importeret, 
og (b) validation-banneret er orange eller forsvundet. Vid rødt banner lader appen dig 
dock starte ändå, men du kan med høj sandsynlighed afbryde behandlingen igen straks. 
Anbefales: mindst 20 bilder, skarpe, med tydeligt overlap mellan på hinanden følgende 
optagelser, alle fra omtrent samme distance til motivet. Vælg före start en preset, der 
passer til dit tidsbudget — vid 30 bilder og Quick-preset er du genom på få minutter, vid 
Quality varer det snarere 1–2 timer.
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Z2 — Behandling (SfM + träning)

Figur 36:  Z2 SfM-fase — stage-ikon „Structure from Motion” med 41 % i den store cirkel, 
øvre statusbjælke vid „SfM 25 %”, Cancel- knap nederst til højre

SfM-fase (kameraer justeres): Stor fremskridtscirkel visar sub-stage-fremskridt (her 
41 % av den kørende Apple- Photogrammetry-session). Status-tekst „Aligning came
ras…” øverst til venstre. Crumb-trail markerer „Cameras” som aktivt trin. Øvre status
bjælke visar pipeline-samlet-fremskridt (25 %) — SfM optager den første halvdel av 
bjælken. Svævende wireframe- kameraer i baggrunden antyder, at positioner skønnes.

Figur 37:  Z2 træningsfase — stage-ikon „Training Gaussians” med 6 %, live-metrikker 
øverst (Training: 400/5000 — Loss: 0.1642 — 138.7 it/s), ETA 33 s, Pause/Cancel nederst

Træningsfase (gaussians optimeres): Sub-stage-ikon skifter til „Training Gaussians”, 
procent tæller iterationer ud fra valgt preset (her 400 / 5 000 for Preview-preset = 8 
% av stagen). Live-metrik-linjen visar loss-värde (0.1642), iterationer pr. sekund (138.7 
it/s) og ETA (33 s). Pipeline-samlet-fremskridt klatrer fra 50 % til 100 % under denna 
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fase. Pause-knappen (i stedet for Cancel-only i SfM-fase) tillader resume senere; Can
cel kasserer trænings-resultatet og vender tilbage til Z1.

Så snart pipelinen kører, fader appen import-overlayet ud og visar en fuldskærms-be
handlingsskærm. I midten kører en stor fremskridtscirkel (220 × 220 pixel) med stage-
ikon, status-tekst og procent-tal; i baggrunden visualiserer en diskret splat- animation 
symbolsk den kørende beregning. Øverst til venstre kan et info-panel indkobles, der 
visar live-metrikker fra träning og SfM. Nederst er der pause/resume, Cancel og i fejltil
fælde en retry-knap.

C-18 SplatTrainingView (baggrunds-animation)

VA R

Fuldskærms-baggrund bag progress-cirklen, fades 
ud vid afbrydelse eller fejl.

T E K N I S K T

Dekorativ animation, der afhængigt av pipeline- 
fremskridtet (0…1) rendrer et stigende antal små 
animerede splat-partikler. Kilden är en beregnet 
fremskridtsværdi, der mapper SfM-faser til 0–0.2 og 
träning til 0.2–1.0 (frame-quality til 0–0.05). Sådan 
„bygger” splats sig synligt op, mens træningen kø
rer. Udelukkende dekorativt — visningen visar ingen 
ægte mellemresultater av den aktuelle träning (det 
ville være live-preview i Expert Mode). Vid afbry
delse eller fejl fader den ud, og kun status-cirklen 
förblir synlig.

KO R T  S AG T

I baggrunden kører en lille ani­
mation av dansende punkter, så 
skærmen inte virker så tom un­
der beregningen. Det er inte din 
ægte 3D-model — den ser du 
først efter træningen i trin Z3. 
Animationen har dock samme to­
nalitet, så du ud fra det omtrent­
lige fortætningsniveau kan aflæ­
se, hvor langt træningen er nået. 
I starten ses kun få punkter, 
mod slutningen fyldes baggrun­
den tydeligt tættere — en sød 
visuel indikator ud over procent-
visningen i cirklen. Om animatio­
nen generer dig (f.eks. fordi du 
vil arbejde vid siden av i bag­
grunden), kan du skifte til Expert 
Mode, hvor den falder væk.
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C-19 Stor progress-cirkel

VA R

I midten av behandlingsskærmen, 220 × 220 pixel.

T E K N I S K T

To over hinanden rendrede ringe: udvendigt en 
dæmpet track-ring, indvendigt en udfyldt fremskrid
tsring med accent- eller rød-stroke (rød vid fejl). 
Inden i cirklen et stage-ikon (hjerne for träning, 
kamera for SfM, film for video-frame-ekstraktion, 
sparkles for frame-quality), stage-titel og det live-
animerede procent-tal i 32-punkts-rounded-font. 
Ikonet pulserer blødt, så længe behandlingen er ak
tiv. Visningen interpolerer på en 30-Hz-timer blødt 
mod det aktuelle ægte fremskridt — med konstant 
kryb (0.0003/frame) plus proportional andel (4 % 
av gappet) og et soft-ceiling, der sættes til 80 % 
av nästa forventede milestone (for SfM fra en hard
kodet milestone- tabel). Sådan virker fremskridtet 
flydende, selv om de ægte SfM-updates kun an
kommer hvert par sekunder.

KO R T  S AG T

Den store cirkel i midten er din 
hoved-visning, mens appen reg­
ner. Den fyldes blødt, selv när 
de ægte beregnings-updates kun 
kommer hvert par sekunder — 
det giver dig følelsen av, at der 
sker något, i stedet for at stirre 
minutter på en fastfrossen pro­
cent. Symbolet i midten skifter 
alt efter, om der lige nu ekstra­
heres frames (film-ikon), kame­
raer justeres (kamera-ikon) eller 
gaussians tränas (hjerne-ikon). 
Procent-tallet refererer til det ak­
tuelle deltrin — den samlede pi­
peline ser du i den smalle bjæl­
ke helt oppe. Vid en fejl farves 
ringen rød i stedet for blå, og 
ikonet pulserer inte længere, så 
du straks bemærker, at något er 
gået galt.

C-22 Info-knap (vis metrikker)

VA R

Øverst til venstre på behandlingsskærmen, 32 × 32 
pixel.

T E K N I S K T

Simpel knap med material-baggrund. Slår info-pa
nelet til eller fra. Ikonet skifter mellan info-cirkel- 
outline og info-cirkel-fyldt, när aktiv. Blød fade-
in-animation. Tooltip „Show detailed processing 
metrics”.

KO R T  S AG T

Som standard er skærmen be­
vidst ryddelig — kun den store 
fremskridtscirkel, mere ser du 
inte i første omgang. Om du som 
teknisk interesseret bruger vil vi­
de mere præcist, vad der sker 
(vilken iteration, hvor høj loss, 
hvor mange gaussians), så klik 
på i-symbolet øverst til venstre. 
Ett lille panel folder ud nederst 
og visar alle live-värden. Endnu 
et klik fader det ud igen. Indstil­
lingen er inte persistent — vid 
hvert nyt trænings-forløb er pa­
nelet først skjult igen, vilket be­
vidst er sådan for inte at skræm­
me begyndere.
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C-23 Info-panel (live-metrikker)

VA R

Nederst til venstre på behandlingsskærmen, kun 
synlig om showProcessingInfo == true.

T E K N I S K T

Tospaltet panel med ultra-thin-material-baggrund. 
Venstre kolonne: stage-specifikke info-linjer — for 
SfM status-tekst og procent; for träning iteration, 
kombineret loss, L1-loss, D-SSIM-loss, gaussian-
count (orange farvet), speed (it/s), elapsed-time, 
beregnet ETA, SH-degree og learning-rate. Højre 
kolonne: status-tekst, time-info-string, inline loss- 
chart (se C-28) og et discoverability-nudge (se 
C-32). Alle värden læses fra trænings-status, der 
opdateres vid hver trænings-tick.

KO R T  S AG T

Info-panelet visar alle live-vär­
den, der i Expert Mode ville stå 
permanent i Inspector-sideba­
ren: aktuel iteration, loss-värde 
(mindre = bedre), antal gaussi­
ans, hastighed, estimeret resttid, 
SH-degree og learning-rate. På 
højre side kører dessutom en lil­
le loss-kurve med, som med ett 
blik fortæller dig, om træningen 
kører i den rigtige retning. Om 
træningen virker træg, hjælper et 
blik her — en loss, der inte læng­
ere falder, eller en ETA, der inte 
længere sjunker, indikerer pro­
blemer. Om loss’en eksploderer 
(pludselig blir gigantisk) eller vi­
sar NaN, er træningen blivit usta­
bil, og en Cancel + Retry eller 
skift til en anden preset er me­
ningsfuldt.

C-25 Pause/Resume-knap

VA R

Nedre navigationslinje, kun synlig under trænings-
stagen (IKKE under SfM), og så længe behandlingen 
kører.

T E K N I S K T

Bordered knap. Kalder afhængigt av status pause 
eller resume. Label skifter mellan „Pause” (med 
pause-ikon) og „Resume” (play-ikon). Under SfM-
trinet visas knappen inte, fordi Apple Photogram
metry inte kender pause-semantik. Pause-tilstanden 
bevarer iteration, gaussian-status og optimizer-mo
mentum fuldstændigt — resume fortsætter, hvor det 
blev pauset.

KO R T  S AG T

Mens træningen kører, kan du til 
enhver tid holde den tilbage og 
fortsætte senere. Meningsfuldt, 
om du i mellemtiden vil lave nå­
got andet på Mac’en, der kræver 
meget GPU — f.eks. video-redi­
gering, spil-test eller en render- 
eksport fra en anden app. Klik 
Pause, lav din ting, klik Resume, 
træningen kører videre præcis, 
hvor den var. Iterations-tæller, 
gaussian-antal og optimizer-mo­
mentum bevares fuldstændigt, 
pause-state koster dig intet i 
kvalitet. Under SfM-fasen er pau­
se inte tilgængelig — Apple Pho­
togrammetry kender inte til en 
pause-funktion, der måste du i 
nødstilfælde arbejde med Can­
cel.
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C-26 Cancel-knap

VA R

Nedre navigationslinje, synlig mens behandlingen 
kører (SfM eller träning).

T E K N I S K T

Rød bordered-knap. Åbner en bekræftelsesdialog 
med titel „Stop and discard progress?”, knapper 
„Discard Progress” (destruktiv) og „Keep Run
ning” (Cancel). Vid bekræftelse sættes cancel-fla
get, trænings-tasken afsluttes, SfM-underproces
sen om nødvendigt afsluttes, og en summary-
linje med afbryd-status skrives i JSONL-loggen. I 
modsætning til pause kasseres trænings-buffer og 
status.

KO R T  S AG T

Afbryd-knappen. I modsætning 
til pause är det endeligt — om 
du därefter vil starte på ny, kører 
behandlingen forfra, alle allerede 
trænede iterationer er tabt. Me­
ningsfuldt, om du har valgt for­
kert preset, træningen kører alt 
for långsamt, eller appen åben­
lyst producerer skidt-resultater, 
og du inte vil vente. Før den fak­
tiske afbrydelse spørger appen 
i en bekræftelsesdialog en gang 
til, så du inte vid et uheld mister 
timers regnetid. Om du kun kort 
vil afbryde, så tag hellre pause.

C-27 Retry-knap

VA R

Nedre navigationslinje, synlig om pipelinen er fejlet 
(SfM-status starter med „SfM failed”, eller træning
en er i fejl-tilstand).

T E K N I S K T

Accent-knap. Starter hele pipelinen forfra. Før start 
tjekkes, om der stadig finns importerede bilder/
videoer. Tidligere fejl-logs bevares i JSONL-map
pen; en ny run skriver en ny log-fil med aktuel 
timestamp.

KO R T  S AG T

Om SfM eller träning afbryder 
med en fejlmeddelelse, kan du 
prøve igen her. Nogle gange 
hjælper det, fordi mange trin 
(RANSAC, densification) har til­
fældighedsdele, og et andet 
forsøg kan lykkes, hvor det førs­
te mislykkedes. Hele pipelinen 
kører så igen forfra — SfM og 
träning, i en frisk JSONL-log-fil. 
Om också andet forsøg fejler, er 
input-bilderna som regel proble­
met (for få, for lidt overlap, be­
vægelses-uskarphed, dårligt lys); 
gå så tilbage med Back og ud­
skift dit materiale. Tip: kig sam­
tidig i training-loggene (Help → 
Open Training Logs), der står 
mere detaljeret, hvor det konkret 
gik galt.
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C-28 Inline Loss Chart

VA R

I info-panelet, højre kolonne, kun synlig under trä
ning med inte-tom forløbs-historik.

T E K N I S K T

Kompakt tegne-område (40 pixel højt), tegner loss-
history som 1-pixel-linje i accent-farve. Data filtre
res til finite-värden (NaN-beskyttelse for ustabile 
træninger). Min/max beregnes over hele historikken 
— charten auto-zoomer altså på værdiområdet. Den 
sista loss-värde står øverst til højre over charten. 
Selve historikken bygges op i app-tilstanden vid 
hvert trænings-tick (typiskt hver 100 iterationer).

KO R T  S AG T

En lille loss-kurve, der med ett 
blik visar dig, om træningen 
„konvergerer” (linje falder mod 
højre), eller om den hænger fast 
eller eksploderer (linje flad el­
ler stigende). Vid en sund trä­
ning falder linjen stejlt i star­
ten og fladegør så — det är 
det forventede forløb, lignende 
en halveringskurve. Charten zoo­
mer automatisk på det aktuelle 
værdiområde, så också små for­
bedringer i slutningen av træ­
ningen förblir synlige. Om linjen 
pludselig skyder opad eller fry­
ser, är det et godt signal om, at 
något går galt — enten er materi­
alet problematisk, eller en anden 
preset ville være bedre egnet. 
Charten hittar du i info-panelet, 
som du folder ud øverst til venst­
re med i-symbolet.

C-32 Discoverability Nudge (Expert-Mode-hint)

VA R

I info-panelet, højre kolonne nederst, kun synlig un
der träning OG i begyndertilstand.

T E K N I S K T

Lille linje med øjne-ikon og caption-tekst „Switch 
to Expert Mode (⌘2) for live splat preview”, i tilba
geholdt tone og 10-punkts-skrift. Intet interaktivt 
element, kun hint. Reagerer inte på klik — brugeren 
ska faktisk trykke Cmd+2 eller klikke menuen Mode 
→ Expert Mode.

KO R T  S AG T

Ett diskret hint om, at i Expert 
Mode är den aktuelle mellemver­
sion av din 3D-model live att se 
i viewporten under træningen. I 
begyndertilstand är det bevidst 
skjult for at holde brugerfladen 
rolig — men mange brugere vid 
slet inte, at funktionen finns, så 
vi peger blidt på det her. Tryk 
Cmd+2, og træningen kører vide­
re i baggrunden, mens du kan se 
på, hvordan din model bygger sig 
op for dine øjne. Det er också 
et godt værktøj til allerede efter 
få tusinde iterationer at vurdere, 
om resultatet blir til något, eller 
om du hellre afbryder og star­
ter på ny. Cmd+1 bringer dig til 
enhver tid tilbage til begynder-
visningen.
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Hvornår til nästa trin?

Appen skifter automatisk til Z3 (forhåndsvisning), så snart træningen er afsluttet med 
succes — du behöver inte klikke. Den nedre navigationslinje skifter så fra Pause/Cancel 
til en Back-knap (tilbage til import) og en Export-knap (frem til eksport). I fejltilfælde 
(rød fejlmeddelelse, stage-ikon er X) optræder Retry i stedet, og du måste beslutte, om 
du starter igen eller går tilbage til import med Back for at ændre billedmateriale.

Z3 — Forhåndsvisning (drej 3D-modellen)

Figur 38:  Simple Mode forhåndsvisnings-trin med 3D-viewer

Figur 39:  Z3 forhåndsvisning efter trænings-afslutning — Bjoerns Blender-buket rekonstru
eret, header visar „Training complete — 3,022 Gaussians in 13s”, Back- og Export-knapper 

nederst

211 / 221



R A D I A N C E K I T Kapitel 10 — Begyndertilstand

VAD BILDEN VISAR  Crumb-trail markerer „Preview” som aktivt trin. Fuldskærms-3D-view
port rendrer den færdig trænede buket-scen (syntetisk Blender-test-sæt fra Bjoern, 
60-frame-subset fra 960 hemisfæriske cams). Header-statusbjælke: „Training complete 
— 3 022 Gaussians in 13 s” — giver endeligt gaussian-antal og träningstid. Drag i view
porten roterer kameraet (yaw/pitch); scroll-wheel zoomer langs view-direction. „Back”-
knap (nederst til venstre) vender tilbage til Z2 for resume eller re-run; „Export”-knap 
(nederst til højre, primary) navigerer videre til Z4.

Efter afslutning av træningen lander appen automatisk i forhåndsvisningen. Her ser 
du din færdige Gaussian-splatting- model i en fuldskærms-metal-visning og kan dreje, 
zoome og panorere den med mus og trackpad. På oversiden av viewporten ligger en 
lille overlay med kamerastyring og info — auto- rotation, trænings-statistik, reset-knap. 
Før nästa trin (eksport) är det værd at tjekke modellen fra olika vinkler for at sikre, at 
rekonstruktionen er ren.

C-36 SplatViewportView (3D-hovedvisning)

VA R

Fuldskærms-baggrund av forhåndsvisnings-trinet.

T E K N I S K T

Metal-baserat 3D-viewport, der rendrer den færdi
ge punktmoln. Rendereren är RadianceKits EGEN 
ForwardPass-rasterizer — samma som redan rend
rar splattarna under träningen — så det är äkta 
WYSIWYG (det som tränas visas och eksporte
ras exakt likadant). Tile-baserat rendering-pipeline 
med order-independent transparency. Om rendere
ren inte kan initialiseres (f.eks. fordi Metal inte er 
tilgængeligt på systemet), optræder i stedet en 
sort baggrund med „Metal not available”-tekst. Vis
ningen ignorerer safe-area, så modellen rækker til 
vinduets kant.

KO R T  S AG T

Hovedviewporten. Her ser du din 
færdige 3D-model rekonstrueret 
av dine fotos, rendret på GPU’en i 
realtid. Klik og træk med venstre 
museknap for at rotere. Scroll-
hjul eller trackpad-gestus med 
to fingre for at zoome. Højre 
museknap eller Cmd+træk til at 
panorere. Modellen består av ti­
tusindvis av semi-transparente 
3D-ellipsoider („gaussians”), der 
rekonstruerer din scen fotorea­
listisk — hver enkelt har en posi­
tion, retning, form og farve, som 
træningen har lært. I det sjæld­
ne tilfælde, at din Mac inte un­
derstøtter Metal, ser du i stedet 
en sort baggrund med en hint-
meddelelse — RadianceKit kræ­
ver tvingende en Metal-istandsat 
GPU.
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C-37 CameraControlsOverlay (styrings-overlay)

VA R

Over viewporten, svævende.

T E K N I S K T

Kompakt UI-overlay med knapper til auto-rotation 
(turntable), reset-camera, baggrunds-valg (Gray/
Black/White), save-screenshot, toggle-info-panel. 
Binder til kamera- parametrene (distance, azimut, 
elevation, target, FOV) og styrer auto-turntable. Un
der træningen (när brugeren i Expert Mode vil se 
viewporten køre med) visar overlayet dessutom en 
kompakt trænings-status-linje.

KO R T  S AG T

Den lille svævelinje over model­
len. Her starter du auto-rotatio­
nen (modellen drejer av sig selv, 
godt til screenshots og korte 
demoer), nulstiller kameraet via 
reset til startpositionen (om du 
har vildet væk), skifter baggrund 
(grå til neutral, sort til maksimal 
kontrast, hvid til lyse modeller) 
og laver screenshots direkte, der 
gemmes under  /Pictures. Prak­
tisk, om du vil visa en bestemt 
detalje fra en helt bestemt vin­
kel uden at skulle eksportere he­
le modellen. Auto-rotationen er 
också en god test for, om model­
len ser lige god ud fra alle sider, 
eller om der är en „beskidt side”, 
opstået av manglende optagel­
ser.

C-38 Export-knap (navigationslinje)

VA R

Nedre navigationslinje i Z3.

T E K N I S K T

Accent-knap med label „Export” og share-ikon. Klik 
udløser skift til Z4. Først tjekker den overordnede 
visning, om fuldversionen er låst op — om inte, visas 
i stedet for eksport-stagen låsevisningen (se U-06).

KO R T  S AG T

Om du er tilfreds med resultatet, 
så klik Export, og du lander i sista 
trin, hvor du vælger format og 
gemmer. Uden købt fuldversion 
lander du i stedet på en skærm­
låsning med unlock-hint og købs-
knap — appen vil inte påtvinge 
dig en fuldversion, men eksport 
är en av premium- funktionerne. 
Så snart du har afsluttet købet, 
kører appen direkte videre i låst-
op-tilstand, og du lander i den 
vante eksport-stage. Om du om­
bestemmer dig, kommer du via 
Back- knappen tilbage til for­
håndsvisningen og kan dreje vi­
dere på modellen.

Hvornår til nästa trin?

Før du eksporterer, så drej modellen en gang helt rundt og tjek: er alle områder, du 
har dækket i dine input-bilder, til stede? Finns der svævende „floaters” (frit svævende 
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gauss-splat-skyer i luften)? Virker baggrunden/himlen ren eller udtværet? Alvorlige pro
blemer kan kun fikses vid nytræning — enten med flere bilder, anden preset eller i 
Expert Mode med floater- reduction-settings.

Z4 — Eksport (vælg format & gem)

Figur 40:  Simple Mode eksport-trin med format-kort

Figur 41:  Z4 eksport-kort — 6 formater (PLY 742 KB valgt, SPZ 74 KB, glTF 708 KB, .splat 
96 KB, Orbit Video, Web Viewer 133 KB), Export-History-sidebar til højre med allerede 

eksporteret PLY

VAD BILDEN VISAR  Crumb-trail markerer „Export” som aktivt trin. Venstre kort-grid 
„Choose Export Format” med alle seks muligheder: PLY (standard-3DGS, 742 KB, med 
fulde SH- koefficienter — her forvalgt med blåt flueben), SPZ (komprimeret 3DGS-for
mat, ~90 % mindre end PLY, 74 KB), glTF (med KHR_​gaussian_​splatting-extension, 708 
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KB), .splat (web-viewer-kompatibel via antimatter15, 96 KB), Orbit Video (360°-MP4 av 
scenen, live-størrelsesberegning), Web Viewer (selvstændig HTML med indlejret 3D-
viewer, 133 KB). Størrelsesangivelser beregnes live ud fra aktuelt gaussian-count og 
format-overhead. Til højre „Export History” lister allerede afsluttede eksporter med for
mat-pille, filnavn og timestamp — klik afslører i Hittar. Primary-CTA nederst til venstre: 
„Export PLY (3DGS Standard)” med gaussian-undertitel „2,991 Gaussians · SH degree 
3″.

I sista trin vælger du blandt 6 eksport-formater (PLY, SPZ, glTF, .splat, orbit-video, web-
viewer) via 2-spaltet kort-grid, klikker Export og vælger lagringssted i macOS-dialogen. 
Til højre kører en history over alle hidtidige eksporter — vid kort-valget visas straks 
under hvert kort den anslåede filstørrelse, så du f.eks. foretrækker SPZ, om du vil på 
nettet (lille), og PLY, om du vil importere til en anden software (SuperSplat, Postshot, 
Blender via plugin) (stor og fuldstændig).

C-39 2-Column Format Grid

VA R

Venstre hovedside av eksport-trinet.

T E K N I S K T

Kort-raster med to fleksible kolonner og 12 punkt 
afstand. Itererer over de formater, der tilbydes i 
begyndertilstand — en filtreret delmængde av den 
fulde formatliste, der kun innehåller de 6 viktigaste 
formater: PLY, SPZ, glTF, .splat, orbit-video, web-
viewer. Compressed-PLY og SOG tilbydes KUN i 
Expert Mode.

KO R T  S AG T

Ett kort-raster med de 6 forma­
ter, der er relevante i begynder­
tilstand: PLY (standardformat for 
andre 3D-værktøjer), SPZ (kom­
primeret variant til web), glTF 
(officiel web3D-standard), .splat 
(til antimatter15-web-viewer), or­
bit- video (færdig MP4 til at visa 
frem) og Web Viewer (selvstæn­
dig HTML-fil med indlejret 3D-
afspiller). Dermed dækker du 90 
% av anvendelses-tilfældene. Om 
du har brug for et av de mindre 
gængse formater (Compressed-
PLY eller SOG til ekstrem kompri­
mering), så skift til Expert Mode, 
der er alle 8 formater tilgænge­
lige. Det kompakte valg her er 
bevidst, så begyndere inte over­
vældes av mangfoldigheden.
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C-40 Format Card Button

VA R

Hvert kort i griddet.

T E K N I S K T

Simpel knap med kort-layout: ikon (f.eks. dokument-
zipper for PLY, arkivboks for SPZ, video-ikon for 
orbit-video) øverst, format-navn som headline, be
skrivelses- caption (2-linjes afkortet), derunder den 
anslåede filstørrelse (live beregnet ud fra format, 
gaussian-count og SH-degree og formateret som 
KB/MB). Vid klik vælges formatet. Det valgte kort får 
accent-baggrund, accent-border og et flueben-ikon 
øverst til højre. Tooltip er format-beskrivelsen.

KO R T  S AG T

Ett kort pr. format. Klik en, 
det fremhæves med accent-far­
ve og et flueben, og export-
knappen härunder tilpasser sin 
tekst („Export PLY”, „Export SPZ” 
osv.). Hvert kort visar et passen­
de symbol, navnet, en tolinjet 
kortforklaring og den anslåede 
filstørrelse vid dit aktuelle træ­
nings-resultat. Størrelsen hjæl­
per dig med fornuftigt att välja 
— om du vil sende resultatet 
pr. mail, så tag den mindste vari­
ant (som regel SPZ eller .splat); 
om du vil arbejde videre i en 
anden 3D-software, så tag den 
med bedste kompatibilitet (ty­
piskt PLY). Vid hover over et kort 
visar tooltippet en mere udførlig 
beskrivelse, om du hittar forskel­
lene mellan formaterne uklare.

C-41 Video Duration-slider

VA R

Under format-griddet, kun synlig om et video- for
mat er valgt (orbit-video eller social-video).

T E K N I S K T

Skydeknap 3–30 sekunder i 1-sekund-skridt, binder 
til video-længden i app-tilstanden. Maks-bredde 
300 pixel. Visas kun, om et video-format er valgt. 
Vid inte- video-formater fjernes skydeknappen helt 
fra visningen — ingen død plats.

KO R T  S AG T

Om du vælger en orbit-video 
som eksport, kan du her bes­
temme længden. 3 sekunder = 
meget snabb drejning, 30 sekun­
der = långsam, rolig drejning om 
din model. Til social- media-reels 
(Instagram, TikTok) er som regel 
6–10 sekunder ideelt — længe 
nok til at visa modellen, kort nok 
til, at seerne inte springer fra. 
Vid præsentationer eller portfo­
lio- videoer måste du gerne tage 
15–20 sekunder. Slideren dukker 
kun op, om et video-format er 
valgt; vid fil-formater som PLY el­
ler SPZ ville den være meningsløs 
og er skjult.
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C-42 Export-knap

VA R

Under format-griddet (og under duration-slideren, 
om video valgt).

T E K N I S K T

Stor accent-knap. Label: „Export {format-navn}”, 
share-ikon. Vid klik åbnes macOS-gem-dialogen 
med format- passende endelse og default-filnavn 
„scen.{ext}”; vid bekræftelse skrives eksporten til 
den valgte URL. Deaktiveret, om intet trænings-re
sultat finns, eller en eksport allerede kører.

KO R T  S AG T

Klik, vælg lagringssted i macOS-
dialogen, færdig — appen skri­
ver filen i det valgte format 
på det valgte sted. Default-
navn er „scen.{endelse}” (f.eks. 
„scen.ply” eller „scen.spz”), den 
kan du ændre vilkårligt i dialo­
gen, före du gemmer. Knappen 
er grå, så længe intet trænings-
resultat foreligger (skulle aldrig 
ske her, fordi du annars slet inte 
ville være i eksport-trinet), eller 
en anden eksport allerede kører. 
Så snart eksporten kører, optræ­
der härunder en fremskridtsvis­
ning; appen förblir betjenbar, så 
du kan allerede forberede nästa 
eksport.

C-43 Export Progress Bar

VA R

Under export-knappen, kun synlig mens en eksport 
kører.

T E K N I S K T

Fremskridtsvisning med maks-bredde 300 pixel, 
härunder caption „Exporting… N %”. Værdien går fra 
0 til 1 og opdateres under skrivningen — vid PLY i 
chunks på 10 000 gaussians, vid SPZ engang efter 
kvantisering, vid orbit-video i frame-intervaller.

KO R T  S AG T

Mens eksporten kører, ser du her 
fremskridtet som smal bjælke 
plus procent-visning. PLY er som 
regel færdig i løbet av sekun­
der, fordi filen simpelthen skri­
ves væk binært. SPZ tager lidt 
længere, fordi dataene undervejs 
kvantiseres og komprimeres. Or­
bit-video är den mest tidkræven­
de eksport — her rendres hver 
enkelt frame på ny; alt efter upp­
lösning og længde kan det vare 
et minut eller længere. Under 
eksporten förblir appen betjen­
bar, så du allerede kan forberede 
nästa format eller klikke videre i 
viewporten.
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C-44 Export Error Display

VA R

Under progress-baren, kun synlig om der opstod en 
fejl vid sista eksport.

T E K N I S K T

Rød linje med warning-ikon og fejltekst. Rød 8 %-
baggrunds-opacity, afrundede hjørner. Maks-bred
de 400 pixel. Hyppige fejlårsager: SOG forventer 
cwebp  i system-PATH (inte App Store-konform); 

skrivefejl vid fuldt diskplads; sandbox- fejl vid lag
ringsmål uden for det tilladte område.

KO R T  S AG T

Om eksporten går galt, optræ­
der her i rødt en kort klartekst-
beskrivelse av problemet. Som 
regel er årsagen indlysende — 
ingen plats på disken, ingen skri­
verettigheder til målmappen eller 
et mål uden for sandbox-tillad­
te områder. Specielt vid SOG-
formatet sker det, at cwebp  
mangler i systemet; i så fald kan 
SOG inte bruges, og du måste vi­
ge til SPZ. Om fejlmeddelelsen er 
uklar, så kig i log-mappen (Help 
→ Open Training Logs), der står 
mere udførligt, vad der gik galt. 
I tvivl hjælper det att välja et 
andet lagringssted — f.eks. skri­
vebordet.

C-46 Export History List

VA R

Højre side av eksport-trinet.

T E K N I S K T

Liste over eksport-historikken (gemt persistent som 
JSON i UserDefaults, plejet efter hver vellykket 
eksport). Hver linje visar format-badge (lille, ac
cent-farvet), timestamp (HH:mm), filnavn (1 linje 
afkortet) og formateret filstørrelse. Klik på en linje 
åbner Hittar med valgt fil. Empty-state: „No exports 
yet”.

KO R T  S AG T

En liste over dine hidtidige 
eksporter — format, klokkeslæt, 
filnavn, størrelse, i kronologisk 
rækkefølge. Klik på en linje, og 
filen fremhæves i Hittar, uden 
at du selv ska navigere genom 
mapper. Praktisk, om du en time 
senere igen ska bruge den sista 
eksport og inte længere vid, hvor 
du gemte den — historikken hus­
ker det. Om du aldrig före har 
eksporteret något, står her et 
venligt hint „No exports yet”. Lis­
ten overlever genstarter av ap­
pen, fordi den er gemt i UserDe­
faults.
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C-48 History Context Menu (højreklik)

VA R

Højreklik på en history-linje.

T E K N I S K T

Kontekstmenu på hver liste-post med to handlinger: 
„Reveal in Hittar” (åbner Hittar med valgt fil, som et 
almindeligt klik) og „Copy Path” (lægger den fulde 
fil- sti som tekst i udklipsholderen). Sidstnævnte er 
användbar til træk-og-slip i andre apps eller over
dragelse til kommandolinjen.

KO R T  S AG T

Højreklik på en history-post åb­
ner en lille menu med to hand­
linger. „Reveal in Hittar” gör det 
samme som et almindeligt klik — 
åbner Hittar med valgt fil, så du 
straks ser den. „Copy Path” læg­
ger den komplette filsti i udklip­
sholderen, så du kan indsætte 
den f.eks. i terminal- kommando­
er, i andre apps eller i en note. 
Særligt praktisk, om du vil give 
eksporten videre til någon eller 
åbne den i et andet program, der 
arbejder med sti-input. Funktio­
nelt en lille, men hjælpsom detal­
je, der følger Mac-typiske betje­
nings-patterns.

Hvornår er arbejdsgangen afsluttet?

Efter en vellykket eksport har du din 3D-model som fil på disken, og historikken visar 
en ny post. Der er ingen „Done”- knap — du kan vedhænge vilkårligt mange eksporter i 
olika formater uden at träna på ny. Om du vil tilbage til forhåndsvisningen (f.eks. for igen 
at tjekke et kamera- perspektiv), så brug Back-knappen i den nedre navigationslinje. 
Om du vil starte en helt ny scen, så gå via Back tilbage til Z1 og brug der Clear All, eller 
File → New Project (Cmd+⇧+N).

Skift til Expert Mode

Tryk til enhver tid Cmd+2 eller vælg Mode → Expert Mode ( M8 ). Hele tilstanden 
bevares: importerede bilder, valgt preset, kørende eller færdig träning, færdig punkt
moln, eksport-historik, endda den aktuelle stage. I Expert Mode visas i stedet for det 
fire-trins-stage hele Inspector-sidebaren med alle ~150 betjeningsfelter. Især: Project 
Navigator (se kapitel 2) tilbyder de udvidede bild-operationer (minus-knap, backspa
ce-delete, Cmd-Z-undo, Quick-Look-forhåndsvisning), live-preview i viewporten under 
træningen samt alle loss-, MCMC-, densification- og Mip-splatting-parametre. Cmd+1 
skifter tilbage til begyndertilstanden — också det taber ingen tilstand.

Ofte stillede spørgsmål

Hvorfor förblir min Start Processing-knap grå?
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Du har endnu inte importeret bilder eller en video. Træk mindst en fil ind i drop-zonen, 
eller brug „Browse Files”. Så snart billedlisten til højre innehåller mindst en post, blir 
knappen aktiv. (Vid kun 1–2 bilder starter den ganske vist, men SfM afbryder straks med 
fejl — se det røde validation- banner.)

Hvorfor er min Export-knap låst?

I begyndertilstand er der to trin: (a) Om trænings-pipelinen endnu inte er færdig, og 
du ingen har, er knappen deaktiveret — du ska først afslutte Z2. (b) Om du endnu 
inte har købt fuldversionen (PurchaseManager.hasAccess == false), ser du i stedet for 
eksport-stagen en låsevisning med låse-ikon og „Unlock Full Version”-knap, der åbner 
purchase-sheetet. Quick- og Preview-presets tillader träning gratis, men eksport er 
premium.

Hvorfor kan jeg inte vælge en preset?

Du kan vælge den — men om du trykker på en premium-preset (Balanced, Quality, 
MCMC-varianter) uden købt fuldversion, springer vælgeren automatisk tilbage på Pre
view, og purchase- sheetet åbnes. Quick og Preview er de eneste gratis brugbare 
presets.

Hvorfor er min drop-zone tom og stiplet-grå, selv om jeg trækker bilder ind?

Sannolikt en UTI-type-mismatch. Appen accepterer JPG, PNG, TIFF, HEIC, MP4, MOV 
plus app’ens egne splat-formater. Andre billedformater (BMP, GIF, WebP, RAW-forma
ter) genkendes IKKE. Om du er sikker på, at din billedtype burde være der, så tjek 
filnavn-endelsen — appen går primärt efter extension, inte efter fil-indhold.

Hvorfor varer SfM så længe, selv om jeg kun har 30 bilder?

Apple Photogrammetry skalerer inte lineært — vid visse bild-konstellationer (indendørs 
rum med komplekse teksturer, bevægelses-uskarphed, dårligt lys) tager det markant 
længere, end bild-count lader formode. Om SfM efter 10+ minutter vid 30 bilder stadig 
hænger, så afbryd og prøv igen med bedre materiale, eller skift til Expert Mode og prøv 
COLMAP/Native- SfM (Cmd+2 → Inspector → Camera Alignment).

Hvor hittar jeg mine training-logs?

Help → Open Training Logs (Cmd+⇧+L). Det åbner ~/​Documents/​RadianceKit/​Logs/​. 
Hver trænings-session skriver en egen JSONL-fil med timestamp i filnavnet — første 
linje er konfigurationen, därefter følger en progress-linje hver 100 iterationer, sista linje 
er summary med final-loss og success- flag.
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